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Assistenza tecnica Bio-Rad™
Il reparto di assistenza tecnica di Bio-Rad negli Stati Uniti è aperto dal lunedì al venerdì, dalle ore 05.00 alle
ore 17.00 (fuso costa pacifica).

Telefono: 1-800-424-6723, opzione 2

E-mail: support@bio-rad.com (solo per U.S.A./Canada)

Per assistenza tecnica al di fuori degli Stati Uniti e del Canada, contattare l'ufficio locale di assistenza tecnica
oppure fare clic sul link Contattaci disponibile all'indirizzo bio-rad.com.

Avviso
Nessuna parte della presente pubblicazione può essere riprodotta o trasmessa in alcuna forma o mediante
alcun mezzo, elettronico o meccanico, fra cui fotocopia, registrazione o qualsiasi sistema di conservazione o
recupero delle informazioni, senza l’autorizzazione scritta di Bio-Rad Laboratories, Inc.

Bio-Rad si riserva il diritto di modificare i propri prodotti e servizi in qualsiasi momento. Questa guida è
soggetta a modifiche senza preavviso. Sebbene si impegni a garantire l'accuratezza, Bio-Rad non si assume
alcuna responsabilità per errori od omissioni, o per danni derivanti dall'applicazione o dall'utilizzo di queste
informazioni.

BIO-RAD è un marchio di Bio-Rad Laboratories, Inc.

SYBR è un marchio di Thermo Fisher Scientific Inc.

EvaGreen è un marchio di Biotium, Inc.

Tutti i marchi utilizzati nel presente documento appartengono ai rispettivi proprietari.

Copyright © 2022 di Bio-Rad Laboratories, Inc. Tutti i diritti riservati.

http://www.bio-rad.com/


Uso previsto

Uso previsto
Il sistema per PCR in tempo reale CFX Opus DxTM con Software CFX Maestro Dx, Security EditionTM ha
lo scopo di eseguire la PCR basata sulla fluorescenza per rilevare sequenze quantitative di acidi nucleici.
Il sistema e il software sono previsti per l'uso diagnostico in vitro da parte di tecnici di laboratorio
qualificati. I sistemi vanno utilizzati con test diagnostici degli acidi nucleici di terzi, che sono stati prodotti
ed etichettati per scopi diagnostici.

Glossario dei simboli

Produttore Numero di lotto

Data di scadenza Per uso diagnostico in vitro

Limite di temperatura Numero di catalogo

Consultare le istruzioni per l'uso Numero di test

Per l'uso con Numero di serie

Solo su prescrizione medica Contiene lattice
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Marchio CE - Regolamento
(UE) 2017/746 IVDR

Traduzioni
I documenti del prodotto possono essere forniti in altre lingue su supporti elettronici.
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Cronologia delle revisioni

Cronologia delle revisioni
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Sicurezza e conformità normativa
I sistemi per PCR in tempo reale CFX Opus 96 Dx, CFX Opus 384 Dx e CFX Opus Deepwell Dx
(denominati in questa guida sistema CFX Opus Dx) si riscaldano e si raffreddano molto rapidamente
durante il funzionamento. Per un funzionamento sicuro del sistema per PCR in tempo reale, Bio-Rad
consiglia vivamente di seguire le specifiche di sicurezza elencate in questo paragrafo e in tutto il manuale.

Etichette di avvertenza per la sicurezza
Le etichette di avvertenza riportate sul sistema CFX Opus Dx e in questo manuale avvisano l’utente
relativamente alle fonti di possibili lesioni o danni. Nella Tabella 1 viene definita ciascuna etichetta di
avvertenza per la sicurezza.

Icona Significato

L'azionamento del sistema CFX Opus Dx prima di aver letto questo manuale può
comportare un rischio di lesioni personali. L'uso dello strumento in un modo non
specificato in questo manuale o da Bio-Rad può comprometterne o disabilitarne le
funzioni di protezione.

Non sussistono rischi biologici o rischi radioattivi associati al sistema CFX Opus Dx
stesso. Tali rischi diventano una preoccupazione solo quando vengono introdotti
nel sistema tramite i campioni da analizzare. Durante la manipolazione di campioni
a rischio biologico o radioattivi, attenersi alle precauzioni consigliate e alle linee
guida specifiche per il proprio laboratorio e luogo. Le linee guida dovrebbero
includere la pulizia, il monitoraggio e i metodi di smaltimento per i materiali
pericolosi in uso.

Inoltre, come indicato sopra, esiste un piccolo rischio di esplosione o di espulsione
di liquidi o vapori dai contenitori dei campioni. Quando si lavora con materiali
pericolosi, il rischio di lesioni dovute al materiale espulso è aggravato dal rischio
che il materiale pericoloso stesso possa essere disperso all'interno e intorno allo
strumento. Gli utenti dovrebbero adottare precauzioni appropriate per tale
circostanza.

Tabella 1. Avvertenze generali di sicurezza
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Sicurezza e conformità normativa

Icona Significato

Il sistema CFX Opus Dx funziona a temperature sufficientemente elevate da
causare gravi ustioni. Lasciare sempre che il blocco campioni torni alla
temperatura ambiente prima di aprire il coperchio e rimuovere i campioni. Anche
dopo il raffreddamento del blocco, le aree circostanti e la piastra del riscaldatore
possono rimanere calde per un tempo prolungato. In situazioni in cui non vi è
tempo sufficiente per consentire allo strumento di raffreddarsi, si consiglia l'uso di
dispositivi di protezione quali guanti termici o “guanti da forno”.

La sicurezza e le prestazioni di qualsiasi sistema che incorpora un sistema CFX
Opus Dx è di esclusiva responsabilità dell'assemblatore del sistema.

Durante il normale funzionamento, il sistema CFX Opus Dx può diventare
sufficientemente caldo da causare l'ebollizione o l’evaporazione dei liquidi nei
campioni, pressurizzando i contenitori dei campioni. Esiste la possibilità che i
contenitori dei campioni possano danneggiarsi causando perdite, spruzzi di fluido
o rotture esplosive nonché l'espulsione di vapori o liquidi all'interno e intorno allo
strumento.

Gli utenti devono sempre utilizzare lo strumento con il coperchio chiuso o
indossare occhiali di protezione, guanti termici e altri dispositivi di protezione
personale durante il funzionamento per evitare lesioni. L'apertura del coperchio
mentre i campioni sono ancora caldi, ad esempio dopo l'interruzione di un'analisi,
può causare fuoriuscite, spruzzi o schizzi di liquido dai contenitori pressurizzati.
Lasciare sempre raffreddare i campioni prima di aprire il coperchio.

Gli utenti non dovrebbero mai eseguire reazioni con il coperchio o sigillo aperto,
allentato, forato o danneggiato in altro modo poiché ciò aumenta la probabilità di
una rottura o esplosione pericolosa.

Gli utenti non dovrebbero mai eseguire reazioni con reagenti volatili che
potrebbero aumentare la probabilità di una rottura o esplosione pericolosa.

Tabella 1. Avvertenze generali di sicurezza, continua
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Sicurezza e conformità normativa

Sicurezza e conformità normativa

Conformità alla sicurezza
Il sistema CFX Opus Dx è stato testato e ritenuto conforme a tutti i requisiti applicabili dei seguenti
standard di sicurezza ed elettromagnetici:

n IEC 61010-1:2010 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per utilizzo
in laboratorio - Parte 1: Prescrizioni generali

n IEC 61010-2-010:2019 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-010: Prescrizioni particolari per apparecchi da laboratorio per il
riscaldamento di materiali

n IEC 61010-2-081:2019 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-081: Prescrizioni particolari per apparecchi da laboratorio automatici e
semi-automatici per analisi e altri scopi

n IEC 61010-2-101:2018 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-101: Prescrizioni particolari per apparecchiature mediche per uso
diagnostico in vitro (IVD)

n CAN/CSA-C22.2 NO. 61010-1-12:2018 Prescrizioni di sicurezza per apparecchi elettrici di misura,
controllo e per utilizzo in laboratorio - Parte 1: Prescrizioni generali

n CAN/CSA-C22.2 NO. 61010-2-010:19 Prescrizioni di sicurezza per apparecchi elettrici di misura,
controllo e per utilizzo in laboratorio - Parte 2-010: Prescrizioni particolari per apparecchi da
laboratorio per il riscaldamento di materiali

n CAN/CSA-C22.2 NO. 61010-2-081:19 Prescrizioni di sicurezza per apparecchi elettrici di misura,
controllo e per utilizzo in laboratorio - Parte 2-081: Prescrizioni particolari per apparecchi da
laboratorio automatici e semi-automatici per analisi e altri scopi

n CSA-C22.2 NO. 61010-2-101:19 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo
e per utilizzo in laboratorio - Parte 2-101: Prescrizioni particolari per apparecchiature mediche per
uso diagnostico in vitro (IVD)

n EN 61010-1:2010 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per utilizzo in
laboratorio - Parte 1: Prescrizioni generali
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Sicurezza e conformità normativa

n EN 61010-2-010:2014 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-010: Prescrizioni particolari per apparecchi da laboratorio per il
riscaldamento di materiali

n EN 61010-2-081:2015 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-081: Prescrizioni particolari per apparecchi da laboratorio automatici e
semi-automatici per analisi e altri scopi

n EN 61010-2-101:2017 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-101: Prescrizioni particolari per apparecchiature mediche per uso
diagnostico in vitro (IVD)

n UL 61010-1:2012 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per utilizzo in
laboratorio - Parte 1: Prescrizioni generali

n UL 61010-2-010:2019 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-010: Prescrizioni particolari per apparecchi da laboratorio per il
riscaldamento di materiali

n UL 61010-2-081:2019 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per
utilizzo in laboratorio - Parte 2-081: Prescrizioni particolari per apparecchi da laboratorio automatici e
semi-automatici per analisi e altri scopi

n UL 61010-2-101:19 Prescrizioni di sicurezza per apparecchi elettrici di misura, controllo e per utilizzo
in laboratorio - Parte 2-101: Prescrizioni particolari per apparecchiature mediche per uso diagnostico
in vitro (IVD)

Compatibilità elettromagnetica (EMC)
Il sistema CFX Opus Dx è stato testato e ritenuto conforme a tutti i requisiti applicabili dei seguenti
standard di compatibilità elettromagnetica:

n IEC 61326-1:2012 Apparecchi elettrici di misura, controllo e laboratorio - Prescrizioni di compatibilità
elettromagnetica - Parte 1: Prescrizioni generali. Testato come dispositivo di classe A.

n IEC 61326-2-6:2012 Apparecchi elettrici di misura, controllo e laboratorio - Prescrizioni di
compatibilità elettromagnetica - Parte 2–6: Prescrizioni particolari per apparecchiature mediche per
uso diagnostico in vitro (IVD)

n EN 61326-1:2013 Apparecchi elettrici di misura, controllo e laboratorio - Prescrizioni di compatibilità
elettromagnetica - Parte 1: Prescrizioni generali. Testato come dispositivo di classe A.

n EN 61326-2:-6:2013 Apparecchi elettrici di misura, controllo e laboratorio - Prescrizioni di
compatibilità elettromagnetica - Parte 2-6: Prescrizioni particolari per apparecchiature mediche per
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uso diagnostico in vitro (IVD)

n FCC Parte 15, Sottoparte B, Sezioni 15.107 e 15.109. Testato come dispositivo digitale di classe A.

n CAN ICES-003v6:2019 Standard per apparecchiature che provocano interferenze, apparecchiature
per la tecnologia dell'informazione (comprese le apparecchiature digitali) - Limiti e metodi di
misurazione. Testato secondo i limiti di classe A.

Note e avvertenze di compatibilità elettromagnetica
n Avvertenza: le modifiche o i cambiamenti apportati a questa unità, non espressamente approvati da

Bio-Rad, potrebbero invalidare l'autorità dell'utente di utilizzare l'apparecchiatura.

n Nota: questo apparecchio è stato collaudato e ritenuto conforme ai limiti previsti per i dispositivi
digitali di classe A, conformemente alla Parte 15 delle norme FCC. Tali limiti sono concepiti per
fornire un ragionevole livello di protezione contro interferenze dannose quando l'apparecchiatura
viene azionata in un ambiente commerciale. Questo dispositivo genera, usa e può irradiare energia a
radiofrequenza; se non viene installato e utilizzato in ottemperanza al manuale delle istruzioni, può
causare interferenze dannose per le radiocomunicazioni. È probabile che il funzionamento di questa
apparecchiatura in una zona residenziale causi interferenze dannose, nel cui caso l'utente dovrà
correggere l'interferenza a proprie spese.

n Nota relativa alla conformità FCC: sebbene questo strumento sia stato testato e ritenuto conforme
alla Parte 15, Sottosezione B delle norme FCC per un dispositivo digitale di classe A, non
dimenticare che tale conformità è volontaria, affinché lo strumento venga qualificato come
“dispositivo esente” ai sensi di 47 CFR 15.103(c), in merito alle norme FCC citate in vigore al
momento della produzione.

n Nota sui cavi: questo strumento è stato testato per la conformità EMC utilizzando cavi USB
appositamente progettati, forniti con lo strumento. Questi cavi, o sostituzioni autorizzate da Bio-Rad,
devono essere utilizzati con questo strumento per garantire la continua conformità ai limiti di
emissioni EMC.
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Requisiti di ambiente
Il sistema CFX Opus Dx sono stati progettati per funzionare in sicurezza nelle condizioni ambientali
elencate nella tabella di seguito.

Parametro Specifica

Ambiente Solo per uso in ambienti interni

Altitudine operativa Fino a 2.000 d’altezza (s.l.m.)

Temperatura ambiente 15-31 °C*

Temperatura di trasporto e conservazione Da -20 a 60 °C**
da -4 a 140 °F

Umidità relativa Dal 20 all’80% (senza condensa)***

Potenza di funzionamento Da 100 a 240 V CA ± 10%, 50/60 Hz, 850 W
max

Fluttuazione della tensione di rete ±10%

Consumo energetico massimo <850 watt

Fusibili 10 A, 250 V, 5 x 20 mm, ad azione veloce (qtà.
2)

Categoria di sovratensione II

Grado di inquinamento 2

*Il funzionamento dello strumento al di fuori di questo intervallo di temperatura potrebbe non soddisfare
le specifiche di prestazione. Una temperatura ambiente compresa tra 5 e 40 °C è considerata sicura.

**Conservare e trasportare lo strumento nel suo contenitore di spedizione per soddisfare queste
condizioni di temperatura.

***Il funzionamento dello strumento a 4 ⁰C dovrebbe essere limitato a 18 ore in queste condizioni. La
conservazione a 4 ⁰C deve essere limitata a un massimo di 72 ore se l'umidità è inferiore al 60% (senza
condensa).

Tabella 2. Requisiti di ambiente per sistema per PCR in tempo reale CFX Opus Dx
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Pericoli
Il sistema CFX Opus Dx è progettato per funzionare in sicurezza se utilizzato nel modo prescritto dal
produttore. Se il sistema o uno dei suoi componenti associati viene utilizzato in un modo non specificato
dal produttore, la protezione intrinseca fornita dallo strumento potrebbe essere compromessa. Bio-Rad
non è responsabile per lesioni o danni causati dall'uso di questa apparecchiatura in modo non specificato
o da modifiche allo strumento non eseguite da Bio-Rad o un agente autorizzato. La manutenzione del
sistema CFX Opus Dx deve essere eseguita solo da personale addestrato Bio-Rad.

Rischi biologici
Il sistema CFX Opus Dx è un prodotto di laboratorio. Se tuttavia sono presenti campioni a rischio
biologico, attenersi alle seguenti linee guida e rispettare eventuali linee guida locali specifiche del
laboratorio e del luogo.

Nota: durante il normale funzionamento di questo strumento, non viene rilasciata alcuna sostanza di
origine biologica potenzialmente dannosa.

Precauzioni generali

n Indossare sempre camice e guanti da laboratorio, nonché occhiali di protezione con elementi
protettivi laterali o occhialini protettivi da laboratorio.

n Tenere le mani lontano da bocca, naso e occhi.

n Prima di lavorare con materiali potenzialmente infettivi, proteggere completamente eventuali tagli o
abrasioni cutanee.

n Lavarsi bene le mani con acqua e sapone dopo aver lavorato con qualsiasi materiale potenzialmente
infettivo e prima di lasciare il laboratorio.

n Rimuovere orologi da polso e braccialetti prima di iniziare il lavoro al banco del laboratorio.

n Conservare tutto il materiale infettivo o potenzialmente infettivo in contenitori infrangibili ed ermetici.

n Prima di uscire dal laboratorio, rimuovere gli indumenti di protezione.

n Non usare i guanti per scrivere, rispondere al telefono, accendere la luce o toccare oggetti che altri
potrebbero toccare a mani nude.

n Cambiare i guanti di frequente. Rimuovere immediatamente i guanti quando sono visibilmente
contaminati.

n Non esporre materiali che non possono essere adeguatamente decontaminati a contatto con
materiale potenzialmente infettivo.
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n Dopo aver completato un'operazione sul materiale a rischio biologico, decontaminare l'area di lavoro
con un disinfettante appropriato (ad esempio, una diluizione di candeggina per uso domestico in
rapporto 1:10).
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Decontaminazione delle superfici

AVVERTENZA Per evitare scosse elettriche, spegnere e scollegare sempre lo
strumento prima di eseguire le procedure di decontaminazione.

Le seguenti superfici possono essere pulite utilizzando un disinfettante battericida, virucida o fungicida di
grado ospedaliero:

n Coperchio esterno e telaio

n Superficie interna del blocco campioni e pozzetti del blocco campioni

n Pannello di controllo e display

Per preparare e applicare il disinfettante, fare riferimento alle istruzioni fornite dal produttore del prodotto.
Dopo aver applicato il disinfettante, sciacquare sempre il blocco campioni e i pozzetti del blocco campioni
svariate volte con acqua. Asciugare accuratamente il blocco campioni e i pozzetti del blocco campioni
dopo aver risciacquato con acqua.

Importante: non utilizzare detergenti abrasivi o corrosivi o soluzioni alcaline forti. Questi agenti
possono graffiare le superfici e danneggiare il blocco campioni, determinando la perdita
dell’accuratezza del controllo termico.

Smaltimento di materiali biologicamente pericolosi

I seguenti materiali potenzialmente contaminati vanno smaltiti in conformità con le normative locali,
regionali, nazionali e di laboratorio.

n Campioni clinici

n Reagenti

n Cuvette di reazione usate o altri materiali di consumo potenzialmente contaminati

Rischi chimici
Il sistema CFX Opus Dx non contiene materiali chimici potenzialmente pericolosi.

Rischio di esplosione o infiammabilità
Il sistema CFX Opus Dx non presenta alcun rischio particolare in relazione all’infiammabilità o
all’esplosione quando viene utilizzato in maniera corretta secondo quanto indicato da Bio-Rad
Laboratories.
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Rischi elettrici
Il sistema CFX Opus Dx non comporta alcun rischio particolare per gli operatori se viene installato e
utilizzato correttamente senza alcuna modifica fisica e collegato a una fonte di alimentazione conforme
alle specifiche.

Trasporto
Prima di spostare o spedire sistema CFX Opus Dx, è necessario eseguire le procedure di
decontaminazione. Spostare o spedire sempre il sistema in un contenitore separato nel materiale di
imballaggio fornito da Bio-Rad per proteggere il sistema da eventuali danni.

Per informazioni sul trasporto del sistema e per richiedere il materiale di imballaggio appropriato,
contattare l’ufficio Bio-Rad locale.

Batteria
Il sistema CFX Opus Dx utilizza una batteria per mantenere le impostazioni dell'ora in caso di
interruzione dell’alimentazione CA. Se l'ora non rimane impostata dopo lo spegnimento dell'unità, può
significare che le batterie si stanno esaurendo.

AVVERTENZA Non tentare di cambiare le batterie. Non sono riparabili dall'utente.
Contattare l'assistenza tecnica Bio-Rad.

Solo per lo stato della California, USA

n Materiale perclorato - Le batterie al litio contengono materiale perclorato; potrebbe essere
necessario un trattamento speciale. Vedere www.dtsc.ca.gov/hazardouswaste/perchlorate.

Smaltimento
Il sistema CFX Opus Dx contiene materiali elettrici che non devono essere smaltiti come rifiuti
indifferenziati e devono essere raccolti separatamente, conformemente alla Direttiva dell'Unione Europea
2012/19/UE sui rifiuti di apparecchiature elettriche ed elettroniche (Direttiva RAEE). Prima dello
smaltimento, contattare il rappresentante Bio-Rad locale per le istruzioni specifiche del paese.

Garanzia
Il sistema CFX Opus Dx e i relativi accessori sono coperti da una garanzia Bio-Rad standard. Per
maggiori dettagli sulla garanzia, contattare l'ufficio Bio-Rad locale.
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Capitolo 1 Introduzione
I sistemi di amplificazione PCR ad alte prestazioni di Bio-Rad integrano i più recenti progressi tecnologici,
fornendo una maggiore accuratezza e riproducibilità nell'amplificazione degli acidi nucleici per
esperimenti genomici.

Il Software CFX Maestro Dx, Security Edition di Bio-Rad è compatibile con i seguenti strumenti e file di
analisi ottimizzati per i saggi con sonde e primer PrimePCR di Bio-Rad.

n Sistema per PCR in tempo reale CFX Opus 96 Dx (denominato in questa guida CFX Opus 96 Dx)

n Sistema per PCR in tempo reale CFX Opus 384 Dx (denominato in questa guida CFX Opus 384 Dx)

n Sistema per PCR in tempo reale CFX Opus Deepwell Dx (denominato in questa guida CFX Opus
Deepwell Dx)
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Utilizzando il Software CFX Maestro Dx, Security Edition (denominato in questa guida CFX Maestro Dx
SE), è possibile interpretare dati complessi e realizzare studi efficaci per l’analisi genetica. Con pochi clic,
è possibile impostare studi e comprendere lo studio di espressione genica con strumenti quali test t, one-
way ANOVA, analisi dei controlli PrimePCR e lo strumento di selezione del gene di riferimento.
Successivamente, è possibile preparare i risultati per pubblicazioni e poster con gli strumenti di
annotazione e visualizzazione dati altamente personalizzabili di CFX Maestro Dx SE.

Nota: la visualizzazione di alcune schermate in CFX Maestro potrebbe apparire diversa da quelle
rappresentate in questa guida per l'utente. La visualizzazione nel software è corretta e la funzionalità
è la stessa.

Importante: La sicurezza informatica è la protezione delle risorse presenti nel cyberspazio dagli
attacchi informatici. La sicurezza informatica è la capacità di Bio-Rad di proteggere le sue persone, le
sue informazioni, i suoi sistemi e anche la sua reputazione nel cyberspazio. Il cyberspazio è un
mondo tecnologicamente interconnesso, sempre attivo e formato da persone, organizzazioni,
informazioni e tecnologia.

Per tutti i problemi di sicurezza informatica, è fondamentale reagire in fretta. Se si sospetta che vi sia un
problema di sicurezza informatica relativo alla propria strumentazione o si sia verificata una violazione
della sicurezza informatica stessa, contattare immediatamente il proprio rappresentante Bio-Rad per
assistenza tecnica.
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Caratteristiche principali del Software CFX Maestro Dx,
Security Edition

Con CFX Maestro Dx SE è possibile eseguire quanto segue:

n Analizzare i dati utilizzando grafici a barre, diagrammi di gruppo o diagrammi di dispersione per
interpretare e comprendere rapidamente i risultati.

n Personalizzare la rappresentazione dei dati ed esportare i grafici ad alta risoluzione per la
pubblicazione e la generazione di report.

n Determinare la qualità dell’RNA e risolvere i problemi degli esperimenti con i controlli dell’analisi
PrimePCR.

n Selezionare il gene di riferimento appropriato e analizzarne la stabilità utilizzando lo strumento di
selezione del gene di riferimento.

n Eseguire analisi statistiche utilizzando la tecnica di analisi della varianza a un criterio di
classificazione (one-way ANOVA) nell’analisi dell’espressione genica.

La presente guida per l’utente spiega queste funzioni e come utilizzarle.

Maggiori informazioni
Dopo aver installato CFX Maestro Dx SE e impostato lo strumento per PCR Bio-Rad associato, è
possibile accedere a questa guida nonché agli argomenti dettagliati della guida di CFX Maestro Dx SE dal
menu Help (Guida) in qualsiasi vista.

Suggerimento: fare clic sul logo Bio-Rad nell’angolo in alto a destra di una finestra di CFX Maestro
Dx SE per avviare il sito web di Bio-Rad. Questo sito include collegamenti a note tecniche, manuali,
video, informazioni di prodotto e assistenza tecnica. Questo sito fornisce inoltre molte risorse
tecniche su un’ampia varietà di metodi e applicazioni correlate alla PCR, alla real-time PCR e
all’espressione genica.
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Capitolo 2 Installazione del Software CFX Maestro
Dx, Security Edition

In questo capitolo viene spiegato come configurare il Software CFX Maestro Dx, Security Edition. Per
informazioni sull’impostazione degli strumenti per PCR in tempo reale di Bio-Rad supportati, consultare la
guida appropriata.

CFX Maestro Dx SE è necessario per analizzare i dati PCR in tempo reale dai sistemi per PCR in tempo
reale CFX Opus 96 Dx, CFX Opus 384 Dx e CFX Opus Deepwell Dx. Inoltre, è possibile utilizzare questo
software per controllare questi sistemi in modalità controllata da software.

I sistemi CFX Opus Dx vengono forniti con un cavo USB nella borsa degli accessori. Utilizzare il cavo
USB per collegare il computer che esegue CFX Maestro Dx SE al sistema CFX Opus Dx.

Rimuovere i materiali di imballaggio e conservarli per utilizzi futuri. Qualora manchi un componente o sia
danneggiato, contattare l’ufficio Bio-Rad locale.
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Requisiti di sistema
Nella Tabella 3 sono elencati i requisiti di sistema minimi e consigliati per il computer che esegue
CFX Maestro Dx SE.

Sistema Minimo Consigliato

Sistema operativo Microsoft Windows 10 (solo 64
bit), build 1511 o successiva,
con gli ultimi aggiornamenti di
sicurezza.

Microsoft Windows 10 (solo 64 bit), build 1511
o successiva, con gli ultimi aggiornamenti di
sicurezza.

Nota: anche Microsoft Windows 11 supporta il Software CFX Maestro Dx, Security Edition

Importante: l'avvio protetto deve essere disabilitato sui computer che eseguono CFX Maestro Dx SE.
I computer che eseguono CFX Maestro Dx SE devono essere configurati in modo che non si riavviino
automaticamente dopo un aggiornamento di sicurezza o del sistema se è in corso un'analisi. Per
ricevere assistenza, rivolgersi all'amministratore di sistema.

Porte 2 porte USB 2.0 ad alta velocità 2 porte USB 2.0 ad alta velocità

Spazio disponibile
su disco rigido

128 GB 128 GB

Velocità del
processore

2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB DI RAM 8 GB DI RAM

Risoluzione dello
schermo

1024 x 768 con modalità true-
color

1280 x 1024 con modalità true-color

Lettore PDF Adobe PDF Reader o Windows PDF Reader di
una delle Microsoft Office Suite supportate:

n 2016

n 2019

Localizzazione È supportato il sistema operativo
Microsoft Windows a 64 bit in
inglese, cinese e russo

È supportato il sistema operativo Microsoft
Windows a 64 bit in inglese, cinese e russo

Tabella 3. Requisiti del computer per CFX Maestro Dx SE

Nota: se si prevede di eseguire il software CFX Automation Control sullo stesso computer di
CFX Maestro Dx SE, impostare la risoluzione dello schermo su 1280 x 1024 con la modalità 16,8
milioni di colori.
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Installazione del software CFX Maestro Dx SE
Importante: prima di installare o aggiornare il software, è necessario scollegare dal computer
CFX Maestro Dx SE tutti gli strumenti collegati. Non occorre spegnere lo strumento durante
l’installazione software. Verificare di aver salvato tutte le analisi e che non vi siano esperimenti in
esecuzione.

Nota: verificare che l'avvio protetto sia disabilitato prima di iniziare la procedura di installazione.
Assicurarsi che il computer sia configurato in modo tale da non riavviarsi automaticamente dopo un
aggiornamento di sistema o di sicurezza se è in corso un'analisi. Per ricevere assistenza, rivolgersi
all'amministratore di sistema.

Per installare il software CFX Maestro Dx SE

1. Se necessario, scollegare dal computer tutti gli strumenti collegati.

Individuare e scollegare il cavo USB dello strumento sul computer CFX Maestro Dx SE. L’estremità
collegata al sistema CFX Opus Dx può rimanere inserita.

2. Accedere al computer CFX Maestro Dx SE con i privilegi amministrativi.

3. Inserire l’unità USB del software CFX Maestro Dx SE nella porta USB del computer.

4. In Windows Explorer (Esplora risorse), accedere e aprire l’unità USB del software CFX Maestro Dx
SE.

L’unità USB contiene le note di rilascio e le seguenti cartelle:

n CFX

n Drivers (Driver)

n Firmware

n Quick Start (Avvio rapido)

Oltre ad altri file, la cartella CFX contiene il programma di installazione del CFX Maestro Dx SE
(CFXMaestroDxSetup.exe).

5. Aprire la cartella CFX e fare doppio clic su CFXMaestroDxSetup.exe per avviare il programma di
installazione.

6. Seguire le istruzioni di installazione visualizzate sullo schermo.

Al termine dell’operazione, l’icona del Software CFX Maestro Dx, Security Edition Bio-Rad viene
visualizzata sul desktop del computer.
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Suggerimento: il programma di installazione di CFX Maestro installa automaticamente la guida
per l’utente del Software CFX Maestro Dx, Security Edition. Per individuare queste guide,
accedere al menu Help (Guida) e selezionare Open User Guides (Apri guide per l'utente).

7. Al termine dell’installazione, è possibile rimuovere in sicurezza l’unità USB del software.
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Rilevamento degli strumenti collegati
Durante l'installazione, il programma di installazione software di CFX Maestro Dx SE installa
automaticamente i driver dello strumento sul computer CFX Maestro Dx SE. CFX Maestro Dx SE rileva gli
strumenti collegati quando si avvia il software.

Per rilevare gli strumenti collegati

1. Se non è ancora stato fatto, inserire l’estremità quadrata (maschio) del cavo USB di tipo B fornito
nella porta USB di tipo B che si trova sul retro della base dello strumento.

2. Inserire l’altra estremità (porta) in una porta USB sul computer CFX Maestro Dx SE.

3. Se lo strumento non è già in esecuzione, premere l’interruttore di alimentazione sullo strumento per
accenderlo.

4. Avviare CFX Maestro Dx SE.

Il software rileva automaticamente lo strumento collegato e ne visualizza il nome nel riquadro Detected
Instruments (Strumenti rilevati) nella finestra Home.

Nota: se lo strumento non viene visualizzato nel riquadro Detected Instruments (Strumenti rilevati),
verificare che il cavo USB sia installato correttamente. Per reinstallare i driver, nella finestra Home
(Home) in CFX Maestro Dx SE selezionare Tools > Reinstall Instrument Drivers (Strumenti >
Reinstalla driver strumento).

36 | Software CFX Maestro Dx SE



File del software

File del software
Nella Tabella 4 sono elencati i tipi di file del CFX Maestro Dx SE.

Tipo di file Estensione Dettagli

Protocollo .prcl Contiene i dettagli di impostazione del protocollo per
eseguire un’analisi PCR.

Piastra .pltd Contiene i dettagli di impostazione della piastra per
eseguire un’analisi PCR.

Dati .pcrd Contiene i risultati di un esperimento eseguito e
dell'analisi PCR.

PrimePCR eseguito .csv Contiene il protocollo e la disposizione della piastra per le
piastre PrimePCR.

Studio dei geni .mgxd Contiene i risultati di più analisi PCR e delle analisi
dell’espressione genica.

File dati preliminari
standalone

.zpcr Contiene le letture della fluorescenza ottenute con il
funzionamento standalone (autonomo), che sono
convertite in file di dati.

LIMS .plrn Contiene le informazioni relative al protocollo e
all'impostazione della piastra per eseguire un'analisi
LIMS compatibile.

JSON .json File di sola lettura generato solo dai sistemi CFX Opus Dx
che contiene i dati del file di analisi che vengono
visualizzati nel riquadro dei dettagli nel browser dei file
quando viene selezionato un file di analisi. Questo file
viene generato al termine di un'analisi. Viene esportato
con il file .zpcr e salvato con i file di dati quando il
percorso di salvataggio è un'unità USB o una cartella di
rete condivisa.

Tabella 4. Tipi di file CFX Maestro Dx SE

Guida per l’utente | 37



Capitolo 2 Installazione del Software CFX Maestro Dx, Security Edition

38 | Software CFX Maestro Dx SE



Capitolo 3 Gestione degli account utente del
Software CFX Maestro Dx, Security Edition

Nel Software CFX Maestro Dx, Security Edition, gli utenti accedono con il nome utente e la password di
Windows. Alla persona che ha installato CFX Maestro Dx SE viene automaticamente assegnato il ruolo di
amministratore e può creare e gestire account e ruoli utente. A tutti gli altri utenti deve essere assegnato
un account utente per poter accedere e utilizzare il software.

Importante: ogni utente deve disporre di un account Windows e di una password nel computer
CFX Maestro Dx SE prima di poter assegnare un account utente e un ruolo. Gli utenti possono
essere membri del gruppo di utenti Windows o del gruppo di amministratori Windows. I membri del
gruppo di utenti Windows possono accedere solo ai file e cartelle CFX Maestro Dx SE. I membri del
gruppo di amministratori Windows possono accedere ai file e alle cartelle di tutti gli utenti del
computer.

In questo capitolo viene spiegato come creare utenti Microsoft Windows per aggiungerli a CFX Maestro
Dx SE. Questo paragrafo spiega inoltre come aggiungere utenti CFX Maestro Dx SE e gestire ruoli e
autorizzazioni utente.
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Avvio del Software CFX Maestro Dx, Security Edition
Nota: ogni utente deve accedere con il proprio nome utente e password di Windows.

Per avviare CFX Maestro Dx SE

1. Sul desktop del computer CFX Maestro Dx SE, fare doppio clic sull’icona del collegamento
CFX Maestro Dx SE per avviare l'applicazione.

2. Nella finestra di dialogo Login (Accesso), digitare la password di Windows e fare clic su OK.

Quando si apre CFX Maestro Dx SE viene visualizzata la finestra Home. La barra del titolo mostra il
nome utente di Windows dell'utente connesso e la barra dei menu mostra un adesivo blu indicante
che il software è conforme alla norma 21 CFR Parte 11, ad esempio:
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Aggiunta di utenti Microsoft Windows al computer con il
Software CFX Maestro Dx, Security Edition

Tutti gli utenti devono accedere al computer CFX Maestro Dx SE con il proprio nome utente e password di
Windows. Per un controllo accurato, gli account utente di Windows non possono essere aggiunti tramite
la finestra di dialogo Start > Settings > Accounts (Start > Impostazioni > Account). Gli account utente di
Windows devono essere aggiunti tramite la console Computer Management (Gestione del computer).

Importante: le modifiche apportate alle proprietà utente di Windows (inclusi il nome utente e il nome
completo) dopo aver creato l’utente CFX Maestro Dx SE associato annullano l’utente CFX Maestro
Dx SE. Prima di salvare l'utente Windows e creare l’utente CFX Maestro Dx SE associato,
assicurarsi che le informazioni siano corrette.

Suggerimento: prima di creare account Windows, rivedere la documentazione di amministrazione
di Microsoft Windows e consultare l'amministratore di sistemaWindows per ulteriori informazioni.

Per aggiungere account utente di Windows al computer CFX Maestro Dx SE

1. Accedere al computer CFX Maestro Dx SE come membro del gruppo dell'amministratore di
Windows.

2. Sul desktop, fare clic con il pulsante destro del mouse su My Computer (Computer) e selezionare
Manage (Gestione) per aprire la console Computer Management (Gestione computer).

3. Nella console Computer Management (Gestione computer), espandere Local Users and Groups
(Utenti e gruppi locali).

4. Fare clic con il pulsante destro del mouse sulla cartella Users (Utenti) e selezionare New User
(Nuovo utente) per aprire la finestra di dialogo New User (Nuovo utente).
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Aggiunta di utenti Microsoft Windows al computer con il Software CFX Maestro Dx, Security Edition

5. Nella finestra di dialogo New User (Nuovo utente), è necessario completare i seguenti campi:

n User name (Nome utente)

n Full name (Nome completo)

n Password

n Confirm password (Conferma password)

6. Fare clic su Create (Crea).
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Aggiunta e rimozione di utenti del Software CFX Maestro Dx,
Security Edition

Suggerimento: solo gli utenti con ruolo di amministratore CFX Maestro Dx SE possono creare e
rimuovere account utenti CFX Maestro Dx SE. Alla persona che ha installato CFX Maestro Dx SE
viene automaticamente assegnato il ruolo di amministratore. Quella persona può assegnare il ruolo
di amministratore ad altri utenti.

Nota: in CFX Maestro Dx SE, il ruolo di amministratore deve essere assegnato ad almeno un utente.

Per aggiungere account utente CFX Maestro Dx SE

1. Verificare che ogni utente previsto sia un membro del gruppo di utenti di Windows o del gruppo di
amministratori di Windows e disponga di una password di Windows sul computer CFX Maestro Dx
SE.

2. Avviare CFX Maestro Dx SE e accedere come amministratore.

3. Nella finestra Home, selezionare User > User Administration (Utente > Amministrazione utenti).

Viene visualizzata la finestra di dialogo User Administration (Amministrazione utenti).
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4. Nella sezione Manage Users (Gestisci utenti), fornire le seguenti informazioni per ogni utente:

n User name (Nome utente): in CFX Maestro Dx SE deve corrispondere al nome utente di
accesso Windows dell’utente.

n Full name (Nome completo): il nome completo dell’utente.

Questo nome viene visualizzato nel campo Full User (Utente completo) nell'audit trail. Questo
nome deve essere lo stesso nome immesso nel campo Full Name (Nome completo) quando è
stato creato l'utente Windows.

n Role (Ruolo): il ruolo da assegnare all’utente.

Nota: è possibile selezionare un solo ruolo dall'elenco a discesa. Per ulteriori informazioni,
vedere Gestione dei ruoli utente del Software CFX Maestro Dx, Security Edition.

n Domain (Dominio): il dominio Windows da cui l'utente accede al software.

Per ulteriori informazioni, rivolgersi all'amministratore di sistema di Windows.

5. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche e chiudere la finestra di dialogo User
Administration (Amministrazione utenti).

Per rimuovere un account utente CFX Maestro Dx SE

1. Avviare CFX Maestro Dx SE e accedere come amministratore.

2. Nella finestra Home, selezionare User > User Administration (Utente > Amministrazione utenti) per
aprire la finestra di dialogo User Administration (Amministrazione utenti).

3. Nel riquadro Manage Users (Gestisci utenti), selezionare Remove (Rimuovi) per ciascun utente che
si desidera rimuovere.

4. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche e chiudere la finestra di dialogo User
Administration (Amministrazione utenti).

Gestione dei ruoli utente del Software CFX Maestro Dx,
Security Edition

Importante: CFX Maestro Dx SE richiede che ad almeno un utente venga assegnato il ruolo di
amministratore. È possibile assegnare questo ruolo a più di un utente.

CFX Maestro Dx SE ha quattro ruoli utente. Ad ogni utente deve essere assegnato un ruolo per poter
accedere al software. Sebbene agli utenti possa essere assegnato un solo ruolo, è possibile modificare il
ruolo di un utente in qualsiasi momento.
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Ad eccezione del ruolo di amministratore, è possibile modificare le autorizzazioni assegnate a ciascun
ruolo. Tutti gli utenti assegnati a un ruolo ereditano solo le autorizzazioni di quel ruolo.

Per impostazione predefinita, i diritti per ogni ruolo sono i seguenti:

n Administrator (Amministratore): questo ruolo dispone di tutte le autorizzazioni; non è possibile
modificare queste autorizzazioni.

n Principal (Entità): questo ruolo dispone di tutte le autorizzazioni tranne per la configurazione della
posta elettronica.

n Operator (Operatore): questo ruolo dispone di tutte le autorizzazioni ad eccezione di quella che
consente di saltare i cicli e di configurare la posta elettronica.

n Guest: questo ruolo può solo leggere file.

Quando si assegnano ruoli in CFX Maestro Dx SE, determinare attentamente i requisiti per ogni utente.
Ad esempio, senza l'autorizzazione al salvataggio, gli utenti a cui è stato assegnato il ruolo Guest non
saranno in grado di firmare un file. Senza l'autorizzazione a configurare un account e-mail, nessuno dei
ruoli riceverà e-mail al termine di un’analisi.

Per modificare le autorizzazioni per un ruolo

1. Avviare CFX Maestro Dx SE e accedere come amministratore.

2. Nella finestra Home, selezionare User > User Administration (Utente > Amministrazione utenti) per
aprire la finestra di dialogo User Administration (Amministrazione utenti).

3. Nella sezione Manage Rights (Gestisci diritti), per ogni ruolo, deselezionare o selezionare la casella
di controllo delle autorizzazioni specifiche secondo necessità.

4. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche e chiudere la finestra di dialogo User
Administration (Amministrazione utenti).

Visualizzazione del ruolo e delle autorizzazioni
Suggerimento: gli utenti cui viene assegnato il ruolo utente Principal (Entità), Operator (Operatore)
o Guest (Ospite) possono visualizzare solo le proprie impostazioni, autorizzazioni e ruoli utente. Gli
utenti cui è stato assegnato il ruolo di amministratore possono visualizzare tutte le autorizzazioni e i
ruoli utente.

Per visualizzare il ruolo utente e le autorizzazioni correnti

u Nella finestra Home, selezionare User > User Administration (Utente > Amministrazione utenti).

Contattare l’amministratore di CFX Maestro Dx SE per modificare le impostazioni, le autorizzazioni e i
ruoli utente elencati nella finestra User Administration (Amministrazione utenti).
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Capitolo 4 Utilizzo del Software CFX Maestro Dx,
Security Edition

Importante: il Software CFX Maestro Dx, Security Edition utilizza l'autenticazione utente di Microsoft
Windows per verificare l'accesso ai file di dati CFX protetti. Contattare l’amministratore di Windows
per creare un ambiente conforme ai requisiti della norma 21 CFR Parte 11.

Utilizzando CFX Maestro Dx SE, gli utenti possono:

n Firmare file di dati e file di studio dei geni.

n Proteggere con password i file di dati.

n Visualizzare e stampare gli audit trail.

In questo paragrafo vengono spiegate nel dettaglio queste caratteristiche.

File protetti
Per impostazione predefinita, CFX Maestro Dx SE salva i file protetti nella cartella personale dell'utente
connesso, che si trova in

C:\Users\<username>\Documents\Bio-Rad\CFX_MDX\My qPCR

È possibile salvare e modificare i file .pcrd in quella cartella. Questa cartella contiene collegamenti ad
altre cartelle (ad esempio, la cartella dei file campione) che contengono file di sola lettura. Tuttavia, un
amministratore può eliminare il contenuto di quella cartella.

Suggerimento: in alternativa, l'amministratore di sistemaWindows può creare una cartella
condivisa e l’amministratore di CFX Maestro Dx SE può programmare il software per salvare tutti i file
in quella cartella.

In CFX Maestro Dx SE, i file di piastra, protocollo, dati e studio dei geni sono contrassegnati come protetti
quando vengono salvati. È possibile creare questi file nel software CFX Maestro o in CFX Maestro Dx SE.
Una volta salvati in CFX Maestro Dx SE, possono essere aperti solo in CFX Maestro Dx SE.

CFX Maestro Dx SE crea un audit trail per tutti i file di dati e file di studio dei geni protetti (rispettivamente
file .pcrd e .mgxd). Il software registra tutta l’attività controllabile nell'audit trail del file. Per ulteriori
informazioni, vedere Audit Trail a pagina 311.
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Firma dei file protetti

Una volta salvato un file in CFX Maestro Dx SE, gli utenti possono aggiungere una firma elettronica. Per
firmare un file, il ruolo dell'utente deve disporre dell'autorizzazione per salvare un file. Ad esempio, per
impostazione predefinita, il ruolo Guest non dispone dell'autorizzazione per salvare un file e pertanto gli
utenti assegnati a questo ruolo non possono firmare un file.

In CFX Maestro Dx SE, i file firmati non sono impostati in sola lettura. Possono essere rivisti, modificati e
firmati più volte. Tutte le modifiche e le firme vengono registrate nell'audit trail del file. È possibile firmare i
seguenti tipi di file:

n File di dati (.pcrd)

n File di studio dei geni (.mgxd)

Nota: i file devono essere salvati prima di poter essere firmati. Se di recente è stata eseguita
un’analisi in CFX Maestro Dx SE, salvare prima il file di dati risultante.

Per firmare un file

1. Effettuare l’accesso a CFX Maestro Dx SE con le proprie credenziali di accesso aWindows.

2. Aprire il file di dati o il file di studio dei geni protetto da firmare.

3. Scegliere File > Sign (File > Firma). Viene visualizzata la finestra di dialogo Electronic Signature
(Firma elettronica).
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4. Immettere il nome utente e la password di Windows e il motivo della firma del file.

Il nome utente e il motivo della firma sono inclusi nell'audit trail (per ulteriori informazioni, vedere
Audit Trail a pagina 311).

5. Fare clic su OK per inviare la firma e chiudere la finestra di dialogo.

Modifica dei file protetti

In CFX Maestro Dx SE, gli utenti possono modificare file protetti, inclusi file di dati e di studio dei geni con
e senza firma. Il software richiede di fornire un motivo per la modifica quando si salva un file di dati o di
studio dei geni protetto modificato. Le modifiche vengono registrate nell'audit trail del file.

Suggerimento: poiché il software non crea audit trail per file di piastra o protocollo, non viene
richiesto di fornire un motivo quando si salvano le modifiche a tali file.

Per salvare un file di dati o di studio dei geni modificato

1. Effettuare l’accesso a CFX Maestro Dx SE con le proprie credenziali di accesso aWindows.

2. Aprire e modificare un file di dati o di studio dei geni protetto.

Suggerimento: per un elenco delle attività controllabili, vedere Eventi controllabili a pagina 313.
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3. Scegliere File > Save (File > Salva). Viene visualizzata la finestra di dialogo Audit Trail Change
Reason (Motivo modifica audit trail).

Questa finestra di dialogo visualizza le informazioni riportate di seguito, che vengono acquisite
nell'intestazione dell’audit trai del file per ogni evento di modifica:

n Date (Data): la data in cui si è verificata la modifica.

n User (Utente): il dominio Windows e il nome utente dell'utente connesso.

n Comment (Commento): l'ultimo commento salvato.

n Signature (Firma): la firma elettronica dell'ultima persona che ha firmato il file.

n Signature reason (Motivo della firma): il motivo della firma.

n Application (Applicazione): CFX Maestro Dx SE (appare come BioRadCFXManager.exe, che è
corretto).

n Application version (Versione dell’applicazione): la versione corrente di CFX Maestro Dx SE.

n Full user (Utente completo): il nome completo dell'utente connesso.

Nota: questo nome appare nell'audit trail.

n Machine (Computer): il computer su cui è installato.
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La tabella delle modifiche mostra le modifiche controllabili che si sono verificate in conseguenza della
modifica. È possibile che venga visualizzata anche una breve descrizione del motivo della modifica.

Suggerimento: è possibile aggiungere o modificare le descrizioni nella colonna Reason for
Change (Motivo della modifica).

4. Rivedere l'elenco delle modifiche. Fornire motivi dettagliati, se necessario.

5. Eseguire una delle seguenti operazioni:

n Fare clic su Save Changes (Salva modifiche) per salvare le modifiche al file, nonché eventuali
modifiche apportate alla tabella e chiudere la finestra di dialogo.

Le modifiche al file e i motivi delle modifiche vengono visualizzati nell'audit trail del file.

n Fare clic su Cancel Changes (Annulla modifiche) per ripristinare il file allo stato precedente e
chiudere la finestra di dialogo.

Le modifiche non vengono salvate nel file e l'audit trail non viene aggiornato.
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Password di protezione dei file

Come ulteriore livello di sicurezza, CFX Maestro Dx SE consente agli utenti di impostare password su tutti
i file protetti. Quando si impostano le password in un file protetto, tenere presenti le seguenti condizioni:

Condizione Azione

Non è richiesta alcuna password. Tutti gli utenti possono aprire, modificare e salvare il file
protetto, in base alle loro autorizzazioni.

Il file richiede la password di
salvataggio.

Tutti gli utenti possono aprire il file protetto e gli utenti
che conoscono la password di salvataggio possono
modificare e salvare il file protetto.

Il file richiede la password di
apertura.

Solo gli utenti che conoscono la password di apertura
possono aprire, modificare e salvare il file protetto.

Il file richiede sia la password di
apertura sia quella di
salvataggio.

Alcuni utenti possono aprire il file protetto e un
sottogruppo di tali utenti può modificare e salvare il file.

A seconda del ruolo dell'utente, qualsiasi utente può eseguire il comando Save As (Salva con nome) per
creare un nuovo file protetto con un altro nome o salvare un file con lo stesso nome in un altro percorso
purché si verifichi una delle seguenti condizioni:

n Il file protetto non è protetto da password.

n L'utente ha la password per aprire il file.

Suggerimento: il nuovo file viene salvato senza password di protezione. Il file originale conserva le
proprie password.

A seconda del ruolo, un utente può modificare e salvare il file originale purché si verifichi una delle
seguenti condizioni:

n Il file non è protetto da password.

n L'utente ha la password per aprire e la password per salvare il file.

Nota: il ruolo dell'utente deve includere il diritto di salvare i file al fine di impostare le password. Ad
esempio, gli utenti con il ruolo Guest non possono salvare i file e quindi non possono impostare le
password in un file.

Importante: solo gli amministratori CFX Maestro Dx SE possono reimpostare o rimuovere le
password.
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Per proteggere con password un file

1. Effettuare l’accesso a CFX Maestro Dx SE con le credenziali di Windows.

2. Aprire il file protetto.

3. Scegliere File > File Passwords (File > Password del file). Viene visualizzata la finestra di dialogo File
Passwords (Password del file).

4. Immettere le password nelle caselle Save Password (Password di salvataggio) e Open Password
(Password di apertura).

Suggerimento: per impostazione predefinita, le password vengono visualizzate come caratteri
asterisco quando vengono digitate. Selezionare Show Password (Mostra password) per
visualizzare la password durante la digitazione.

Importante: le password fanno distinzione tra maiuscole e minuscole. CFX Maestro Dx SE non
imposta limitazioni sulle password. Per la procedura consigliata, consultare l'amministratore di
sistema per i requisiti della password presso la propria struttura.

5. Fare clic su Set Passwords (Imposta password) per impostare le password e chiudere la finestra di
dialogo.

6. Scegliere File > Save (File > Salva) per salvare le modifiche al file.
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Per rimuovere le password

Importante: è necessario essere un amministratore di CFX Maestro Dx SE per rimuovere le
password.

1. Nella finestra di dialogo Password Required (Password richiesta), fare clic su Remove Passwords
(Rimuovi password).

Viene visualizzata la finestra di dialogo di accesso a CFX Maestro Dx SE.

2. Fornire il nome utente e la password di Windows per l’amministratore di CFX Maestro Dx SE e fare
clic su OK.

Viene visualizzato il file di dati originale.

Importante: è necessario salvare il file per rimuovere le password.

3. Scegliere File > Save (File > Salva) per salvare le modifiche al file.
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Per modificare le password

Importante: solo gli amministratori di CFX Maestro Dx SE possono modificare le password.

1. Aprire il file protetto.

2. Scegliere File > File Passwords (File > Password del file). Viene visualizzata la finestra di dialogo File
Passwords (Password del file).

Suggerimento: le opzioni Save Password (Password di salvataggio), Open Password
(Password di apertura) e Show Password (Mostra password) sono disabilitate.

3. Fare clic su Reset Passwords (Reimposta password).

Viene visualizzata la finestra di dialogo di accesso a CFX Maestro Dx SE.
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4. Fornire il nome utente e la password di Windows per l’amministratore di CFX Maestro Dx SE e fare
clic su OK.

Viene visualizzata la finestra di dialogo File Passwords (Password del file).

5. Eseguire una delle seguenti operazioni:

n Per reimpostare la password di protezione, digitare una nuova password nella casella della
password appropriata.

n Per rimuovere la protezione tramite password, deselezionare le caselle della password.

6. Fare clic su Set Passwords (Imposta password) per salvare le modifiche alla password e uscire dalla
finestra di dialogo.
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Capitolo 5 Area di lavoro
Il Software CFX Maestro Dx, Security Edition fornisce un’interfaccia per l’impostazione delle piastre, lo
sviluppo di protocolli PCR, la loro esecuzione sugli strumenti CFX Opus Dx Deepwell Dx e l’analisi dei dati
dalle analisi PCR.

CFX Maestro Dx SE presenta cinque aree di lavoro principali:

n Finestra Home

n Finestra Startup Wizard (Procedura guidata di avvio)

n Finestra Protocol Editor (Editor protocollo)

n Finestra Plate Editor (Editor piastra)

n Finestra Data Analysis (Analisi dei dati)

Ogni spazio di lavoro viene mostrato e illustrato brevemente in questo capitolo.
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Finestra Home
CFX Maestro Dx SE si apre nella finestra Home (Home) e visualizza la procedura guidata di avvio, dalla
quale è possibile impostare un esperimento, eseguire o ripetere un’analisi, o analizzare un’analisi
esistente. Dalla finestra Home, è inoltre possibile visualizzare i registri dell’applicazione e dello strumento,
creare e gestire utenti e accedere a numerosi strumenti utili. Per maggiori informazioni, fare riferimento al
Capitolo 6, Finestra Home.
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Procedura guidata di avvio

Procedura guidata di avvio
Utilizzare la procedura guidata di avvio per impostare ed eseguire rapidamente esperimenti definiti
dall’utente o per selezionare ed eseguire un esperimento PrimePCR. È possibile utilizzare questa
procedura guidata anche per ripetere un’analisi o per analizzare i dati dell’analisi.
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Finestra dell’editor protocollo
Nell’editor protocollo è possibile creare, aprire, rivedere e modificare un protocollo. È inoltre possibile
modificare la temperatura del coperchio per il protocollo aperto. La funzionalità dell’editor protocollo è
dettagliata nel Capitolo 7, Creazione di protocolli.
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Finestra dell’editor piastra

Finestra dell’editor piastra
Nell’editor piastra è possibile creare, aprire, rivedere e modificare una piastra. La funzionalità Editor
piastra è descritta dettagliatamente nel Capitolo 8, Preparazione delle piastre.
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Finestra Data Analysis (Analisi dei dati)
Nella finestra Data Analysis (Analisi dei dati), è possibile visualizzare e confrontare i dati delle analisi,
eseguire analisi statistiche, esportare i dati e creare report pronti per essere pubblicati. La funzionalità di
analisi dei dati è descritta nel dettaglio nel Capitolo 10, Descrizione generale della finestra Data Analysis
(Analisi dei dati) e nel Capitolo 11, Dettagli dell’analisi dei dati.
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Capitolo 6 Finestra Home
Il Software CFX Maestro Dx, Security Edition fornisce un'interfaccia per sviluppare protocolli PCR,
eseguirli su sistemi CFX Dx e analizzare dati delle analisi PCR.

In questo capitolo viene fornita un’introduzione a CFX Maestro Dx SE e vengono spiegate le funzioni
accessibili dalla finestra Home.
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Finestra Home
Quando si apre CFX Maestro Dx SE, viene visualizzata la finestra Home con la procedura di
configurazione guidata, dalla quale è possibile impostare un’analisi, eseguire o ripetere un’analisi, oppure
analizzare un’analisi esistente. Dalla finestra Home, è inoltre possibile visualizzare i registri
dell’applicazione e dello strumento, creare e gestire gli utenti e accedere a diversi strumenti utili.

1. La barra del titolo del software mostra il nome del software e l’utente connesso.

2. La barra dei menu offre l’accesso rapido ai comandi del menu File (File), View (Visualizza),
Users (Utenti), Run (Analisi), Tools (Strumenti), Window (Finestra) e Help (Guida).

3. I comandi della barra degli strumenti forniscono un accesso rapido alle opzioni dei menu.

4. Nel riquadro di sinistra sono visualizzati gli strumenti collegati al computer CFX Maestro Dx SE
e sono disponibili i pulsanti da cui è possibile far funzionare il coperchio e visualizzare lo stato
degli strumenti.

LEGENDA

64 | Software CFX Maestro Dx SE



Finestra Home

5. Il riquadro principale mostra la finestra di lavoro. La finestra operativa predefinita della
schermata Home è quella della procedura guidata di avvio.

6. Nella barra di stato sono visualizzati i nomi degli strumenti collegati e dell’utente registrato.

Comandi del menu File
New (Nuovo): consente di aprire una finestra di dialogo da cui è possibile scegliere di creare un nuovo
protocollo, una nuova piastra o un nuovo studio dei geni.

Open (Apri): consente di aprire una finestra di dialogo da cui è possibile scegliere di individuare e aprire
un protocollo, una piastra, un file di dati, uno studio dei geni, un file LIMS, un’analisi da uno strumento
stand-alone (analisi stand-alone) o un file di analisi PrimePCR esistenti.

Recent Data Files (File di dati recenti): consente di visualizzare un elenco dei file PCR aperti di recente.

Repeat a Run (Ripeti un’analisi): consente di aprire Windows Explorer (Esplora risorse) nel percorso dei
file PCR salvati, in cui è possibile individuare un’analisi da ripetere.

Exit (Esci): consente di chiudere CFX Maestro Dx SE.

Comandi del menu View (Visualizza)
Application Log (Registro applicazione): consente di visualizzare un registro di utilizzo del software
dall’installazione iniziale alla data corrente.

Run Reports (Report di analisi): consente di visualizzare un elenco di report di analisi.

Startup Wizard (Procedura guidata di avvio): consente di visualizzare la procedura guidata di avvio nel
riquadro principale.

Run Setup (Impostazione analisi): consente di visualizzare la finestra Run Setup (Impostazione analisi)
nel riquadro principale.

Instrument Summary (Riepilogo strumenti): consente di visualizzare la finestra Instrument Summary
(Riepilogo strumenti) nel riquadro principale.

Detected Instruments (Strumenti rilevati): consente di scegliere se visualizzare o meno gli strumenti
collegati nel riquadro di sinistra. Per impostazione predefinita, il software visualizza gli strumenti collegati
nel riquadro di sinistra.

Toolbar (Barra degli strumenti): consente di scegliere se visualizzare o no la barra degli strumenti nella
parte superiore della schermata. Per impostazione predefinita, il software visualizza la barra degli
strumenti.
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Status Bar (Barra di stato): consente di scegliere se visualizzare o no la barra di stato nella parte inferiore
dello schermo. Per impostazione predefinita, il software visualizza la barra di stato.

Show (Mostra): consente di aprire una finestra di dialogo dalla quale è possibile

n Visualizzare o bloccare il registro di stato.

n Aprire e visualizzare la cartella dei dati di CFX Maestro Dx SE.

n Aprire e visualizzare la cartella dei dati dell’utente.

n Aprire e visualizzare la cartella dei file LIMS.

n Aprire e visualizzare la cartella PrimePCR.

n Visualizzare la cronologia dell’analisi.

n Visualizzare le proprietà di tutti gli strumenti collegati.

Comandi del menu User (Utente)
Select User (Seleziona utente): consente di aprire la schermata di accesso in cui è possibile selezionare
un utente dall’elenco a discesa User Name (Nome utente) e accedere all’applicazione.

Change Password (Modifica password): consente di aprire la finestra di dialogo Change Password
(Modifica password) in cui gli utenti possono modificare la propria password.

Nota: questa opzione è disabilitata perCFX Maestro Dx SE. Gli utenti devono modificare la propria
password di Windows per cambiare quella di CFX Maestro Dx SE.

User Preferences (Preferenze utente): consente di aprire la finestra di dialogo User Preferences
(Preferenze utente) in cui gli utenti possono modificare le impostazioni predefinite per

n Inviare e ricevere una notifica e-mail al termine dell’analisi

n Salvare i file di dati

n Creare protocolli tramite l’editor dei protocolli o l’autowriter protocollo

n Creare piastre

n Analizzare dati

n Eseguire analisi dell’espressione genica

n Determinare la qualità dei dati

n Esportare i dati dello strumento CFX
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User Administration (Amministrazione utenti): consente di aprire la finestra di dialogo User
Administration (Amministrazione utenti) in cui gli amministratori possono creare utenti, modificare le
autorizzazioni dei ruoli e assegnare i ruoli agli utenti.

Bio-Rad Service Login (Accesso all’assistenza Bio-Rad): ad uso esclusivo del personale dell’assistenza
tecnica Bio-Rad. Non selezionare questo comando.

Comandi del menu Run (Analisi)
User-defined Run (Analisi definita dall’utente): consente di aprire la finestra Run Setup (Impostazione
analisi), nella quale è possibile impostare un protocollo e una piastra definiti dall’utente, quindi eseguire
un esperimento PCR sullo strumento selezionato.

PrimePCR Run (Analisi PrimePCR): consente di aprire la scheda Start Run (Avvia analisi) nella finestra
Run Setup (Impostazione analisi) con il protocollo PrimePCR e il layout della piastra predefiniti, caricati in
base allo strumento selezionato.

End-Point Only Run (Analisi solo del punto finale): consente di aprire la scheda Start Run (Avvia analisi)
nella finestra Run Setup (Impostazione analisi) con il protocollo del punto finale e il layout della piastra
predefiniti, caricati in base allo strumento selezionato.

Qualification Run (Analisi di qualificazione): consente di aprire la scheda Start Run (Avvia analisi) nella
finestra Run Setup (Impostazione analisi) con il protocollo di qualificazione e il layout della piastra
Bio-Rad predefiniti, caricati per lo strumento selezionato.

Comandi del menu Tools (Strumenti)
Master Mix Calculator (Calcolatore master mix): consente di aprire il calcolatore della master mix in cui
è possibile creare una miscela di reazione e stampare i calcoli.

Protocol AutoWriter (Autowriter protocollo): consente di aprire la finestra di dialogo Protocol AutoWriter
(Autowriter protocollo) in cui è possibile creare un protocollo in tutta semplicità.

Ta Calculator (Calcolatore Ta): consente di aprire il calcolatore Ta in cui è possibile calcolare la
temperatura di annealing dei primer.

Dye Calibration Wizard (Procedura guidata Calibrazione coloranti): consente di aprire la procedura
guidata per la calibrazione dei coloranti in cui è possibile calibrare uno strumento per un nuovo fluoroforo.

Reinstall Instrument Drivers (Reinstalla driver strumento): consente di reinstallare i driver che
controllano la comunicazione con i sistemi per PCR in tempo reale di Bio-Rad.

Zip Data and Log Files (Comprimi dati e file di registro): consente di aprire una finestra di dialogo in cui è
possibile selezionare i file da comprimere e salvare un file zippato per l’archiviazione o l’invio tramite
posta elettronica.
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Batch Analysis (Analisi dei lotti): consente di aprire la finestra di dialogo Batch Analysis (Analisi dei lotti)
in cui è possibile impostare i parametri per analizzare più di un file di dati alla volta.

Options (Opzioni): consente di aprire una finestra di dialogo in cui è possibile

n configurare le impostazioni del server di posta elettronica;

n configurare le impostazioni di esportazione per LIMS, Seegene e altri file di dati.

Suggerimento: è inoltre possibile selezionare l'opzione per avviare automaticamente il
visualizzatore Seegene al momento dell'esportazione se si sceglie di esportare i dati in
formato Seegene.

n Modificare la lingua visualizzata dall'interfaccia utente (inglese, cinese, russo)

Importante: è necessario riavviare CFX Maestro Dx SE per visualizzare la lingua
selezionata.

Importante: la lingua del sistema operativo deve corrispondere alla lingua che si desidera
visualizzare nell’interfaccia CFX Maestro Dx SE.

Comandi del menu Help (Guida)
Suggerimento: il menu Help (Guida) è disponibile nella barra dei menu in tutte le finestre del
software CFX Maestro Dx SE.

Contents (Contenuto): consente di visualizzare la scheda Contents (Contenuto) nella guida di
CFX Maestro Dx SE.

Index (Indice): consente di visualizzare la scheda Index (Indice) nella guida di CFX Maestro Dx SE.

Search (Cerca): consente di visualizzare la scheda Search (Cerca) nella guida di CFX Maestro Dx SE.

Open User Guide (Apri Guida utente): consente di aprire un PDF di questa guida.

Additional Documentation (Documentazione aggiuntiva): fornisce l'accesso al manuale operativo dei
sistemi per PCR in tempo reale CFX Opus Dx.

Release Notes (Note di rilascio): consente di aprire il documento delle note di rilascio per la versione di
CFX Maestro Dx SE installata.

Video Resources (Risorse video): consente di aprire un sito web in cui risiedono le risorse video
Bio-Rad, come i video tutorial.

qPCR Applications and Technologies Web Site (Sito web applicazioni e tecnologie qPCR): consente
di aprire il sito web delle applicazioni e tecnologie qPCR di Bio-Rad, da cui è possibile scoprire altre
informazioni sulla PCR in tempo reale (qPCR).
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PCR Reagents Web Site (Sito web reagenti PCR): consente di aprire il sito web dei reagenti PCR e
qPCR di Bio-Rad, da cui è possibile ordinare i reagenti PCR, le supermix, i coloranti e i kit.

PCR Plastic Consumables Web Site (Sito web materiali di consumo in plastica PCR): consente di
aprire il sito web dei materiali di consumo e degli elementi in plastica per PCR di Bio-Rad, da cui è
possibile ordinare piastre PCR, sigilli per piastre, provette e tappi, e altri accessori di plastica.

Software Web Site (Sito web software): consente di aprire il sito web del software di analisi PCR di Bio-
Rad, da cui è possibile ordinare le versioni aggiornate di CFX Maestro Dx SE di Bio-Rad.

About (Informazioni): consente di visualizzare le informazioni di copyright e versione di CFX Maestro Dx
SE.

Comandi della barra degli strumenti

: consente di aprire Windows Explorer (Esplora risorse), in cui è possibile individuare e aprire un file
di dati o un file di studio dei geni.

: consente di aprire il Master Mix Calculator (Calcolatore master mix).

: consente di aprire la finestra Run Setup (Impostazione analisi).

: consente di aprire la finestra Run Setup (Impostazione analisi) con il protocollo PrimePCR e il
layout della piastra predefiniti, caricati in base allo strumento selezionato.

: consente di aprire la procedura guidata di avvio.
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Finestra Startup Wizard (Procedura guidata di avvio)
Quando CFX Maestro Dx SE si avvia, nel riquadro operativo compare la procedura guidata di avvio. Dalla
finestra di dialogo Startup Wizard (Procedura guidata di avvio)

n Selezionare uno strumento dagli strumenti rilevati e impostare un’analisi definita dall’utente o
PrimePCR.

n Aprire e ripetere un’analisi.

n Aprire un file di dati per analizzare i risultati di una singola analisi o un file di studio dei geni per i
risultati di più analisi dell’espressione genica.

Tali attività sono spiegate in maniera particolareggiata nei capitoli che seguono.

Barra di stato
A sinistra della barra di stato in fondo alla finestra principale del software è visualizzato lo stato attuale
degli strumenti rilevati. A destra della barra di stato il sistema visualizza il nome dell’utente attuale con la
data e l’ora.
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Riquadro Detected Instruments (Strumenti rilevati)
Il riquadro Detected Instruments (Strumenti rilevati) visualizza tutti gli strumenti collegati al computer
CFX Maestro Dx SE. Per impostazione predefinita, ciascuno strumento viene visualizzato come icona e il suo
numero di serie viene visualizzato come nome.

Da questo riquadro, è possibile

n Visualizzare le proprietà e i coloranti calibrati per lo strumento selezionato.

Per informazioni sulle proprietà dello strumento, vedere Visualizzazione delle proprietà di uno
strumento a pagina 74.

n Visualizzare lo stato di uno strumento collegato.

n Aprire il coperchio motorizzato sullo strumento selezionato.

n Chiudere il coperchio motorizzato sullo strumento selezionato.

n Visualizzare lo stato di tutti gli strumenti collegati.

Per visualizzare lo stato di uno strumento collegato

u Nel riquadro Detected Instruments (Strumenti rilevati), selezionare lo strumento target ed eseguire
una delle seguenti opzioni:

n Fare clic su View Status (Visualizza stato) nella sezione Selected Instrument (Strumento
selezionato).

n Fare clic con il pulsante destro del mouse e scegliere View Status (Visualizza stato) dal menu
visualizzato.

La finestra di dialogo Run Details (Dettagli analisi) viene visualizzata con la scheda Run Status (Stato
analisi). Lo stato dello strumento selezionato viene visualizzato sotto il riquadro dello stato
dell’analisi, ad esempio:
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Per aprire o chiudere il coperchio di uno strumento

u Nel riquadro Detected Instruments (Strumenti rilevati), selezionare lo strumento target ed eseguire
una delle seguenti opzioni:

n Fare clic su Open Lid (Apri coperchio) o Close Lid (Chiudi coperchio) nella sezione Selected
Instrument (Strumento selezionato).

n Fare clic con il pulsante destro del mouse e scegliere l’azione appropriata dal menu visualizzato.

n Aprire la finestra di dialogo Run Details (Dettagli analisi), selezionare la scheda Run Status
(Stato analisi) e fare clic su Open Lid (Apri coperchio) o Close Lid (Chiudi coperchio).

Per visualizzare lo stato di tutti gli strumenti rilevati

u Eseguire una delle seguenti operazioni:

n Nel riquadro Detected Instruments (Strumenti rilevati) della sezione All Instruments (Tutti gli
strumenti), fare clic su View Summary (Visualizza riepilogo).

n Nella barra dei menu, selezionare View > Instrument Summary (Visualizza > Riepilogo
strumenti).

Viene visualizza la finestra di dialogo Instrument Summary (Riepilogo strumenti).

Suggerimento: se il sistema rileva solo uno strumento collegato, la sezione All Instruments
(Tutti gli strumenti) non viene visualizzata nel riquadro Detected Instruments (Strumenti rilevati).
Per visualizzare il riepilogo strumenti per un solo strumento, selezionare View > Instrument
Summary (Visualizza > Riepilogo strumenti).
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Comandi della barra degli strumenti Instrument Summary (Riepilogo strumenti)

Nella Tabella 5 vengono elencati i comandi e le funzioni della barra degli strumenti Instrument Summary
(Riepilogo strumenti).

Pulsante Nome pulsante Funzione

Create a new Run (Crea
nuova analisi)

Crea un’analisi sul blocco selezionato
aprendo la finestra Run Setup
(Impostazione analisi).

Stop (Arresta) Arresta l’analisi attuale sui blocchi
selezionati.

Pause (Pausa) Mette in pausa l’analisi attuale sui blocchi
selezionati.

Resume (Riprendi) Riprende l’analisi sui blocchi selezionati.

Flash Block Indicator
(Lampeggio indicatore di
blocco)

Fa lampeggiare il LED indicatore sul
coperchio dei blocchi selezionati.

Open Lid (Apri coperchio) Apre il coperchio motorizzato del blocco
selezionato.

Close Lid (Chiudi
coperchio)

Chiude il coperchio motorizzato del blocco
selezionato.

Hide Selected Blocks
(Nascondi blocchi
selezionati)

Consente di nascondere i blocchi
selezionati nell’elenco Instrument
Summary (Riepilogo strumenti)

Show All Blocks (Mostra
tutti i blocchi)

Consente di visualizzare i blocchi
selezionati nell’elenco Instrument
Summary (Riepilogo strumenti)

Show (Mostra) Seleziona quali blocchi mostrare
nell’elenco. Selezionare una delle opzioni
per mostrare tutti i blocchi rilevati, tutti i
blocchi inattivi, tutti i blocchi in esecuzione
con l’utente attuale o tutti i blocchi in
esecuzione

Tabella 5. Comandi della barra degli strumenti Instrument Summary (Riepilogo strumenti)
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Visualizzazione delle proprietà di uno strumento
Dal riquadro Detected Instruments (Strumenti rilevati) è possibile visualizzare i dettagli di uno strumento
selezionato, incluse le proprietà, lo stato della vite di imballaggio (solo strumenti CFX Connect e CFX
Touch) e un elenco dei relativi coloranti calibrati (fluorofori).

Per visualizzare le proprietà dello strumento

u Nel riquadro Detected Instruments (Strumenti rilevati), fare clic con il pulsante destro del mouse sullo
strumento desiderato e scegliere Properties (Proprietà) dal menu visualizzato.

Scheda Properties (Proprietà)

Nella scheda Properties (Proprietà) sono elencati i dettagli tecnici sullo strumento selezionato tra cui il
modello, i numeri di serie dei rispettivi componenti e le versioni del firmware. Il nome predefinito dello
strumento (il suo numero di serie) appare in numerose posizioni, tra cui il riquadro Detected Instruments
(Strumenti rilevati) nella barra di intestazione della finestra di dialogo Instrument Properties (Proprietà
strumento). È possibile rinominare lo strumento in modo da identificarlo più facilmente.

Nota: non è possibile modificare il nome dello strumento CFX Opus utilizzando CFX Maestro.

Scheda Calibrated Dyes (Coloranti calibrati)

Nella scheda Calibrated Dyes (Coloranti calibrati) sono visualizzati i fluorofori calibrati e le piastre per lo
strumento selezionato.

Per maggiori informazioni sulla calibrazione, fare clic sul pulsante Info (Informazioni) nella colonna Detail
(Dettagli).

74 | Software CFX Maestro Dx SE



Operazioni preliminari

Operazioni preliminari
In questo paragrafo vengono spiegate le attività che potrebbe essere necessario eseguire prima di
utilizzare CFX Maestro Dx SE, ad esempio:

n Creazione di una master mix di reazione

n Calibrazione di nuovi coloranti

Creazione di una master mix di reazione
Utilizzando il Master Mix Calculator di CFX Maestro Dx SE, è possibile calcolare facilmente il volume
richiesto di ciascun componente nel master mix. È possibile stampare la tabella di calcolo della master
mix con la stampante predefinita e salvare i calcoli per ciascun target per un utilizzo futuro.

Per creare un master mix delle reazioni con il Master Mix Calculator

1. Per aprire il Master Mix Calculator (Calcolatore master mix), eseguire una delle seguenti operazioni:

n Selezionare Tools > Master Mix Calculator (Strumenti > Calcolatore master mix).

n Fare clic su Master Mix Calculator (Calcolatore master mix) nella barra degli strumenti.

Viene visualizzata la finestra Master Mix Calculator (Calcolatore master mix).
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2. Nella sezione Reaction (Reazione), selezionare un metodo di rilevamento:

n SYBR®Green/EvaGreen®

n Probes (Sonde)

3. Per creare un nuovo target, nella sezione Target fare clic su Create New (Crea nuovo). Nell’elenco a
discesa dei target appare un nuovo nome target.

4. (Facoltativo) Per modificare il nome target predefinito:

a. Evidenziare il nome del target nell’elenco a discesa dei target.

b. Immettere un nuovo nome target nella casella Target.

c. Premere il tasto Enter (Invio).

5. Regolare le concentrazioni iniziale e finale per i primer diretto e inverso e per le sonde.

6. Nella sezione Master Mix Setup (Impostazione master mix), correggere i valori per

n Numero di reazioni da eseguire
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n Volume di reazione per pozzetto

n Volume modello per pozzetto

n Concentrazione supermix per pozzetto

n Volume di reazione in eccesso per pozzetto

7. (Facoltativo) Eseguire le fasi 2-6 per il numero necessario di target.

8. Nella sezione Choose Target to Calculate (Scegli target da calcolare), selezionare il target da
calcolare.

Suggerimento: è possibile calcolare solo un target, diversi target o tutti i target nello stesso
tempo.

I volumi calcolati dei componenti necessari per ciascun target selezionato sono visualizzati nella
tabella dei master mix.

9. Fare clic su Set as Default (Imposta come predefinito) per impostare le quantità inserite nelle sezioni
Target and Master Mix Setup (Impostazioni Target e Master mix) come nuovi valori predefiniti.

10. Fare clic su OK per salvare il contenuto della finestra di dialogo Master Mix Calculator.

Per stampare la tabella dei calcoli della master mix

u Per stampare una tabella dei calcoli della master mix, fare clic su Print (Stampa).

La tabella di calcolo viene stampata sulla stampante predefinita.

Per salvare la tabella dei calcoli della master mix in formato .pdf

u Cambiare la stampante predefinita con un driver PDF e fare clic su Print on the Master Mix Calculator
(Stampa sul calcolatore master mix).

Per eliminare target

u Selezionare il target utilizzando l’elenco a discesa dei target e fare clic su Remove (Rimuovi).

Importante: la rimozione di un target dall'elenco dei target lo rimuove anche da qualsiasi calcolo
della master mix in cui viene utilizzato. Prestare attenzione quando si elimina un target.

Calibrazione di nuovi coloranti
I sistemi CFX Opus 96 Dx e CFX Opus Deepwell Dx vengono calibrati in fabbrica per i fluorofori
comunemente utilizzati nelle piastre con pozzetti bianchi e pozzetti trasparenti. I sistemi CFX Opus 384 Dx
vengono calibrati in fabbrica per i fluorofori comunemente utilizzati esclusivamente nelle piastre con
pozzetti bianchi. Nella Tabella 6 vengono elencati i fluorofori e il canale per cui viene calibrato ogni
strumento.
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Nota: i sistemi CFX Opus 96 Dx, CFX Opus 384 Dx e CFX Opus Deepwell Dx includono anche un
canale dedicato alla chimica FRET. Questo canale non richiede calibrazione per determinati
coloranti.

Importante: se si esegue una calibrazione definita dall'utente di un colorante calibrato in fabbrica, lo
strumento utilizza la calibrazione definita dall'utente invece della calibrazione eseguita in fabbrica.

Fluorofori Canale Eccitazione, nm Rilevamento, nm Strumento

FAM, SYBR®
Green I

1 450–490 515–530 Sistemi CFX
Opus 96 Dx,
CFX Opus 384
Dx e CFX Opus
Deepwell Dx

VIC, HEX, CAL
Fluor Gold 540,
Cal Fluor
Orange 560

2 515–535 560–580 Sistemi CFX
Opus 96 Dx,
CFX Opus 384
Dx e CFX Opus
Deepwell Dx

ROX, Texas
Red, CAL Fluor
Red 610, TEX
615

3 560–590 610–650 Sistemi CFX
Opus 96 Dx,
CFX Opus 384
Dx e CFX Opus
Deepwell Dx

CY5, Quasar
670

4 620–650 675–690 Sistemi CFX
Opus 96 Dx,
CFX Opus 384
Dx e CFX Opus
Deepwell Dx

Quasar 705,
Cy5.5

5 672–684 705–730 Solo sistemi
CFX Opus 96 Dx

Chimica FRET (non calibrata in fabbrica)

Colore non
calibrato in
fabbrica

FRET 450–490 560-580 Sistemi CFX
Opus 96 Dx,
CFX Opus 384
Dx e CFX Opus
Deepwell Dx

Tabella 6. Fluorofori calibrati in fabbrica, canali e strumenti
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Per calibrare nuovi coloranti per sistemi CFX

1. Nella finestra Home, selezionare uno strumento target nel riquadro Detected Instruments (Strumenti
rilevati).

2. Selezionare Tools > Calibration Wizard (Strumenti > Procedura guidata di calibrazione) per aprire la
procedura guidata di calibrazione del colorante.

I fluorofori già calibrati per lo strumento target vengono visualizzati nella tabella dei fluorofori calibrati.

3. Nella sezione Calibrate New or Existing Fluorophores (Calibra fluorofori nuovi o esistenti), dall’elenco
a discesa selezionare il fluoroforo da calibrare.

Se il nome del fluoroforo non è incluso nell’elenco, digitarne il nome nella casella di testo per
aggiungerlo all’elenco.

Importante: prestare attenzione durante la denominazione di fluorofori calibrati personalizzati.
Se si crea una calibrazione del colorante personalizzata per un fluoroforo con lo stesso nome di
un fluoroforo calibrato in fabbrica, il fluoroforo personalizzato (non il fluoroforo calibrato in
fabbrica) sarà quello utilizzato dallo strumento durante le analisi.

4. Selezionare il tipo di piastra per il fluoroforo.

Se il tipo di piastra non è incluso nell’elenco, digitare il nome nella casella di testo per aggiungerlo
all’elenco.
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5. Selezionare un canale per il fluoroforo.

6. Selezionare una colonna piastra per il fluoroforo.

7. (Facoltativo) Digitare un colore da associare al fluoroforo.

8. Fare clic su Add to Plate (Aggiungi a piastra) per aggiungere il fluoroforo.

9. (Facoltativo) Ripetere i passaggi da 3 a 8 per aggiungere ciascun fluoroforo che si prevede di
calibrare per la piastra.

10. Una volta completata l’aggiunta di fluorofori, fare clic su View Plate (Visualizza piastra) per aprire la
finestra Pure Dye Plate Display (Display piastra colorante puro).

Usare questa finestra come guida per il caricamento dei coloranti nella piastra.

11. Preparare una piastra a 96, 384 pozzetti o a pozzetti profondi per la calibrazione del colorante:

a. Pipettare la soluzione di colorante in ciascun pozzetto, seguendo il pattern mostrato in Pure Dye
Plate Display (Display piastra colorante puro).

b. Per ciascun fluoroforo, riempire quattro pozzetti con 50 µl (piastra a 96 pozzetti o a pozzetti
profondi), 30 µl (piastra a 384 pozzetti) di soluzione di colorante da 300 nM. Si noti che almeno
metà piastra contiene pozzetti vuoti.

c. Sigillare la piastra usando il metodo di sigillatura che verrà utilizzato nell’esperimento.

12. Posizionare la piastra di calibrazione nel blocco e chiudere il coperchio.

13. Nella procedura guidata per la calibrazione dei coloranti, fare clic su Calibrate (Calibra), quindi su OK
per confermare che la piastra è nel blocco.

14. Quando il Software CFX Maestro Dx, Security Edition completa l’analisi di calibrazione, viene
visualizzata una finestra di dialogo. Fare clic su Yes (Sì) per terminare la calibrazione e aprire il Dye
Calibration Viewer (Visualizzatore calibrazione colorante).

15. Fare clic su OK per chiudere la finestra.

Impostazione delle preferenze utente
Suggerimento: per utilizzare CFX Maestro Dx SE non è necessario eseguire queste attività. È
possibile saltare questa sezione o eseguire queste attività in qualsiasi momento.

In CFX Maestro Dx SE, ogni utente può personalizzare il proprio ambiente di lavoro. Ad esempio, nel
menu Users > User Preferences (Utenti > Preferenze utente), è possibile eseguire quanto segue:

n Impostare le notifiche e-mail relative al completamento dell’analisi.
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Nota: questa funzione è disponibile solo per gli utenti al cui ruolo è stato assegnato questo
diritto. Per ulteriori informazioni, vedere Gestione dei ruoli utente del Software CFX Maestro Dx,
Security Edition a pagina 45.

n Modificare le impostazioni predefinite per

o La posizione in cui salvare i file

o I file di impostazione dell’analisi

o Il prefisso di denominazione dei file

n Impostare i parametri predefiniti da utilizzare per la creazione di un nuovo protocollo e una nuova
piastra.

n Impostare i parametri predefiniti per le analisi dei dati e l’espressione genica.

n Personalizzare i parametri di controllo qualità predefiniti.

n Personalizzare i parametri di esportazione dati.

Nel menu Tools (Strumenti), è possibile eseguire quanto segue:

n Creare una master mix.

n Calibrare i coloranti per uno strumento specifico.

Nota: la master mix e la calibrazione dei coloranti sono disponibili per chiunque acceda al software.

In questo paragrafo viene spiegato come eseguire queste attività.

Impostazione delle notifiche e-mail

È possibile collegare CFX Maestro Dx SE al server di posta elettronica in uscita per inviare la notifica e-
mail del completamento dell’analisi ad un elenco di utenti. Si può anche scegliere di allegare un file di dati
e un report di analisi all’elenco di utenti. Per impostare la connessione tra CFX Maestro Dx SE e il server
SMTP, vedere Connessione di Security Edition a un server SMTP a pagina 83.

Nota: la capacità di un’utente di accedere alle funzioni di impostazione della posta elettronica
dipende dal ruolo dell’utente e dalle autorizzazioni assegnate dall’amministratore. Per i dettagli sulla
gestione degli utenti e dei loro ruoli, vedere Gestione dei ruoli utente del Software CFX Maestro Dx,
Security Edition a pagina 45.
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Per impostare le notifiche e-mail

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

Viene visualizzata la finestra di dialogo User Preferences (Preferenze utente) con la scheda Email
(E-mail).

Nota: l’utente viene avvisato se il sistema rileva che non è stato impostato un server SMTP
valido per CFX Maestro Dx SE. Fare clic su Configure Outgoing Email (Configura posta
elettronica in uscita) per aprire la finestra di dialogo Options (Opzioni) e configurare il server
SMTP di posta elettronica. Per ulteriori informazioni, vedere Connessione di Security Edition a
un server SMTP a pagina 83.

2. Nella casella di testo To (A), digitare l’indirizzo e-mail di ogni persona che si intende informare al
termine di un’analisi. Tutti i destinatari riceveranno un’e-mail al termine dell’analisi.

Nota: è necessario immettere ogni indirizzo e-mail su una riga separata. Premere Enter (Invio) o
Return (Ritorno a capo) dopo ciascun indirizzo.

3. (Facoltativo) nella casella di testo cc, digitare l’indirizzo e-mail di ogni destinatario a cui si prevede di
inviare una copia di ogni notifica e-mail.

4. (Facoltativo) Per impostazione predefinita, tutti i destinatari ricevono una copia del file di dati sotto
forma di allegato. Deselezionare questa casella di controllo se non si desidera allegare una copia del
file di dati.

5. (Facoltativo) Selezionare Attach Analysis Report (Allega report di analisi) per allegare un PDF del
report di analisi all’e-mail.

6. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo User Preferences
(Preferenze utente).
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Nota: potrebbe essere possibile configurare il sistema per inviare una notifica e-mail al proprio
cellulare a seconda del proprio fornitore di servizi. Contattare il proprio fornitore di servizi di telefonia
cellulare per informazioni specifiche sull'indirizzo e-mail del cellulare. Inserire l'indirizzo e-mail del
telefono (ad esempio, 5552221234@your_service_provider_EmailDomain.net) nella casella di testo
To (A) della schermata User Preferences (Preferenze utente).

Per modificare l’indirizzo e-mail di un destinatario

u Modificare l’indirizzo e-mail secondo necessità e fare clic su OK.

Per rimuovere un destinatario dell’e-mail

1. Selezionare il destinatario dell’e-mail e premere il tasto Delete (Cancella).

2. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.

Connessione di Security Edition a un server SMTP

Importante: alcuni fornitori di servizi di webmail hanno aumentato la sicurezza della posta
elettronica. Se si utilizzano questi account, occorre abilitare l’impostazione Allow less secure apps
(Consenti app meno sicure) nelle impostazioni dell’account per permettere a CFX Maestro Dx SE di
inviare e-mail. Per ulteriori informazioni, vedere le informazioni relative alla sicurezza del proprio
provider di servizi di webmail.

Se per inviare e-mail si utilizza il server SMTP Google Gmail o Microsoft Office 365, è necessario abilitare
la verifica a 2 fattori e generare una "Password App" nelle impostazioni dell’account Gmail od Office365.
Per l’autenticazione nella finestra di dialogo Maestro Email Setup (Impostazione e-mail Maestro), copiare
e incollare la “Password App” nel campo Password invece della normale password per la posta.

Occorre stabilire una connessione da CFX Maestro Dx SE al server di posta elettronica prima che il
software possa inviare notifiche e-mail.

Per collegare CFX Maestro Dx SE a un server di posta elettronica

1. Eseguire una delle seguenti operazioni:

n Selezionare User > User Preferences (Utente > Preferenze utente) e fare clic sull’opzione
Configure Outgoing Email (Configura posta elettronica in uscita) della scheda Email (E-mail).

n Selezionare Tools > Options (Strumenti > Opzioni).

Viene visualizzata la finestra di dialogo Options (Opzioni) con la scheda Email (E-mail).
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2. Fornire le informazioni riportate di seguito per la propria azienda:

n SMTP Server Name (Nome server SMTP): il nome del server di posta elettronica in uscita
dell’azienda.

n Port (Porta): il numero di porta del server SMTP, che solitamente è il 25.

n Use SSL (Utilizza SSL): opzione Secure Sockets Layer (SSL). Alcuni server SMTP richiedono
questa impostazione. Se non è richiesto dall’azienda, deselezionare questa casella di controllo.

n Use Default “From” Address (Utilizza indirizzo “Da” predefinito): il nome del server di posta
elettronica dell’azienda. Alcuni server SMTP richiedono che tutte le e-mail inviate abbiano un
indirizzo “Da” appartenente a un determinato dominio, ad esempio nome@aziendautente.com.
In tal caso, deselezionare questa casella di controllo e immettere un indirizzo e-mail valido.

n Authentication Required (Autenticazione richiesta): se il sito richiede l’autenticazione
dell’account, verificare che questa casella di controllo sia selezionata.

n User Name (Nome utente): il nome dell’account autenticato. È obbligatorio solo se è selezionata
l’opzione Authentication Required (Autenticazione richiesta).
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n Password: la password dell’account autenticato. È obbligatorio solo se è selezionata l’opzione
Authentication Required (Autenticazione richiesta).

Importante: Se per inviare e-mail si utilizza il server SMTP Google Gmail o Microsoft Office 365,
è necessario abilitare la verifica a 2 fattori, quindi generare una "Password App" nelle
impostazioni dell’account Gmail od Office365. Per l’autenticazione nella finestra di dialogo
Maestro Email Setup (Impostazione e-mail Maestro), copiare e incollare la “Password App” nel
campo Password del CFX Maestro Dx SE invece della normale password per la posta.

Per verificare se le impostazioni del server SMTP sono corrette, immettere un indirizzo e-mail valido
nella casella di testo Test Email Address (Verifica indirizzo di posta elettronica) e fare clic su Test
Email (Messaggio di posta elettronica di prova).

Nota: alcuni server SMTP non consentono gli allegati e altri consentono solo gli allegati fino a
una dimensione specifica. Se si intende inviare per e-mail file di dati e/o report utilizzando
CFX Maestro Dx SE, selezionare Test Attachment (Prova allegato) e impostare le dimensioni in
MB per l’allegato su 5 megabyte (MB) o più.

3. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Modifica delle impostazioni file predefinite

Nella scheda Files (File) presente nella finestra di dialogo User Preference (Preferenze utente) è
possibile modificare quanto segue:

n Il percorso predefinito in cui salvare i file CFX Maestro Dx SE

n I file predefiniti per l’impostazione dell’analisi

n I parametri di denominazione file predefiniti

Per cambiare le impostazioni file predefinite

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Files (File).
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3. Nella sezione Default Folder for File Creation (Cartella predefinita per la creazione file), selezionare
la cartella predefinita nella quale si desidera salvare i nuovi file. È possibile selezionare un percorso
diverso per ciascun tipo di file:

n Protocol (Protocollo)

n Plate (Piastra)

n Data File (File di dati)

n Gene Study (Studio dei geni)

4. Nella sezione File Selection for Run Setup (Selezione dei file per l’impostazione dell’analisi),
individuare e selezionare i file protocollo target e piastra che devono apparire quando si apre la
finestra Experiment Setup (Impostazione esperimento).

5. Nella sezione file di dati, definire il prefisso e/o il suffisso per i file di dati. Per ogni parte, selezionare
un nuovo valore dall’elenco a discesa. È inoltre possibile fornire valori di prefisso e suffisso
personalizzati nelle caselle di testo Prefix (Prefisso) e Suffix (Suffisso).

CFX Maestro Dx SE visualizza un’anteprima del nome file sotto le caselle di selezione.

6. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
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ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.

Impostazione dei parametri predefiniti del protocollo

Per impostare i parametri predefiniti del protocollo per l’editor protocollo e per l’autowriter
protocollo

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Protocol
(Protocollo).

3. Nella sezione Protocol Editor (Editor protocollo), specificare i valori per le seguenti impostazioni che
vengono visualizzate nell’editor protocollo:

n Sample volume (Volume campione): il volume di ciascun campione nei pozzetti (in µl).

n Lid Shutoff temperature (Temperatura di arresto coperchio): la temperatura in ºC alla quale il
riscaldatore del coperchio si spegne durante un’analisi.

4. Nella sezione Protocol AutoWriter (Autowriter protocollo), specificare i valori per le seguenti
impostazioni che vengono visualizzate nell’autowriter protocollo:

n Annealing temperature (Temperatura di annealing): la temperatura in ºC per gli esperimenti
che utilizzano iProof DNA polimerasi, iTaq DNA polimerasi o altre polimerasi.

n Amplicon length (Lunghezza amplicone): la lunghezza dell’amplicone in bp.

5. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.
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Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.

Impostazione dei parametri predefiniti della piastra

Le modifiche apportate alla scheda Plate (Piastra) sono disponibili per tutti gli utenti del software. Le
modifiche apportate durante l’impostazione piastra sono disponibili per gli utenti dopo il salvataggio e la
chiusura del file piastra.

Nella finestra di dialogo User Preferences (Preferenze utente), è possibile eseguire quanto segue:

n Impostare i parametri predefiniti della piastra.

n Aggiungere nuovi nomi di target, campioni e gruppi biologici alle rispettive librerie.

n Eliminare i nomi di target, campioni e gruppi biologici dalle rispettive librerie.

Per impostare i parametri predefiniti della piastra

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Plate (Piastra).
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3. Specificare i valori per le seguenti impostazioni per il nuovo file piastra. Tali valori vengono
visualizzati nella finestra Plate Editor (Editor piastra):

n Plate type (Tipo di piastra)

n Plate size (Dimensioni piastra)

n Units (Unità): la concentrazione del templato iniziale per i pozzetti che contengono standard.

CFX Maestro Dx SE utilizza queste unità per creare una curva standard nella scheda Data
Analysis Quantification (Quantificazione analisi dei dati).

n Scientific notation (Notazione scientifica): quando è selezionata questa opzione, CFX Maestro
Dx SE visualizza le unità della concentrazione in notazione scientifica.

n Scan mode (Modalità di scansione): il numero o il tipo di canali da esaminare durante un’analisi.

n Fluorophores (Fluorofori): i fluorofori predefiniti che compaiono nei controlli di caricamento dei
pozzetti dell’editor piastra.

n Libraries (Librerie): i nomi di target, campioni e gruppi biologici che vengono generalmente
utilizzati negli esperimenti:

o Target names (Nomi target): i nomi dei geni e delle sequenze target.

o Sample names (Nomi campioni): i nomi dei campioni dell’esperimento o una caratteristica
di identificazione dei campioni [ad esempio, Mouse1 (Topo1), Mouse2 (Topo2), Mouse3
(Topo3)].

o Biological group names (Nomi gruppi biologici): i nomi dei gruppi di campioni simili che
hanno lo stesso stato o condizione di trattamento (ad esempio, 0Hr, 1Hr, 2Hr).

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Per aggiungere un nuovo nome per target, campioni o gruppi biologici

u Nella casella della libreria appropriata, digitare il nome per il target, campione o gruppo biologico e
fare clic su OK.

Per eliminare un nome di target, campione o gruppo biologico

u Nella casella della libreria appropriata, selezionare il nome e premere il tasto Delete (Canc), quindi
fare clic su OK.

Importante: i nomi che vengono eliminati dalla libreria vengono rimossi dal software e non sono più
disponibili per gli utenti. Per ripristinare i nomi CFX Maestro Dx SE predefiniti, fare clic su Restore
Defaults (Ripristina impostazioni predefinite). Facendo clic su Restore Defaults (Ripristina
impostazioni predefinite) nella finestra di dialogo User Preferences (Preferenze utente), tutte le
preferenze in tutte le schede verranno ripristinate alle impostazioni predefinite originali. Procedere
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con cautela quando si eliminano i nomi CFX Maestro Dx SE predefiniti e quando si fa clic su questo
pulsante.

90 | Software CFX Maestro Dx SE



Operazioni preliminari

Impostazione dei parametri predefiniti per l’analisi dei dati

Per impostare i parametri predefiniti per l’analisi dei dati

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Data Analysis
(Analisi dei dati).

3. Nella sezione Analysis Mode (Modalità di analisi), selezionare la modalità con la quale analizzare i
dati: Fluorophore (Fluoroforo) o Target.

4. Nella sezione PCR Quantitation (Quantificazione PCR), impostare i parametri predefiniti per le
seguenti opzioni:

n Baseline Setting (Impostazione linea basale): il metodo della linea basale per la modalità di
analisi.

n Cq Determination Mode (Modalità di determinazione Cq): la modalità con la quale vengono
calcolati i valori Cq per ciascuna traccia di fluorescenza (regressione o soglia singola).

n Threshold Calc. Mode (Modalità calc. soglia): la quantità target del punto finale.

L’impostazione predefinita è Auto (Automatico). In pratica, il software calcola automaticamente il
punto finale target. Per impostare una soglia specifica, deselezionare la casella di controllo Auto
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(Automatico) e inserire la quantità del punto finale desiderata, calcolata in relative unità di
fluorescenza (o RFU). Il valore massimo è 65.000,00 RFU. I file di dati per le analisi successive
utilizzeranno questa impostazione della soglia.

n Baseline Calc. Mode (Modalità calc. linea basale): il valore della linea basale per tutte le tracce.

L’impostazione predefinita è Auto (Automatico). In pratica, il software calcola automaticamente
la linea basale per tutte le tracce. Per impostare una valore specifico di linea basale,
deselezionare la casella di controllo Auto (Automatico) e inserire i valori minimo e massimo per
l’intervallo di ciclo (da 1 a 9.999). I file di dati per le analisi successive utilizzeranno questo
intervallo di ciclo.

n Log View (Visualizzazione registro): determina il modo in cui il software visualizza i dati di
amplificazione:

o On (Acceso): i dati di amplificazione vengono visualizzati in un grafico semilogaritmico.

o Off (Spento) (impostazione predefinita): i dati di amplificazione vengono visualizzati in un
grafico lineare.

5. Nella sezione End Point (Punto finale), selezionare il numero di cicli finali per la media quando si
effettuano i calcoli dei punti finali:

n PCR: il numero di cicli finali di cui calcolare la media per i dati di quantificazione (il valore
predefinito è 5).

n End Point Only run (Analisi solo nel punto finale): il numero di cicli finali di cui calcolare la
media per i dati nel punto finale (il valore predefinito è 2).

6. Nella sezione Melt Curve (Curva di fusione), selezionare il tipo di picco da rilevare (positivo o
negativo).

7. Nella sezione Well Selector (Selettore pozzetto), selezionare come visualizzare le etichette pozzetto
(in base a tipo di campione, nome target o nome campione).

8. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.
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Impostazione dei parametri predefiniti del file di dati dell’espressione genica

Baseline Calc. Mode Per impostare i parametri predefiniti per un nuovo file di dati
dell’espressione genica

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Gene
Expression (Espressione genica).

3. Specificare i valori per le seguenti impostazioni:

n Relative to (Rispetto a): rappresenta graficamente i dati dell’espressione genica rispetto a un
controllo (che inizia con 1) o a zero:

o Zero: il software ignora il controllo. Questa è l’impostazione predefinita quando non viene
assegnato alcun campione di controllo nella finestra Experiment Settings (Impostazioni
esperimento).

o Control (Controllo): il software calcola i dati in relazione al campione di controllo assegnato
nella finestra Experiment Setup (Impostazione esperimento).

n X-axis (Asse X): rappresenta graficamente il campione o il target sull’asse delle ascisse.

n Y-axis (Asse Y): rappresenta graficamente la scala lineare, log2 o log10 sull’asse delle ordinate.

n Scaling (Scala): l’opzione di scala per il grafico. L’opzione predefinita è Unscaled (Non scalato):

o Highest (Più alto): il software scala il grafico rispetto al punto dati più alto.

o Lowest (Più basso): il software scala il grafico rispetto al punto dati più basso.

o Unscaled (Non scalato): il software presenta i dati non scalati nel grafico.

n Mode (Modalità): la modalità di analisi, quantità relativa (∆Cq) o espressione normalizzata
(∆∆Cq).

n Error Bar (Barra di errore): la variabilità dei dati presentata come deviazione standard (Std.
Dev.) o errore standard della media (Std. Error Mean).

n Error Bar Multiplier (Moltiplicatore barra di errore): il moltiplicatore della deviazione standard
utilizzato per rappresentare graficamente le barre di errore (il valore predefinito è 1).

È possibile aumentare il moltiplicatore a 2 o 3.

n Sample Types to Exclude (Tipi di campioni da escludere): i tipi di campione da escludere
dall’analisi.
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È possibile selezionare uno o più campioni da escludere dall’analisi. Per escludere tutti i tipi di
campione, deselezionare le caselle di controllo di ogni tipo di campione selezionato.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.

Personalizzazione delle regole di controllo qualità

In CFX Maestro Dx SE, è possibile impostare le regole di controllo qualità, che vengono applicate ai dati
nella finestra Data Analysis (Analisi dei dati). Il software convalida i dati rispetto alle regole impostate.

Nota: per impostazione predefinita, tutte le regole di controllo qualità sono abilitate.

Suggerimento: è possibile escludere facilmente i pozzetti che non rispettano un parametro CQ
dall’analisi nel modulo QC (CQ) della finestra Data Analysis (Analisi dei dati).

Per personalizzare le regole di controllo qualità

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda QC (CQ).
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Dove:

n NTC (No Template Control): controllo senza templato

n NRT (No Reverse Transcriptase): controllo senza trascrittasi inversa

n Efficiency (Efficienza): efficienza della reazione

n Std Curve R^2: valore R quadrato per la curva standard

n Replicate group Cq Std Dev: deviazione standard calcolata per ciascun gruppo di replicati

3. Per ciascuna regola CQ, eseguire una delle seguenti operazioni:

n Per usare il suo valore predefinito, non fare nulla.

n Per modificarne il valore, fare clic sulla relativa casella di testo Value (Valore), digitare un nuovo
valore e premere il tasto Enter (Invio).

n Per disabilitare la regola, deselezionare la sua casella di controllo Use (Usa).

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
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ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.

Personalizzazione dei parametri di esportazione dati

È possibile esportare dati CFX Maestro Dx SE nei seguenti formati:

n Testo (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Importante: sul computer in uso deve essere installato Microsoft Excel per poter esportare i dati in
un foglio di calcolo Microsoft Excel.

È possibile specificare il tipo di dati da esportare e personalizzare la stampa dei dati esportati.

Per personalizzare i parametri di esportazione dati

1. Selezionare User > User Preferences (Utente > Preferenze utente) per aprire la finestra di dialogo
User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Custom Export
(Personalizza esportazione).
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3. Nell’elenco a discesa Export Format (Formato esportazione), selezionare un formato in cui esportare
i dati.

4. Nella sezione Data to Export (Dati da esportare), selezionare o deselezionare le caselle di controllo
per il tipo di dati da esportare. Gli elementi selezionati vengono visualizzati nella casella di riepilogo
Exported Columns (Colonne esportate).

Nota: per impostazione predefinita, le informazioni sull’analisi sono incluse nell’intestazione.
Deselezionare questa casella di controllo se si desidera che le informazioni sull’analisi non
vengano incluse.

5. È possibile cambiare l’ordine di visualizzazione di stampa degli elementi selezionati.

Nella casella di elenco Exported Columns (Colonne esportate), selezionare l’elemento, quindi fare
clic sui pulsanti freccia a sinistra dell’elenco per spostarlo su o giù.

6. Facoltativamente, è possibile cambiare i nomi delle colonne di output degli elementi selezionati:

a. Fare clic su Customize Column Names (Personalizza nomi colonna).

Viene visualizzata la finestra di dialogo Column Name Customizer (Personalizzazione nomi
colonna).

b. Per ciascun nome di colonna predefinito che si desidera modificare, digitare il nuovo nome nel
campo Custom Name (Personalizza nome) corrispondente.
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c. Eseguire una delle seguenti operazioni:

n Fare clic su OK per salvare le modifiche e tornare alla scheda Custom Export (Personalizza
esportazione). Il nuovo nome viene visualizzato tra parentesi accanto al nome di colonna
predefinito nella casella di riepilogo Exported Columns (Colonne esportate).

n Fare clic su Cancel (Annulla) per annullare le modifiche e tornare alla scheda Custom
Export (Personalizza esportazione).

7. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra di
dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede verranno
ripristinate alle impostazioni predefinite originali. Procedere con cautela quando si fa clic su questo
pulsante.
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Un protocollo è una serie di fasi che vengono eseguite in una determinata sequenza. Nel Software
CFX Maestro Dx, Security Edition, tutte le fasi sono associate alle opzioni sullo strumento. Ad esempio, le
fasi indicano allo strumento di controllare la temperatura del blocco e del coperchio, applicare una
differenza di temperatura nel blocco, effettuare la lettura di una piastra o eseguire l’analisi della curva di
fusione. Ogni opzione viene specificata per i vari tipi di piastre e di analisi.

CFX Maestro Dx SE offre due opzioni per la creazione di protocolli: Protocol Editor (Editor protocollo) e
Protocol AutoWriter (Autowriter protocollo).

Le funzioni dell’editor protocollo includono quanto segue:

n Controlli del protocollo standard per creare protocolli in modo rapido

n Possibilità di calcolare rapidamente un gradiente per il numero di file selezionato

n Possibilità di calcolare rapidamente il tempo di esecuzione per il tipo di piastra selezionato

n Possibilità di modificare le fasi del protocollo

n Possibilità di salvare i protocolli per successivi riutilizzi

n Possibilità di stampare il protocollo su una stampante predefinita

L’autowriter protocollo genera automaticamente un protocollo PCR personalizzato con le diverse fasi di
attivazione enzimatica (hot start), denaturazione iniziale, annealing ed estensione utilizzando i parametri
forniti dall’utente. È inoltre possibile visualizzare una rappresentazione grafica del protocollo suggerito e
modificare, eseguire o salvare il protocollo.
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Parametri e intervalli per le fasi del protocollo
Utilizzare le informazioni della Tabella 7 per modificare le impostazioni predefinite per le fasi del
protocollo.

Fasi della temperatura

La temperatura target è un valore compreso tra 4,0 e 100,0 °C, impostato in decimi di grado. Il sistema
raggiunge questa temperatura e mantiene quel valore per un periodo di tempo specificato (il tempo di
mantenimento).

Fasi del gradiente

L'intervallo di gradiente è la differenza tra la temperatura inferiore e quella superiore in una fase del
gradiente. L'intervallo massimo consentito è di 24 °C. La temperatura inferiore è un valore compreso tra
30,0 e 99,0 °C, impostato in decimi di grado. La temperatura superiore massima è di 100 °C. Il
termociclatore aumenta fino al gradiente di temperatura target attraverso il blocco e mantiene quella
temperatura per un tempo di mantenimento specificato.

Importante: lo strumento calcola il valore del gradiente. Quando si immette un valore nei campi
superiore e inferiore del calcolatore del gradiente, il software calcola e assegna automaticamente le
temperature per i campi rimanenti. Quando si immette una temperatura in un campo qualsiasi tra il
campo superiore e quello inferiore, lo strumento calcola automaticamente i campi rimanenti. Non è
possibile inserire manualmente un valore di temperatura in ogni campo.
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Parametro Intervallo Descrizione

Ramp rate
(Velocità di
rampa)

n Per i sistemi CFX Opus 96 Dx:
0,1 - 5 °C al sec

n Per i sistemi CFX Opus 384 Dx:
0,1 - 2,5 °C al sec

n Per i sistemi CFX Opus Deepwell
Dx:
0,1 - 2,5 °C al sec

Indica al termociclatore di raggiungere la
temperatura target alla velocità specificata
in quella fase.

Disponibile solo per fasi di temperatura.

Increment
(Incremento)

Un numero compreso tra -10,0 e
10,0 °C per ciclo in decimi di grado

Indica al termociclatore di modificare la
temperatura target di un'unità per ogni ciclo,
dove un numero positivo aumenta la
temperatura e un numero negativo la
diminuisce.

Disponibile solo per fasi di temperatura.

Extend (Estendi) Un tempo compreso tra -60 e 60
sec per ciclo

Indica al termociclatore di estendere il
tempo di mantenimento per ogni ciclo. Un
numero positivo aumenta il tempo di
mantenimento, mentre un numero negativo
lo diminuisce.

Disponibile per entrambe le fasi della
temperatura e del gradiente.

Beep (Segnale
acustico)

(Nessun parametro) Indica al termociclatore di emettere un
segnale acustico per segnalare che il
termociclatore ha raggiunto la temperatura
target per quella fase.

Disponibile solo per fasi di temperatura.

Plate read
(Lettura piastra)

(Nessun parametro) Indica al termociclatore di aggiungere una
lettura della piastra nella fase selezionata.

Disponibile per entrambe le fasi della
temperatura e del gradiente.

Tabella 7. Parametri e intervalli per le fasi del protocollo
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Finestra dell’editor protocollo
Utilizzare l’editor protocollo per creare, aprire, rivedere e modificare un protocollo. Per impostazione
predefinita, l’editor protocollo apre un protocollo a 2 fasi in tempo reale per una piastra da 96 pozzetti.

1. La barra dei menu fornisce un accesso rapido ai comandi dei menu File (File), Settings
(Impostazioni) e Tools (Strumenti).

2. La barra degli strumenti offre l’accesso rapido per salvare e stampare il protocollo, stabilire
dove inserire una fase, impostare il volume del campione e visualizzare il tempo stimato di
esecuzione del protocollo.

3. Nel riquadro principale è visualizzata una rappresentazione grafica del protocollo.

4. Nel riquadro inferiore appare la struttura del protocollo.

5. Nel riquadro di sinistra sono visualizzati i controlli del protocollo che è possibile aggiungere per
personalizzare il protocollo.

LEGENDA

Comandi del menu File
Save (Salva): consente di salvare il protocollo corrente.
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Save As (Salva con nome): consente di salvare il protocollo corrente con un nuovo nome o in un nuovo
percorso.

File Passwords (Password file): consente agli utenti di impostare le password di salvataggio e apertura
file.

Suggerimento: per ulteriori informazioni, vedere Password di protezione dei file a pagina 52.

Close (Chiudi): consente di chiudere l’editor protocollo.

Comando del menu Settings (Impostazioni)
Lid Settings (Impostazioni coperchio): apre la finestra di dialogo Lid Setting (Impostazione coperchio) in
cui si può modificare o impostare la temperatura del coperchio.

Comandi del menu Tools (Strumenti)
Gradient Calculator (Calcolatore gradiente): apre una finestra di dialogo dalla quale è possibile
selezionare il tipo di blocco per una fase gradiente. L'impostazione predefinita è 96 pozzetti.

Run time Calculator (Calcolatore tempo di analisi): apre una finestra di dialogo dalla quale è possibile
selezionare il tipo di piastra e la modalità di scansione per calcolare il tempo di analisi stimato nella
finestra Run Setup (Impostazione analisi). L'impostazione predefinita è 96 pozzetti, All channels (Tutti i
canali).

Comandi della barra degli strumenti

: consente di salvare il file del protocollo corrente.

: consente di stampare la finestra selezionata.

: questo comando consente di scegliere dove inserire i passaggi relativi alla fase
attualmente selezionata.

: questo comando consente di immettere un volume di campione in µl. I volumi
dei campioni variano in base al tipo di blocco:

n Per un blocco da 96 pozzetti, l’intervallo è compreso tra 0 e 50 µl.

n Per un blocco da 384 pozzetti, l’intervallo è compreso tra 0 e 30 µl.
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n Per un blocco da 96 pozzetti profondi, l’intervallo è compreso tra 0 e 125 µl.

: consente di visualizzare il tempo di esecuzione stimato in base alle fasi del
protocollo, alla velocità di rampa e al tipo di blocco selezionati.

: consente di visualizzare informazioni della Guida sui protocolli.

Comandi di modifica protocollo
Il riquadro sinistro della finestra dell’editor protocollo comprende i comandi che è possibile utilizzare per
creare i protocolli.

Ciascun controllo è composto da una serie di parametri che rappresentano una fase nel protocollo. È
possibile modificare ciascun parametro e aggiungerlo o rimuoverlo per personalizzare il protocollo.
Questa sezione descrive le opzioni disponibili in ogni controllo.

n Insert Step (Inserisci fase): inserisce una fase prima o dopo la fase
selezionata. È possibile modificare i valori della temperatura e del tempo
di mantenimento nella visualizzazione grafica del protocollo o nella
struttura del protocollo.

n Insert Gradient (Inserisci gradiente): inserisce una fase gradiente in
base al tipo di blocco del pozzetto selezionato nel calcolatore del
gradiente. È possibile modificare l’intervallo del gradiente nel riquadro
Gradient (Gradiente) che viene visualizzato quando si inserisce una fase
gradiente.

n Insert GOTO (Inserisci GOTO): inserisce una fase ciclica (loop), che
indica al software di ripetere determinate fasi in sequenza per un numero

di cicli specificato. Le ripetizioni iniziano dopo il completamento del primo ciclo. Ad esempio, è
possibile indicare il software di eseguire 39 ripetizioni delle fasi 2–4. Dopo la ripetizione finale, il
software avrà eseguito le fasi 2–4 per un totale di 40 volte. È possibile modificare la fase di ritorno
(GOTO) e il numero di cicli nella visualizzazione grafica o nella struttura del protocollo.

n Insert Melt Curve (Inserisci curva di fusione): inserisce una fase di lettura della curva di fusione.

n Insert Plate Read to Step (Inserisci lettura piastra nella fase): aggiunge un comando di lettura
piastra alla fase selezionata. Una lettura piastra misura la quantità di fluorescenza alla fine di un
ciclo. La fase di lettura piastra di solito è l’ultima fase in un loop GOTO.

Suggerimento: dopo aver aggiunto un comando di lettura piastra a una fase, il pulsante cambia
in Remove Plate Read (Rimuovi lettura piastra) quando si seleziona la fase.
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n Remove Plate Read (Rimuovi lettura piastra): rimuove un comando di lettura piastra dalla fase
selezionata.

Suggerimento: dopo aver rimosso un comando di lettura piastra da una fase, il pulsante
cambia in Add Plate Read to Step (Aggiungi lettura piastra alla fase) quando si seleziona la fase.

n Step Options (Opzioni fase): apre la finestra di dialogo Step Options (Opzioni fase) e visualizza le
opzioni disponibili per la fase selezionata. Per informazioni dettagliate sulle opzioni della fase, vedere
Opzioni fase a pagina 106.

Suggerimento: è inoltre possibile accedere alle opzioni della fase facendo clic con il pulsante
destro del mouse sulla fase nella visualizzazione grafica.

n Delete Step (Elimina fase): elimina la fase selezionata dal protocollo.
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Opzioni fase

Aprire la finestra di dialogo Step Options (Opzioni fase) per visualizzare le opzioni che è possibile
aggiungere, modificare o rimuovere da una fase.

n Plate Read (Lettura piastra): quando è selezionata questa opzione, viene aggiunta una lettura
piastra alla fase.

n Temperature (Temperatura): imposta la temperatura target per la fase selezionata.

n Gradient (Gradiente): imposta l’intervallo gradiente per la fase; l’intervallo è compreso tra 1 e 24 °C.

Nota: viene eseguito un gradiente con la temperatura più bassa nella parte anteriore del blocco
(fila H in questa immagine) e la temperatura più alta nella parte posteriore del blocco (fila A in
questa immagine).

n Increment (Incremento): la quantità per aumentare (o diminuire) la temperatura della fase
selezionata; questo valore viene aggiunto alla temperatura target con ogni ciclo. L’intervallo è
compreso tra ±0,1 e 10 °C.

Nota: per diminuire la temperatura, immettere un segno meno (-) prima del valore numerico (ad
esempio, -5 °C).

n Ramp Rate (Velocità di rampa): la velocità di rampa per la fase selezionata; l’intervallo dipende dalle
dimensioni del blocco.

n Time (Tempo): il tempo di mantenimento della fase selezionata.
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n Extend (Estendi): la quantità di tempo (in sec) per prolungare o ridurre la fase selezionata; questa
opzione viene aggiunta al tempo di mantenimento in ogni ciclo; l’intervallo è compreso tra ±1 e 60
sec.

n Beep (Segnale acustico): se selezionato, viene emesso un segnale acustico durante la fase.

Suggerimento: quando si immette un valore che non rientra nell’intervallo dell’opzione, il
software lo modifica con il valore più vicino compreso nell’intervallo.
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Creazione di un protocollo nell’editor protocollo
Usando l’editor protocollo, è possibile creare file protocollo personalizzati. Inoltre, è possibile modificare e
salvare i file di protocollo precedentemente salvati o i file di protocollo campione spediti con CFX Maestro
Dx SE.

Per creare un nuovo file protocollo, procedere come segue:

n Aprire un file protocollo nell’editor protocollo.

Suggerimento: è possibile aprire un protocollo nuovo o esistente nell'editor del protocollo.

n Impostare il nuovo protocollo.

n Aggiungere fasi al protocollo dal riquadro dei controlli del protocollo.

n Modificare le proprietà delle fasi.

n Salvare il protocollo.

Suggerimento: per creare un nuovo protocollo da un file di protocollo salvato in precedenza o di
esempio, vedere Apertura di un protocollo esistente nell’editor protocollo a pagina 110.

Apertura di un nuovo file di protocollo nell’editor protocollo
CFX Maestro Dx SE offre più opzioni per aprire un nuovo file di protocollo:

n Dal menu File nella finestra Home

n Dalla finestra di dialogo Run Setup (Impostazione analisi) nella finestra Home

n Dalla finestra di dialogo Startup Wizard (Procedura guidata di avvio) nella finestra Home

Per aprire un nuovo file di protocollo dal menu File

u Nella finestra Home, selezionare File > New > Protocol (File > Nuovo > Protocollo).

Viene visualizzata la finestra dell’editor protocollo con il file di protocollo predefinito.

Suggerimento: per le informazioni sull’impostazione del protocollo predefinito, vedere Modifica
delle impostazioni file predefinite a pagina 85.

Per aprire un nuovo protocollo dalla finestra di dialogo Run Setup (Impostazione analisi)

1. Nella finestra Home, eseguire una delle seguenti operazioni per aprire la finestra di dialogo Run
Setup (Impostazione analisi):

n Selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente).
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n Fare clic su User-defined Run Setup (Impostazione analisi definita dall’utente) nella barra degli
strumenti.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo) e
visualizza il file di protocollo predefinito.

2. Fare clic su Create New (Crea nuovo).

Viene visualizzata la finestra dell’editor protocollo con il protocollo in tempo reale predefinito.

Per aprire un nuovo file di protocollo dalla procedura guidata di avvio

1. Nella finestra Home, eseguire una delle seguenti operazioni per aprire la procedura guidata di avvio
se non è già visualizzata:

n Selezionare View > Startup Wizard (Visualizza > Procedura guidata di avvio).

n Fare clic su Startup Wizard (Procedura guidata di avvio) nella barra degli strumenti.

2. Se necessario, selezionare il tipo di strumento dall’elenco a discesa.

3. Fare clic su User-defined (Definito dall’utente) come tipo di analisi.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo) e
visualizza il file di protocollo predefinito.

4. Fare clic su Create New (Crea nuovo).

Viene visualizzata la finestra dell’editor protocollo con il protocollo in tempo reale predefinito.

Per aprire un nuovo protocollo dal menu Run (Analisi)

1. Nella finestra Home, eseguire una delle seguenti operazioni per aprire la finestra di dialogo Run
Setup (Impostazione analisi):

n Selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente).

n Fare clic su User-defined Run Setup (Impostazione analisi definita dall’utente) nella barra degli
strumenti.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo) e
visualizza il file di protocollo predefinito.

2. Fare clic su Create New (Crea nuovo).

Viene visualizzata la finestra dell’editor protocollo con il protocollo in tempo reale predefinito.
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Apertura di un protocollo esistente nell’editor protocollo
CFX Maestro Dx SE fornisce i file protocollo campione che è possibile modificare e salvare come nuovi
protocolli personalizzati. È inoltre possibile creare un nuovo protocollo da un protocollo personalizzato
esistente.

Per aprire un file protocollo di esempio

1. Nella finestra Home, selezionare File > Open > Protocol (File > Apri > Protocollo).

Per impostazione predefinita, Windows Explorer (Esplora risorse) si apre nel percorso della cartella
dei file di esempio di CFX Maestro Dx SE.

2. Aprire la cartella dei file di esempio. Sono presenti le seguenti cartelle:

n ConventionalProtocols (Protocolli convenzionali): contiene i file protocollo di esempio per
l’analisi PCR tradizionale.

n DataFiles (File di dati): contiene i file di dati di esempio che è possibile utilizzare per esplorare le
funzioni di CFX Maestro Dx SE.

n MeltCalibration (Calibrazione di fusione): contiene i file protocollo di esempio da utilizzare con il
software Precision Melt Analysis di Bio-Rad.

n Plates (Piastre): contiene i file piastra di esempio.

n RealTimeProtocols (Protocolli in tempo reale): contiene i file protocollo di esempio per l’analisi
PCR in tempo reale.

3. Aprire la cartella del protocollo per il tipo di analisi che si intende effettuare, ConventionalProtocols
(Protocolli convenzionali) o RealTimeProtocols (Protocolli in tempo reale).

4. Selezionare il protocollo che si è scelto e fare clic su Open (Apri).

Il protocollo di esempio viene aperto nella finestra Protocol Editor (Editor protocollo).

5. Selezionare File > Save As (File > Salva con nome) e salvare il protocollo con un nuovo nome o in
una nuova cartella.

Per aprire un protocollo esistente

1. Nella finestra Home, eseguire una delle seguenti operazioni:

n Selezionare File > Open > Protocol (File > Apri > Protocollo), accedere al protocollo target,
selezionarlo e fare clic su Open (Apri).

n Aprire la procedura guidata di avvio ed eseguire una delle seguenti operazioni:

o Per modificare il protocollo visualizzato, fare clic su Edit Selected (Modifica selezione).
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o Per modificare un altro protocollo esistente, fare clic su Select Existing (Seleziona
esistente) e accedere al file target.

Il protocollo viene aperto nella finestra Protocol Editor (Editor protocollo).

2. Selezionare File > Save As (File > Salva con nome) e salvare il protocollo con un nuovo nome o in
una nuova cartella.

Impostazione di un nuovo protocollo
Suggerimento: se il file del protocollo include i parametri richiesti (ad esempio, se si sta modificando
un file piastra esistente) è possibile saltare questo paragrafo. Passare al capitolo Aggiunta di fasi ad
un protocollo a pagina 113.

I nuovi file protocollo richiedono i seguenti parametri:

n Tipo di blocco

n Modalità di scansione per il tipo di blocco scelto

n Temperatura del coperchio

n Volume del campione
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Impostazione del tipo di blocco

CFX Maestro Dx SE calcola automaticamente gli incrementi della temperatura per le fasi gradiente in
base al tipo di blocco.

Nota: il tipo di piastra impostato nell’editor protocollo deve corrispondere alla piastra presente nel
modulo di reazione.

Per impostare il tipo di blocco

u Nella finestra Protocol Editor (Editor protocollo), selezionare Tools > Gradient Calculator (Strumenti
> Calcolatore gradiente) e scegliere il tipo di piastra appropriato nell’elenco a discesa visualizzato.

Selezione della modalità di scansione per il tipo di blocco scelto

Per determinare il tempo di esecuzione del protocollo, selezionare il tipo di blocco target e la modalità di
scansione.

Per selezionare il tipo di blocco e la modalità di scansione

u Nella finestra Protocol Editor (Editor protocollo), selezionare Tools > Run time Calculator (Strumenti
> Calcolatore tempo di esecuzione) e scegliere il tipo di piastra e la modalità di scansione appropriati
nell’elenco a discesa visualizzato.

Regolazione della temperatura del coperchio

CFX Maestro Dx SE imposta le temperature predefinite del coperchio nel seguente modo:

n Strumenti a 96 pozzetti e a pozzetti profondi: 105,0 °C

n Strumenti a 384 pozzetti: 95,0 °C

È possibile modificare le impostazioni predefinite o disattivare il riscaldatore del coperchio, come ritenuto
necessario per il protocollo.

Per regolare la temperatura del coperchio

1. Nella finestra dell’editor piastra, selezionare Settings > Lid Settings (Impostazioni > Impostazioni
coperchio).

Viene visualizzata la finestra di dialogo Lid Settings (Impostazioni coperchio).

2. Eseguire una delle seguenti operazioni:

n Selezionare User Defined (Definito dall’utente) e immettere un valore per la temperatura nella
casella di testo.

n Selezionare Turn Off Lid Heater (Spegni riscaldatore coperchio).

3. Fare clic su OK per accettare le modifiche e chiudere la finestra di dialogo.
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Impostazione del volume del campione

Per impostazione predefinita, CFX Maestro Dx SE imposta il volume campione per ciascun pozzetto a
25 µl. I volumi dei campioni variano in base al tipo di blocco, ad esempio:

n 0–50 µl per un blocco a 96 pozzetti

n 0–30 µl per un blocco a 384 pozzetti

Lo strumento utilizza una delle due modalità di controllo della temperatura per determinare quando il
campione raggiunge la temperatura target in un protocollo:

n Calculated mode (Modalità calcolata): quando il volume del campione è impostato su un volume
diverso da zero appropriato per il blocco, lo strumento calcola la temperatura del campione in base al
volume del campione. Questa è la modalità standard.

n Block mode (Modalità blocco): quando il volume del campione è impostato su zero (0) µl, lo
strumento registra la temperatura del campione come se fosse uguale alla temperatura del blocco
misurata.

Per impostare il volume del campione per un blocco specifico

u Nella finestra Plate Editor (Editor piastra), digitare il valore corretto nella casella di testo Sample
Volume (Volume campione) nella barra degli strumenti.

Suggerimento: nella finestra di dialogo User Preferences (Preferenze utente) è possibile modificare
il volume predefinito del campione. Fare riferimento a Modifica delle impostazioni file predefinite a
pagina 85.

Aggiunta di fasi ad un protocollo
Per aggiungere una fase al protocollo

1. Aprire il protocollo nella finestra Protocol Editor (Editor protocollo).

2. Stabilire dove inserire la nuova fase. Nella barra degli strumenti, selezionare Before (Prima) o After
(Dopo) nell’elenco a discesa Step (Fase).

3. Nel grafico, selezionare la fase prima o dopo la quale si intende inserire la nuova fase.

4. Nel riquadro di sinistra, fare clic su Insert Step (Inserisci fase).

5. Per cambiare la temperatura o il tempo di mantenimento, fare clic sul valore predefinito presente sul
grafico o sulla struttura del protocollo e digitare un nuovo valore.

6. (Facoltativo) Nel riquadro di sinistra, fare clic su Step Options (Opzioni fase) per visualizzare la
finestra di dialogo Step Options (Opzioni fase) e modificare le opzioni disponibili per la fase
selezionata.
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Suggerimento: è possibile accedere alla finestra di dialogo Step Options (Opzioni fasi) del
menu di scelta rapida nel riquadro del grafico o nel riquadro della struttura del protocollo.

7. Fare clic su OK e poi su Yes (Sì) per salvare le modifiche apportate al protocollo.

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

8. Nella finestra di dialogo Save As (Salva con nome), immettere un nome per il nuovo file di protocollo
e fare clic su Save (Salva).

Inserimento di una fase gradiente
Per inserire una fase gradiente

1. Verificare che le dimensioni della piastra per il gradiente corrispondano a quelle del tipo di blocco
dello strumento, a 96 pozzetti, 384 pozzetti o a pozzetti profondi.

2. Se non è già stato fatto, selezionare le dimensioni della piastra per il gradiente:

Selezionare Tools > Gradient Calculator (Strumenti > Calcolatore gradiente) e scegliere il tipo di
pozzetto appropriato dall’elenco a discesa.

3. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

4. Nel grafico o nel riquadro della struttura, selezionare la fase prima o dopo la quale si programma di
inserire la fase gradiente.

5. Nel riquadro di sinistra, fare clic su Insert Gradient (Inserisci gradiente). La nuova fase gradiente
viene evidenziata nel grafico e nel riquadro della struttura, ad esempio:

114 | Software CFX Maestro Dx SE



Creazione di un protocollo nell’editor protocollo

La temperatura di ciascuna riga nel gradiente viene visualizzata nella tabella del gradiente nel
riquadro a destra.

6. Per modificare l’intervallo della temperatura del gradiente, eseguire una delle seguenti operazioni:

n Fare clic sulla temperatura predefinita nel grafico o nel riquadro della struttura e inserire una
nuova temperatura.

n Fare clic su Step Options (Opzioni fase) per inserire l’intervallo di gradiente nella finestra Step
Options (Opzioni fase).

n Modificare il valore Range (Intervallo) nella tabella del gradiente.

7. Per modificare il tempo di conservazione, fare clic sul tempo predefinito nella vista a grafico o a testo
e inserire un nuovo tempo.

8. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche.

Inserimento di una fase GOTO
Nota: non è possibile inserire una fase GOTO in una serie GOTO; non è possibile creare loop GOTO
annidati.
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Per inserire una fase GOTO

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si programma di inserire la fase GOTO.

3. Nel riquadro di sinistra, fare clic su Insert GOTO (Inserisci GOTO).

4. Per modificare il numero di fase GOTO o il numero di ripetizioni GOTO, selezionare il numero
predefinito nel grafico o nel riquadro struttura e immettere un nuovo valore.

5. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche.

Inserimento di una fase della curva di fusione
Suggerimento: non è possibile inserire una fase della curva di fusione all’interno di un loop GOTO.

Nota: la fase della curva di fusione include un’attesa di 30 sec all’inizio della fase che non viene
visualizzata nel protocollo.

Per inserire una fase di curva di fusione

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si programma di inserire la fase di curva di
fusione.
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3. Nel riquadro di sinistra, fare clic su Insert Melt Curve (Inserisci curva di fusione). La nuova fase di
curva di fusione viene evidenziata nel grafico e nel riquadro della struttura, ad esempio:

4. Per modificare l’intervallo della temperatura di fusione o il tempo di incremento, selezionare il numero
predefinito nel grafico o nel riquadro struttura e inserire un nuovo valore.

5. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche.
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Aggiunta o rimozione di una fase di lettura piastra
Suggerimento: dopo aver aggiunto un comando di lettura piastra a una fase, il pulsante cambia in
Remove Plate Read (Rimuovi lettura piastra) quando si seleziona la fase.

Per aggiungere una lettura piastra ad una fase

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si prevede di inserire la fase di lettura piastra.

3. Nel riquadro a sinistra, fare clic su Add Plate Read to Step (Aggiungi lettura piastra alla fase) per
aggiungere una lettura piastra alla fase selezionata.

4. Fare clic su OK, quindi su Yes (Sì) per salvare le modifiche.

Per rimuovere una lettura piastra da una fase

u Sul grafico, selezionare la fase che contiene la lettura piastra e fare clic su Remove Plate Read
(Rimuovi lettura piastra) nel riquadro a sinistra.

Modifica delle opzioni della fase
Per cambiare le opzioni della fase per la fase selezionata

1. Selezionare la fase target nel grafico o nel riquadro struttura.

2. Nel riquadro di sinistra, fare clic su Step Options (Opzioni fase) per aprire la finestra di dialogo Step
Options (Opzioni fase).

In alternativa, fare clic con il tasto destro del mouse sulla fase target in uno dei riquadri e selezionare
Step Options (Opzioni fase) nel menu che appare.

3. Per aggiungere, modificare o rimuovere le opzioni:

n Immettere un valore nella casella di testo appropriata.

n Modificare un valore nella casella di testo specifica.

n Selezionare o deselezionare una casella di controllo.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo Step Options (Opzioni fase).

5. Fare clic su OK e poi su Yes (Sì) per salvare il protocollo.

118 | Software CFX Maestro Dx SE



Creazione di un protocollo nell’editor protocollo

Eliminazione di una fase
Importante: questa funzione non può essere annullata. Procedere con cautela quando si eliminano
le fasi.

Per eliminare una fase del protocollo

1. Selezionare la fase nel grafico o nel riquadro struttura.

2. Nel riquadro di sinistra, fare clic su Delete Step (Elimina fase) per eliminare la fase selezionata.

3. Fare clic su OK e poi su Yes (Sì) per salvare il protocollo.

Copia, esportazione o stampa di un protocollo
Per copiare un protocollo

u Fare clic con il pulsante destro del mouse sulla struttura del protocollo e scegliere Copy Protocol
(Copia protocollo).

È possibile incollare la struttura in un file .txt, .xls, .doc o .ppt.

Per esportare un protocollo

1. Fare clic con il pulsante destro del mouse sulla struttura del protocollo e selezionare Export Protocol
(Esporta protocollo).

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. (Facoltativo) In Windows Explorer, navigare fino alla cartella in cui salvare il file del protocollo.

3. Nel campo File name (Nome file), digitare un nome per il file del protocollo esportato.

4. Fare clic su Save (Salva).

Per stampare un protocollo

u Fare clic con il pulsante destro del mouse sulla struttura del protocollo e selezionare Print (Stampa).

È possibile stampare la struttura del protocollo sulla stampante predefinita.
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Creazione di un protocollo con Protocol AutoWriter
(AutoWriter protocollo)

Importante: Bio-Rad non garantisce che l’esecuzione di un protocollo creato con Protocol
AutoWriter (AutoWriter protocollo) generi sempre un prodotto di PCR.

L’autowriter protocollo di CFX Maestro Dx SE genera automaticamente protocolli di ciclo in base ai
seguenti parametri di input:

n Amplicon length (Lunghezza amplicone): la lunghezza prevista del prodotto di PCR

n Annealing temperature (Temperatura di annealing): la reazione Ta per i primer utilizzati

Se il valore di Ta non è noto, è possibile utilizzare il calcolatore Ta per calcolarlo automaticamente in
base alle sequenze del primer.

Nota: il valore di Ta viene regolato secondo le informazioni relative alla temperatura di fusione
del primer (Tm) che sono basate sull’enzima selezionato e sulla velocità di protocollo.

n Enzyme type (Tipo di enzima): l’enzima DNA polimerasi [iTaq, iProof DNA polimerasi (iProof DNA
polimerasi) o Other (Altro)]

Se si utilizza un enzima diverso da iTaq o iProof DNA polimerasi, è possibile immettere informazioni
aggiuntive, tra cui l’intervallo del gradiente, il tempo di attivazione hot-start (in sec) e il tempo di
estensione finale (in sec).

n Run speed (Velocità analisi): la velocità di reazione [Standard (Normale), Fast (Veloce) o Ultrafast
(Ultraveloce)].

L’autowriter protocollo ottimizza il protocollo in base all’impostazione della velocità selezionata. Il
tempo totale di analisi viene determinato dal numero di fasi e cicli, dal tempo di incubazione in ogni
fase e dal tempo necessario per il raggiungimento dell’uniformità alla temperatura target.

Utilizzando i parametri immessi e le linee guida standard per la PCR, l’autowriter protocollo genera
automaticamente un protocollo PCR personalizzato con le diverse fasi di attivazione enzimatica (hot
start), denaturazione iniziale, annealing ed estensione. È inoltre possibile visualizzare una
rappresentazione grafica del protocollo suggerito e modificare, eseguire o salvare il protocollo.
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Per creare un nuovo protocollo utilizzando l’autowriter protocollo di CFX Maestro Dx SE

1. Nella finestra Home, selezionare Tools > Protocol AutoWriter (Strumenti > Autowriter protocollo).

Viene visualizzata la finestra di dialogo Protocol AutoWriter (Autowriter protocollo).

2. Nella sezione Enter Target Values/Enzyme (Immetti valori target/enzima), eseguire quanto segue:

n Immettere la temperatura di annealing (Ta) per i primer, se nota.

Suggerimento: per ulteriori informazioni, vedere Utilizzo del calcolatore Ta a pagina 122.

Nota: per ulteriori informazioni sui calcoli utilizzati nel calcolatore Ta, vedere Breslauer et al.
1986.

n Immettere la lunghezza dell’amplicone in coppie di basi (bp).

n Selezionare un tipo di enzima dall’elenco di opzioni [iTaq DNA polymerase (iTaq DNA
polimerasi), iProof DNA polymerase (iProof DNA polimerasi) o Other (Altro)].

Suggerimento: se si seleziona Other (Altro) come tipo di enzima, i parametri nella sezione
Additional Parameters (Parametri aggiuntivi) (opzionale) si attivano.

Guida per l’utente | 121



Capitolo 7 Creazione di protocolli

3. Se è stato selezionato Other (Altro) come tipo di enzima, è possibile aggiungere i seguenti parametri
al protocollo:

n Gradient range (Intervallo gradiente)

n Temperatura di attivazione hot start

n Final extension time (Tempo di estensione finale)

4. Nella sezione Type (Tipo), spostare la barra di scorrimento per selezionare una velocità di protocollo
[Standard, Fast (Veloce) o Ultrafast (Ultraveloce)]. CFX Maestro Dx SE regola il tempo totale di
analisi.

5. Selezionare il tipo di PCR da eseguire [Real-time PCR (PCR in tempo reale) è l’impostazione
predefinita].

Con real-time PCR, CFX Maestro Dx SE aggiunge una fase di lettura piastra per raccogliere i dati
della fluorescenza.

6. Nella sezione di anteprima, rivedere il protocollo. È possibile apportare le modifiche necessarie.

7. Eseguire una delle seguenti operazioni:

n Fare clic su OK per salvare il nuovo protocollo. Dopo averlo salvato, il protocollo apre la
procedura guidata di avvio. Fare clic su Edit Selected (Modifica selezionato) per apportare
modifiche al protocollo. Ad esempio, potrebbe essere necessario modificare la temperatura del
coperchio e il volume del campione.

n Fare clic su Cancel (Annulla) per chiudere la finestra senza salvare il protocollo.

Utilizzo del calcolatore Ta
Quando la temperatura di annealing per il primer non è nota, è possibile utilizzare il calcolatore Ta per
calcolarne il valore. Per creare il protocollo, è possibile utilizzare il valore presente nell’autowriter
protocollo o nell’editor protocollo.

Informazioni sul calcolatore Ta
Il calcolatore Ta calcola il valore Tm per ciascun primer, nonché il valore Ta per il protocollo alla velocità
standard.

Il valore Ta per il protocollo si basa sui valori medi Tm del primer con applicazione delle seguenti regole:

n Se la differenza tra i valori Tm del primer è >4 °C, il valore Ta = (il minore dei due valori Tm del primer
+ 2) – 4 °C

n Se la differenza tra i valori Tm è ≤4 °C, il valore Ta = (media dei valori Tm del primer) – 4 °C
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Metodo di conteggio delle coppie di basi

Per ciascun primer, il calcolatore Ta utilizza il metodo di conteggio delle coppie di basi per le sequenze
fino a 14 coppie di basi (bp).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

dove w, x, y e z sono rispettivamente i numeri delle basi A, T, G e C nella sequenza.

Metodo del vicino più vicino

Per le sequenze più lunghe di 14 bp, viene utilizzato il metodo del vicino più vicino. Nel metodo del vicino
più vicino, i calcoli della temperatura di fusione si basano sulla relazione termodinamica tra entropia
(ordine o misura della casualità dell’oligonucleotide), entalpia (calore rilasciato o assorbito
dall’oligonucleotide), energia libera e temperatura.

∆H = ∆G + T* ∆S

dove:

n ∆H = valore di entalpia, Cal/Mole*K

n T = temperatura, Kelvin

n ∆S = valore di entropia, Cal/Mole*K

n ∆G = energia libera di Gibbs in Cal/Mole*K

La variazione di entropia ed entalpia viene calcolata direttamente sommando i valori per le coppie di
nucleotidi mostrate nella Tabella 8 (Breslauer et al. 1986).

La relazione tra l’energia libera e la concentrazione di reagenti e prodotti in equilibrio viene calcolata
come segue:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

dove R è la costante gas (1,986 Cal/Mole*K).

Dalla sostituzione di G nelle due equazioni e la risoluzione per T deriva:

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

presupponendo che la concentrazione di DNA e del complesso DNA-primer siano uguali.

È stato determinato empiricamente che c’è una variazione di energia libera di 5 kcal (3,4 kcal) (Sugimoto
et al. 1996) durante la transizione dal DNA a singola elica al DNA a forma B. Si tratta presumibilmente
dell’energia necessaria per l'inizio della formazione dell’elica. Infine, l’aggiunta di una regolazione per il
sale fornisce un’equazione che il calcolatore Tautilizza:

T = (∆H – 5(KCal/K*Mole))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (concentrazione molare del sale)
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Non è necessaria alcuna costante di regolazione per la concentrazione salina, dal momento che i vari
parametri sono stati determinati a 1 M NaCl e il log10 di 1 è zero.

I calcoli termodinamici presumono che la l’appaiamento si verifichi a pH 7,0. I calcoli Tm presumono che
le sequenze non siano simmetriche e contengano almeno una G o C.

La sequenza di oligonucleotidi deve essere lunga almeno 14 basi per fornire valori Tm ragionevoli. Con
meno di 14 basi si utilizza il metodo di conteggio delle coppie di basi (vedere la Tabella 8 riportata di
seguito).

Interazione ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabella 8. Costanti di interazione Breslauer
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Utilizzo del calcolatore Ta

Per utilizzare il calcolatore Ta

1. Per aprire il calcolatore Ta, eseguire una delle seguenti operazioni:

n Se ci si trova nell’autowriter protocollo, fare clic su Ta Calculator (Calcolatore Ta).

n Nella finestra Home, selezionare Tools > Ta Calculator (Strumenti > Calcolatore Ta).

Viene visualizzata la finestra di dialogo Ta Calculator (Calcolatore Ta).

2. Nella casella di testo Forward Primer (Primer diretto), digitare o incollare la sequenza del primer
diretto.

Suggerimento: è inoltre possibile utilizzare i pulsanti A, T, G, C sul lato sinistro della finestra di
dialogo per inserire la sequenza.

3. Nella casella di testo Reverse Primer (Primer inverso) digitare o incollare la sequenza del primer
inverso.

4. Fare clic su Calculate (Calcola).
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Il calcolatore Ta calcola e visualizza il valore Tm di ciascun primer e i valori medi di Tm e Ta, ad
esempio:

Se i valori Tm del primer presentano una differenza di oltre 4 °C l’uno dall’altro, l’autowriter protocollo
utilizza il valore Tm del primer più basso +2 °C come base per calcolare il valore Ta, che è possibile
modificare ulteriormente cambiando l’enzima e la velocità di reazione.

Il calcolatore Ta genera una temperatura di annealing per velocità standard con iTaq DNA polimerasi.
Quando si utilizza un enzima diverso, le impostazioni di velocità regolano automaticamente la Ta.

5. Eseguire una delle seguenti operazioni:

n Se il calcolatore Ta è stato aperto dall’autowriter protocollo, fare clic su OK. Si torna all’autowriter
protocollo. La temperatura di annealing viene automaticamente modificata.

n Se il calcolatore Ta è stato aperto dal menu Tools (Strumenti), registrare i calcoli e fare clic su
Cancel (Annulla) per chiudere il calcolatore.
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Un file piastra contiene informazioni sui parametri di analisi, come la modalità di scansione, i fluorofori e il
contenuto del pozzetto. Dopo l’analisi, il Software CFX Maestro Dx, Security Edition collega il contenuto
del pozzetto ai dati di fluorescenza raccolti durante l’analisi e applica l’analisi appropriata nella finestra
Data Analysis (Analisi dei dati). Ad esempio, i pozzetti caricati con il tipo di campione standard vengono
usati per generare una curva standard.

CFX Maestro Dx SE fornisce due opzioni per creare le piastre: l’editor piastra per le analisi PCR in tempo
reale e la procedura guidata di impostazione per l’analisi dell’espressione genica normalizzata.

L’editor piastra include le seguenti funzioni:

n Fluorofori standard e tipi di campione da assegnare ai pozzetti della piastra

n Possibilità di impostare il target di riferimento e il campione di controllo per l’analisi dell’espressione
genica

n Possibilità di modificare l'impostazione della piastra prima, durante o dopo un’analisi

n Possibilità di salvare file piastra per successivi riutilizzi

n Possibilità di stampare il file piastra su una stampante predefinita

La procedura di impostazione guidata aiuta a creare una disposizione della piastra per l’analisi
dell’espressione genica normalizzata. È possibile usare la procedura di impostazione guidata prima,
durante o dopo un’analisi.
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Finestra dell’editor piastra
La finestra Plate Editor (Editor piastra) viene utilizzata per creare piastre personalizzate o modificare
piastre esistenti.

1. La barra dei menu fornisce rapido accesso ai comandi del menu File e Settings (Impostazioni),
nonché alle opzioni degli strumenti di modifica della piastra.

2. La barra degli strumenti fornisce rapido accesso alle importanti funzioni di caricamento piastra.

3. Il riquadro principale visualizza la struttura della piastra e le opzioni piastra quando vengono
applicate.

4. Il riquadro a destra visualizza le opzioni che vengono utilizzate per personalizzare la piastra.

5. Il riquadro inferiore visualizza il tipo di piastra e fornisce rapido accesso alle opzioni di
visualizzazione.

LEGENDA

Comandi del menu File
Save (Salva): salva il file di dati della piastra nel percorso specificato nella scheda File della finestra di
dialogo User Preferences (Preferenze utente). Per ulteriori informazioni, vedere Modifica delle
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impostazioni file predefinite a pagina 85. Questo elemento del menu è disponibile solo quando si crea un
nuovo file piastra.

Save As (Salva con nome): salva il file di dati piastra aperto con un nuovo nome fornito. Questo elemento
del menu è disponibile solo quando si crea un nuovo file piastra.

File Passwords (Password file): consente agli utenti di impostare le password di salvataggio e apertura
file.

Extract Plate (Estrai piastra): apre una finestra di dialogo in cui è possibile estrarre/salvare il file piastra
(.pltd). Questo elemento del menu è disponibile solo quando si visualizza o si modifica un file piastra
esistente.

Print (Stampa): stampa il file di dati piastra aperto.

Close (Chiudi): chiude l’editor piastra.

Comandi del menu Edit (Modifica)
Undo (Annulla): annulla una modifica a un file piastra finché il file piastra non viene salvato.

Redo (Ripeti): annulla l’azione Undo (Annulla) più recente a meno che il file piastra non sia stato salvato.

Comandi del menu Settings (Impostazioni)
Plate Size (Dimensioni piastra): apre una finestra di dialogo da cui è possibile selezionare le dimensioni
della piastra per l’analisi.

Nota: le dimensioni della piastra devono essere uguali a quelli del blocco dello strumento su cui
viene eseguita l’analisi.

Scegliere 96 pozzetti per:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Scegliere 384 pozzetti per:

n CFX Opus 384Dx

Plate Type (Tipo di piastra): consente di scegliere il tipo di pozzetti della piastra che contiene i campioni,
BRWhite (BR bianco) o BR Clear (BR trasparente). Per ottenere un’analisi dei dati accurata, il tipo di
piastra selezionato deve corrispondere al tipo di piastra utilizzato nell’analisi.

Nota: è necessario calibrare i nuovi tipi di piastra. Per ulteriori informazioni, vedere Calibrazione
di nuovi coloranti a pagina 77.
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Number Convention (Convenzione numerica): consente di selezionare o deselezionare l’opzione per
visualizzare le unità in notazione scientifica. Per impostazione predefinita, le unità vengono visualizzate in
notazione scientifica.

Units (Unità): permette di scegliere le unità da mostrare nel foglio di calcolo quando si esegue la
quantificazione di sconosciuti vs. una curva standard.

Modifica dei comandi del menu Tools (Strumenti)
Setup Wizard (Procedura di impostazione guidata): apre la procedura di impostazione guidata, in cui è
possibile definire la disposizione e i parametri di analisi per la piastra attuale. È possibile usare la
procedura guidata di avvio prima, durante o dopo aver completato un’analisi.

Spreadsheet View/Importer (Vista foglio di calcolo/Programma importazione): apre la finestra di dialogo
View (Visualizza), che visualizza la disposizione della piastra come modello in formato foglio di calcolo. È
possibile usare questa finestra di dialogo per esportare o importare i dati del modello piastra in formato
.csv.

Flip Plate (Inclina piastra): inclina il contenuto della piastra di 180o.

Comandi della barra degli strumenti

Ripristina una modifica in una piastra. CFX Maestro Dx SE supporta fino
a dieci azioni di annullamento

Annulla l'azione Undo (Annulla) più recente. CFX Maestro Dx SE
supporta fino a dieci azioni di ripetizione.

Salva il file piastra corrente.

Visualizza un elenco a discesa da cui è possibile aumentare o diminuire
l’ingrandimento della vista piastra.

Visualizza un elenco a discesa da cui è possibile selezionare una
modalità di scansione, che indica allo strumento da quali canali
raccogliere i dati di fluorescenza durante un’analisi.

Apre il Well Groups Manager (Gestore gruppi di pozzetti), che è possibile
usare per creare dei gruppi di pozzetti per la piastra attuale.

Visualizza una finestra di dialogo in cui è possibile scegliere i colori e i
simboli per le tracce di amplificazione.
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Apre la finestra di dialogo View (Visualizza), che visualizza la
disposizione della piastra come modello in formato foglio di calcolo. È
possibile usare questa finestra di dialogo per esportare o importare i dati
del modello piastra in formato .csv.

Apre la procedura di impostazione guidata, in cui è possibile definire la
disposizione e i parametri di analisi per la piastra attuale. È possibile
usare la procedura di impostazione guidata prima, durante o dopo
un’analisi.

Apre la scheda Plate (Piastra) nella finestra di dialogo User Preferences
(Preferenze utente), in cui è possibile definire i parametri della
disposizione piastra e creare o eliminare i nomi del target, del campione e
del gruppo biologico. Le modifiche apportate nella scheda Plate (Piastra)
sono disponibili alla prossima apertura dell’editor piastra.

Visualizza le fasi necessarie per l’impostazione di una piastra e il
caricamento dei pozzetti.
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Creazione di un file piastra usando l’editor piastra
Usando l’editor piastra, è possibile creare file piastra personalizzati. Inoltre, è possibile modificare e
salvare file piastra salvati in precedenza o file piastra di esempio forniti insieme al sistema CFX Opus Dx.

Per creare un nuovo file piastra, procedere come segue:

n Aprire un file piastra nell’editor piastra.

n Selezionare il tipo di piastra.

Nota: il tipo di piastra per il file piastra deve corrispondere alla piastra presente nel modulo di
reazione.

n Selezionare la modalità di scansione da utilizzare nel protocollo.

n Selezionare i fluorofori da utilizzare nella piastra.

n Selezionare il tipo di campione, i target e i campioni.

n Selezionare i replicati tecnici, se opportuno.

n Salvare il layout della piastra.

Suggerimento: per creare una nuova piastra dai file piastra di esempio o salvati in precedenza,
vedere Apertura di un file piastra esistente nell’editor piastra a pagina 134.

Apertura di un nuovo file piastra nell’editor piastra
CFX Maestro Dx SE offre più opzioni per aprire un nuovo file piastra:

n Dalla finestra Home

n Dalla finestra di dialogo Startup Wizard (Procedura guidata di avvio)

n Dalla finestra di dialogo Run Setup (Impostazione analisi)

Per aprire un nuovo file piastra dalla finestra Home

u Selezionare File > New > Plate (File > Nuovo > Piastra).

Viene visualizzata la finestra Plate Editor (Editor piastra) con il file piastra predefinito per lo strumento
selezionato.

Suggerimento: per informazioni sull’impostazione del file piastra predefinito, vedere Modifica
delle impostazioni file predefinite a pagina 85.
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Per aprire un nuovo file piastra dalla procedura guidata di avvio

1. Nella finestra Home, eseguire una delle seguenti operazioni per aprire la procedura guidata di avvio
se non è già visualizzata:

n Selezionare View > Startup Wizard (Visualizza > Procedura guidata di avvio).

n Fare clic su Startup Wizard (Procedura guidata di avvio) nella barra degli strumenti.

2. Se necessario, selezionare il tipo di strumento dall’elenco a discesa.

3. Per creare una nuova piastra, fare clic su User-defined (Definito dall’utente) come tipo di analisi.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) che visualizza la scheda Protocol
(Protocollo).

4. Fare clic sulla scheda Plate (Piastra) e fare clic su Create New (Crea nuovo).

Si apre la finestra dell’editor piastra, che visualizza la disposizione predefinita della piastra per lo
strumento selezionato.

Per aprire un nuovo file piastra dalla finestra di dialogo Run Setup (Impostazione analisi)

1. Nella finestra Home, eseguire una delle seguenti operazioni per aprire la finestra di dialogo Run
Setup (Impostazione analisi):

n Selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente).

n Fare clic su User-defined Run Setup (Impostazione analisi definita dall’utente) nella barra degli
strumenti.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo).

2. Per creare una nuova piastra, fare clic sulla scheda Plate (Piastra) e fare clic su Create New (Crea
nuovo).

Si apre la finestra dell’editor piastra, che visualizza la disposizione predefinita della piastra per lo
strumento selezionato.
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Apertura di un file piastra esistente nell’editor piastra
CFX Maestro Dx SE fornisce i file piastra campione che è possibile modificare e salvare come nuove
piastre. È inoltre possibile creare un nuovo file piastra da un file piastra salvato in precedenza.

Per aprire un file piastra del campione

1. Nella finestra Home, selezionare File > Open > Plate (File > Apri > Piastra).

Windows Explorer (Esplora risorse) viene aperto nel percorso della cartella dei file Sample
(Campione) del sistema CFX Opus Dx.

2. Aprire la cartella dei file Sample (Campione), quindi la cartella Plates (Piastre).

3. Selezionare un file piastra e fare clic su Open (Apri).

Il file piastra del campione si apre nella finestra Plate Editor (Editor piastra).

4. Selezionare File > Save As (File > Salva con nome) e salvare il file piastra con un nuovo nome o in
una nuova cartella.

Per aprire un file piastra salvato in precedenza

1. Nella finestra Home, eseguire una delle seguenti operazioni:

n Selezionare File > Open > Plate (File > Apri > Piastra), accedere alla piastra target e
selezionarla, quindi fare clic su Open (Apri).

n Aprire la procedura guidata di avvio ed eseguire una delle seguenti operazioni:

o Per modificare un file piastra esistente, fare clic su Select Existing (Seleziona esistente) e
accedere al file target.

o Per modificare il file piastra visualizzato, fare clic su Edit Selected (Modifica selezione).

Il file piastra target viene aperto nella finestra Plate Editor (Editor piastra).

2. Selezionare File > Save As (File > Salva con nome) e salvare il file piastra con un nuovo nome o in
una nuova cartella.
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Impostazione di un nuovo file piastra
Suggerimento: se il file piastra include i parametri richiesti (ad esempio, se si sta modificando un file
piastra esistente o di esempio), è possibile ignorare questo paragrafo. Procedere a Assegnazione di
parametri opzionali al file piastra a pagina 143.

I nuovi file piastra richiedono i seguenti parametri:

n Plate size (Dimensioni piastra)

n Plate type (Tipo di piastra)

n Scan mode (Modalità di scansione)

n Un fluoroforo (colorante)

n Un tipo campione

Selezione delle dimensioni e del tipo di piastra

Importante: è necessario selezionare le dimensioni della piastra durante l’impostazione della
stessa. Non è possibile modificare la dimensione della piastra durante o dopo l’analisi.

Il software applica la dimensione e il tipo di piastra a tutti i pozzetti durante l’analisi. Assicurarsi che le
dimensioni della piastra selezionate corrispondano a quelle della piastra che si utilizzerà nell’analisi.

I sistemi CFX Opus DxBio-Rad vengono calibrati in fabbrica per molte combinazioni di coloranti
fluorescenti e piastre. La calibrazione è specifica per strumento, colorante e tipo di piastra. Assicurarsi
che il fluoroforo che si intende utilizzare sia calibrato per il tipo di piastra selezionato.

Suggerimento: per calibrare una nuova combinazione di colorante e tipo di piastra su uno
strumento, selezionare Tools > Dye Calibration Wizard (Strumenti > Calibrazione guidata colorante).
Per ulteriori informazioni sulla calibrazione di coloranti e tipi di piastre, vedere Calibrazione di nuovi
coloranti a pagina 77.

Selezione della modalità di scansione

I sistemi CFX Opus 96 Dx e CFX Opus Deepwell Dx eccitano e rilevano i fluorofori in cinque canali (più
FRET). Il sistema CFX Opus 384 Dx eccita e rileva i fluorofori in quattro canali (più FRET). Tutti i sistemi
utilizzano diverse modalità di scansione per l’acquisizione dei dati per raccogliere i dati di fluorescenza
durante un’analisi.

CFX Maestro Dx SE fornisce tre modalità di scansione:

n All Channels (Tutti i canali)

o Esegue la scansione dei canali da 1 a 5 sui sistemi CFX Opus 96 Dx e CFX Opus Deepwell Dx

o Esegue la scansione dei canali da 1 a 4 sui sistemi CFX Opus 384 Dx
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n SYBR®/FAM

o Esegue la scansione solo del canale 1

o Fornisce una scansione rapida

n FRET

o Esegue la scansione solo del canale FRET

o Fornisce una scansione rapida

Selezione dei fluorofori

Importante: prima di iniziare l’analisi, i sistemi CGFX verificano che i fluorofori specificati dall’utente
nella piastra siano calibrati su quello strumento. Non è possibile eseguire una piastra se include
fluorofori che non sono stati calibrati su tale strumento.

È necessario caricare almeno un fluoroforo per il layout della piastra prima dell’analisi. A questo punto
della procedura è possibile aggiungere la quantità di fluorofori necessaria, ma la piastra deve contenere
almeno un fluoroforo. I fluorofori selezionati vengono visualizzati come opzioni per i target nel campo
Target Names (Nomi target).

Utilizzare la finestra di dialogo Select Fluorophores (Seleziona fluorofori) per caricare i fluorofori (o i
coloranti piastra) nei controlli di carico pozzetto dell’editor piastra. I fluorofori visualizzati nella finestra di
dialogo Select Fluorophores (Seleziona fluorofori) dipendono dalla modalità di scansione selezionata:

n All Channels (Tutti i canali)

Vengono visualizzati tutti i fluorofori disponibili.

Suggerimento: è possibile aggiungere la quantità necessaria di fluorofori, ma è possibile
caricare solo un fluoroforo per canale in ciascun pozzetto.

n SYBR®/FAM

Vengono visualizzati solo i fluorofori del canale 1.

n FRET

Viene visualizzato solo il fluoroforo del canale 6.

Suggerimento: il fluoroforo FRET del canale 6 viene visualizzato solo quando la modalità di
scansione selezionata è FRET. Non è disponibile per la modalità di scansione All Channels
(Tutti i canali).

Nota: non è possibile aggiungere né rimuovere direttamente i fluorofori dalla finestra di dialogo
Select Fluorophore (Seleziona fluoroforo). È necessario calibrare i nuovi fluorofori in uno strumento
utilizzando la procedura guidata di calibrazione del colorante. Al termine della calibrazione, il nuovo
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fluoroforo viene automaticamente aggiunto a questo elenco. Per ulteriori informazioni, vedere
Calibrazione di nuovi coloranti a pagina 77.

Selezione dei tipi di campione

Importante: è necessario selezionare almeno un tipo di campione da assegnare ai pozzetti della
piastra prima di eseguire l’analisi.

CFX Maestro Dx SE offre cinque tipi di campione:

n Unknown (Sconosciuto)

n Standard

n NTC (controllo senza templato)

n Positive Control (Controllo positivo)

n Negative Control (Controllo negativo)

n NRT (senza trascrittasi inversa)

Selezionare i tipi di campione per i pozzetti della piastra.

Impostazione di una nuova piastra

Per impostare una nuova piastra

1. Aprire una nuova piastra nella finestra Plate Editor (Editor piastra).

2. Per impostare le dimensioni della piastra, selezionare Settings > Plate Size (Impostazioni >
Dimensioni piastra) e selezionare le dimensioni appropriate della piastra dal menu a discesa.

3. Per impostare il tipo di piastra, selezionare Settings > Plate Type (Impostazioni > Tipo di piastra) e
selezionare BRWhite (BR bianco) o BR Clear (BR trasparente) dal menu a discesa.

4. Facoltativamente, dal menu Settings (Impostazioni), è possibile modificare la convenzione numerica
e le unità di visualizzazione:

n Per modificare la convenzione numerica, selezionare Settings > Number Convention
(Impostazioni > Convenzione numerica) e selezionare Scientific Notation (Notazione
scientifica).

Suggerimento: per impostazione predefinita, viene selezionata la notazione scientifica. In
questo caso, selezionando la notazione scientifica si annulla l’impostazione predefinita e si
imposta la convenzione numerica sul formato standard.

n Per cambiare le unità di visualizzazione, selezionare Settings > Units (Impostazioni > Unità) e
selezionare un nuovo valore di unità.
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5. Per impostare la modalità di scansione, selezionare la modalità appropriata dall’elenco a discesa
Scan Mode (Modalità di scansione) nella barra degli strumenti della finestra Plate Editor (Editor
piastra).

6. Selezionare i fluorofori necessari per la piastra:

a. Nel riquadro di destra, fare clic su Select Fluorophores (Seleziona fluorofori).

Viene visualizzata la finestra di dialogo Select Fluorophores (Seleziona fluorofori). Vengono
visualizzati i fluorofori disponibili per il tipo di modalità di scansione selezionato nella Fase 5, ad
esempio:

b. Per selezionare un fluoroforo, fare clic sulla relativa casella di controllo Selected (Selezionato).

Suggerimento: per rimuovere un fluoroforo dall’elenco, deselezionarne la casella di
controllo Selected (Selezionato).

c. Per cambiare il colore di visualizzazione del fluoroforo, fare clic sulla relativa casella Color
(Colore).

Nota: il colore selezionato rappresenta il fluoroforo sia nella finestra Plate Editor (Editor
piastra) sia nei grafici Data Analysis (Analisi dei dati).
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d. Nella finestra di dialogo Color (Colore), selezionare il colore desiderato oppure fare clic su
Define Custom Colors (Definisci colori personalizzati) e creare un nuovo colore per
rappresentare il fluoroforo.

e. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo Select Fluorophores
(Seleziona fluorofori).

7. Occorre selezionare almeno un pozzetto in cui caricare un tipo di campione. Per impostazione
predefinita, viene selezionato il pozzetto A1.

Nel riquadro della piastra, eseguire una delle seguenti operazioni:

n Per caricare più pozzetti adiacenti, fare clic su un pozzetto e trascinare la selezione fino al
pozzetto target.

n Per caricare più pozzetti non adiacenti, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

n Per caricare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per caricare una riga intera, fare clic sul numero di riga corrispondente.

n Per caricare l’intera piastra, fare clic nell’angolo in alto a sinistra della piastra.

Ad esempio:
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8. Assegnare un tipo di campione al pozzetto o ai pozzetti selezionati dal menu a discesa Sample Type
(Tipo campione).

9. Assegnare almeno un fluoroforo a tutti i pozzetti che contengono il tipo di campione. È possibile
assegnare più di un fluoroforo al pozzetto o al gruppo di pozzetti.

Nota: è possibile assegnare solo un fluoroforo per canale. Non è possibile assegnare più di un
fluoroforo dello stesso canale allo stesso pozzetto.

Suggerimento: a questo punto della procedura è possibile associare un target al fluoroforo
oppure assegnare solo il fluoroforo al pozzetto e associare un target al fluoroforo dopo
l’esecuzione dell’esperimento.

n Per assegnare solo un fluoroforo ai pozzetti selezionati, nella sezione Target Names (Nomi
target) presente nel riquadro di destra, selezionare la casella di controllo Load (Carica) per il
fluoroforo specifico.

n Per associare un target a un fluoroforo, nella sezione Target Names (Nomi target) selezionare
un nome target dall’elenco a discesa per il fluoroforo specifico. Il software seleziona
automaticamente la casella di controllo Load (Carica) corrispondente.

10. Per i pozzetti contenenti un tipo di campione Standard, occorre caricare una concentrazione.
Ciascun pozzetto può avere un valore di concentrazione diverso. Per impostazione predefinita,
CFX Maestro Dx SE carica la concentrazione 1.00E+06 per tutti i pozzetti con il tipo di campione
Standard. Se necessario, è possibile modificare il valore.

a. Nel riquadro della piastra, selezionare un pozzetto o gruppo di pozzetti Standard:

b. Nella sezione Concentration (Concentrazione), fare clic su Load (Carica) per caricare il valore
nel pozzetto o nei pozzetti selezionati.

c. (Facoltativo) Per caricare un’altra concentrazione, digitare il nuovo valore nella casella di testo
Concentration (Concentrazione) e premere Enter (Invio).
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d. Eseguire questo passaggio per tutti i pozzetti con tipo di campione Standard.

Suggerimento: per caricare la stessa concentrazione per tutti i pozzetti Standard,
assicurarsi che nell’elenco a discesa sotto il valore della concentrazione venga visualizzata
la voce <All> (Tutti). Per caricare lo stesso valore di concentrazione per tutti i pozzetti con
un determinato fluoroforo, fare clic sull’elenco a discesa e selezionare il fluoroforo.

11. Fare clic su OK per salvare la nuova piastra.
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Voci del menu di scelta rapida per lo strumento Plate Editor (Editor piastra)

Nella Tabella 9 vengono elencati gli elementi del menu disponibili nello strumento Plate Editor (Editor
piastra) quando si fa clic con il pulsante destro del mouse su uno dei pozzetti dello strumento. Questo
menu viene visualizzato anche in Spreadsheet View/Importer (Vista foglio di calcolo/Programma di
importazione).

Elemento Funzione

Copy (Copia) Copia tutto il foglio di calcolo.

Copy as Image (Copia
come immagine)

Copia il foglio di calcolo come file immagine.

Print (Stampa) Stampa il foglio di calcolo.

Print Selection (Stampa
selezione)

Stampa solo le celle selezionate.

Export to Excel
(Esporta in Excel)

Esporta il file in un foglio di calcolo di Excel.

Export to CSV (Esporta
in CSV)

Esporta il file come file .csv.

Export to Xml (Esporta
in Xml)

Esporta il file come file .xml.

Export to Html (Esporta
in Html)

Esporta il file come file .html.

Find (Trova) Cerca un testo specifico.

Sort (Ordina) Ordina il foglio di calcolo selezionando fino a tre colonne di dati
nella finestra Sort (Ordina).

Tabella 9. Elementi del menu di scelta rapida disponibili nello strumento Plate Spread-
sheet View/Importer (Vista foglio di calcolo piastra/Programma di importazione)
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Assegnazione di parametri opzionali al file piastra
Un file piastra contiene le informazioni sul contenuto di ciascun pozzetto caricato con il campione per
un’analisi. Dopo l’analisi, CFX Maestro Dx SE collega il contenuto del pozzetto ai dati di fluorescenza
raccolti durante il protocollo e applica l’analisi appropriata nella finestra Data Analysis (Analisi dei dati).

In CFX Maestro Dx SE, è possibile assegnare parametri a ciascun pozzetto nella piastra prima, durante o
persino dopo l’esecuzione degli esperimenti. È possibile assegnare i parametri a un file piastra esistente
o a un file piastra nuovo. Questi parametri includono:

n Target names (Nomi target): il target o i target di interesse (geni o sequenze) in ciascun pozzetto
caricato.

n Sample names (Nomi campione): la caratteristica di identificazione o la condizione che corrisponde
al campione in ciascun pozzetto caricato, come mouse1 (topo1), mouse2 (topo2) o mouse3 (topo3).

n Biological groups (Gruppi biologici): la caratteristica di identificazione o la condizione che
corrisponde a un gruppo di pozzetti, ad esempio 0Hr, 1Hr o 2Hr.

Suggerimento: i nomi di target, campioni e gruppi biologici tra i pozzetti devono coincidere per
poter confrontare i dati nella scheda Gene Expression (Espressione genica) della finestra Data
Analysis (Analisi dei dati). Ciascun nome deve contenere le stesse caratteristiche in termini di
maiuscole/minuscole, punteggiatura e spaziatura. Ad esempio, "Actin” (Actina) non è uguale a
"actin” (actina), "2Hr" non è uguale a "2 hr" e "Mouse 1" (Topo 1) non è uguale a "mouse1”
(topo1). Per garantire la coerenza dei nomi, immettere i nomi nella sezione Libraries (Librerie) in
User > User Preferences > Plate (Utente > Preferenze utente > Piastra), disponibile nella
finestra Home.

n Technical replicates (Replicati tecnici): ogni pozzetto che viene usato per analizzare la stessa
combinazione di campione e target, ovvero le reazioni qPCR di replicati.

n Dilution series (Serie di diluizione): la quantità con cui cambiare la concentrazione del tipo di
campione Standard all’interno di un gruppo di replicati per creare dati della curva standard da
analizzare.

Assegnazione di un target ai pozzetti
Suggerimento: è possibile assegnare lo stesso nome target a un solo pozzetto o a più pozzetti.
Inoltre, è possibile assegnare più target allo stesso pozzetto.

Importante: facendo clic su OK dopo aver assegnato un target, le modifiche vengono salvate e
l’opzione Undo (Annulla) viene disabilitata sulla barra degli strumenti dell’editor piastra. Procedere
con cautela quando si fa clic su OK.
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Per assegnare un target ad un pozzetto o ad un gruppo di pozzetti

1. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un tipo di
campione.

Per ulteriori informazioni sull’assegnazione dei tipi di campione ai pozzetti vedere Selezione dei tipi di
campione a pagina 137.

2. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.

n Per selezionare più pozzetti adiacenti, fare clic su un pozzetto e trascinare la selezione fino al
pozzetto target.

n Per selezionare più pozzetti non adiacenti, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

n Per selezionare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per selezionare una riga intera, fare clic sul numero di riga corrispondente.

3. Nel riquadro a destra, selezionare un nome dall’elenco a discesa Target Name (Nome target) per
ciascun fluoroforo selezionato.

4. Ripetere la Fase 3 per ciascun pozzetto o gruppo di pozzetti cui è necessario assegnare un target.

Suggerimento: è possibile assegnare lo stesso nome target o un nome target diverso per
ciascun fluoroforo selezionato.

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Nota: se per errore è stata modificata la piastra, fare clic su Undo (Annulla) nella barra degli
strumenti dell’editor piastra prima di fare clic su OK per accettare le modifiche.

Per rimuovere un nome target

u Per rimuovere un nome target dal pozzetto o dal gruppo di pozzetti selezionato, deselezionare la
casella di controllo Load (Carica) corrispondente.
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Importante: la rimozione di un nome target da un pozzetto rimuove anche il relativo fluoroforo
associato. Prestare attenzione durante la rimozione di un nome target da un pozzetto.

Per aggiungere un nome target all’elenco

u Per aggiungere un nome target all’elenco a discesa, eseguire una delle seguenti operazioni:

n Digitare un nome nell’elenco a discesa Target Name (Nome target) e premere Enter (Invio).

Suggerimento: i nomi target che vengono aggiunti a un elenco vengono visualizzati in tutti
gli altri elenchi target.

n Fare clic sul simbolo + verde a destra dell’elenco a discesa, digitare un nome per il target e
premere Enter (Invio).

n Fare clic su User Preferences (Preferenze utente) nella barra degli strumenti e aggiungere il
nome alla libreria Target Names (Nomi target) nella scheda Plate (Piastra).

Importante: i nomi target che vengono aggiunti nell’elenco a discesa sono disponibili solo per la
piastra corrente e solo se si assegna il nome a un pozzetto e si salva il layout della piastra. Se
non si assegna il nome a un pozzetto e non si salva il layout della piastra, il nome non viene
salvato e non sarà disponibile per utilizzi futuri. Per aggiungere un nome target in modo
permanente, aggiungerlo anche alla libreria Target Names (Nomi target) usando la finestra di
dialogo User Preferences (Preferenze utente). I nomi che vengono aggiunti alla libreria sono
disponibili solo dopo aver riaperto l’editor piastra. Per ulteriori informazioni, vedere Impostazione
dei parametri predefiniti della piastra a pagina 88.

Per eliminare un nome target dall’elenco

1. Fare clic su User Preferences (Preferenze utente) sulla barra degli strumenti.

Viene visualizzata la finestra di dialogo User Preferences (Preferenze utente) con la scheda Plate
(Piastra).

2. Nella libreria Target Names (Nomi target) della scheda Plate (Piastra), selezionare il nome da
eliminare e premere il tasto Delete (Elimina).

3. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo User Preferences
(Preferenze utente).

Importante: non è possibile eliminare i nomi target che sono stati salvati con un file piastra. I
nomi personalizzati che vengono aggiunti all’elenco a discesa Target Names (Nomi target) e
non vengono utilizzati e salvati con la piastra, vengono automaticamente rimossi dall’elenco. I
nomi che vengono eliminati dalla libreria Target Names (Nomi target) vengono rimossi in modo
permanente dal software e non sono più disponibili per gli utenti. Procedere con cautela quando
si eliminano i nomi target.
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Assegnazione di un nome campione ai pozzetti
Nota: per assegnare un nome campione, ai pozzetti selezionati è necessario assegnare almeno un
fluoroforo. Se ai pozzetti selezionati non viene assegnato alcun fluoroforo, l’elenco a discesa Sample
Names (Nomi campione) è disabilitato. Per ulteriori informazioni sull’assegnazione di fluorofori,
vedere Assegnazione di un target ai pozzetti a pagina 143.

Suggerimento: a ciascun pozzetto o gruppo di pozzetti è possibile assegnare un solo nome
campione.

Per assegnare un nome campione ad un pozzetto o gruppo di pozzetti

1. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un fluoroforo.

2. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti.

3. Nel riquadro a destra, selezionare un nome nell’elenco a discesa Sample Names (Nomi campione).

Il software seleziona automaticamente la casella di controllo Load (Carica) corrispondente.

4. Ripetere la Fase 3 per ciascun pozzetto o gruppo di pozzetti a cui è necessario assegnare un nome
campione.

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Nota: se per errore è stata modificata la piastra, fare clic su Undo (Annulla) nella barra degli
strumenti dell’editor piastra prima di fare clic su OK per accettare le modifiche.

Per rimuovere un nome campione

u Per rimuovere un nome campione da un pozzetto o da un gruppo di pozzetti selezionato,
deselezionare la casella di controllo Load (Carica) corrispondente.

Per aggiungere un nome campione all’elenco

u Per aggiungere un nome campione all’elenco a discesa, eseguire una delle seguenti operazioni:

n Digitare un nome nell’elenco a discesa Sample Names (Nomi campione) e premere Enter
(Invio).

n Fare clic sul simbolo + verde a destra dell’elenco a discesa e digitare un nome per il campione.
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n Fare clic su User Preferences (Preferenze utente) nella barra degli strumenti e aggiungere il
nome alla libreria Sample Names (Nomi campione) nella scheda Plate (Piastra).

Importante: i nomi campione che vengono aggiunti nell’elenco a discesa sono disponibili solo
per la piastra corrente e solo se si assegna il nome a un pozzetto e si salva il layout della piastra.
Se non si assegna il nome a un pozzetto e non si salva il layout della piastra, il nome non viene
salvato e non sarà disponibile per utilizzi futuri. Per aggiungere un nome campione in modo
permanente, aggiungerlo anche alla libreria Sample Names (Nomi campione) usando la finestra
di dialogo User Preferences (Preferenze utente). I nomi che vengono aggiunti alla libreria sono
disponibili solo dopo aver riaperto l’editor piastra. Per ulteriori informazioni, vedere Impostazione
dei parametri predefiniti della piastra a pagina 88.

Per eliminare un nome campione dall’elenco

1. Fare clic su User Preferences (Preferenze utente) sulla barra degli strumenti.

Viene visualizzata la finestra di dialogo User Preferences (Preferenze utente) con la scheda Plate
(Piastra).

2. Nella libreria Sample Names (Nomi campione) della scheda Plate (Piastra), selezionare il nome da
eliminare e premere il tasto Delete (Elimina).

3. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo User Preferences
(Preferenze utente).

Importante: non è possibile eliminare i nomi campione che sono stati salvati con un file piastra. I
nomi personalizzati che vengono aggiunti all’elenco Sample Names (Nomi campione) e non
vengono utilizzati e salvati con la piastra, vengono automaticamente rimossi dall’elenco a
discesa. I nomi che vengono eliminati dalla libreria Sample Names (Nomi campione) vengono
rimossi dal software e non sono più disponibili per gli utenti. Procedere con cautela quando si
eliminano i nomi campione.

Assegnazione di gruppi biologici ai pozzetti
Nota: per assegnare un gruppo biologico, è necessario assegnare almeno un fluoroforo ai pozzetti
selezionati. L’assegnazione di un fluoroforo abilita l’elenco a discesa Biological Groups (Gruppi
biologici). Per ulteriori informazioni sull’assegnazione di fluorofori, vedere Assegnazione di un target
ai pozzetti a pagina 143.

Suggerimento: a ciascun pozzetto o gruppo di pozzetti è possibile assegnare un gruppo biologico.

Per assegnare un gruppo biologico a un pozzetto o gruppo di pozzetti

1. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un fluoroforo.

2. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti.
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3. Nel riquadro di destra, effettuare una selezione dall'elenco a discesa Biological Group (Gruppo
biologico).

CFX Maestro Dx SE seleziona automaticamente la casella di controllo Load (Carica) corrispondente.

4. Ripetere la Fase 3 per ciascun pozzetto o gruppo di pozzetti cui è necessario assegnare un gruppo
biologico.

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Nota: se per errore è stata modificata la piastra, fare clic su Undo (Annulla) nella barra degli
strumenti dell’editor piastra prima di fare clic su OK per accettare le modifiche.

Per rimuovere un gruppo biologico

u Per rimuovere un gruppo biologico dal pozzetto o dal gruppo di pozzetti selezionato, deselezionare la
casella di controllo Load (Carica) corrispondente.

Per aggiungere un gruppo biologico all'elenco

u Per aggiungere un gruppo biologico all'elenco a discesa, eseguire una delle seguenti operazioni:

n Digitare un nome nella casella a discesa Biological Group (Gruppo biologico) e premere Enter
(Invio).

n Fare clic sul simbolo + verde a destra dell’elenco a discesa e digitare un nome per il gruppo
biologico.

n Fare clic su User Preferences (Preferenze utente) nella barra degli strumenti e aggiungere il
nome alla libreria Biological Group Names (Nomi gruppi biologici) nella scheda Plate (Piastra).

Importante: i nomi dei gruppi biologici che vengono aggiunti nell’elenco a discesa sono
disponibili solo per la piastra corrente e solo se si assegna il nome a un pozzetto e si salva il
layout della piastra. Se non si assegna il nome a un pozzetto e non si salva il layout della piastra,
il nome non viene salvato e non sarà disponibile per utilizzi futuri. Per aggiungere un nome del
gruppo biologico in modo permanente, aggiungerlo anche nella libreria Biological Group Names
(Nomi gruppi biologici) attraverso la finestra di dialogo User Preferences (Preferenze utente). I
nomi che vengono aggiunti alla libreria sono disponibili solo dopo aver riaperto l’editor piastra.
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Per ulteriori informazioni, vedere Impostazione dei parametri predefiniti della piastra a pagina
88.

Per eliminare il nome di un gruppo biologico dall’elenco

1. Fare clic su User Preferences (Preferenze utente) sulla barra degli strumenti.

Viene visualizzata la finestra di dialogo User Preferences (Preferenze utente) con la scheda Plate
(Piastra).

2. Nella libreria Biological Group Names (Nomi gruppi biologici) della scheda Plate (Piastra),
selezionare il nome da eliminare e premere il tasto Delete (Canc).

3. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo User Preferences
(Preferenze utente).

Importante: non è possibile eliminare i nomi dei gruppi biologici che sono stati salvati con un file
piastra. I nomi personalizzati che vengono aggiunti nell’elenco a discesa Biological Group
Names (Nomi gruppi biologici) e che non vengono utilizzati e salvati con la piastra, vengono
automaticamente rimossi dall’elenco. I nomi che vengono eliminati dalla libreria Biological Group
Names (Nomi gruppi biologici) vengono rimossi in modo permanente dal software e non sono
più disponibili per gli utenti. Prestare attenzione durante l’eliminazione dei nomi dei gruppi
biologici.

Per visualizzare tutti i gruppi biologici sulla piastra

u Fare clic su Show Biological Groups (Mostra gruppi biologici) per visualizzare tutti i gruppi biologici
sulla piastra.

Ogni gruppo viene identificato con un colore specifico e il pulsante Show Biological Groups (Mostra
gruppi biologici) diventa Hide Biological Groups (Nascondi gruppi biologici).

Fare clic su Hide Biological Groups (Nascondi gruppi biologici) per cancellare il colore nei pozzetti. In
alternativa, è possibile fare clic su un pozzetto qualsiasi nella piastra per nascondere i gruppi
biologici.
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Assegnazione dei numeri di replicati tecnici ai pozzetti
Importante: per assegnare numeri di replicati tecnici, il contenuto dei pozzetti selezionati deve
essere identico. Ciò significa che i pozzetti selezionati devono avere lo stesso tipo di campione e
fluoroforo. Se appropriato, devono essere assegnati anche gli stessi nomi di target e campione e lo
stesso gruppo biologico. Se non sono uguali, CFX Maestro Dx SE non abilita questa opzione.

Per assegnare numeri di replicati tecnici a un gruppo di pozzetti

1. Nell’editor piastra, assicurarsi che il contenuto del gruppo di pozzetti sia identico.

2. Nel riquadro della piastra, selezionare il gruppo di pozzetti target.

3. Per assegnare lo stesso numero di replicati a tutti i pozzetti selezionati, nella sezione Replicate # (N.
replicati), che si trova nel riquadro di destra, digitare il numero di replicati nella casella e quindi
selezionare Load (Carica).

4. (Facoltativo) Per applicare una serie di replicati a un insieme di pozzetti selezionati:

a. Fare clic su Technical Replicates (Replicati tecnici). La sezione Replicate # (Replicato n.)
cambia per visualizzare le seguenti opzioni:

n Replicate size (Dimensione replicati): un numero che rappresenta il numero di pozzetti in
ciascun gruppo di replicati

n Starting replicate # (N. iniziale replicati): il primo numero della serie di replicati per il
gruppo di replicati selezionato

Nota: per impostazione predefinita, CFX Maestro Dx SE visualizza il numero iniziale dei
replicati come numero successivo all’ultimo numero di replicati tecnici assegnato nella
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piastra. Ad esempio, se l’ultimo numero di replicati tecnici nella piastra è cinque, il
successivo numero iniziale sarà sei. È possibile modificare il numero iniziale con un numero
qualsiasi che non sia stato già assegnato.

n Direzione di caricamento (orizzontale o verticale)

b. Fare clic su Apply (Applica) per applicare i parametri alla serie e tornare alla visualizzazione
Replicate # (Replicato n.).

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Nota: se per errore è stata modificata la piastra, fare clic su Undo (Annulla) nella barra degli
strumenti dell’editor piastra prima di fare clic su OK per accettare le modifiche.

Per rimuovere un pozzetto da una serie di replicati

u Selezionare il pozzetto o il gruppo di pozzetti da rimuovere e deselezionare la casella di controllo
Replicate # Load (Replicato n. da caricare).

In alternativa, è possibile fare clic su Clear Replicate # (Cancella n. replicati) per cancellare il numero
di replicati dal pozzetto o gruppo di pozzetti selezionato.

Per visualizzare tutti i replicati tecnici sulla piastra

u Fare clic su Show Technical Replicates (Mostra replicati tecnici) per visualizzare tutti i replicati tecnici
presenti nella piastra.

Ciascun gruppo è identificato con un colore specifico e il pulsante Show Technical Replicates
(Mostra replicati tecnici) diventa Hide Technical Replicates (Nascondi replicati tecnici).

Fare clic su Hide Technical Replicates (Nascondi replicati tecnici) per cancellare il colore nei pozzetti.
In alternativa, è possibile fare clic su un pozzetto qualsiasi nella piastra per nascondere i replicati
tecnici.

Assegnazione di una serie di diluizione ai tipi di campione
standard
Come indicato in precedenza, a tutti i pozzetti con il tipo di campione Standard (Standard) deve essere
assegnato un valore di concentrazione. È possibile assegnare una serie di diluizione a più pozzetti con il
tipo di campione Standard.

Nota: per assegnare una serie di diluizione a un gruppo di pozzetti, i pozzetti devono essere inclusi
in una serie di replicati tecnici. Per informazioni sull’aggiunta di pozzetti ad una serie di replicati,
vedere Assegnazione dei numeri di replicati tecnici ai pozzetti a pagina 150.
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Per assegnare una serie di diluizione a un gruppo di pozzetti campione Standard

1. Nell’editor piastra, verificare che vengano soddisfatti i seguenti requisiti:

n Il tipo di campione per il gruppo di pozzetti è Standard.

n A tutti i pozzetti nel gruppo è stato assegnato almeno un fluoroforo e tutti contengono gli stessi
fluorofori.

n Tutti i pozzetti nel gruppo sono inclusi nella stessa serie di replicati tecnici.

Nota: CFX Maestro Dx SE abilita l’opzione Dilution Series (Serie di diluizione) solo quando
tutti i pozzetti selezionati soddisfano questi criteri.

2. Nel riquadro della piastra, selezionare il gruppo di pozzetti target.

3. Nella sezione Concentration (Concentrazione) nel riquadro a destra, fare clic su Dilution Series
(Serie di diluizione). La sezione Concentration (Concentrazione) cambia per visualizzare le seguenti
opzioni:

n Starting concentration (Concentrazione iniziale): il valore di concentrazione da cui inizia la
serie

n Replicates from and to (Replicati da e a): i replicati nella serie cui sarà applicato il fattore di
diluizione

n Dilution factor (Fattore di diluizione): la quantità per modificare la concentrazione all’interno di
ciascun gruppo di replicati

4. Impostare i valori per le opzioni o accettare le impostazioni predefinite.

5. Per impostazione predefinita, la serie di diluizione diminuisce in base al fattore di diluizione.
Selezionare Increasing (In aumento) per aumentare la serie di diluizione.

6. (Opzionale) Per impostazione predefinita, il fattore di diluizione si applica a tutti i fluorofori nella serie
di replicati. Se la serie contiene più di un fluoroforo e si desidera applicare la diluizione ad un solo
fluoroforo, selezionarla dall’elenco a discesa.
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7. Fare clic su Apply (Applica) per applicare la serie di diluizione al gruppo di pozzetti e tornare alla vista
Concentration (Concentrazione).

8. Fare clic su OK per accettare le modifiche e salvare la piastra.

Copia del contenuto del pozzetto in un altro pozzetto
È possibile copiare il contenuto di un pozzetto e incollarlo in un solo pozzetto o in più pozzetti. Tuttavia, è
possibile copiare il contenuto di un solo pozzetto. Non è possibile selezionare più pozzetti e copiarne il
contenuto.

Per copiare il contenuto del pozzetto in un altro pozzetto

1. Nel riquadro della piastra, selezionare il pozzetto da copiare.

2. Fare clic con il pulsante destro del mouse sul pozzetto e selezionare Copy Well (Copia pozzetto).

3. Selezionare il pozzetto o i pozzetti in cui incollare il contenuto:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.

n Per selezionare più pozzetti adiacenti, fare clic su un pozzetto e trascinare la selezione fino al
pozzetto target.

n Per selezionare più pozzetti non adiacenti, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

4. Con i pozzetti target selezionati, fare clic con il pulsante destro del mouse e scegliere Paste Well
(Incolla pozzetto).

CFX Maestro Dx SE incolla il contenuto del primo pozzetto nei pozzetti selezionati.

Aggiunta di una nota ad un pozzetto
È possibile aggiungere una nota descrittiva ad un pozzetto. È possibile visualizzare le note pozzetto nella
scheda Quantification (Quantificazione) della finestra Data Analysis (Analisi dei dati).

Per aggiungere una nota ad un pozzetto

1. Nel riquadro della piastra, selezionare il pozzetto o i pozzetti a cui si intende aggiungere una nota.

2. Nella sezione View (Visualizza) nel riquadro inferiore, selezionare Well Note (Nota pozzetto).

L’area Well Note (Nota pozzetto) viene visualizzata nel riquadro a destra.
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3. Digitare il contenuto della nota nella casella di testo e premere Enter (Invio).

Il testo viene visualizzato nella parte inferiore dei pozzetti selezionati.

Suggerimento: se in precedenza è stata creata una nota relativa ai pozzetti, può essere
selezionata dall’elenco a discesa e applicata ai pozzetti selezionati.

Cancellazione di tutto il contenuto dei pozzetti
È possibile cancellare il contenuto di un singolo pozzetto, di un gruppo di pozzetti o di un’intera piastra. La
cancellazione dei pozzetti non rimuove i dati di fluorescenza raccolti durante la lettura della piastra.

Importante: la cancellazione di un pozzetto rimuove definitivamente il contenuto dal pozzetto. Se si
fa clic su OK e si salva la piastra dopo avere eliminato un pozzetto, non è possibile annullare
l’operazione di cancellazione. Prestare attenzione durante la cancellazione dei pozzetti.

Per cancellare tutte le impostazioni dei pozzetti

1. Nella finestra Plate Editor (Editor piastra), selezionare il pozzetto o il gruppo di pozzetti nel riquadro
della piastra:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.

n Per selezionare più pozzetti adiacenti, fare clic su un pozzetto e trascinare la selezione fino al
pozzetto target.

n Per selezionare più pozzetti non adiacenti, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

n Per selezionare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per selezionare una riga intera, fare clic sul numero di riga corrispondente.

2. Nel riquadro di destra, fare clic su Clear Wells (Cancella pozzetti).

CFX Maestro Dx SE cancella tutte le impostazioni dei pozzetti selezionati.

3. Eseguire una delle seguenti operazioni:

n Se per errore sono stati cancellati dei pozzetti, fare clic su Undo (Annulla) nella barra degli
strumenti dell’editor piastra prima di fare clic su OK per accettare le modifiche.

Importante: se si fa clic su OK prima di aver selezionato Undo (Annulla) le modifiche
verranno salvate e il comando Undo (Annulla) sulla barra degli strumenti dell’editor piastra
risulterà disabilitato.

n Fare clic su OK per accettare le modifiche e salvare la piastra.
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Modifica delle impostazioni dell’esperimento
Usare la finestra di dialogo Experiment Settings (Impostazioni esperimento) per visualizzare o modificare
l’elenco di target, campioni o gruppi biologici, oppure per impostare il gruppo dei campioni di analisi
dell’espressione genica per analizzare se sono stati assegnati gruppi biologici ai pozzetti nella piastra.

Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), la scheda Targets (Target)
visualizza un elenco dei nomi target per ciascuna reazione PCR, come il gene target o le sequenze
geniche di interesse.

La scheda Samples and Biological Groups (Campioni e gruppi biologici) visualizza un elenco di nomi di
campioni e gruppi biologici che indicano l’origine del target, come un campione prelevato a 1 ora (1Hr) o
da un individuo specifico [(mouse1) (topo 1)].

Per cambiare le impostazioni della piastra usando la finestra di dialogo Experiment
Settings (Impostazioni esperimento)

1. Per aprire la finestra di dialogo Experiment Settings (Impostazioni esperimento), eseguire una delle
seguenti operazioni:

n Nel riquadro a destra dell’editor piastra, fare clic su Experiment Settings (Impostazioni
esperimento).

n Nella scheda Gene Expression (Espressione genica) della finestra Data Analysis (Analisi dei
dati), fare clic su Experiment Settings (Impostazioni esperimento).

Viene visualizzata la finestra di dialogo Experiment Settings (Impostazioni esperimento) con il
contenuto della scheda Targets (Target).
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2. Per aggiungere un nuovo nome di target, campioni o gruppi biologici, nella scheda appropriata
digitare un nome nella casella di testo New (Nuovo) e fare clic su Add (Aggiungi).

3. Per rimuovere uno o più nomi di target, campioni o gruppi biologici dall’elenco, nella scheda
appropriata selezionare la casella di controllo dell’elemento nella colonna Select to Remove
(Seleziona per rimuovere) e fare clic su Remove checked item(s) (Rimuovi elementi
selezionati).

4. CFX Maestro Dx SE esclude il tipo di campione NTC (controllo senza templato) dall’analisi
dell’espressione genica.

Per includere i tipi di campione NTC, deselezionare la casella di controllo corrispondente nella
sezione Exclude the following sample types (Escludi i seguenti tipi di campione). Selezionando la
casella di controllo appropriata, è possibile scegliere di escludere i seguenti tipi di campione:

n NRT (senza trascrittasi inversa)

n Negative Control (Controllo negativo)

n Positive Control (Controllo positivo)

n Standard

5. Nella scheda Targets (Target):

a. Per selezionare un target come riferimento per l’analisi dei dati dell’espressione genica,
selezionarlo nella colonna Reference (Riferimento).

b. Per nascondere le impostazioni dell’analisi che saranno applicate nella scheda Gene
Expression (Espressione genica) della finestra Analysis Settings (Impostazioni analisi),
deselezionare Show Analysis Settings (Mostra impostazioni analisi).

Il software nasconde le seguenti colonne:

n Color (Colore)

n Show Chart (Mostra grafico)

n Auto Efficiency (Efficienza automatica)

n Efficiency (%) [Efficienza (%)]

c. Per cambiare il colore del target quando viene tracciato nel grafico dell’espressione genica, fare
clic sulla relativa cella nella colonna Color (Colore), selezionare un nuovo colore nella finestra di
dialogo Color (Colore) che viene visualizzata e fare clic su OK.

d. Per visualizzare il target nel colore selezionato all’interno del grafico dell’espressione genica,
selezionare la casella di controllo corrispondente nella colonna Show Chart (Mostra grafico).
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e. Per impostazione predefinita, CFX Maestro Dx SE calcola automaticamente l’efficienza relativa
per un target se i suoi dati includono una curva standard.

Per usare un valore di efficienza determinato in precedenza, digitare il valore nella relativa cella
della colonna Efficiency (%) [Efficienza (%)] e premere il tasto Enter (Invio). CFX Maestro Dx SE
deseleziona la casella di controllo Auto Efficiency (Efficienza automatica).

6. Nella scheda Samples and Biological Groups (Campioni e gruppi biologici):

a. Per selezionare un campione o un gruppo biologico come campione di controllo per l’analisi dei
dati dell’espressione genica, selezionare la relativa casella di controllo nella colonna Control
(Controllo).

b. Per assegnare la condizione di controllo a un campione o a un gruppo biologico di un’analisi,
fare clic sulla relativa casella di controllo nella colonna Control (Controllo).

c. Se non è già selezionata, fare clic sull’opzione Show Analysis Settings (Mostra impostazioni
analisi) per visualizzare o modificare i parametri di analisi che verranno applicati nella scheda
Gene Expression (Espressione genica). Il software nasconde le colonne Color (Colore) e Show
Chart (Mostra grafico).

7. Fare clic su OK per salvare i parametri nella finestra di dialogo Experiment Settings (Impostazioni
esperimento) e tornare alla finestra dell’editor piastra.
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Creazione di gruppi di pozzetti
I gruppi di pozzetti dividono una piastra singola in sottoinsiemi di pozzetti che possono essere analizzati in
modo indipendente nella finestra Data Analysis (Analisi dei dati). Una volta impostati i gruppi di pozzetti,
selezionarne uno nella finestra Data Analysis (Analisi dei dati) per analizzare i dati come gruppo
indipendente. Ad esempio, impostare i gruppi di pozzetti per analizzare più esperimenti eseguiti in una
sola piastra o per analizzare ciascun gruppo di pozzetti con una curva standard diversa.

Nota: il gruppo di pozzetti predefinito è All Wells (Tutti i pozzetti).

Per creare dei gruppi di pozzetti

1. Per aprire Well Groups Manager (Gestione gruppi di pozzetti), eseguire una delle seguenti
operazioni:

n Nella barra degli strumenti dell’editor piastra, fare clic su Well Groups (Gruppi di pozzetti).

n Nella finestra Data Analysis (Analisi dei dati), fare clic su ManageWell Groups (Gestisci gruppi
di pozzetti).

Viene visualizzata la finestra di dialogo Well Groups Manager (Gestione gruppi di pozzetti).

2. Fare clic su Add (Aggiungi) per creare un nuovo gruppo. Il menu a discesa visualizza il nome gruppo
come Group 1 (Gruppo 1) per il primo gruppo.
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3. Selezionare i pozzetti per il gruppo di pozzetti nella vista della piastra, facendo clic e trascinando
attraverso il gruppo di pozzetti. I pozzetti selezionati sono visualizzati in blu nel Manager (Gestore).

4. (Opzionale) Per cambiare il nome del gruppo, selezionare il nome nel menu a discesa e digitare un
nuovo nome.

5. (Opzionale) Per eliminare un gruppo di pozzetti, selezionarne il nome nell’elenco a discesa e fare clic
su Delete (Elimina).

6. Fare clic su OK per finire e chiudere la finestra, oppure fare clic su Cancel (Annulla) per chiudere la
finestra senza apportare modifiche.

Elementi del menu di scelta rapida per la finestra di dialogo Well Groups Manager
(Gestione gruppi di pozzetti)

Nella Tabella 10 sono elencati gli elementi del menu disponibili nella finestra Well Groups Manager
(Gestione gruppi di pozzetti) quando si fa clic con il pulsante destro del mouse su un pozzetto.

Elemento Funzione

Copy (Copia) Copia il contenuto del pozzetto, che può quindi essere
incollato in un altro pozzetto o pozzetti.

Copy as Image (Copia come
immagine)

Copia la visualizzazione del selettore pozzetto come
un’immagine.

Print (Stampa) Stampa la visualizzazione del selettore pozzetto.

Print Selection (Stampa
selezione)

Stampa solo le celle selezionate.

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to CSV (Esporta in CSV) Esporta i dati come documento con valori separati da
virgole.

Export to Xml (Esporta in Xml) Esporta i dati come un documento .xml.

Export to Html (Esporta in html) Esporta i dati come un documento .html.

Tabella 10. Elementi del menu di scelta rapida nella finestra di dialogo Well Groups
Manager (Gestione gruppi di pozzetti)
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Modifica degli stili tracce
Durante l’impostazione della piastra e mentre è in corso l’analisi, è possibile modificare il colore e lo stile
delle tracce di amplificazione. Si possono quindi visualizzare facilmente le tracce nella finestra di stato
Real-Time mentre vengono raccolti i dati.

Per modificare gli stili tracce

1. Fare clic su Trace Styles (Stili tracce) nella barra degli strumenti dell’editor piastra.

Viene visualizzata la finestra di dialogo Trace Styles (Stili tracce) per la piastra aperta, ad esempio:

2. Per visualizzare gli stili tracce per un particolare fluoroforo, selezionarlo dall’elenco a discesa
Fluorophores (Fluorofori).

3. Per modificare la visualizzazione della traccia:

a. Selezionare il tipo di traccia dall’elenco a discesa Wells (Pozzetti).

b. Fare clic sul relativo colore nella colonna Color (Colore).

c. Nella finestra di dialogo Color (Colore) che viene visualizzata, scegliere un altro colore per la
traccia e fare clic su OK.

CFX Maestro Dx SE visualizza il cambio di colore per il tipo di pozzetto nella griglia.

d. (Facoltativo) Dall’elenco a discesa Symbols (Simboli), selezionare un simbolo per la traccia.

4. Per cambiare rapidamente l’assortimento di colori, fare clic sulla scelta desiderata nella sezione
Color Quick Set (Impostazione rapida colore).
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5. Per visualizzare le etichette dei pozzetti nella griglia, selezionare il tipo di etichetta nella sezione Well
Labels (Etichette pozzetto).

6. Fare clic su OK per salvare le modifiche o su Cancel (Annulla) per annullarle.
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Visualizzazione, esportazione e importazione della piastra in
formato foglio di calcolo

Lo strumento Spreadsheet View/Importer (Vista foglio di calcolo/Programma importazione) visualizza il
contenuto di una piastra in formato foglio di calcolo. Il visualizzatore consente di visualizzare, importare
ed esportare i dati dei pozzetti come descritto di seguito.

Utilizzo del visualizzatore di fogli di calcolo per esportare e importare i dati della
piastra

Dal visualizzatore del foglio di calcolo, è possibile esportare il nome target, il nome del campione, il nome
del gruppo biologico e le note del pozzetto come modello in un formato delimitato da tabulazioni in
un'applicazione come Microsoft Excel. Tali dati possono essere importati anche da un'applicazione
delimitata da tabulazioni in una piastra predefinita da un file di informazioni sull'esperimento.

Per usare lo strumento Spreadsheet View/Importer (Vista foglio di calcolo/Programma
importazione)

1. Creare e salvare un file piastra (vedere Creazione di un file piastra usando l’editor piastra).

2. Nella barra degli strumenti dell’editor piastra, fare clic sulla scheda Spreadsheet View/Importer (Vista
foglio di calcolo/Programma importazione) per aprire la finestra di dialogo Plate Spreadsheet View
(Vista foglio di calcolo piastra).
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3. (Facoltativo) Fare clic sulle caselle Show Biological Set Name (Mostra nome set biologico) e Show
Well Note (Mostra nota pozzetto) per visualizzare le colonne in Spreadsheet View (Vista foglio di
calcolo) e nel file esportato.

4. Fare clic sul pulsante Export Template (Esporta modello) per creare un modello vuoto in un file Excel
(formato .csv). Il file esportato visualizzerà lo stesso layout della piastra.

Suggerimento: quando si salvano i file piastra, utilizzare il nome del file piastra per identificare
facilmente il file.

5. Popola le celle del file Excel con il contenuto del pozzetto.

Nota: è possibile modificare solo il contenuto di una cella all’interno di una colonna che presenta
un asterisco (*) accanto al nome della colonna (*Nome target, *Nome campione, *Nome gruppo
biologico, *Nota pozzetto).

Nota: non è possibile aggiungere valori alle colonne Standard Curve (Curva standard) e
Quantity (Quantità) nel file Excel esportato. Per modificare quei dati, tornare all'editor piastra e
selezionare Settings > Units (Impostazioni > Unità) nella barra dei menu. Al termine dell’analisi
della piastra, i dati di questi standard vengono visualizzati nel grafico della curva standard della
scheda Quantification (Quantificazione) nella finestra Data Analysis (Analisi dei dati) con le unità
selezionate.

6. Importare nuovamente il file Excel popolato nell'editor piastra facendo clic sul pulsante Import
(Importa). I dati della piastra importati vengono visualizzati nella finestra Plate Spreadsheet View
(Vista foglio di calcolo piastra).

Importante: se si dispone di più fluorofori, sarà necessario eseguire le fasi da 3 a 5 per ciascun
fluoroforo utilizzando il menu a discesa Flours List (Elenco fluorofori) in Plate Spreadsheet View
(Vista foglio di calcolo piastra).

7. Fare clic sul pulsante OK. I nuovi dati della piastra ora vengono visualizzati nella finestra Plate Editor
(Editor piastra).

Suggerimento: è possibile visualizzare le voci di menu disponibili nello strumento Spreadsheet
View/Importer tool (Vista foglio di calcolo/Programma importazione) facendo clic con il pulsante
destro del mouse su qualsiasi pozzetto dello strumento o su una qualsiasi delle intestazioni di tabella
della finestra Plate Spreadsheet View (Vista foglio di calcolo piastra).
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Creazione di una disposizione piastra usando la procedura di
impostazione guidata

È possibile usare la procedura guidata di impostazione per inserire le informazioni sul layout della piastra
necessarie per l’analisi dell’espressione genica normalizzata, fra cui:

n Nomi target

n Nomi campione

n Posizione dei target e del campione sulla piastra

n Geni di riferimento

n Campione di controllo

È possibile usare la procedura di impostazione guidata prima, durante o dopo un’analisi.

Utilizzo della procedura di impostazione guidata della piastra
In questo paragrafo si spiega come creare una disposizione piastra utilizzando la procedura di
impostazione guidata piastra. Per visualizzare più facilmente il contenuto di ogni pozzetto nella piastra,
fare clic su Zoom plate (Ingrandisci piastra) nella parte superiore della procedura guidata di impostazione.

Importante: se si torna alla scheda Auto layout (Layout automatico) mentre si è in un’altra scheda
della procedura guidata di impostazione, viene ripristinato il layout della piastra. Prestare attenzione
durante la selezione di questa scheda.

Suggerimento: è possibile ripristinare il layout selezionando Tools > Clear Plate (Strumenti >
Cancella piastra) nella procedura guidata di impostazione.

Per utilizzare la procedura guidata di impostazione piastra

1. Aprire l’editor piastra.

2. Per aprire la procedura guidata di impostazione, eseguire una delle seguenti operazioni:

n Scegliere Editing Tools > Setup Wizard (Strumenti di modifica > Procedura guidata di
impostazione).

n Fare clic su Setup Wizard (Procedura guidata di impostazione) nella barra degli strumenti
dell’editor piastra.

Appare la procedura guidata di impostazione con la scheda Auto layout (Disposizione automatica).
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3. Nella scheda Auto layout (Layout automatico), procedere come segue:

a. Fare clic su un pozzetto nella griglia e trascinarlo verso il basso per specificare l’area della
piastra in cui si intende caricare il campione.

b. Inserire il numero di target e campioni da caricare.

Suggerimento: il numero di target e campioni deve essere uguale al numero di celle
selezionate. Se i numeri immessi non si adattano all’area selezionata, modificare i numeri o
l’area di selezione della piastra. È possibile specificare l’orientamento degli elementi sulla
piastra e il loro raggruppamento.

c. (Facoltativo) Cambiare l’orientamento della piastra. Ad esempio, è possibile impostare i target
nelle colonne e i campioni in file o gruppi di campioni.

d. Fare clic su Next (Avanti) per passare alla scheda Target names (Nomi target).

Nota: se il layout della piastra non presenta uno schema regolare, utilizzare la scheda Target
names (Nomi target) per posizionare manualmente i target o la scheda Sample names (Nomi
campione) per posizionare manualmente i campioni sulla piastra. Fare clic e trascinare per
selezionare più pozzetti.

4. Nella scheda Target names (Nomi target), definire i nomi target dei gruppi target:

a. Eseguire una delle seguenti operazioni:

n Per rinominare i target per gruppo, impostare Select by (Seleziona per) su Target.

n Per rinominare i target per pozzetto, impostare Select by (Seleziona per) su Well (Pozzetto).
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b. Selezionare un gruppo di target o il pozzetto nella griglia e digitare un nome nell’elenco a
discesa Target name (Nome target).

Suggerimento: premere il tasto Tab per selezionare il gruppo o pozzetto successivo
immediatamente a destra oppure premere Enter (Invio) per selezionare il gruppo o pozzetto
successivo immediatamente sotto. In alternativa, nelle schede Target name (Nome target)
e Sample name (Nome campione), tenere premuto il tasto Control (Ctrl) e fare clic su un
pozzetto per selezionare più pozzetti non adiacenti.

c. Fare clic su Next (Avanti) per passare alla scheda Sample Names (Nomi campione).

5. Nella scheda Sample names (Nomi campione), definire i nomi campione per i gruppi di campioni.

6. Fare clic su Next (Avanti) per passare alla scheda Reference targets (Target di riferimento).

7. Nella scheda Reference targets (Target di riferimento), selezionare uno o più target da utilizzare
come riferimenti per l’espressione genica normalizzata e fare clic su Next (Avanti) per passare alla
scheda Control sample (Campione di controllo).

8. Nella scheda Control sample (Campione di controllo), selezionare un campione da utilizzare come
controllo per i calcoli della rispettiva espressione genica.

9. Fare clic su OK per salvare il layout della piastra e tornare all’editor piastra dove è possibile definire
altri parametri della piastra. Per maggiori informazioni, vedere Assegnazione di parametri opzionali al
file piastra a pagina 143.

In alternativa, fare clic su Previous (Precedente) per tornare alla scheda precedente e apportare
eventuali modifiche.

Nota: se si torna alla scheda Auto layout (Layout automatico), la piastra viene automaticamente
ripristinata. Procedere con cautela quando si fa clic su Previous (Precedente).
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In questo capitolo viene spiegato come eseguire esperimenti di dosaggio personalizzati (definiti
dall'utente) o PrimePCR utilizzando il Software CFX Maestro Dx, Security Edition.

Un file di dati dell’analisi contiene informazioni relative al protocollo e alla piastra per l’analisi. Il file
contiene anche i dati delle analisi che CFX Maestro Dx SE esegue al termine dell’analisi.

CFX Maestro Dx SE semplifica la configurazione e l’esecuzione di esperimenti definiti dall’utente o
PrimePCR. La finestra Run Setup (Impostazione analisi) guida l’utente attraverso le fasi comuni della
configurazione di un esperimento fino alla finestra di dialogo Start Run (Avvia analisi) da cui si avvia
l’analisi.
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Finestra Run Setup (Impostazione analisi)
La finestra Run Setup (Impostazione analisi) fornisce un accesso rapido ai file e alle impostazioni
necessarie a impostare ed eseguire un esperimento. Quando si sceglie di eseguire un esperimento
definito dall’utente, si apre la finestra Run Setup (Impostazione analisi) che mostra la scheda Protocol
(Protocollo). Quando si sceglie di eseguire un esperimento PrimePCR, si apre la finestra Run Setup
(Impostazione analisi) che mostra la scheda Start run (Avvia analisi).

Suggerimento: per informazioni su PrimePCR, vedere Esecuzione di esperimenti PrimePCR a
pagina 186; per informazioni sulla scheda Start run (Avvia analisi), vedere Scheda Start Run (Avvia
analisi) a pagina 176.
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1. Le schede guidano l’utente attraverso la procedura di impostazione ed esecuzione
di un esperimento:

n Scheda Protocol (Protocollo): consente di selezionare un protocollo esistente da
eseguire o modificare, oppure di creare un nuovo protocollo nell’editor protocollo.

n Scheda Plate (Piastra): consente di selezionare una piastra esistente da eseguire
o modificare, oppure di creare una nuova piastra nell’editor piastra.

n Scheda Start Run (Avvia analisi): consente di visualizzare le impostazioni
dell’esperimento, di selezionare uno o più blocchi dello strumento e avviare
l’analisi.

2. La finestra principale visualizza le opzioni per ciascuna scheda quando vengono
applicate.

3. I pulsanti di navigazione danno accesso alla scheda Start Run (Avvia analisi).

LEGENDA

Accesso alla finestra Run Setup (Impostazione analisi)
Per accedere alla finestra Run Setup (Impostazione analisi)

u Eseguire una delle seguenti operazioni:

n Nella scheda Run setup (Impostazione analisi) della procedura guidata di avvio, fare clic su
User-defined (Definita dall’operatore) o PrimePCR.

n Nella finestra Home, fare clic su User-defined Run Setup (Impostazione analisi definita
dall’utente) o su PrimePCR Run Setup (Impostazione analisi PrimePCR) nella barra degli
strumenti.

n Nella finestra Home, selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente)
oppure Run > PrimePCR Run (Analisi > Analisi PrimePCR).
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Scheda Protocol (Protocollo)
La scheda Protocol (Protocollo) visualizza un’anteprima del file protocollo che si pianifica di eseguire. Un
file di protocollo contiene le istruzioni per le fasi di temperatura dello strumento, nonché le opzioni
strumento che controllano velocità di rampa, volume campione e temperatura del coperchio.

Come impostazione predefinita, il software visualizza il protocollo definito nella selezione file della
sezione Run Setup (Impostazione analisi) nella scheda Files (File), nella finestra di dialogo User > User
Preferences (Utente > Preferenze utente). Nella finestra di dialogo User Preferences (Preferenze utente),
è possibile modificare il protocollo predefinito. Per ulteriori informazioni, vedere Modifica delle
impostazioni file predefinite a pagina 85.

La scheda Protocol (Protocollo) consente di effettuare le seguenti operazioni:

n Creare un nuovo protocollo da eseguire

n Selezionare un protocollo esistente da eseguire o modificare

Per maggiori informazioni su come creare e modificare i protocolli, fare riferimento al Capitolo 7,
Creazione di protocolli.
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Per creare un nuovo protocollo

1. Nella scheda Protocol (Protocollo), fare clic su Create New (Crea nuovo).

Viene visualizzato l’editor protocollo.

2. Utilizzare l’editor protocollo per creare un nuovo protocollo.

3. Fare clic su OK per salvare il protocollo e tornare alla scheda Protocol (Protocollo) in Run Setup
(Impostazione analisi).

4. Esaminare i dettagli del protocollo ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Plate (Piastra).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezione) per tornare alla
finestra dell’editor protocollo. Riesaminare il protocollo, salvare le modifiche, quindi fare clic su
Next (Avanti) nella scheda Protocol (Protocollo) per procedere alle scheda Plate (Piastra).

Selezione di un protocollo esistente

1. Nella scheda Protocol (Protocollo), eseguire una delle seguenti operazioni:

n Fare clic su Select Existing (Seleziona esistente) e accedere a un protocollo esistente.

n Fare clic su Express Load e selezionare un protocollo dall’elenco a discesa dei protocolli.

Suggerimento: nell’elenco a discesa Express Load è possibile aggiungere o rimuovere
protocolli. Per maggiori informazioni, fare riferimento ad Aggiunta e rimozione di protocolli di
Express Load riportato di seguito.

2. Esaminare i dettagli del protocollo ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Plate (Piastra).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezione) per aprire l’editor
protocollo. Riesaminare il protocollo, salvare le modifiche, quindi fare clic su Next (Avanti) nella
scheda Protocol (Protocollo) per procedere alle scheda Plate (Piastra).

Aggiunta e rimozione di protocolli di Express Load

È possibile modificare il contenuto dell’elenco a discesa di Express Load che appare nell’editor protocollo.
I protocolli in questo elenco vengono salvati nella seguente cartella:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<nome_utente>\ExpressLoad\

Per modificare l’elenco di protocolli Express Load

1. Navigare fino alla cartella ExpressLoad e aprirla.

2. Esaminare i file dei protocolli (.pcrl) nella cartella.
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3. Eseguire una delle seguenti operazioni:

n Eliminare i protocolli dalla cartella per rimuoverli dall’elenco a discesa.

n Copiare i protocolli nella cartella per aggiungerli all’elenco a discesa.
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Scheda Plate (Piastra)
Nota: se il protocollo selezionato nella scheda Protocol (Protocollo) non include una fase di lettura
piastra per l’analisi PCR in tempo reale, la scheda Plate (Piastra) viene nascosta. Per visualizzare la
scheda Plate (Piastra), aggiungere almeno una lettura piastra al protocollo.

La scheda Plate (Piastra) visualizza un’anteprima del file di piastra che si prevede di caricare. In un’analisi
PCR in tempo reale, il file della piastra contiene una descrizione del contenuto di ciascun pozzetto, inclusi
i relativi fluorofori, la modalità di scansione e il tipo di piastra. CFX Maestro Dx SE utilizza queste
descrizioni per la raccolta e l'analisi dei dati.

Per impostazione predefinita, il software visualizza la piastra definita nella sezione File Selection for Run
Setup (Selezione file per l’impostazione dell’analisi) della scheda Files (File) nella finestra di dialogo User
> User Preferences (Utente > Preferenze utente). Nella finestra di dialogo User Preferences (Preferenze
utente), è possibile modificare la piastra predefinita. Per ulteriori informazioni, vedere Modifica delle
impostazioni file predefinite a pagina 85.

Nella scheda Plate (Piastra), è possibile:

n Creare una nuova piastra da caricare.

n Selezionare una piastra esistente da caricare o modificare.
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Per ulteriori informazioni sulla creazione e sulla modifica delle piastre, vedere il Capitolo 8, Preparazione
delle piastre.

Per creare una nuova piastra

1. Nella scheda Plate (Piastra) fare clic su Create New (Crea nuovo).

Viene visualizzato l’editor piastra.

2. Usare l’editor piastra per creare una nuova piastra.

3. Fare clic su OK per salvare la piastra e tornare alla scheda Plate (Piastra) in Run Setup
(Impostazione analisi).

4. Esaminare i dettagli della piastra ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Start Run (Avvia
analisi).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezione) per tornare all’editor
piastra. Revisionare il file piastra, salvare le modifiche, quindi fare clic su Next (Avanti) sulla
scheda Plate (Piastra) per procedere alla scheda Start Run (Avvia analisi).

Per selezionare un file piastra esistente

1. Nella scheda Plate (Piastra), eseguire una delle seguenti operazioni:

n Fare clic su Select Existing (Seleziona esistente) e accedere a un file di piastra esistente.

n Fare clic su Express Load e selezionare un file di piastra dall’elenco a discesa.

Suggerimento: è possibile aggiungere o rimuovere piastre dall’elenco a discesa Express
Load. Per ulteriori informazioni fare riferimento al capitolo Aggiunta e rimozione di file
piastra di Express Load riportato di seguito.

2. Esaminare i dettagli della piastra ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Start Run (Avvia
analisi).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezione) per aprire la finestra
dell’editor piastra. Revisionare il file piastra, salvare le modifiche, quindi fare clic su Next (Avanti)
per procedere alla scheda Start Run (Avvia analisi).

Aggiunta e rimozione di file piastra di Express Load

È possibile modificare il contenuto dell’elenco a discesa di Express Load che appare nell’editor piastra. Le
piastre visualizzate in questo elenco vengono salvate nella seguente cartella:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<nome_utente>\ExpressLoad\
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Per modificare l’elenco di file di piastra dell’elenco Express Load

1. Navigare fino alla cartella ExpressLoad e aprirla.

2. Esaminare i file piastra (.pltd) nella cartella.

3. Eseguire una delle seguenti operazioni:

n Eliminare i file di piastra dalla cartella per rimuoverli dall’elenco a discesa.

n Copiare i file di piastra nella cartella per aggiungerli all’elenco a discesa.
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Scheda Start Run (Avvia analisi)
La scheda Start Run (Avvia analisi) visualizza le informazioni relative all’esperimento da eseguire.
Visualizza anche il blocco o i blocchi di strumenti collegati sui quali è possibile eseguire l’esperimento.

La scheda Start Run (Avvia analisi) consente di effettuare le seguenti operazioni:

n Visualizzare informazioni dettagliate sull’analisi, incluso il file del protocollo selezionato, il file piastra
e la modalità di scansione.

n Aggiungere note relative all’analisi.

n Visualizzare i dettagli relativi a tutti gli strumenti collegati, incluso il relativo stato di esecuzione (in
corso o inattivo), il volume del campione in µl, la temperatura del coperchio, la modalità di
emulazione e l’ID o il codice a barre, se disponibile.

Nota: è possibile modificare le colonne visualizzate nella tabella Start Run on Selected Block
(Avvia analisi sui blocchi selezionati). Per ulteriori informazioni, vedere Modifica dei dettagli nella
tabella dei blocchi selezionati a pagina 177.

n Selezionare il blocco o i blocchi in cui eseguire l’analisi.

n Aprire o chiudere da remoto il coperchio di ogni strumento selezionato.

176 | Software CFX Maestro Dx SE



Scheda Start Run (Avvia analisi)

n Avviare l’analisi.

Modifica dei dettagli nella tabella dei blocchi selezionati

È possibile modificare le colonne che sono visualizzate nella tabella Start Run on Selected Blocks (Avvia
analisi nei blocchi selezionati). Nella tabella si può anche modificare il volume del campione predefinito e i
valori della temperatura del coperchio. Le modifiche dell’impostazione vengono applicate all’analisi che
deve essere effettuata.

Per aggiungere colonne nella tabella Start Run on Selected Blocks (Avvia analisi nei
blocchi selezionati)

u Con il pulsante destro del mouse, fare clic sulla tabella e scegliere un’opzione nel menu visualizzato.

Per rimuovere colonne nella tabella Start Run on Selected Blocks (Avvia analisi nei blocchi
selezionati)

u Con il pulsante destro del mouse, fare clic sulla tabella e deselezionare l’opzione nel menu
visualizzato.

Per modificare il volume campione o i valori della temperatura del coperchio per un blocco

u Selezionare la cella del volume campione o della temperatura del coperchio per il blocco target e
digitare un nuovo valore nella cella.

Per aggiungere un ID o un codice a barre dell’analisi per un blocco

u Selezionare la cella ID/Bar Code (ID/codice a barre) per il blocco target e digitare un ID oppure
eseguire la scansione del blocco con un lettore di codici a barre.

Esecuzione di un esperimento
Importante: prima di eseguire un esperimento, verificare che il software anti-virus del computer in
uso non avvii una scansione durante l’analisi. Per ulteriori informazioni, vedere Installazione del
software CFX Maestro Dx SE a pagina 34 e rivolgersi all'amministratore di sistema.

Per eseguire un esperimento

1. Nella scheda Start Run (Avvia analisi), verificare i dettagli della piastra e del protocollo nella sezione
Run Information (Informazioni analisi).

2. (Opzionale) Aggiungere note relative all’analisi o l’esperimento nella casella di testo Notes (Note).

3. Selezionare la casella di controllo di uno o più blocchi sui quali eseguire l’analisi.

Suggerimento: per eseguire l’esperimento su tutti i blocchi, selezionare Select All Blocks
(Seleziona tutti i blocchi), che si trova sotto la tabella Selected Blocks (Blocchi selezionati).
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4. (Opzionale) Fare clic su Flash Block Indicator (Lampeggio indicatore di blocco) per far lampeggiare il LED
di indicazione sui blocchi strumento selezionati.

5. Inserire le piastre dell’esperimento nel blocco:

a. Fare clic su Open Lid (Apri coperchio). Il coperchio motorizzato di ciascun blocco selezionato si
apre.

b. Inserire una piastra dell’esperimento in ogni blocco selezionato.

c. Fare clic su Close Lid (Chiudi coperchio).

Suggerimento: nel sistema CFX Opus Dx, toccare Open Lid (Apri coperchio) o Close Lid
(Chiudi coperchio) nella schermata Home.

6. Fare clic su Open Lid (Apri coperchio) e Close Lid (Chiudi coperchio) per aprire e chiudere il
coperchio motorizzato di ogni blocco dello strumento selezionato.

7. Esaminare i dettagli dell’analisi ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Start Run (Avvia analisi).

n Se i dettagli non sono corretti:

o Correggere i dettagli nella tabella Selected Blocks (Blocchi selezionati) e fare clic su Start
Run (Avvia analisi).

o Tornare alla scheda corretta ed eseguire le modifiche necessarie, salvare le modifiche,
quindi fare clic su Next (Avanti) per tornare alla scheda Start Run (Avvia analisi) e avviare
l’analisi.

Per avviare una nuova analisi da un’analisi precedente

u Eseguire una delle seguenti operazioni:

n Selezionare File > Repeat a Run (File > Ripeti un’analisi) nella barra dei menu principale del
software; individuare e fare doppio clic sul file di dati dell’analisi che si desidera ripetere.

n Selezionare la scheda Repeat Run (Ripeti analisi) della procedura guidata di avvio, quindi fare
doppio clic sul file di dati dell’analisi che si desidera ripetere.

Opzionalmente, nella scheda Repeat Run (Ripeti analisi), fare clic su Browse (Sfoglia), quindi
navigare e fare doppio clic sul file di dati dell’analisi che si desidera ripetere.
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Finestra di dialogo Run Details (Dettagli analisi)
Quando si fa clic su Start Run (Avvia analisi), CFX Maestro Dx SE chiede di salvare il file di dati (.pcrd),
avvia l’analisi e apre la finestra di dialogo Run Details (Dettagli analisi). La finestra di dialogo Run Details
(Dettagli analisi) comprende tre schede di stato:

n Run Status (Stato analisi): utilizzare questa scheda per visualizzare lo stato corrente del protocollo,
aprire o chiudere il coperchio, mettere in pausa un’analisi, aggiungere ripetizioni, saltare fasi o
arrestare l’analisi.

n Real-time Status (Stato in tempo reale): utilizzare questa scheda per visualizzare i dati di
fluorescenza della PCR in tempo reale a mano a mano che vengono raccolti.

n Time Status (Stato tempo): utilizzare questa scheda per visualizzare un timer di conto alla rovescia
a schermo intero per il protocollo.

Queste schede sono spiegate nel dettaglio nei paragrafi che seguono.

Scheda Run Status (Stato analisi)
La scheda Run Status (Stato analisi) visualizza lo stato attuale di un’analisi in corso. In questa schermata
è inoltre possibile controllare il coperchio e modificare l’analisi in corso.
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1. Riquadro dello stato dell’analisi: visualizza lo stato di avanzamento corrente del
protocollo.

2. Comandi Run Status (Stato analisi): consentono di utilizzare lo strumento o
interrompere il protocollo attuale.

3. Riquadro Run Information (Informazioni analisi): visualizza i dettagli dell’analisi.

LEGENDA

Comandi di stato dell’analisi

Utilizzare i comandi della scheda Run Status (Stato analisi) per far funzionare lo strumento dal software o
cambiare un’analisi in corso.

Nota: apportare modifiche al protocollo durante l’analisi, come aggiungere ripetizioni, non modifica il
file del protocollo associato all’analisi. Tali azioni sono registrate nel registro dell’analisi.

: apre il coperchio motorizzato sugli strumenti selezionati.

Importante: l’apertura del coperchio durante un’analisi mette in pausa l’analisi durante la fase
corrente e potrebbe alterare i dati. Comandi di stato dell’analisi a pagina 180.

: chiude il coperchio motorizzato sugli strumenti selezionati.

: aggiunge più ripetizioni alla fase GOTO corrente del protocollo. Questa opzione è disponibile solo
quando è in corso una fase GOTO.

Nota: è possibile aggiungere ulteriori ripetizioni durante un ciclo GOTO quando il protocollo è in
corso. Tuttavia, CFX Maestro Dx SE riconosce la modifica più recente del numero di ripetizioni.
Ad esempio, se si aggiungono 10 ulteriori ripetizioni durante un ciclo GOTO, il software
cambierà il numero totale in n + 10. Se successivamente si aggiungono altre cinque (5)
ripetizioni durante lo stesso ciclo, CFX Maestro cambierà il numero totale di ripetizioni in n + 5.
La prima modifica (10 ripetizioni) viene ignorata. Per garantire che il software esegua il numero
di ripetizioni desiderato, immettere il numero totale (in questo caso, 15 ripetizioni).

: esclude la fase corrente del protocollo.

Nota: se si avvia un comando di esclusione durante una fase GOTO, il sistema passa al ciclo
successivo nel loop GOTO. Se al momento del comando di esclusione era in corso l'ultimo ciclo
della fase GOTO, il sistema passa alla fase successiva.
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: fa lampeggiare il LED sullo strumento selezionato per identificare i blocchi selezionati.

: mette in pausa il protocollo.

Nota: questa azione viene registrata nel registro dell’analisi.

: riprende un protocollo messo in pausa.

: interrompe l’analisi prima che termini il protocollo.

Nota: interrompere un’analisi prima della fine del protocollo potrebbe alterare i dati.

Apertura del coperchio dello strumento durante un'analisi PCR

Se il coperchio di uno strumento viene aperto durante un’analisi PCR, CFX Maestro Dx SE visualizzerà la
seguente finestra di dialogo di conferma:

Mentre viene visualizzata la finestra di dialogo, lo strumento continua a eseguire il protocollo. Il pulsante OK
mette in pausa l’analisi e il coperchio dello strumento si sblocca e si apre. Il pulsante Cancel (Annulla) consente
di chiudere la finestra di dialogo e riprendere l'analisi.
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Scheda Real-time Status (Stato in tempo reale)
La scheda Real-time Status (Stato in tempo reale) visualizza i dati della PCR in tempo reale raccolti ad
ogni ciclo durante l’analisi dopo le prime due letture piastra.

1. Riquadro delle tracce di amplificazione: consente di visualizzare i dati
dell’amplificazione in tempo reale durante l’analisi.

2. Well group identifier (Identificativo gruppo di pozzetti): se durante l’impostazione
piastra i gruppi di pozzetti sono stati identificati, gli utenti possono selezionare un
gruppo di pozzetti per visualizzarne le tracce, i pozzetti e le informazioni tabulari.

Step number identifier (Identificativo numero di fase): se il protocollo raccoglie i dati
in più di una fase (per esempio durante l’amplificazione e la curva di fusione), gli
utenti possono selezionare una specifica fase e visualizzare le tracce raccolte
durante tale fase.

3. Well selector pane (Riquadro selettore pozzetto): visualizza i pozzetti attivi, inattivi e
vuoti della piastra.

4. Plate setup table pane (Riquadro tabella di impostazione piastra): visualizza
l’impostazione piastra in formato tabulare.

LEGENDA
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5. Riquadro dei dettagli dell’analisi: consente di visualizzare lo stato in tempo reale
dell’analisi tra cui

n Fase corrente

n Ripetizione corrente

n Temperatura corrente

n Tempo residuo

n Temperatura del campione

n Temperatura del coperchio

6. Plate Setup (Impostazione piastra): consente di aprire la finestra di dialogo Plate
Setup (Impostazione piastra) nella quale gli utenti possono modificare
l’impostazione della piastra corrente durante un’analisi.

Nella scheda Real-time Status (Stato in tempo reale), è possibile:

n Mostrare o nascondere le tracce in tempo reale selezionandole nel riquadro del selettore di pozzetti o
nella tabella di impostazione piastra.

n Visualizzare tracce singole o gruppi di tracce selezionandole nella casella a discesa del gruppo di
pozzetti.

n Modificare la piastra o sostituire il file piastra.

n Applicare un file PrimePCR all’analisi.

Mostrare o nascondere le tracce in tempo reale

Per impostazione predefinita, tutti i pozzetti riempiti sono attivi e compaiono nella tabella di configurazione
della piastra. I pozzetti attivi sono visualizzati in blu nel riquadro del selettore pozzetto. I pozzetti nascosti
vengono visualizzati in grigio chiaro, mentre i pozzetti inutilizzati vengono visualizzati in grigio scuro nel
riquadro del selettore di pozzetti.

È possibile nascondere le tracce dai pozzetti attivi durante l’analisi. CFX Maestro Dx SE continua a
raccogliere dati per tutti i pozzetti; quando si nascondono i pozzetti, i relativi dati non vengono visualizzati
nella tabella di impostazione della piastra.

Per nascondere le tracce in tempo reale

u Nel riquadro del selettore di pozzetti, fare clic sui pozzetti attivi (blu) che si desidera nascondere.

Per mostrare le tracce in tempo reale

u Nel riquadro del selettore di pozzetti, fare clic sui pozzetti nascosti (grigio chiaro) che si desidera
visualizzare.

Per maggiori informazioni sul selettore pozzetto, vedere Selettore pozzetto a pagina 205.
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Modifica di un’impostazione piastra

Per modificare un’impostazione della piastra

u Fare clic su Plate Setup (Impostazione piastra), quindi selezionare View/Edit Plate
(Visualizza/Modifica piastra).

Viene visualizzata la finestra dell’editor piastra, in cui è possibile modificare la piastra durante
l’esecuzione dell’analisi. Per ulteriori informazioni sulla modifica delle piastre, vedere il Capitolo 8,
Preparazione delle piastre.

Nota: è inoltre possibile modificare gli stili della traccia dalla finestra dell’editor piastra. Le
modifiche vengono visualizzate nel grafico della traccia di amplificazione nella scheda Real-time
Status (Stato in tempo reale).

Sostituzione di un file piastra

Suggerimento: la sostituzione di un file piastra è particolarmente utile se si avvia un’analisi con un
file Quick Plate nella cartella ExpressLoad.

Per sostituire un file piastra

u Fare clic su Plate Setup (Impostazione piastra) e selezionare una delle seguenti opzioni:

n Replace Plate file (Sostituisci file piastra): selezionare il nuovo file piastra dall’elenco nella
finestra del browser

n Apply PrimePCR file (Applica file PrimePCR): cercare il file di un’analisi da cui si otterrà il layout
della piastra utilizzando la funzione di ricerca intelligente oppure fare clic su Browse (Sfoglia) per
individuare un file che è stato scaricato dal sito web Bio-Rad e che non si trova nella cartella
PrimePCR

Nota: CFX Maestro Dx SE controlla la modalità di scansione e le dimensioni della piastra per il
file piastra, che devono corrispondere alle impostazioni con cui è stata avviata l’analisi.
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Scheda Time Status (Stato tempo)
La scheda Time Status (Stato tempo) visualizza il tempo rimanente per completare l’analisi in corso.
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Esecuzione di esperimenti PrimePCR
Gli esperimenti PrimePCR utilizzano dosaggi specifici per pathway o malattia che Bio-Rad ha convalidato
e ottimizzato in wet-lab e che sono disponibili nei seguenti formati:

n Pannelli prepiastrati: piastre contenenti i dosaggi specifici per un pathway biologico o una malattia;
includono controlli PrimePCR e geni di riferimento.

n Piastre configurate personalizzate: piastre che possono essere impostate in un layout definito
dall’utente con la possibilità di scegliere dosaggi per target di interesse, controlli e riferimenti.

n Dosaggi individuali: le provette contenenti i singoli set di primer per l’uso nelle reazioni in tempo
reale.

Per ridurre il tempo di analisi complessivo, è possibile rimuovere la fase di fusione nel protocollo. Bio-Rad
raccomanda vivamente di non apportare altre modifiche ad un protocollo di analisi PrimePCR. Il
protocollo predefinito è quello usato per la convalida del dosaggio. Qualsiasi deviazione da tale
raccomandazione può alterare i risultati. I cambiamenti al protocollo vengono annotati nella scheda Run
Information (Informazioni analisi) del file di dati risultante e in qualsiasi report creato.

Per avviare un’analisi PrimePCR

u Per avviare un’analisi PrimePCR, eseguire una delle seguenti operazioni:

n Nella procedura guidata di avvio, selezionare PrimePCR nella scheda Run Setup (Impostazione
analisi), quindi selezionare la chimica appropriata (SYBR® o probe).

n Selezionare un’analisi PrimePCR dall’elenco Recent Runs (Analisi recenti) nella scheda Repeat
run (Ripeti analisi) della procedura guidata di avvio.

n Selezionare File > Open > PrimePCR Run File (File > Apri > File di analisi PrimePCR) nella
finestra Home.

n Selezionare e trascinare un file di analisi PrimePCR nella finestra Home.

Dopo aver selezionato un’analisi PrimePCR, si apre la finestra Run Setup (Impostazione analisi) nella
scheda Start Run (Avvia analisi) con la disposizione piastra PrimePCR predefinita, caricata in base allo
strumento selezionato.

Per rimuovere la fase di fusione nel protocollo

u Nella scheda Protocol (Protocollo), deselezionare la casella vicino a Include Melt Step (Includi fase di
fusione).
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Per importare le informazioni target per le piastre PrimePCR in un layout della piastra

1. Eseguire una delle seguenti operazioni:

n Nella scheda Real-time Status (Stato in tempo reale) nella finestra di dialogo Run Details
(Dettagli analisi), selezionare Plate Setup > Apply PrimePCR File (Impostazione piastra >
Applica file PrimePCR).

n Nella finestra Data Analysis (Analisi dei dati), selezionare Plate Setup > Apply PrimePCR File
(Impostazione piastra > Applica file PrimePCR).

2. Nella finestra di dialogo PrimePCR Run File (File di analisi PrimePCR), fare clic su Browse (Sfoglia)
per accedere al file PrimePCR appropriato (.csv).

3. Selezionare il file PrimePCR target e fare clic su Open (Apri).

Il sistema CFX Opus Dx importa le informazioni target nel layout della piastra.
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Trasferimento dei dati stand-alone per l’analisi
Importante: quando si trasferiscono file di dati dal sistema CFX Opus Dx a CFX Maestro Dx SE,
vengono trasferiti tutti i file salvati nel sistema. Verificare che lo spazio su disco sia sufficiente per
trasferire i dati in sicurezza.

Al termine dell’analisi, CFX Maestro Dx SE analizza i dati di fluorescenza. Se l’analisi viene eseguita in
modalità stand-alone e salvata sul sistema CFX Opus Dx stesso, i dati devono essere trasferiti nel
computer CFX Maestro Dx SE per l’analisi.

Il sistema CFX Opus Dx può memorizzare fino a 100 analisi PCR in tempo reale. Al termine dell’analisi, è
possibile trasferire i file di dati stand-alone nel computer CFX Maestro Dx SE tramite e-mail, unità USB o
tramite il software stesso.

In questo paragrafo viene spiegato come trasferire i file di dati stand-alone nel computer CFX Maestro Dx
SE.

Trasferimento di dati tramite e-mail
Per inviare un file di dati al termine di un’analisi

1. Impostare le notifiche e-mail per lo strumento.

Vedere Impostazione delle notifiche e-mail a pagina 81 o il manuale operativo del sistema per PCR in
tempo reale CFX Opus Dx.

2. Quando si impostano le notifiche e-mail, assicurarsi che sia selezionata l’opzione Attach Data File
(Allega file di dati).

I dati dell’analisi vengono inviati tramite e-mail come file .pcrd.

Trasferimento di dati dai sistema per PCR in tempo reale CFX
Opus Dx
Tramite la funzionalità File Browser (Browser file) del sistema CFX Opus Dx, è possibile trasferire file di
dati a un'unità USB collegata o a una cartella di rete condivisa. È inoltre possibile trasferire file di
protocollo CFX Maestro Dx SE da un'unità USB o un'unità di rete condivisa nella cartella utente o nella
cartella pubblica del sistema CFX Opus Dx ed eseguirli sul sistema CFX Opus Dx.

Suggerimento: in questo paragrafo viene spiegato come trasferire i dati. Per informazioni sulla
configurazione della connessione Ethernet, vedere il manuale operativo del sistema per PCR in
tempo reale CFX Opus Dx disponibile nel menu Help (Guida) del software CFX Maestro Dx SE.
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1. Nella schermata Home del sistema CFX Opus Dx, toccare Files (File) per visualizzare la schermata
File Browser (Browser file).

2. Nella schermata File Browser (Browser file), individuare il file che si desidera copiare, quindi toccare
il file per visualizzare il riquadro dei dettagli.

3. Nel riquadro dei dettagli del file, toccare Options (Opzioni), quindi Copy (Copia).

Viene visualizzata la finestra di dialogo Select Location (Seleziona percorso).

4. Nella finestra di dialogo Select Location (Seleziona percorso), eseguire una delle seguenti
operazioni:

n Individuare una cartella esistente.

n Scegliere il percorso in cui creare una cartella all'interno della quale salvare il file, quindi toccare
Create Folder (Crea cartella)

( ) per creare una nuova cartella in quella posizione.

5. Toccare Select (Seleziona) per copiare il file nel percorso selezionato o Cancel (Annulla) per tornare
alla schermata File Browser (Browser file).

Nota: se nel percorso selezionato esiste un file con lo stesso nome, viene visualizzata una
finestra di messaggio. Toccare Yes (Sì) per sovrascrivere il file esistente o No per tornare alla
schermata File Browser (Browser file).
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Quando il file viene copiato correttamente, sul sistema CFX Opus Dx viene visualizzato un
messaggio di conferma.
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Trasferimento dei dati tramite il Software CFX Maestro Dx, Security
Edition
Per trasferire i dati tramite CFX Maestro Dx SE

1. Nel riquadro Detected Instruments (Strumenti rilevati) della finestra Home, fare clic con il pulsante
destro sullo strumento target e scegliere Retrieve Data Files (Recupera file di dati).

CFX Maestro Dx SE visualizza la finestra di dialogo Browse For Folder (Sfoglia cartella).

2. Nella finestra di dialogo Browse For Folder (Sfoglia cartella), accedere al percorso in cui si intende
salvare i file di dati e fare clic su OK.

Il processo di trasferimento crea una cartella chiamata Real-Time Data (Dati in tempo reale) nella
posizione selezionata. I dati dell’analisi sono salvati nella cartella Real-Time Data (Dati in tempo
reale) come file .zpcr separati.

Trasferimento dei dati con un’unità USB
Se si inserisce un’unità USB nella porta USB dello strumento, il file di dati viene automaticamente salvato
nella directory principale dell’unità USB una volta completata l’analisi. È inoltre possibile individuare i file
di dati salvati in precedenza e salvarli su un’unità USB collegata.

Per trasferire file di dati su un'unità USB su sistema CFX Opus Dx

u Nella finestra di dialogo Select Location (Seleziona percorso), toccare USB e accedere alla cartella di
destinazione in cui copiare il file oppure Cancel (Annulla) per tornare alla schermata File Browser
(Browser file).

Nota: se nel percorso selezionato esiste un file con lo stesso nome, viene visualizzata una
finestra di dialogo. Toccare Yes (Sì) per sovrascrivere il file esistente o No per tornare alla
schermata File Browser (Browser file).

Quando il file viene copiato correttamente, sul sistema CFX Opus Dx viene visualizzato un messaggio di
conferma.
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Trasferimento dei dati tramite un'unità di rete condivisa utilizzando
il sistema per PCR in tempo reale CFX Opus Dx
Suggerimento: è possibile trasferire dati da e verso un'unità di rete condivisa solo tramite il sistema
CFX Opus Dx.

Il sistema CFX Opus Dx consente di collegarsi a un'unità di rete condivisa tramite Ethernet. Una volta
stabilita la connessione, è possibile trasferire file di dati da e verso una cartella sull'unità di rete condivisa.

Per trasferire dati da e verso un'unità di rete condivisa

u Nella finestra di dialogo Select Location (Seleziona percorso), toccare Network (Rete) e accedere
alla cartella di destinazione in cui copiare il file oppure Cancel (Annulla) per tornare alla schermata
File Browser (Browser file).

Nota: se nel percorso selezionato esiste un file con lo stesso nome, viene visualizzata una
finestra di dialogo. Toccare Yes (Sì) per sovrascrivere il file esistente o No per tornare alla
schermata File Browser (Browser file).

Quando il file viene copiato correttamente, sul sistema CFX Opus Dx viene visualizzato un messaggio di
conferma.

Creazione di un file di dati
Per analizzare i dati trasferiti dallo strumento al computer CFX Maestro Dx SE, il file di dati compressi (file
.zpcr) deve essere convertito in un file di dati (file .pcrd). CFX Maestro Dx SE converte il file .zpcr in un file
.pcrd, quindi seleziona un file di piastra caratterizzato dalla stessa modalità di scansione e dimensioni di
piastra e lo applica al file .pcrd.

Per creare un file di dati da un file di dati stand-alone

1. In CFX Maestro Dx SE, eseguire una delle seguenti operazioni:

n Individuare il file .zpcr target e trascinarlo nella finestra Home di CFX Maestro Dx SE.

n Selezionare File > Open > Stand-alone Run (File > Apri > Analisi stand-alone), accedere al file
target e selezionarlo.

CFX Maestro Dx SE visualizza la finestra di dialogo Save As (Salva con nome).

2. Accedere alla cartella in cui si intende salvare il file .pcrd e fare clic su Save (Salva).

Dopo aver salvato il file .pcrd, CFX Maestro Dx SE apre la finestra Data Analysis (Analisi dei dati) e
visualizza i dati risultanti.
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Il Software CFX Maestro Dx, Security Edition elabora i dati della PCR in tempo reale automaticamente al
termine di ciascuna analisi e apre la finestra Data Analysis (Analisi dei dati) per visualizzarne i dati (il file
.pcrd).

n Trascinare un file di dati (estensione .pcrd) nella finestra Home e rilasciarlo.

n Selezionare File > Open > Data File (File > Apri > File di dati) nella finestra Home e accedere al file
.pcrd target.

n Selezionare File > Recent Data Files (File > File di dati recenti) nella finestra Home per effettuare la
selezione dall’elenco degli ultimi dieci file di dati aperti più di recente.

n Scegliere la scheda Analyze (Analizza) nella procedura guidata di avvio e selezionare un file da
Recent Files (File recenti) oppure fare clic su Browse (Sfoglia) per individuare il file di dati.

Finestra Data Analysis (Analisi dei dati)
La finestra Data Analysis (Analisi dei dati) visualizza più schede; ciascuna scheda mostra i dati analizzati
per un metodo di analisi specifico o le informazioni specifiche dell’analisi. Le schede vengono visualizzate
solo se i dati raccolti nell’analisi sono disponibili per quel tipo di analisi.

Suggerimento: per scegliere le schede da visualizzare, selezionarle dal menu a discesa View
(Visualizza) nella finestra Data Analysis (Analisi dei dati). Per tornare nel layout della scheda
originale, selezionare Settings > Restore Default Window Layout (Impostazioni > Ripristina layout
predefinito della finestra).
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Barra degli strumenti Data Analysis (Analisi dei dati)
La barra degli strumenti della finestra Data Analysis (Analisi dei dati) fornisce rapido accesso a importanti
funzioni dell’analisi dei dati.

La Tabella 11 elenca le funzioni dei pulsanti nella barra degli strumenti.

Pulsante Nome Funzione

Plate Setup
(Impostazione
piastra)

View/Edit plate (Visualizza/Modifica piastra):
consente di aprire l’editor piastra per
visualizzare e modificare il contenuto dei
pozzetti.

Replace Plate (Sostituisci piastra): consente di
selezionare un file piastra per sostituire il layout
della piastra.

Apply PrimePCR file (Applica file PrimePCR):
consente di selezionare un file di analisi per
sostituire il layout piastra per un’analisi
PrimePCR.

ManageWell
Groups (Gestisci
gruppi di pozzetti)

Apre la finestra Well Groups Manager (Gestore
gruppi di pozzetti) per creare, modificare ed
eliminare i gruppi di pozzetti.

Gruppo di pozzetti Selezionare il nome di un gruppo di pozzetti
esistente dal menu a discesa. La selezione
predefinita è All Wells (Tutti i pozzetti). Questo
pulsante viene visualizzato solo quando si
creano dei gruppi di pozzetti.

Analysis Mode
(Modalità di analisi)

Analizza i dati in modalità Fluorophore
(Fluoroforo) o Target (Target).

Help (Guida) Consente di aprire la guida del software da cui è
possibile trovare la guida in linea e una copia
digitale di questo manuale in formato PDF
Acrobat.

Tabella 11. Barra degli strumenti della finestra Data Analysis (Analisi dei dati)
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Barra dei menu Data Analysis (Analisi dei dati)
Nella Tabella 12 sono elencate le voci della barra dei menu disponibili nella finestra Data Analysis (Analisi
dei dati).

Voce di menu Comando Funzione

File (File) Save (Salva) Salva il file.

Save as (Salva con nome) Consente di salvare il file con un nuovo nome.

File Passwords (Password dei file) Consente agli utenti di impostare password
per il salvataggio e l’apertura di file.

Sign (Firma) Consente agli utenti di firmare il file di dati.

Repeat Run (Ripeti analisi) Consente di estrarre il file di protocollo e
piastra dall’analisi corrente per rieseguirlo.

Close (Chiudi) Chiude la finestra Data Analysis (Analisi dei
dati).

View (Visualizza) Run Log (Registro analisi) Consente di aprire la finestra Run Log
(Registro analisi) per visualizzare il registro
dell’analisi del file di dati corrente.

Audit Trail Consente di aprire l’audit trail per il file.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information
(Quantificazione, Curva di fusione,
Espressione genica, Punto finale,
Visualizzazione dati
personalizzata, CQ, Informazioni
analisi)

Visualizza i dati analizzati nelle schede
selezionate della finestra Data Analysis
(Analisi dei dati). Deve essere selezionata
almeno una scheda.

Tabella 12. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati)
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Voce di menu Comando Funzione

Settings
(Impostazioni)

Cq Determination Mode (Modalità
di determinazione Cq)

Consente di selezionare la modalità
Regression (Regressione) o Single Threshold
(Soglia singola) per determinare come
vengono calcolati i valori Cq per ogni traccia.

Tabella 12. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati),
continua
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Voce di menu Comando Funzione

Baseline Setting (Impostazione
linea basale)

Consente di selezionare il metodo di
sottrazione della linea basale per i gruppi di
pozzetti selezionati.

Analysis Mode (Modalità di analisi) Consente di analizzare i dati in base al
fluoroforo o in base al target.

Cycles to Analyze (Cicli da
analizzare)

Consente di selezionare i cicli da analizzare.

Baseline Threshold (Soglia linea
basale)

Consente di aprire la finestra Baseline
Threshold (Soglia linea basale) per regolare la
linea basale o la soglia.

Trace Styles (Stili tracce) Apre la finestra di dialogo Trace Styles (Stili
tracce).

Plate Setup (Impostazione piastra) Apre l’editor piastra per visualizzare e
modificare la piastra; sostituire la piastra
attuale con una del file piastra definito
dall’utente o un file di analisi PrimePCR.

Include All Excluded Wells (Includi
tutti i pozzetti esclusi)

Include tutti i pozzetti esclusi nell’analisi.

Mouse Highlighting
(Evidenziazione mouse)

Consente di attivare o disattivare
l’evidenziazione simultanea dei dati con il
puntatore del mouse.

Suggerimento: se la funzione Mouse
Highlighting (Evidenziazione mouse) è
disattivata, premere il tasto Control (Ctrl)
per attivare temporaneamente
l’evidenziazione.

Restore Default Window Layout
(Ripristina layout finestra
predefinito)

Ripristina l’impostazione predefinita per la
disposizione delle finestre.

Tabella 12. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati),
continua
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Voce di menu Comando Funzione

Export (Esporta) Export All Data Sheets (Esporta
tutte le schede dati)

Consente di selezionare se esportare tutte le
visualizzazioni del foglio di calcolo da ogni
scheda in un file .csv, .txt, Excel o .xml.

Export RDML File (Esporta file
RDML)

Consente di selezionare la versione 1.1 o 1.0
di RDML in cui esportare il file.

Custom Export (Esportazione
personalizzata)

Apre la finestra Custom Export (Esportazione
personalizzata) in cui è possibile specificare i
file da esportare e il formato file.

Export to LIMS Folder (Esporta
nella cartella LIMS)

Apre una finestra per salvare i dati in un
formato prestabilito nella cartella LIMS.

Manual Export (Esportazione
manuale)

Consente di aprire una finestra per identificare
il percorso in cui salvare i dati di tutte le
visualizzazioni del foglio di calcolo in file Excel
strutturati specificatamente per essere
utilizzati da Seegene, Inc. e Bio-Rad
Laboratories.

Suggerimento: è inoltre possibile
avviare automaticamente il visualizzatore
Seegene durante l'esportazione. Per
ulteriori informazioni, vedere Comandi
del menu Tools (Strumenti) a pagina 67.

Tools (Strumenti) Reports (Report) Apre il Report per questo file di dati.

Well Group Reports (Report
gruppo pozzetti)

Apre la finestra Well Group Report (Report
gruppo pozzetti) per i gruppi di pozzetti
specificati.

Import Fluorophore Calibration
(Importa calibrazione fluoroforo)

Selezionare un file di calibrazione da
applicare al file di dati attuale.

qbase+ Se installato, avvia qbase+ v2.5 direttamente
dal file .pcrd corrente.

Generate LIMS PLRN file (Genera
file PLRN LIMS)

Consente di salvare il file di dati come file .plrn
formattato LIMS.

Tabella 12. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati),
continua
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Dettagli scheda
In ciascuna scheda della finestra Data Analysis (Analisi dei dati) sono visualizzati i dati dei grafici e dei
fogli di calcolo per una specifica metodologia di analisi ed è incluso un selettore pozzetto per selezionare i
dati che si desiderano mostrare. Per impostazione predefinita, la finestra Data Analysis (Analisi dei dati)
visualizza la scheda Quantification (Quantificazione) quando si apre. È possibile utilizzare i dati del
grafico di amplificazione nella scheda Quantification (Quantificazione) per determinare le impostazioni di
analisi appropriate per l’analisi.

Nota: il software collega i dati nei riquadri di ciascuna scheda Data Analysis (Analisi dei dati). Ad
esempio, quando si evidenzia un pozzetto mettendo il puntatore del mouse sopra il pozzetto nel
selettore pozzetto si mettono in evidenza i dati in tutti gli altri riquadri.

Selettore del numero di fase
I sistemi CFX Opus Dx possono acquisire dati di fluorescenza in più fasi del protocollo; il software
mantiene i dati acquisiti in ogni fase in modo indipendente. CFX Maestro Dx SE visualizza il selettore del
numero di fase sotto il grafico della curva standard nella scheda Quantification (Quantificazione). Quando
un protocollo contiene almeno una fase di raccolta dati, CFX Maestro Dx SE visualizza i dati della prima
fase di raccolta.

Se il protocollo contiene più fasi di raccolta, è possibile selezionare un’altra fase dall’elenco a discesa, ad
esempio:
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Quando si seleziona una fase, il software applica tale selezione a tutti i dati mostrati nella finestra Data
Analysis (Analisi dei dati).

Visualizzazione dei gruppi di pozzetti nell’analisi dei dati
I pozzetti nella piastra possono essere raggruppati in sottoinsieme per l’analisi indipendente utilizzando i
gruppi di pozzetti. Quando si creano gruppi di pozzetti, i rispettivi nomi gruppo sono visualizzati
nell’elenco a discesa Well Groups (Gruppi pozzetti) della finestra Data Analysis (Analisi dei dati) sulla
barra degli strumenti.

Se si creano gruppi di pozzetti, il software visualizza il gruppo di pozzetti predefinito All Wells (Tutti i
pozzetti) quando si apre la finestra Data Analysis (Analisi dei dati), visualizzando i dati in tutti i pozzetti
con contenuto nei grafici e nei fogli di calcolo. Solo i pozzetti di quel gruppo di pozzetti caricato con il
contenuto viene visualizzato nel selettore di pozzetti e solo i dati di tali pozzetti sono inclusi nei calcoli
dell’analisi dei dati.

Suggerimento: per creare, modificare ed eliminare gruppi di pozzetti, fare clic su ManageWell
Groups (Gestisci gruppi di pozzetti) nella barra degli strumenti.

Nota: se non si creano gruppi di pozzetti, nella barra degli strumenti non viene visualizzato l’elenco a
discesa Well Groups (Gruppi di pozzetti).

Modifica del contenuto dei pozzetti dopo l’analisi
La modifica della modalità di visualizzazione dei dati durante l’analisi dei dati apportata cambiando il
contenuto dei pozzetti nell’editor piastra non comporta cambiamenti ai dati della fluorescenza raccolti da
ogni pozzetto durante l’analisi. Dopo che il modulo ha raccolto i dati della fluorescenza, non è possibile
eliminare tale dati anche se si può scegliere di rimuovere i dati dalla visualizzazione e dall’analisi.

Per cambiare il contenuto dei pozzetti dopo un’analisi

u Nella finestra Data Analysis (Analisi dei dati), fare clic su Plate Setup (Impostazione piastra), quindi
selezionare una delle seguenti opzioni:

n Edit/View Plate (Modifica/Visualizza piastra): consente di aprire l’editor piastra in cui è possibile
apportare modifiche manuali al layout.

n Replace Plate file (Sostituisci file piastra): consente di aprire il browser Select Plate (Seleziona
piastra), in cui è possibile accedere a un file piastra precedentemente salvato con cui sostituire il
layout della piastra corrente.

n Replace PrimePCR File (Sostituisci file PrimePCR): consente di aprire la finestra di dialogo
Select PrimePCR file (Seleziona file PrimePCR) in cui è possibile accedere a un file di analisi
PrimePCR e applicarlo al layout della piastra.
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Suggerimento: è possibile aggiungere o modificare le informazioni sul contenuto del pozzetto prima
o durante un’analisi, oppure dopo il completamento di un’analisi di PCR. Occorre assegnare la
modalità di analisi e la dimensione della piastra prima dell’analisi. Tali parametri non possono
cambiare dopo l’analisi.
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Impostazioni dell’analisi dei dati
I dati del grafico di amplificazione nella scheda Quantification (Quantificazione) mostrano l’unità di
fluorescenza relativa (RFU) per ciascun pozzetto ad ogni ciclo. Ogni traccia presente nel grafico
rappresenta i dati di un singolo fluoroforo in un pozzetto. Questi dati vengono utilizzati per determinare i
valori Cq per ogni pozzetto sulla base di ciascun fluoroforo. Il software utilizza una delle due modalità per
determinare i valori Cq:

n Regression (Regressione): applica un modello di regressione non lineare multivariabile alle singole
tracce dei pozzetti e utilizza tale modello per calcolare un valore Cq ottimale.

n Single Threshold (Soglia singola): utilizza un valore singolo di soglia per calcolare il valore Cq in
base al punto di attraversamento della soglia delle singole tracce della fluorescenza.

Per scegliere la modalità di determinazione Cq, selezionare Settings > Cq Determination Mode
(Impostazioni > Modalità di determinazione Cq).

Regolazione della soglia
Nella modalità Single Threshold (Soglia singola), è possibile regolare la soglia per un fluoroforo facendo
clic sulla linea di soglia nel grafico di amplificazione e spostando il cursore del mouse in verticale. In
alternativa, è possibile specificare una soglia di attraversamento esatta per il fluoroforo selezionato.

Impostazioni della linea basale
Il software imposta automaticamente la linea basale per ogni singolo pozzetto. L’impostazione della linea
basale determina il metodo della sottrazione della linea basale per tutte le tracce di fluorescenza. Il
software fornisce tre opzioni di sottrazione della linea basale:

n No Baseline Subtraction (Nessuna sottrazione linea basale): consente di visualizzare i dati come
tracce di fluorescenza relativa. Alcune analisi non sono possibili in questa modalità e, pertanto, il
software non visualizza le schede Gene Expression (Espressione genica), End Point (Punto finale) e
Allelic Discrimination (Discriminazione allelica).

n Baseline Subtracted (Linea basale sottratta): consente di visualizzare i dati come tracce sottratte
alla linea basale per ciascun fluoroforo in un pozzetto. Il software deve eseguire la sottrazione della
linea basale dai dati al fine di determinare i cicli di quantificazione, costruire curve standard e
determinare la concentrazione di campioni sconosciuti. Per generare una traccia con sottrazione
della linea basale, il software adatta la migliore linea retta attraverso la fluorescenza registrata di
ciascun pozzetto durante i cicli della linea basale, quindi sottrae i migliori dati di adattamento dai dati
di fondo sottratti in ciascun ciclo.

n Baseline Subtracted Curve Fit (Adattamento curva con sottrazione della linea basale): consente di
visualizzare i dati come tracce sottratte della linea basale e il software rende uniforme la curva
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sottratta alla linea basale usando un filtro di media centrata. Questo processo viene eseguito in modo
che ciascuna Cq rimanga invariante.

Oltre a queste opzioni, è inoltre possibile selezionare Apply Fluorescent Drift Correction (Applica correzione
deriva fluorescente). Per i pozzetti che hanno valori RFU in deriva in modo anomalo durante i pochi cicli
iniziali di un’analisi, il software deriva una linea basale stimata dai pozzetti vicini per cui è stata generata
correttamente una linea basale orizzontale.

Per cambiare l’impostazione della sottrazione della linea basale

u Selezionare Settings > Baseline Setting (Impostazioni > Impostazione linea basale).

Modalità di analisi
I dati possono essere raggruppati e analizzati tramite fluoroforo o nome target. Quando raggruppati per
fluoroforo, le tracce dei dati vengono visualizzate tramite fluoroforo come indicato nell’impostazione della
piastra per tale analisi. I dati del singolo fluoroforo sono visualizzati nel grafico di amplificazione e della curva
standard (se disponibile) quando vengono selezionate le caselle di controllo appropriate del selettore di
fluoroforo, che si trovano sotto il grafico di amplificazione.

Quando raggruppati per target, le tracce dei dati vengono visualizzate tramite nome target come inserito
nell’impostazione della piastra per tale analisi.

Per scegliere una modalità di analisi dei dati

u Eseguire una delle seguenti operazioni:

n Selezionare Settings > Analysis Mode (Impostazioni > Modalità di analisi).
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n Scegliere una modalità dal menu a discesa Analysis Mode (Modalità di analisi) nella barra degli
strumenti.

Cicli da analizzare
È possibile limitare il numero di cicli da analizzare. È possibile analizzare i dati anche da una determinata
serie di cicli. Il numero massimo di cicli che è possibile analizzare è 50.

Nota: la rimozione dei cicli dall’inizio di un’analisi può avere un impatto significativo sulla definizione
della linea di base.

Per limitare l’analisi dei dati a una determinata gamma di cicli

1. Selezionare Select Settings > Cycles to Analyze (Seleziona impostazioni > Cicli da analizzare).

Viene visualizzata la finestra di dialogo Cycles to Analyze (Cicli da analizzare).

2. Immettere i valori del ciclo di inizio e del ciclo di fine e quindi fare clic su OK.

Per tornare ai cicli inizialmente usati per l’analisi, fare clic su Restore Defaults (Ripristina valori predefiniti)
nella finestra di dialogo Cycles to Analyze (Cicli da analizzare).
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Selettore pozzetto
Utilizzare il selettore pozzetto per visualizzare o nascondere i dati del pozzetto nei grafici o nei fogli di
calcolo in tutta la finestra Data Analysis (Analisi dei dati). Nel selettore pozzetto possono essere
selezionati solo i pozzetti caricati con il campione. Il software colora i pozzetti nel selettore dei pozzetti:

n Blu: indica i pozzetti selezionati. I dati dei pozzetti selezionati vengono visualizzati nella finestra Data
Analysis (Analisi dei dati).

n Grigio chiaro: indica i pozzetti non selezionati. I dati dei pozzetti non selezionati non vengono
visualizzati nella finestra Data Analysis (Analisi dei dati).

n Grigio scuro: indica i pozzetti vuoti.

Per visualizzare o nascondere i dati del pozzetto

u Nel selettore dei pozzetti, eseguire una delle seguenti operazioni:

n Per nascondere un pozzetto, fare clic sul singolo pozzetto. Per visualizzare tale pozzetto, fare di
nuovo clic sul pozzetto.

n Per nascondere più pozzetti, trascinare il cursore del mouse sui pozzetti che si intende
selezionare. Per visualizzare tali pozzetti, trascinare di nuovo il cursore del mouse su quei
pozzetti.

n Fare clic nell’angolo in alto a sinistra della piastra per nascondere tutti i pozzetti. Fare di nuovo
clic nell’angolo in alto a sinistra per visualizzare tutti i pozzetti.

n Fare clic sull’inizio di una colonna o riga per nascondere tali pozzetti. Fare di nuovo clic sulla
colonna o riga per visualizzare di nuovo i pozzetti.
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Elementi del menu di scelta rapida del selettore dei pozzetti
La Tabella 13 elenca le opzioni selezionabili con il pulsante destro del mouse, disponibili nella
visualizzazione del selettore dei pozzetti.

Elemento Funzione

Well XX (Pozzetto XX) Visualizza solo questo pozzetto, rimuove questo pozzetto dalla
visualizzazione, imposta il colore per questo pozzetto o esclude questo
pozzetto dall’analisi.

Pozzetti selezionati (facendo clic
con il tasto destro del mouse e
trascinando il cursore)

Visualizza solo questi pozzetti, rimuove questi pozzetti dalla
visualizzazione, imposta il colore per questi pozzetti o esclude questi
pozzetti dall’analisi.

Copy (Copia) Compia il contenuto del pozzetto negli appunti, incluso il tipo di
campione e il N. replicato.

Copy as Image (Copia come
immagine)

Copia la visualizzazione del selettore pozzetto come un’immagine.

Print (Stampa) Stampa la visualizzazione del selettore pozzetto.

Print Selection (Stampa
selezione)

Stampa la selezione corrente.

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to CSV (Esporta in CSV) Esporta i dati come documento .csv.

Export to Xml (Esporta in Xml) Esporta i dati come un documento .xml.

Well Labels (Etichette pozzetto) Cambia le etichette pozzetto con Sample Type (Tipo di campione),
Target Name (Nome target) o Sample Name (Nome campione).

Tabella 13. Elementi del menu di scelta rapida nella visualizzazione del selettore dei pozzetti
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Esclusione provvisoria dei pozzetti dall’analisi
Per escludere provvisoriamente i pozzetti dall’analisi dei dati

1. Fare clic con il pulsante destro del mouse sul pozzetto nel selettore dei pozzetti, su una traccia di
fluorescenza o su un punto tracciato sulla curva standard. Per escludere più pozzetti, fare clic con il
tasto destro del mouse e trascinare il cursore per evidenziare più pozzetti, tracce o punti.

2. Dal menu di scelta rapida, scegliere l’opzione appropriata:

n Well > Exclude Well (Pozzetto > Escludi pozzetto)

n Selected Wells > Exclude from Analysis (Pozzetti selezionati > Escludi da analisi)

n Selected Traces > Exclude these wells from Analysis (Tracce selezionate > Escludi questi
pozzetti dall’analisi)

In alternativa, per rimuovere definitivamente i pozzetti dall’analisi, cancellare il contenuto dei pozzetti
nell’editor piastra facendo clic sul pulsante Clear Wells (Cancella pozzetti).

Importante: è necessario immettere nuovamente qualsiasi contenuto del pozzetto cancellato.

Per includere un pozzetto escluso

u Con il tasto destro del mouse, fare clic sul pozzetto appropriato nel selettore dei pozzetti e
selezionare Well > Include Well in Analysis (Pozzetto > Includi pozzetto nell’analisi).
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Grafici
Ogni grafico della finestra Data Analysis (Analisi dei dati) visualizza i dati in un grafico diverso e include
opzioni che consentono di regolare ed esportare i dati o i grafici.

Strumenti dei grafici
Nella Tabella 14 vengono elencate le opzioni selezionabili con il pulsante destro del mouse, disponibili
nella maggior parte dei grafici.

Elemento Funzione

Copy (Copia) Copia il grafico negli appunti.

Save Image As... (Salva
immagine con nome)

Salva il grafico come file immagine. Impostare la risoluzione e le
dimensioni dell’immagine, quindi selezionare il tipo di file (PNG, GIF,
JPG, TIF o BMP).

Page Setup... (Impostazione
pagina)

Seleziona le impostazioni di una pagina per la stampa.

Print... (Stampa) Stampa il grafico.

Set Scale to Default (Imposta
scala su predefinito)

Mostra tutti i dati nel grafico a barre. Le barre di scorrimento
visualizzano se sono presenti troppi punti dati/campioni da visualizzare
nella struttura del grafico.

Chart Settings (Impostazioni
grafico)

Consente di aprire la finestra di dialogo Chart Settings (Impostazioni
grafico) in cui è possibile modificare le opzioni di visualizzazione del
grafico fra cui:

n Titoli del grafico e degli assi

n Font e dimensioni del grafico e degli assi

n Scala degli assi

n Posizione della legenda

Tabella 14. Elementi del menu di scelta rapida comuni alla maggior parte dei grafici

Gli strumenti del grafico vengono inoltre visualizzati in ciascun grafico nella finestra Data Analysis (Analisi
dei dati). Tutti i grafici mostrano questi strumenti:

Copy to Clipboard (Copia negli Appunti): consente di copiare il contenuto della visualizzazione a grafico
negli Appunti.
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Chart Settings (Impostazioni grafico): consente di aprire la finestra di dialogo Chart Settings
(Impostazioni grafico) in cui è possibile modificare le opzioni di visualizzazione del grafico.

Export (Esporta): consente di aprire la finestra di dialogo Export Options (Opzioni esportazione), da cui è
possibile modificare la risoluzione e le dimensioni del grafico e salvarlo in un percorso specificato in uno
dei seguenti tipi di file:

n .bmp

n .jpg

n .png

Strumenti del grafico a barre

Oltre agli strumenti del grafico, nei grafici a barre vengono visualizzati i seguenti strumenti:

Sort (Ordina): consente di ordinare i target e i campioni in ordine alfabetico diretto o inverso.

Color Settings (Impostazioni colore): consente di aprire la finestra di dialogo Color Settings
(Impostazioni colore), in cui è possibile cambiare il colore dei target e dei campioni.

Per ulteriori informazioni su questi strumenti, vedere Modifica e annotazione della vista grafico a pagina
270.

Strumenti del grafico di amplificazione

Oltre a quelli elencati sopra, nei grafici di amplificazione vengono visualizzati i seguenti strumenti:

Trace Styles (Stili traccia): consente di aprire la finestra di dialogo Trace Styles (Stili traccia), in cui è
possibile modificare l’aspetto delle tracce nel grafico di amplificazione.

Baseline Threshold (Soglia linea di base): consente di aprire la finestra di dialogo Baseline Threshold
(Soglia linea di base), in cui è possibile modificare la linea di base predefinita per i pozzetti selezionati o
modificare la soglia per ogni curva di fluorescenza nel grafico di amplificazione.

Copia dei dati del grafico negli Appunti

È possibile copiare il contenuto della vista a grafico e incollarlo in qualsiasi applicazione che accetta file
immagine bitmap.

Per copiare i dati del grafico negli Appunti

1. Dagli strumenti del grafico, selezionare l'icona Copy to Clipboard (Copia negli Appunti).

2. Aprire un’applicazione che accetta immagini bitmap, ad esempio Microsoft Word.

3. Fare clic con il pulsante destro del mouse e selezionare Paste (Incolla) per incollare l’immagine
bitmap dagli appunti nell’applicazione.
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Modifica delle impostazioni di visualizzazione grafico

Usare la finestra di dialogo Chart Settings (Impostazioni grafico) per modificare i titoli, i font e le
dimensioni, la scala degli assi e la posizione della legenda per il grafico visualizzato. Le modifiche
apportate si applicano solo al grafico visualizzato e vengono salvate con il grafico.

Per cambiare le impostazioni di visualizzazione grafico

1. Dagli strumenti del grafico, fare clic su Chart Settings (Impostazioni grafico).

Appare la finestra di dialogo Chart Settings (Impostazioni grafico).

2. Selezionare la scheda Chart And Axes (Grafico e assi) per:

n Digitare un titolo per il grafico.

n Digitare un nuovo titolo per l’asse x e regolare l’angolazione delle etichette.

n Digitare un nuovo titolo per l’asse y.

3. Selezionare la scheda Fonts (Font) per cambiare il font del grafico e le dimensioni del font.

Suggerimento: per impostazione predefinita, le dimensioni del font vengono automaticamente
scalate quando cambia la dimensione del grafico. Selezionare Change Font Size (Cambia
dimensione font) per impostare una dimensione font statica per ciascun tipo di etichetta.

4. Selezionare la scheda Axes Scale (Scala assi) per:

n Deselezionare la scala automatica degli assi x e y e specificare i valori di scala minimo e
massimo.

n Scegliere di visualizzare le linee della griglia o i simboli di spunta sul grafico.
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5. Selezionare la scheda Legend (Legenda) per:

n Scegliere di nascondere la legenda del grafico.

n Cambiare la posizione predefinita della legenda del grafico.

Nota: quando la legenda viene posizionata a destra o a sinistra del grafico, consente di
visualizzare solo i primi dieci fluorofori nel grafico.

6. Fare clic su Apply (Applica) in qualsiasi momento per visualizzare le modifiche delle impostazioni
grafico senza salvare le modifiche.

7. Fare clic su OK per salvare le modifiche e tornare al grafico.

Esportazione del grafico

Utilizzare questa finestra di dialogo per modificare la larghezza, l’altezza e la risoluzione del grafico ed
esportarlo in uno dei seguenti formati file:

n .bmp

n .jpg

n .png

È possibile utilizzare il grafico esportato per visualizzare i risultati nelle sessioni di anteprima, nelle
presentazioni di Microsoft PowerPoint e nelle riviste specializzate.

Nota: prendere in considerazione quanto segue quando si modificano le impostazioni:

n Limiti massimo e minimo di larghezza e altezza

o A 72 dpi: 0,1 - 83 pollici

o A 96 dpi: 0,1 - 62 pollici

o A 150 dpi: 0,1 - 40 pollici

o A 300 dpi: 0,1 - 20 pollici

o A 600 dpi: 0,1 - 10 pollici

o A tutte le risoluzioni: 2 - 6.000 pixel

n Le proporzioni si basano sulla larghezza.

Per esportare il grafico

1. Dagli strumenti del grafico, fare clic su Export (Esporta).

Viene visualizzata la finestra di dialogo Export Preview (Anteprima dell’esportazione).
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2. Modificare le impostazioni per la visualizzazione secondo necessità.

3. Fare clic su Export (Esporta).

4. Nella finestra di dialogo Export (Esporta), procedere come segue:

a. (Facoltativo) Accedere alla cartella in cui salvare il file del grafico.

b. Digitare un nome per il file e scegliere un tipo di file dall’elenco a discesa.

5. Fare clic su Save (Salva) per salvare il file del grafico.

Modifica delle impostazioni della soglia della linea basale

Nella modalità Single Threshold (Soglia singola), è possibile regolare la soglia per un fluoroforo facendo
clic sulla linea di soglia nel grafico di amplificazione e spostando il cursore del mouse in verticale. In
alternativa, è possibile specificare una soglia di attraversamento esatta per il fluoroforo selezionato.

Suggerimento: è possibile specificare un intervallo di cicli per determinare la linea basale per tutti i
file di dati nella scheda Data Analysis (Analisi dei dati) in User > User Preferences (Utente >
Preferenze utente).

Per regolare il ciclo di inizio e di fine della linea basale per ciascun pozzetto

1. Nella scheda Quantification (Quantificazione), selezionare un singolo fluoroforo sotto il grafico di
amplificazione.

2. Dagli strumenti del grafico, selezionare Baseline Threshold (Soglia linea basale).
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Viene visualizzata la finestra di dialogo Baseline Threshold (Soglia linea basale).

3. Nella sezione Baseline Cycles (Cicli linea basale), eseguire una delle seguenti operazioni:

n Per selezionare un pozzetto, fare clic sul rispettivo numero di riga.

n Per selezionare più pozzetti adiacenti, fare clic sul numero di riga del primo pozzetto e trascinare
la colonna verso il basso fino all’ultimo pozzetto.

n Per selezionare più pozzetti non adiacenti, premere il tasto Control (Ctrl) e fare clic sul numero di
riga di ciascun pozzetto target.

n Per selezionare tutti i pozzetti, fare clic in alto a sinistra sulla tabella.

4. Regolare il Baseline Begin cycle (Ciclo di inizio linea basale) e il Baseline End cycle (Ciclo di fine
linea basale) per tutti i pozzetti selezionati, oppure modificare il numero del ciclo di inizio e di fine
nella parte inferiore del foglio di calcolo.

Suggerimento: per ripristinare gli ultimi valori salvati delle impostazioni, fare clic su Reset All
User Defined Values (Ripristina tutti i valori definiti dall’utente).

5. Fare clic su OK per salvare le modifiche e tornare al grafico.

Per specificare un intervallo di cicli per tutti i file

u Nella finestra Home o Plate Editor (Editor piastra), selezionare User > User Preferences (Utente >
Preferenze utente) e scegliere la scheda Data Analysis (Analisi dei dati).

Ordinamento dei dati di target, campioni e gruppi biologici

Nota: questa opzione è disponibile solo nei grafici dell’espressione genica.

Per impostazione predefinita, gli elenchi Targets (Target), Samples (Campioni) e Biological Groups
(Gruppi biologici) vengono visualizzati in ordine alfabetico. Usare la finestra di dialogo Sort (Ordina) per
ordinare la visualizzazione in ordine alfabetico inverso o per spostare manualmente un termine in un’altra
posizione dell’elenco.

Per ordinare i dati di target, campioni e gruppi biologici

1. Dagli strumenti del grafico, fare clic su Sort (Ordina).

Viene visualizzata la finestra di dialogo Gene Expression Chart Sorting (Ordinamento grafico
dell’espressione genica).
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2. Nella finestra di dialogo, fare clic su Z-A per ordinare l’elenco nell’ordine alfabetico inverso.

3. Per spostare un termine manualmente, selezionarlo e fare clic sul pulsante appropriato tra i grafici:

n Fare clic sulla freccia Su o Giù per spostare il termine selezionato di una posizione.

n Fare clic sulla freccia della barra Su o Giù per spostare il termine selezionato in alto o in basso
nell’elenco.

4. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).
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Modifica delle impostazioni di colore del target e del campione

Nota: questa opzione è disponibile solo nei grafici dell’espressione genica.

Usare la finestra di dialogo Color Settings (Impostazioni colore) per cambiare il colore di un target o un
campione, o per rimuovere l’elemento dal grafico.

Per cambiare le impostazioni di colore

1. Dagli strumenti del grafico, selezionare Color Settings (Impostazioni colore).

Appare la finestra di dialogo Color Settings (Impostazioni colore).

2. Per cambiare il colore di visualizzazione per un target o un campione, fare clic sul suo colore nella
colonna Color (Colore).

3. Nella finestra di dialogo Color (Colore) che viene visualizzata, selezionare un nuovo colore e fare clic
su OK.

4. Per rimuovere l’elemento dal grafico dell’espressione genica, deselezionare la relativa casella di
controllo nella colonna Show Chart (Mostra grafico).

Suggerimento: per cancellare tutti gli elementi dal grafico dell’espressione genica,
deselezionare la casella di controllo Show Chart (Mostra grafico) nell’intestazione della colonna.

5. (Opzionale) Per impostazione predefinita, il colore del grafico a barre è visualizzato sotto forma di
gradiente. Per visualizzare il colore in tinta unita, selezionare Use Solid Colors (Usa colori in tinta
unita).

6. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).
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Ingrandimento di un’area nel grafico
Per ingrandire un’area del grafico

u Fare clic e trascinare il cursore sul grafico, quindi fare clic su Zoom. Il software ridimensiona il grafico
e lo centra sull’area selezionata.

Nota: il grafico a barre non richiede l’uso del comando popup Zoom.

Per ripristinare la visualizzazione completa del grafico

u Fare clic con il pulsante destro del mouse sul grafico e scegliere Set Scale to Default (Imposta scala
su predefinito).

Copia di grafici in un file Microsoft
È possibile copiare i grafici dei dati in documenti Microsoft Word, Excel o PowerPoint. La risoluzione
dell’immagine corrisponde a quella della schermata da cui è stata ottenuta l’immagine.

Per copiare i grafici in un file Microsoft

1. Nella finestra Data Analysis (Analisi dei dati), fare clic su Copy To Clipboard (Copia negli Appunti)
nell'angolo in alto a destra del riquadro del grafico.

2. Aprire un file Microsoft vuoto e incollare il contenuto dagli Appunti.

Elementi comuni del menu di scelta rapida per i grafici
La Tabella 15 elenca gli elementi del menu selezionabili con pulsante destro del mouse e che sono
disponibili nei grafici. Alcuni degli elementi sono presenti per tutti i grafici, inclusi gli elementi per
modificare la modalità di visualizzazione dei dati o per esportare facilmente i dati da un grafico.

Elemento Funzione

Copy (Copia) Copia il grafico negli appunti.

Save Image As
(Salva immagine
con nome)

Consente di salvare l'immagine con una dimensione, una risoluzione e un tipo di
file specificati, inclusi PNG (predefinito), JPG e BMP.

Page Setup
(Imposta pagina)

Consente di visualizzare le opzioni di impostazione della stampa.

Print (Stampa) Stampa il grafico.

Tabella 15. Elementi del menu di scelta rapida per i grafici

216 | Software CFX Maestro Dx SE



Grafici

Elemento Funzione

Set Scale to Default
(Imposta scala su
predefinito)

Riporta il grafico alla sua visualizzazione predefinita dopo averlo ingrandito.

Chart Options
(Opzioni grafico)

Consente di aprire la finestra Chart Options (Opzioni grafico) per modificare il
grafico, ad esempio cambiando il titolo, selezionando i limiti per gli assi x e y,
mostrando le linee della griglia e i segni di graduazione secondari negli assi.

Nota: gli elementi del menu che si applicano a determinati grafici sono descritti nel Capitolo 11,
Dettagli dell’analisi dei dati.
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Fogli di calcolo
I fogli di calcolo visualizzati in Data Analysis (Analisi dei dati) includono opzioni per l’ordinamento e il
trasferimento dei dati. Ordinare le colonne in base a uno dei seguenti metodi:

n Fare clic e trascinare una colonna in una nuova posizione nella tabella selezionata.

n Fare clic sull'intestazione della colonna per ordinare i dati in ordine crescente e decrescente.

Per ordinare fino a tre colonne di dati nella finestra Sort (Ordina)

1. Fare clic con il tasto destro sul foglio di calcolo e selezionare Sort (Ordina).

2. Nella finestra di dialogo Sort (Ordina), selezionare il primo titolo colonna da ordinare. Ordinare i dati
in ordine crescente e decrescente.

3. Selezionare una seconda o terza colonna da ordinare e scegliere Ascending (Crescente) o
Descending (Decrescente).

4. Fare clic su OK per ordinare i dati oppure fare clic su Cancel (Annulla) per interrompere
l’ordinamento.

Suggerimento: evidenziare i dati sui grafici associati e sul selettore dei pozzetti mantenendo il
cursore del mouse su una cella. Fare clic in una cella per copiare e incollare il suo contenuto in un
altro programma software.

Elementi comuni del menu di scelta rapida per i fogli di calcolo
La Tabella 16 elenca gli elementi del menu di scelta rapida in una qualunque visualizzazione del foglio di
calcolo.

Elemento Funzione

Copy (Copia) Copia il contenuto dei pozzetti selezionati negli appunti, quindi lo
incolla in un foglio di calcolo come Excel.

Copy as Image (Copia come
immagine)

Copia la vista del foglio di calcolo come file di immagine e la incolla
in un file che accetta un file di immagine, come ad esempio i file di
testo, di immagine o di foglio di calcolo.

Print (Stampa) Stampa la visualizzazione corrente.

Print Selection (Stampa
selezione)

Stampa la selezione corrente.

Tabella 16. Elementi del menu di scelta rapida per i fogli di calcolo

218 | Software CFX Maestro Dx SE



Fogli di calcolo

Elemento Funzione

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to Text (Esporta in
formato testo)

Esporta i dati in un editor di testo.

Export to CSV (Esporta in CSV) Esporta i dati in un file .csv.

Export to Xml (Esporta in Xml) Esporta i dati in un file .xml.

Export to Html (Esporta in Html) Esporta i dati in un file .html.

Find (Trova) Cerca un testo.

Sort (Ordina) Ordina i dati selezionando fino a tre colonne.

Select Columns (Seleziona
colonne)

Seleziona le colonne che saranno visualizzate nel foglio di calcolo.

Tabella 16. Elementi del menu di scelta rapida per i fogli di calcolo, continua
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Export (Esporta)
CFX Maestro Dx SE offre diverse opzioni di esportazione dal menu a discesa Export (Esporta):

n Export All Data Sheets (Esporta tutte le schede dati)

n Export RDML Files (Esporta file RDML)

n Custom Export (Esportazione personalizzata)

n Export to LIMS Folder (Esporta nella cartella LIMS)

n Manual Export (Esportazione manuale)

Esportazione di tutte le schede di dati
È possibile esportare tutte le viste dei fogli di calcolo da ogni scheda di CFX Maestro Dx SE in singoli file.

Per esportare tutte le schede di dati

u Selezionare Export > Export All Data Sheets (Esporta > Esporta tutte le schede dati), quindi
selezionare il tipo di file desiderato:

n CSV (*.csv)

n Testo (*.txt)

n Cartella di lavoro di Excel (*.xlsx)

Le analisi esportate vengono salvate in più file della cartella di lavoro di Excel con una scheda
del foglio di lavoro dei dati di analisi per file. Quando un'analisi include più fluorofori, i dati di
ciascun fluoroforo vengono esportati in una scheda del foglio di lavoro separata.

n Cartella di lavoro Excel - combinata (*.xlsx)

Le analisi esportate vengono salvate in un singolo file della cartella di lavoro di Excel che include
più schede del foglio di lavoro, una per ogni set di dati di analisi.

n Excel 97 - 2003 (*.xls)

Importante: sul computer in uso deve essere installato Microsoft Excel per poter esportare
i dati in un foglio di calcolo Microsoft Excel.

n Xml (*.xml)
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Esportazione dei file RDML
RDML è uno standard universale di dati strutturati per lo scambio dei dati della PCR quantitativa (qPCR).
Lo standard per lo scambio dei dati è un file di testo in formato .xml (Extensible Markup Language). Per
ulteriori informazioni sul formato per lo scambio dei dati RDML, fare riferimento al sito web del consorzio
internazionale RDML (www.rdml.org).

Importante: i file RDML esportati includono dati di analisi con le impostazioni di base applicate nella
finestra Data Analysis (Analisi dei dati). Per ulteriori informazioni sulle impostazioni di base, vedere
Impostazioni della linea basale a pagina 202.

Nota: se si utilizza la versione 2.3 o una versione successiva del software qbase+, salvare il file
RDML come versione 1.1.

Per esportare un file RDML

1. Selezionare Export > Export RDML Files (Esporta > Esporta file RDML) e selezionare RDML v1.1 o
RDML v1.0 dall’elenco che appare.

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. Nella finestra di dialogo Save As (Salva con nome), specificare un nome file e la posizione in cui
salvare il file RDML.

3. Fare clic su OK per salvare il file di esportazione.
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Creazione di un file di esportazione personalizzato
Per creare un file di esportazione personalizzato

1. Selezionare Export > Custom Export (Esporta > Esportazione personalizzata). Viene visualizzata la
finestra di dialogo Custom Export (Esportazione personalizzata).

2. Selezionare il formato di esportazione dall’elenco a discesa che viene visualizzato.

3. Selezionare le caselle di controllo per gli elementi da esportare.

4. (Opzionale) Fare clic su Customize Column Names (Personalizza nomi colonna) per cambiare i nomi
delle colonne.

5. Fare clic su Export (Esporta). Viene visualizzata la finestra di dialogo Save As (Salva con nome).
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6. Nella finestra di dialogo Save As (Salva con nome), specificare un nome file e la posizione in cui
salvare il file esportato.

7. Fare clic su OK per salvare il file di esportazione.
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Esportazione in una cartella LIMS
È possibile esportare i dati in un formato file compatibile con LIMS. Per ulteriori informazioni sulla
creazione, gestione e utilizzo di file LIMS, vedere l’Appendice C, Integrazione LIMS.

Per esportare i dati in formato LIMS

1. Selezionare Export > Export to LIMS Folder (Esporta > Esporta nella cartella LIMS).

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. Nella finestra di dialogo Save As (Salva con nome), specificare un nome file e la posizione in cui
salvare il file esportato.

3. Fare clic su OK per salvare il file di esportazione.

Esportazione dei dati con formattazione Seegene
È possibile esportare i dati da tutte le visualizzazioni del foglio di calcolo in file Excel strutturati
specificatamente per essere utilizzati da Seegene, Inc.

Suggerimento: è inoltre possibile avviare automaticamente il visualizzatore Seegene al termine
dell'esportazione. Per ulteriori informazioni, vedere Comandi del menu Tools (Strumenti) a pagina
67.

Per esportare i dati nel formato specifico di Seegene

1. Selezionare Export (Esporta) > Manual Export (Esportazione manuale).

Viene visualizzata la finestra di dialogo Browse For Folder (Sfoglia per cartelle).

2. Nella finestra di dialogo Browse For Folder (Sfoglia per cartelle), specificare un percorso di cartella in
cui salvare i file Excel con formattazione Seegene (.xlsx) esportati.

Le analisi vengono esportate in più file della cartella di lavoro di Excel con una scheda del foglio di
lavoro dei dati di analisi per file.

3. Fare clic su OK per salvare i file di esportazione.
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La finestra Data Analysis (Analisi dei dati) del Software CFX Maestro Dx, Security Edition comprende
diverse schede da cui visualizzare i dati, spiegate nel dettaglio in questo capitolo.

Suggerimento: è possibile scegliere quali schede visualizzare nella finestra Data Analysis (Analisi
dei dati) utilizzando il menu View (Visualizza). Il layout personalizzato viene salvato nel file di dati.
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Scheda Quantification (Quantificazione)
Utilizzare i dati della scheda Quantification (Quantificazione) per impostare le condizioni di analisi dei dati,
tra cui le impostazioni della linea basale per i singoli pozzetti e le impostazioni di soglia. La scheda
Quantification (Quantificazione) visualizza i dati in queste quattro visualizzazioni:

n Grafico di amplificazione: consente di visualizzare le unità di fluorescenza relativa (RFU) per ciascun
pozzetto in ogni ciclo. Ogni traccia presente nel grafico rappresenta i dati di un singolo fluoroforo in
un pozzetto.

n Curva standard: viene visualizzata solo se l’analisi include pozzetti indicati come standard per il tipo
di campione (Std). La curva standard visualizza il ciclo di soglia tracciato sul registro della quantità
iniziale. La legenda visualizza l’efficienza di reazione (E) per ciascun fluoroforo nei pozzetti con un
tipo di campione standard.

n Well selector (Selettore di pozzetti): consente di selezionare i pozzetti con i dati della fluorescenza
che si desidera mostrare.

n Foglio di calcolo: consente di visualizzare un foglio di calcolo dei dati raccolti nei pozzetti selezionati.

Opzioni fluoroforo
Per visualizzare i dati del fluoroforo nei grafici e nei fogli di calcolo della scheda Quantification
(Quantificazione), selezionare i fluorofori target sotto il grafico di amplificazione. Per nascondere i dati del
fluoroforo nella finestra Data Analysis (Analisi dei dati), selezionare la casella di controllo corrispondente.
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Finestra di dialogo Trace Styles (Stili traccia)
Utilizzando la finestra di dialogo Trace Styles (Stili traccia) è possibile modificare l’aspetto delle tracce nei
grafici di amplificazione e curva di fusione nelle schede Quantification (Quantificazione) e Melt Curve
(Curva di fusione). È possibile poi visualizzare in anteprima le modifiche nel selettore pozzetto che appare
nella finestra di dialogo Trace Styles (Stili traccia).

Modifica degli stili traccia

1. Selezionare un unico fluoroforo nel grafico di amplificazione.

2. Per aprire la finestra di dialogo Trace Styles (Stili traccia), eseguire una delle seguenti operazioni:

n Fare clic su Trace Styles (Stili traccia) nel grafico di amplificazione.

n Selezionare Settings > Trace Styles (Impostazioni > Stili traccia) nella barra dei menu Data
Analysis (Analisi dei dati).

n Fare clic con il pulsante destro e scegliere Trace Styles (Stili traccia).

Viene visualizzata la finestra di dialogo Trace Styles (Stili traccia).

3. Nella finestra di dialogo Trace Styles (Stili traccia), selezionare un gruppo di pozzetti specifico nel
selettore pozzetto nel riquadro inferiore. In alternativa, selezionare i pozzetti che contengono un tipo
di campione nel menu a discesa nella colonnaWells (Pozzetti).

4. Eseguire una delle seguenti operazioni:
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n Per scegliere un colore per i pozzetti selezionati, fare clic sulla casella nella colonna Color
(Colore).

n Per assegnare un simbolo ai pozzetti selezionati, selezionare un simbolo dall’elenco a discesa
Symbol (Simbolo).

n Per colorare rapidamente i pozzetti in base all’etichetta del pulsante, fare clic sull’impostazione
rapida appropriata:

o Random byWell (Casuale in base al pozzetto)

o Random by Replicate (Casuale in base al replicato)

o Use Fluor Colors (Utilizza colori fluoroforo)

o Use Target Colors (Utilizza colori target)

o Use Sample Colors (Utilizza colori campione)

n Per assegnare le etichette dei pozzetti, scegliere Sample Type (Tipo campione), Target Name
(Nome target), Sample Name (Nome campione) o Symbol (Simbolo).

Opzione Log Scale (Scala logaritmica)
Selezionare Log Scale (Scala logaritmica) sotto il grafico di amplificazione per visualizzare le tracce della
fluorescenza in una scala semilogaritmica:

Suggerimento: per ingrandire un’area del grafico, trascinare il cursore sull’area desiderata. Per
tornare alla visualizzazione completa, fare clic con il pulsante destro del mouse sul grafico e
selezionare Set Scale to Default (Imposta scala predefinita).
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Grafico della curva standard
Il software crea un grafico della curva standard nella scheda Quantification (Quantificazione) se i dati
includono i tipi di campione definiti come Std per almeno un fluoroforo nell’analisi.

Nel grafico della curva standard vengono visualizzate le seguenti informazioni:

n Nome per ciascuna curva (il fluoroforo o il target).

n Il colore di ogni fluoroforo o target.

n L’efficienza della reazione (E). Utilizzare questa statistica per ottimizzare una reazione multiplex e
per equalizzare i dati per una curva standard.

Nota: l’efficienza della reazione descrive quanto del target viene prodotto con ogni ciclo del
protocollo. Un’efficienza del 100% indica che si sta raddoppiando il target con ogni ciclo.

n Coefficiente di determinazione, R2 (scritto come R^2). Utilizzare questa statistica per determinare il
livello di correttezza della descrizione dei dati da parte della linea (bontà di adattamento).

n Pendenza

n Intercetta y

Guida per l’utente | 229



Capitolo 11 Dettagli dell’analisi dei dati

Opzioni del menu del grafico di amplificazione
Oltre alle comuni opzioni del menu di scelta rapida per i grafici (vedere Elementi comuni del menu di
scelta rapida per i grafici a pagina 216), nella Tabella 17 vengono elencate le opzioni di menu disponibili
solo per il grafico di amplificazione.

Opzione di menu Funzione

Well XX, Fluor Target
(Pozzetto XX, Fluoroforo
target)

Visualizza solo questo pozzetto, rimuove questo pozzetto dalla
visualizzazione, imposta il colore per questa traccia o esclude questo
pozzetto dall’analisi.

Selected Traces (Tracce
selezionate)

Visualizza solo questi pozzetti, rimuove questi pozzetti dalla
visualizzazione, imposta il colore per queste tracce o esclude questi
pozzetti dall’analisi.

Show Threshold Values
(Mostra valori soglia)

Visualizza il valore della soglia per ogni curva di amplificazione nel
grafico.

Trace Styles (Stili tracce) Apre la finestra Trace Styles (Stili tracce) per modificare gli stili delle
tracce che appaiono nelle tabelle Quantification (Quantificazione) e Melt
Curve (Curva di fusione).

Baseline Thresholds
(Soglie linea basale)

Apre la finestra Baseline Thresholds (Soglie linea basale) per modificare
la linea basale o le soglie di ogni fluoroforo (le modifiche sono visualizzate
nel grafico di amplificazione nella scheda Quantification
(Quantificazione).

Tabella 17. Voci di menu selezionabili con il pulsante destro e sinistro nel grafico di ampli-
ficazione

Foglio di calcolo della scheda Quantification (Quantificazione)
Nella Tabella 18 vengono definiti i dati visualizzati nel foglio di calcolo della scheda Quantification
(Quantificazione).

Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Target (Target) Nome target caricato nei pozzetti dell’editor piastra

Tabella 18. Contenuto del foglio di calcolo della scheda Quantification (Quantificazione)
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Informazione Descrizione

Content (Contenuto) Una combinazione di tipo campione (necessario) e N. replicato
(opzionale) caricati nell’editor piastra

Sample (Campione) Nome campione caricato nei pozzetti dell’editor piastra

Cq Ciclo di quantificazione per ciascuna traccia

Modifica dei dati del target, del contenuto o del campione

È possibile cambiare i dati nelle colonne Target (Target), Content (Contenuto) e Sample (Campione)
modificando il file piastra usando l’editor piastra anche dopo aver eseguito l’esperimento.

Per modificare i dati nelle colonne Content (Contenuto), Target e Sample (Campione)

u Fare clic su Plate Setup (Impostazione piastra) e selezionare View/Edit Plate (Visualizza/Modifica
piastra) per aprire l’editor di piastre.
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Scheda Quantification Data (Dati di quantificazione)
La scheda Quantification Data (Dati di quantificazione) mostra i dati di quantificazione raccolti in ogni
pozzetto. CFX Maestro Dx SE mostra i dati in quattro diverse visualizzazioni del foglio di calcolo:

n Results (Risultati): consente di visualizzare un foglio di calcolo dei dati. Questa è la visualizzazione
predefinita.

n Standard Curve Results (Risultati curva standard): consente di visualizzare un foglio di calcolo dei
dati della curva standard.

n Plate (Piastra): consente di visualizzare i dati in ciascun pozzetto come mappa della piastra.

n RFU: consente di visualizzare le quantità di RFU in ciascun pozzetto per ogni ciclo.

Selezionare ogni foglio di calcolo dall’elenco a discesa che è visualizzato sotto la scheda Quantification
Data (Dati di quantificazione).

Foglio di calcolo Results (Risultati)
Nel foglio di calcolo Results (Risultati) vengono visualizzati i dati di ciascun pozzetto della piastra.

Nota: tutti i calcoli della deviazione standard sono validi per i gruppi di replicati assegnati nei pozzetti
della finestra dell’editor piastra. I calcoli stabiliscono la media del valore Cq per ciascun pozzetto
presente nel gruppo di replicati.

Nella Tabella 19 vengono definiti i dati visualizzati nel foglio di calcolo Results (Risultati).
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Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Target (Target) Nome del target di amplificazione (gene)

Content (Contenuto) Tipo di campione e n. di replicati

Sample (Campione) Descrizione del campione

Biological Set Name (Nome set
biologico)

Nome del set biologico

Cq Ciclo di quantificazione

CqMean (Media Cq) Media del ciclo di quantificazione per il gruppo di replicati

Cq Std. Dev (Dev. std. Cq) Deviazione standard del ciclo di quantificazione per il gruppo di
replicati

Starting Quantity (SQ, Quantità
iniziale)

Stima della quantità iniziale del target

Log Starting Quantity (Registro
quantità iniziale)

Registro della quantità iniziale

SQMean (Media SQ) Media della quantità iniziale

SQ Std. Dev (Dev. std. SQ) Deviazione standard della quantità iniziale nei replicati

Tabella 19. Contenuto del foglio di calcolo Results (Risultati)
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Foglio di calcolo dei risultati della curva standard
Il foglio di calcolo Standard Curve Results (Risultati della curva standard) mostra i parametri calcolati per
la curva standard.

Nella Tabella 20 vengono definiti i dati visualizzati sul foglio di calcolo Standard Curve Results (Risultati
della curva standard).

Informazione Descrizione

Fluor (or Target) [Fluoroforo (o
target)]

Fluoroforo (o target) rilevato

Efficiency (%) (Efficienza %) Efficienza della reazione

Slope (Pendenza) Pendenza della curva standard.

Y-intercept (Intercetta y) Punto nel quale la curva intercetta l’asse y

R^2 Coefficiente di determinazione

Tabella 20. Contenuto del foglio di calcolo Standard Curve Results (Risultati della curva stan-
dard)
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Foglio di calcolo Plate (Piastra)
Il foglio di calcolo Plate (Piastra) visualizza una mappa delle piastre con i dati di un fluoroforo alla volta.

Per visualizzare i dati di un determinato fluoroforo

u Fare clic sulla scheda nella parte inferiore del foglio di calcolo.
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Foglio di calcolo RFU
Nel foglio di calcolo RFU sono visualizzate le letture in unità di fluorescenza relativa (RFU) di ogni
pozzetto, acquisite durante ciascun ciclo dell’analisi. Il numero del pozzetto appare in cima a ciascuna
colonna e il numero del ciclo appare a sinistra di ogni riga.
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Scheda Melt Curve (Curva di fusione)
Per coloranti che legano il DNA e sonde di ibridazione non scindibili, la fluorescenza è più brillante
quando i due filamenti di DNA si appaiano. Tuttavia, se la temperatura aumenta verso la temperatura di
fusione (Tm), la fluorescenza diminuisce a una velocità costante (pendenza costante). Alla Tm si osserva
una drastica riduzione della fluorescenza con una notevole variazione della pendenza. La velocità di
questa variazione viene determinata tracciando la prima regressione negativa della fluorescenza rispetto
alla temperatura (-d(RFU)/dT). La velocità più elevata di variazione della fluorescenza determina picchi
visibili e rappresenta la Tm dei complessi di DNA a doppia elica.

CFX Maestro Dx SE traccia i dati RFU raccolti durante una curva di fusione in funzione della temperatura.
Per analizzare i dati del picco di fusione, il software assegna a ogni picco una temperatura iniziale e finale
muovendo la barra della soglia. Il piano dell’area del picco è specificato dalla posizione della barra della
soglia di fusione. Un picco valido deve avere un’altezza minima rispetto alla distanza tra la barra della
soglia e l’altezza del picco più alto.

La scheda Melt Curve (Curva di fusione) visualizza la Tm (temperatura di fusione) dei prodotti di PCR
amplificati, in quattro visualizzazioni:

n Melt Curve (Curva di fusione): consente di visualizzare i dati in tempo reale per ogni fluoroforo come
unità RFU per temperatura per ogni pozzetto.

n Melt Peak (Picco di fusione): consente di visualizzare la regressione negativa dei dati RFU per
temperatura per ogni pozzetto.

n Well selector (Selettore di pozzetti): consente di visualizzare i pozzetti per i quali mostrare o
nascondere i dati.

n Peak spreadsheet (Foglio di calcolo del picco): consente di visualizzare i dati raccolti nel pozzetto
selezionato.

Nota: questo foglio di calcolo visualizza fino a due picchi per ogni traccia. Per visualizzare più
picchi, fare clic sulla scheda Melt Curve Data (Dati curva di fusione).
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Nella Tabella 21 vengono definiti i dati visualizzati nel foglio di calcolo della curva di fusione.

Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content
(Contenuto)

Una combinazione di tipo di campione e numero del replicato

Sample
(Campione)

Nome del campione caricato nell’editor piastra.

Melt Temp
(Temperatura di
fusione)

La temperatura del picco di fusione per ogni pozzetto

Nota: in questo foglio di calcolo vengono visualizzati solo i due picchi più alti.

Tabella 21. Contenuto del foglio di calcolo Melt Curve (Curva di fusione)
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Correzione dei dati della curva di fusione
Per correggere i dati della curva di fusione

u Eseguire una delle seguenti operazioni:

n Fare clic e trascinare le barre della soglia nel grafico Melt Peak (Picco di fusione) per includere o
escludere i picchi nell’analisi dei dati.

n Selezionare Positive (Positivo) nel menu a discesa Peaks (Picchi) per visualizzare i dati del
foglio di calcolo per i picchi al di sopra della linea della soglia di fusione o selezionare Negative
(Negativo) per visualizzare i dati del foglio di calcolo per i picchi al di sotto della linea della soglia
di fusione.

n Aprire la finestra Trace Styles (Stili traccia) per cambiare il colore delle tracce nei grafici Melt
Curve (Curva di fusione) e Melt Peak (Picco di fusione).

n Selezionare un numero nel selettore Step Number (Numero fase) per visualizzare i dati della
curva di fusione in un’altra fase del protocollo. L’elenco mostra più di una fase se il protocollo
include letture piastra in più di una fase della curva di fusione.

n Selezionare i pozzetti nel selettore di pozzetti per concentrarsi sui sottoinsiemi dei dati.

n Selezionare un gruppo di pozzetti per visualizzare e analizzare un sottoinsieme dei pozzetti nella
piastra. Nel menu a discesa Well Group (Gruppo di pozzetti) presente nella barra degli
strumenti, selezionare ogni gruppo di pozzetti per nome.
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Scheda Melt Curve Data (Dati curva di fusione)
La scheda Melt Curve Data (Dati curva di fusione) mostra i dati della scheda Melt Curve (Curva di fusione)
in più fogli di calcolo che includono tutti i picchi di fusione per ciascuna traccia. CFX Maestro Dx SE offre
quattro opzioni di foglio di calcolo in cui visualizzare i dati della curva di fusione:

n Melt Peaks (Picchi di fusione): consente di visualizzare tutti i dati, compresi tutti i picchi di fusione, per
ciascuna traccia. Questa è la visualizzazione predefinita.

n Plate (Piastra): consente di visualizzare una vista dei dati e i contenuti di ciascun pozzetto nella
piastra.

n RFU: consente di visualizzare le quantità RFU a ciascuna temperatura per ciascun pozzetto.

n -d(RFU)/dT: consente di visualizzare la velocità di variazione negativa nella RFU al variare della
temperatura (T). Si tratta di un primo grafico di regressione per ciascun pozzetto nella piastra.

Selezionare ogni foglio di calcolo dall’elenco a discesa che è visualizzato sotto la scheda Melt Curve Data
(Dati curva di fusione).

Foglio di calcolo dei picchi di fusione
Il foglio di calcolo dei picchi di fusione visualizza tutti i dati della curva di fusione.

La Tabella 22 a pagina 241 definisce i dati che vengono visualizzati nel foglio di calcolo dei picchi di
fusione.
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Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content (Contenuto) Tipo di campione elencato nella finestra dell’editor piastra

Target (Target) Target di amplificazione (gene)

Sample (Campione) Nome del campione elencato nella finestra dell’editor piastra

Melt Temperature (Temperatura di
fusione)

La temperatura di fusione di ciascun prodotto, elencata come un
picco (massimo) per riga nel foglio di calcolo

Peak Height (Altezza picco) Altezza del picco

Begin Temperature (Temperatura
iniziale)

Temperatura all’inizio del picco

End Temperature (Temperatura
finale)

Temperatura alla fine del picco

Tabella 22. Contenuto del foglio di calcolo Melt Peaks (Picchi di fusione)

Foglio di calcolo Plate (Piastra)
Il foglio di calcolo Plate (Piastra) visualizza i dati della curva di fusione in formato piastra.

Nota: per regolare il picco che richiama il software, regolare la linea di soglia nel grafico del picco di
fusione sulla scheda Melt Curve (Curva di fusione).

Nella Tabella 23 a pagina 242 vengono definiti i dati visualizzati nel foglio di calcolo della piastra.
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Informazione Descrizione

Content
(Contenuto)

Combinazione di tipo di campione (necessario) e del n. di replicati (facoltativo)

Sample
(Campione)

Descrizione del campione

Peak 1 (Picco 1) Primo picco di fusione (massimo)

Peak 2 (Picco 2) Secondo picco di fusione (inferiore)

Tabella 23. Contenuto del foglio di calcolo Plate (Piastra)

Foglio di calcolo RFU
Il foglio di calcolo RFU visualizza la fluorescenza per ciascun pozzetto durante ogni ciclo acquisito
durante la curva di fusione.

Nella Tabella 24 sono definiti i dati visualizzati nel foglio di calcolo RFU.

Informazione Descrizione

Numero di pozzetto (A1, A2, A3, A4, A5) Posizione del pozzetto nella piastra per i
pozzetti caricati

Temperatura Temperatura di fusione del target amplificato,
tracciata come unico pozzetto per fila e vari
pozzetti per più prodotti nello stesso pozzetto

Tabella 24. Contenuto del foglio di calcolo RFU
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Foglio di calcolo -d(RFU)/dT
Il foglio di calcolo -d(RFU)/dT visualizza la velocità di variazione negativa nella RFU al variare della
temperatura (T).

Nella Tabella 25 vengono definiti i dati visualizzati sul foglio di calcolo -d(RFU)/dT.

Informazione Descrizione

Numero di pozzetto (A1, A2, A3, A4, A5) Posizione del pozzetto nella piastra per i pozzetti caricati

Temperatura -d(RFU)/dT Tasso negativo di cambio in RFU quando cambia la
temperatura (T)

Tabella 25. Contenuto del foglio di calcolo -d(RFU)/dT
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Scheda End Point (Punto finale)
Aprire la scheda End Point (Punto finale) per analizzare le unità di fluorescenza relativa (RFU) finali per i
pozzetti di campione. Il software confronta i livelli RFU per i pozzetti con campioni sconosciuti con i livelli
RFU per i pozzetti con controlli negativi e “richiama” il valore positivo o negativo sconosciuto. I campioni
positivi hanno un valore RFUmaggiore del valore RFUmedio dei controlli negativi più il valore di cutoff.

Per analizzare i dati del punto finale, la piastra deve contenere i controlli negativi; altrimenti il software non
può effettuare la chiamata.

n Eseguire un protocollo di quantificazione: impostare un protocollo standard. Al termine dell’analisi,
aprire la finestra Data Analysis (Analisi dei dati), modificare le impostazioni di analisi dei dati nella
scheda Quantification (Quantificazione), quindi fare clic sulla scheda End Point (Punto finale) per
scegliere un ciclo del punto finale.

n Eseguire un protocollo End Point Only (Solo punto finale): caricare il protocollo End Point Only (Solo
punto finale) nella scheda Plate (Piastra) della finestra Run Setup (Impostazione analisi), selezionare
o creare una piastra e avviare l’analisi.

Nella scheda End Point (Punto finale) sono visualizzati i valori medi RFU per determinare se il target è
stato amplificato dall’ultimo ciclo (finale). Utilizzare questi dati per stabilire se è presente (positivo) una
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particolare sequenza target in un campione. I target positivi hanno valori RFU maggiori del livello di cut-off
definito dall’utente.

Suggerimento: per creare un protocollo end point, aprire la scheda Protocol (Protocollo) nella
finestra Run Setup (Impostazione analisi) e selezionare Run > End Point Only Run (Analisi > Analisi
solo punto finale).

Al termine dell’analisi, il file di dati si apre nella scheda End Point (Punto finale), che comprende le
seguenti sezioni:

n Settings (Impostazioni): consente di modificare le impostazioni dell’analisi dei dati.

n Results (Risultati): consente di visualizzare i risultati immediatamente dopo avere modificato le
impostazioni.

n Well Selector (Selettore pozzetti): consente di selezionare i pozzetti con i dati al punto finale che si
intende visualizzare.

n RFU spreadsheet (Foglio di calcolo RFU): consente di visualizzare il valore RFU finale rilevato nei
pozzetti selezionati.

Dati relativi ai risultati
Nella sezione Results (Risultati) vengono visualizzati i seguenti dati:

n Lowest RFU value (Valore RFUminimo): il valore RFUminimo nei dati

n Highest RFU value (Valore RFUmassimo): il valore RFUmassimo nei dati

n Negative Control Average (Media controlli negativi): RFU media per i pozzetti che contengono
controlli negativi

n Cut Off Value (Valore di cut-off): calcolato aggiungendo la tolleranza (RFU o percentuale di intervallo
elencate nelle impostazioni) e la media dei controlli negativi. I campioni con RFUmaggiori del valore
di cut-off verranno chiamati "Positive" (Positivi). Per regolare il valore di cut-off, modificare RFU o
Percentage of Range (Percentuale di intervallo)

Il valore di cut-off viene calcolato utilizzando questa formula:

Valore di cutoff = media dei controlli negativi + tolleranza

Selezionare una tolleranza utilizzando uno di questi metodi:

n RFUs (RFU) (impostazione predefinita): selezionare questo metodo per utilizzare un valore RFU
assoluto per la tolleranza. Il valore di tolleranza RFUminimo è 2. Il valore massimo è il valore
assoluto del valore RFUmassimo, meno il valore assoluto del valore RFUminimo. Il valore di
tolleranza RFU predefinito è il 10% dell’intervallo RFU totale.
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n Percent of Range (Percentuale di intervallo): selezionare questo metodo per utilizzare una
percentuale dell’intervallo RFU per la tolleranza. La percentuale di intervallo minima è 1%. La
percentuale di intervallo massima è 99%. La percentuale di intervallo predefinita è 10%.
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Regolazione dell’analisi dei dati del punto finale
Per modificare i dati nella scheda End Point (Punto finale)

u Eseguire una delle seguenti operazioni:

n Scegliere un fluoroforo dall’elenco a discesa.

n Scegliere un valore End Cycle to Average (Cicli finali per media) per impostare il numero di cicli
con cui calcolare la RFUmedia al punto finale.

n Selezionare RFUs (RFU) per visualizzare i dati in unità di fluorescenza relativa.

n Selezionare Percentage of Range (Percentuale di intervallo) per visualizzare i dati come
percentuale dell’intervallo RFU.

n Selezionare i pozzetti nel selettore di pozzetti per concentrarsi sui sottoinsiemi dei dati.

n Selezionare un gruppo di pozzetti per visualizzare e analizzare un sottoinsieme dei pozzetti nella
piastra. Nel menu a discesa Well Group (Gruppo di pozzetti) presente nella barra degli
strumenti, selezionare ogni gruppo di pozzetti per nome.

Foglio di calcolo RFU per l’analisi al punto finale
Nella Tabella 26 vengono definiti i dati visualizzati nel foglio di calcolo RFU della scheda End Point (Punto
finale).

Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content (Contenuto) Combinazione del tipo di campione e del n. di replicati

End RFU (RFU finale) RFU nel ciclo del punto finale

Call (Richiamo) Positivo o negativo, dove i campioni positivi hanno un valore RFUmaggiore
della media RFU dei controlli negativi più il valore di cutoff

Sample (Campione) Nome del campione caricato nell’editor piastra

Tabella 26. Contenuto del foglio di calcolo del punto finale della RFU
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Scheda Allelic Discrimination (Discriminazione allelica)
La scheda Allelic Discrimination (Discriminazione allelica) assegna i genotipi ai pozzetti con campioni
sconosciuti. Usare questi dati per identificare i campioni con genotipi diversi, fra cui Allele 1 (Allele 1),
Allele 2 (Allele 2), Heterozygote (Eterozigote), No Call (Nessuna chiamata) (senza amplificazione) o
Undetermined (Indeterminato).

Nota: i dati per la discriminazione allelica devono derivare dalle analisi multiplex con almeno due
fluorofori. Ciascun fluoroforo identifica un allele in tutti i campioni.

L’analisi della discriminazione allelica richiede il seguente contenuto minimo del pozzetto:

n Due fluorofori in ciascun pozzetto

n Campioni NTC (No Template Control) per l’analisi ottimizzata dei dati

CFX Maestro Dx SE offre quattro opzioni in cui visualizzare i dati della discriminazione allelica:

n Grafico della discriminazione allelica: consente di visualizzare i dati in un grafico della RFU per Allele
1/Allele 2. Ciascun punto del grafico rappresenta i dati di entrambi i fluorofori in un pozzetto. È
possibile passare tra le coordinate cartesiane e quelle polari selezionando e deselezionando la
casella di controllo Polar Coordinates (Coordinate polari). Le coordinate cartesiane rappresentano la
RFU per Allele 1 sull’asse x e la RFU per Allele 2 sull’asse y. Le coordinate polari rappresentano
l’angolo sull’asse x e la distanza tra l’origine e la RFU sull’asse y (mediana di tutti gli NTC).
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n Foglio di lavoro del pozzetto: consente di visualizzare i dati della discriminazione allelica raccolti in
ciascun pozzetto della piastra.

n Selettore pozzetto: consente di selezionare i pozzetti con i dati allelici che si desidera mostrare.

n Pannello Selected Fluorophores (Fluorofori selezionati): consente di modificare le etichette dell’asse
x e dell’asse y nel grafico della discriminazione allelica, il ciclo da analizzare e se visualizzare la
mappa delle chiamate.

Regolazione dei dati per la discriminazione allelica
Il software assegna automaticamente un genotipo ai pozzetti con campioni sconosciuti, in base alle
posizioni degli NTC e all’angolo e alla distanza dei punti dati sconosciuti rispetto agli NTC.

Per modificare i dati della discriminazione allelica

u Eseguire una delle seguenti operazioni:

n Per visualizzare le coordinate polari, selezionare la casella di controllo nel grafico della
discriminazione allelica.

n Per visualizzare un altro fluoroforo, sceglierlo dall’elenco a discesa nel pannello Selected
Fluorophores (Fluorofori selezionati).

n Per modificare una chiamata, trascinare il cursore sui punti dati nel diagramma della
discriminazione allelica e scegliere un’opzione dall’elenco Selected Wells (Pozzetti selezionati):

o Allele 1 (Allele 1)

o Allele 2 (Allele 2)

o Heterozygote (Eterozigote)

o Undetermined (Indeterminato)

o No Call (Nessuna chiamata)

o Auto Call (Chiamata automatica)

Suggerimento: selezionare Auto Call (Chiamata automatica) per tornare alla chiamata
predefinita.
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Opzioni di menu dei grafici
Oltre alle opzioni comuni del menu di scelta rapida per i grafici (vedere Elementi comuni del menu di
scelta rapida per i grafici a pagina 216), la Tabella 27 elenca le opzioni di menu disponibili nel grafico
Allelic Discrimination (Discriminazione allelica).

Opzione di menu Funzione

Zoom Focalizza la visualizzazione del grafico nell’area selezionata
(facendo clic e trascinando il cursore nel grafico).

Suggerimento: per ripristinare lo zoom e mostrare tutti i punti
dei dati, fare clic con il pulsante destro del mouse e scegliere
Set Scale to Default (Imposta scala su predefinito).

Well (Pozzetto) Le opzioni disponibili per il pozzetto selezionato sono: Display only
this well (Visualizza solo questo pozzetto), Remove this well from
view (Rimuovi questo pozzetto dalla visualizzazione), Set color for
this trace (Imposta colore per questa traccia) o Exclude this well from
analysis (Escludi questo pozzetto dall’analisi).

Selected Wells (Pozzetti
selezionati)

Le opzioni disponibili per i pozzetti selezionati (selezionati facendo
clic e trascinando il cursore nel grafico) sono: Display only these
wells (Visualizza solo questi pozzetti), Remove these wells from
view (Rimuovi questi pozzetti dalla visualizzazione), Set color for
these traces (Imposta colore per queste tracce) o Exclude these
wells from analysis (Escludi questi pozzetti dall’analisi).

Tabella 27. Opzioni di menu selezionabili con il pulsante destro e sinistro del mouse del gra-
fico Allelic Discrimination (Discriminazione allelica)

Foglio di calcolo della discriminazione allelica
La Tabella 28 definisce i dati visualizzati sul foglio di calcolo della discriminazione allelica.

Informazione Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Sample (Campione) Descrizione del nome campione

Tabella 28. Contenuto del foglio di calcolo della discriminazione allelica
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Informazione Descrizione

Call (Richiamo) Identità dell’allele, fra cui Allele 1 (Allele 1), Allele 2 (Allele 2),
Heterozygote (Eterozigote), No Call (Nessun richiamo) o
Undetermined (Indeterminato)

Tipo Auto (Automatico) o Manual (Manuale), descrive come è stato
effettuato il richiamo. Automatico indica che il richiamo è stato
selezionato dal software. Manuale indica che il richiamo è stato scelto
dall’operatore.

RFU1 RFU per Allele 1

RFU2 RFU per Allele 2

Tabella 28. Contenuto del foglio di calcolo della discriminazione allelica, continua
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Scheda di visualizzazione personalizzata dei dati
La scheda Custom Data View (Visualizzazione personalizzata dei dati) visualizza più riquadri in un
formato personalizzabile.

L’elenco a discesa Load a Preset View (Carica vista predefinita) offre una scelta di modelli di formati di
visualizzazione. La vista predefinita visualizzata dipende dal file analizzato. Ad esempio, se sono presenti
i dati della curva di fusione, appare la vista predefinita Amp+Melt.
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Creazione di una vista personalizzata dei dati
Per creare una vista personalizzata dei dati

u Eseguire una delle seguenti operazioni:

n Dall’elenco a discesa, selezionare una vista preimpostata alternativa.

n Dall’elenco a discesa che si trova nella parte superiore di ciascun riquadro, selezionare un’altra
vista del grafico.

n Cambiare il numero di righe e colonne nella scheda.

n Modificare le dimensioni dei singoli riquadri. Trascinare le barre verso il bordo di ciascun
riquadro.

Fare clic su Save as Preset (Salva come preimpostato) per salvare la vista personalizzata come modello
preimpostato. Fare clic su Manage Presets (Gestisci preimpostazioni) per eliminare, rinominare o
ripristinare le viste preimpostate esistenti.
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Scheda QC (CQ)
Utilizzare la scheda QC (CQ) per valutare velocemente la qualità dei dati dell’analisi in base alle regole
definite nella scheda QC (CQ) della finestra User Preferences (Preferenze utente).

CFX Maestro Dx SE offre quattro opzioni in cui visualizzare i dati del CQ:

n Amplification chart (Grafico di amplificazione): consente di visualizzare la RFU per ciascun
pozzetto a ogni ciclo. Ogni traccia presente nel grafico rappresenta i dati di un singolo fluoroforo in un
pozzetto.

n QC rules table (Tabella delle regole CQ): consente di visualizzare le regole di CQ e le impostazioni
che definiscono ogni regola. Le regole di CQ applicate sono indicate da un segno di spunta.

n Well selector (Selettore di pozzetti): consente di selezionare i pozzetti con i dati della fluorescenza
che si desidera mostrare.

n QC rule summary pane (Riquadro di riepilogo della regola di CQ): consente di visualizzare la regola
di CQ selezionata ed evidenzia i pozzetti che non soddisfano tale regola.
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Modifica dei criteri CQ
Per modificare i criteri CQ

u Selezionare o deselezionare la casella di controllo Use (Utilizza) per la regola da includere o
escludere dal controllo qualità.

Esclusione dei pozzetti che non superano il CQ
CFX Maestro Dx SE visualizza i pozzetti che non superano i criteri di CQ nella colonna Results (Risultati)
presente nella tabella delle regole di CQ e nel riquadro di riepilogo.

Per escludere i pozzetti che non soddisfano i criteri di CQ

u Selezionare Exclude Wells (Escludi pozzetti) per ogni pozzetto da escludere.
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Scheda Run Information (Informazioni analisi)
Nella scheda Run Information (Informazioni analisi) sono indicati il protocollo e altre informazioni su
ciascuna analisi. Utilizzare questa scheda per eseguire quanto segue:

n Visualizzare il protocollo.

n Immettere o modificare note sull’analisi.

n Immettere o modificare l’ID o il codice a barre per l’analisi.

n Visualizzare gli eventi che potrebbero essersi verificati durante l’analisi. Utilizzare questi messaggi
per contribuire alla risoluzione di errori in un’analisi.

Suggerimento: con il pulsante destro del mouse, fare clic sul protocollo per copiarlo, esportarlo o
stamparlo. Con il pulsante destro del mouse, fare clic sui riquadri Notes (Note), ID/Bar Code
(ID/Codice a barre) o Other (Altro) per annullare, tagliare, copiare, incollare, eliminare o selezionare il
testo.
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Report di analisi dei dati
Nella finestra di dialogo Report vengono visualizzate le informazioni sul file di dati corrente della finestra
Data Analysis (Analisi dei dati). Per aprire un report, selezionare Tools > Reports (Strumenti > Report)
oppure fare clic su Reports (Report) sulla barra degli strumenti.

Nella finestra di dialogo Report sono incluse le seguenti sezioni:

n Menu e barra degli strumenti: fornisce le opzioni per formattare, salvare e stampare il report o il
modello.

n Elenco delle opzioni (in alto a sinistra della finestra di dialogo): fornisce le opzioni da visualizzare nel
report.

n Riquadro delle opzioni (in basso a sinistra della finestra di dialogo): consente di visualizzare le
caselle di testo in cui è possibile immettere informazioni relative all’opzione selezionata.

n Riquadro di anteprima (a destra della finestra di dialogo): consente di visualizzare l’anteprima del
report corrente.
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Categorie dei report di analisi dei dati
Nella Tabella 29 vengono elencate tutte le opzioni disponibili per un report di analisi dei dati, a seconda
del tipo di dati presenti nella finestra Data Analysis (Analisi dei dati).

Categoria Opzione Descrizione

Intestazione

Titolo, sottotitolo e logo per il report

Report Information (Informazioni
sul report)

Data di analisi, nome utente, nome file di
dati, percorso file di dati e gruppo di
pozzetti selezionato

Audit Information (Informazioni
audit)

Informazioni aggiuntive richieste per
l’audit, tra cui le firme

Notes (Note) Note sul report di dati

Impostazione dell’analisi

Run Information (Informazioni
analisi)

Data di analisi, nome utente, nome file di
dati, percorso file di dati e gruppo di
pozzetti selezionato

Protocol (Protocollo) Visualizzazione del testo delle fasi e delle
opzioni del protocollo

Plate Display (Display piastra) Visualizzazione delle informazioni della
piastra in ciascun pozzetto della piastra.

Quantificazione

Analysis Settings (Impostazioni
dell’analisi)

Numero di fasi per la raccolta dei dati,
modalità di analisi, e metodica di
sottrazione della linea basale

Amplification Chart (Grafico
dell’amplificazione)

Grafico dell’amplificazione per le analisi
che includono i dati di quantificazione

Standard Curve Chart (Grafico
della curva standard)

Grafico della curva standard

Tabella 29. Categorie dei report di analisi dei dati nell’elenco delle opzioni
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Categoria Opzione Descrizione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Espressione genica – Grafico a barre

Analysis Settings (Impostazioni
dell’analisi)

Modalità di analisi, dati del grafico,
opzione di messa in scala ed errore
grafico

Chart (Grafico) Copia del grafico a barre

Target Names (Nomi target) Grafico dei nomi target

Sample Names (Nomi campione) Grafico dei nomi campione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Target Stability (Stabilità target) Grafico dei valori della stabilità target

Box-and-Whisker Chart
(Diagramma a scatola e baffi)

Diagramma a scatola e baffi

Dot Plot Chart (Grafico a punti) Grafico a punti

Espressione genica - Diagramma di gruppo e grafico di dispersione

Analysis Settings (Impostazioni
dell’analisi)

Impostazioni per ciascun tipo di grafico

Chart (Grafico) Copia del grafico

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun target

Espressione genica – dati ANOVA

ANOVA Settings (Impostazioni
ANOVA)

Soglia del valore P usata nell’analisi

ANOVA Results (Risultati
ANOVA)

Tabella dei risultati dall’analisi ANOVA e
post-hoc HSD di Tukey

Tabella 29. Categorie dei report di analisi dei dati nell’elenco delle opzioni, continua
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Categoria Opzione Descrizione

Curva di fusione

Analysis Settings (Impostazioni
dell’analisi)

Numero fase di fusione e impostazione
della barra di soglia

Melt Curve Chart (Grafico curva
di fusione)

Grafico curva di fusione

Melt Peak Chart (Grafico picco di
fusione)

Grafico picco di fusione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Discriminazione allelica

Analysis Settings (Impostazioni
dell’analisi)

Fluorofori, ciclo e visualizzazione della
mappa delle chiamate

Allelic Discrimination Chart
(Grafico discriminazione allelica)

Copia del grafico di discriminazione
allelica

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Punto finale

Analysis Settings (Impostazioni
dell’analisi)

Fluoroforo, media cicli di fine, modalità,
valore RFU più basso, valore RFU più
alto e valore di cut-off

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Parametri CQ

Data (Dati) Foglio di calcolo che elenca i parametri
per ciascuna regola CQ

Tabella 29. Categorie dei report di analisi dei dati nell’elenco delle opzioni, continua
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Creazione di un report di analisi dei dati
È possibile salvare il layout del report come modello da utilizzare nuovamente per report simili.

Per creare un report di analisi dei dati

1. Prima di creare il report, apportare le modifiche finali al contenuto dei pozzetti, ai pozzetti selezionati,
ai grafici e ai fogli di calcolo nella finestra Data Analysis (Analisi dei dati).

2. Selezionare Tools > Reports (Strumenti > Report) nella barra del menu Data Analysis (Analisi dei
dati) per aprire la finestra di dialogo Report (Report).

3. Scegliere le opzioni che si desidera includere nel report. Il report si apre con le opzioni predefinite
selezionate. Selezionare o deselezionare le caselle di controllo per modificare intere categorie o
singole opzioni all’interno di una categoria.

Nella Tabella 29 a pagina 258 vengono elencate le opzioni disponibili da visualizzare.

Nota: i dati che vengono visualizzati nel report dipendono dalle selezioni correnti effettuate nelle
schede della finestra Data Analysis (Analisi dei dati). Ad esempio, un’analisi di quantificazione
potrebbe non contenere una curva standard e, pertanto, tali dati non vengono visualizzati nella
finestra Data Analysis (Analisi dei dati) o nel report dei dati.

4. Cambiare l’ordine delle categorie e degli elementi in un report. Trascinare le opzioni nella relativa
posizione. Gli elementi possono essere riordinati solamente all’interno delle categorie a cui
appartengono.

5. (Facoltativo) Nel riquadro Report Options (Opzioni report), inserire le informazioni relative all’opzione
selezionata:

n Scegliere un sottoinsieme di informazioni da visualizzare nel report.

n Scegliere impostazioni specifiche per l’opzione selezionata.

n Modificare il testo da visualizzare per l’opzione selezionata.

6. Fare clic su Update Report (Aggiorna report) per aggiornare l’anteprima del report con tutte le
modifiche.

7. Stampare o salvare il report:

a. Fare clic sul pulsante Print Report (Stampa report) nella barra degli strumenti per stampare il
report corrente.

b. Selezionare File > Save (File > Salva) per salvare il report in formato file PDF (file Adobe Acrobat
Reader), MHT (documento Microsoft) o MHTML (documento Microsoft).

c. Selezionare un percorso in cui salvare il file.
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d. Selezionare File > Save As (File > Salva con nome) per salvare il report con un nuovo nome o in
un nuovo percorso.

8. (Facoltativo) Creare un modello di report con le informazioni desiderate. Per salvare le impostazioni
del report attuali in un modello, selezionare Template > Save oppure Save As (Modello > Salva/Salva
con nome). Caricare il modello di report la volta successiva in cui si desidera creare un nuovo report.
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Creazione di report sul gruppo di pozzetti
Per creare un report del gruppo di pozzetti

1. Selezionare Tools > Well Group Reports (Strumenti > Report gruppo di pozzetti) nella finestra Data
Analysis (Analisi dei dati).

2. Nella finestra di dialogo Well Groups Reports (Report gruppi di pozzetti), selezionare tutti i gruppi di
pozzetti, le fasi di amplificazione e le fasi di fusione da includere nel report.

3. Inserire il percorso o navigare fino alla cartella di destinazione in cui salvare il report.

4. (Opzionale) Selezionare Choose a Report Template (Scegli un modello di report) e navigare fino alla
cartella del file modello.

5. (Opzionale) Selezionare Open Destination Folder (Apri cartella di destinazione) per aprire la cartella
e visualizzare i report dopo che sono stati generati.

6. Fare clic su Create Reports (Crea report).
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Con l’utilizzo di controlli rigorosamente qualificati nelle reazioni, è possibile utilizzare il Software
CFX Maestro Dx, Security Edition per eseguire l’analisi dell’espressione genica al fine di normalizzare le
differenze relative in una concentrazione target tra i campioni. Generalmente vengono utilizzati i livelli di
espressione per uno o più geni di riferimento per normalizzare i livelli di espressione di un gene
d’interesse. I geni di riferimento prendono in considerazione il carico di differenze o altre variazioni
rappresentate in ciascun campione e i rispettivi livelli di espressione non dovrebbero essere pregiudicati
nel sistema biologico studiato.

Scegliere la scheda Gene Expression (Espressione genica) nella finestra Data Analysis (Analisi dei dati)
per valutare differenze relative tra le reazioni PCR in due o più pozzetti. Ad esempio, si possono valutare
numeri relativi di genomi virali o numeri relativi di sequenze transfettate in una reazione PCR.
L’applicazione più comune per lo studio dell’espressione genica è il confronto della concentrazione cDNA
in più di una reazione per stimare i livelli dell’RNA messaggero di stato stazionario.

Il software calcola il livello relativo di espressione di un target con uno di questi scenari:

n Il livello relativo di espressione di una sequenza target (Target 1) rispetto a un altro target (Target 2);
ad esempio, la quantità di un gene rispetto a un altro gene in condizioni di trattamento del campione
identiche.

n Livello relativo di espressione di una sequenza target in un campione rispetto allo stesso target in
condizioni di trattamento del campione diverse; ad esempio, la quantità relativa di un gene rispetto a
se stesso in condizioni temporali, geografiche o di sviluppo differenti.

Impostazione della piastra per l’analisi dell’espressione
genica

Per eseguire l’analisi dell’espressione genica, il contenuto dei pozzetti deve includere quanto segue:

n Due o più target: i due target che rappresentano diverse sequenze o geni amplificati nei campioni.

n Uno o più target di riferimento: almeno un target deve essere un target di riferimento per
l’espressione normalizzata. Assegnare tutti i target di riferimento nella finestra Experiment Settings
(Impostazioni esperimento) per analizzare i dati in modalità Normalized Expression (Espressione
normalizzata) (ΔΔCq). Le analisi che non contengono un riferimento devono essere analizzate
usando la modalità Relative Expression (Espressione relativa) (ΔCq).
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n Campioni comuni: le reazioni devono includere campioni comuni (almeno due) per visualizzare i dati
tracciati nella scheda Gene Expression (Espressione genica). Questi campioni devono
rappresentare vari trattamenti o condizioni per ciascuna delle sequenze target. Assegnare un
campione di controllo (opzionale) nella finestra Experiment Settings (Impostazioni esperimento). Se
non si seleziona alcun controllo, il software utilizza il valore Cqminimo come controllo.

I requisiti per l’impostazione Gene Expression (Espressione genica) nell’editor piastra dipendono dal fatto
che il contenuto della reazione sia PCR singleplex, con un fluoroforo nelle reazioni, o PCRmultiplex, con
più di un fluoroforo nelle reazioni.

Impostazione guidata della piastra
Se l’impostazione piastra di un file di dati non contiene le informazioni richieste per l’analisi ed è
selezionata la scheda Gene Expression (Espressione genica), lo spazio normalmente occupato dal
grafico a barre conterrà le istruzioni per inserire queste informazioni. Per l’espressione genica
normalizzata, completare le seguenti fasi:

1. Definire i nomi target e campione usando una delle seguenti opzioni:

n Plate Setup (Impostazione piastra): consente di aprire la finestra dell’editor piastra.

n Replace Plate File (Sostituisci file piastra): consente di aprire il browser Select Plate (Seleziona
piastra), in cui è possibile accedere a un file piastra precedentemente salvato con cui sostituire il
layout della piastra corrente.

n Replace PrimePCR File (Sostituisci file PrimePCR): consente di aprire la finestra di dialogo
Select PrimePCR file (Seleziona file PrimePCR), in cui è possibile accedere a un file di analisi
PrimePCR™ e applicarlo al layout della piastra.

2. Selezionare uno o più target di riferimento a un campione di controllo usando la finestra di dialogo
Experiment Settings (Impostazioni esperimento).

Se la disposizione della piastra contiene già le informazioni sul target e sul campione, è necessario
eseguire solo la seconda fase che è evidenziata in arancione. Questa fase deve essere completata
prima di poter eseguire l’analisi dell’espressione genica normalizzata.

Nota: i dati per il grafico di dispersione e il diagramma di gruppo vengono visualizzati solo se
vengono soddisfatti tutti i requisiti per l’espressione genica normalizzata elencati in Plate Setup
(Impostazione piastra) per Gene Expression Analysis (Analisi espressione genica).
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Grafici dell’espressione genica
CFX Maestro Dx SE visualizza i dati dell’espressione genica in più viste. Nella Tabella 30 sono elencate
le opzioni di rappresentazione grafica disponibili nel software.

Pulsante Nome Funzione

Rappresentazione grafica Consente di visualizzare i dati dell’espressione
genica normalizzata in una delle seguenti
visualizzazioni:

n Grafico a barre (impostazione predefinita)

n Diagramma a scatola e baffi

n Grafico a punti

Diagramma di gruppo Visualizza i dati dell’espressione normalizzata
in una gerarchia basata sul grado di similitudine
dell’espressione per i vari target e campioni.

Grafico di dispersione Visualizza l’espressione normalizzata dei target
per un controllo rispetto ad un campione
sperimentale.

ANOVA Visualizza i risultati di un’analisi ANOVA a un
criterio di classificazione sui dati
dell’espressione genica utilizzando i seguenti
pacchetti R per eseguire l’analisi ANOVA e
determinare i risultati del Tukey test:

n Companion to Applied Regression (car)

n Medie ai minimi quadrati (lsmeans)

Strumento di selezione del gene
di riferimento

(Disponibile nella scheda Study Analysis
(Analisi dello studio) della finestra Gene Study
(Studio dei geni)) Identifica i geni di riferimento
analizzati e li classifica come Ideal (Ideal),
Acceptable (Accettabile) o Unstable (Instabile)
in base alla loro stabilità.

Analisi dei controlli PrimePCR (Disponibile nella scheda Study Analysis
(Analisi dello studio) della finestra Gene Study
(Studio dei geni)) Visualizza i risultati dei
campioni analizzati.

Tabella 30. Opzioni del grafico dell’espressione genica
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Rappresentazione grafica

L’espressione relativa dei target viene rappresentata in queste due viste:

n Grafico dell’espressione genica: consente di visualizzare i dati di PCR in tempo reale con uno dei
seguenti valori:

o ΔΔCq - espressione normalizzata relativa calcolata usando i campioni di controllo e i target di riferimento.

o ΔCq - quantità relativa del gene target in un campione rispetto a un campione di controllo.

Per ulteriori informazioni sulla visualizzazione dei dati, vedere Modifica e annotazione della vista
grafico a pagina 270.

n Foglio di calcolo: consente di visualizzare un foglio di calcolo dei dati dell’espressione genica.

Suggerimento: fare clic con il pulsante destro del mouse su qualsiasi grafico o foglio di calcolo
per visualizzare le opzioni. Selezionare View/Edit Plate (Visualizza/Modifica piastra) dal menu a
discesa Plate Setup (Impostazione piastra) per aprire l’editor piastra e cambiare il contenuto dei
pozzetti nella piastra.

Suggerimento: dal menu di scelta rapida, selezionare Sort (Ordina) per riorganizzare l’ordine
dei nomi target e campione nel grafico.
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Espressione genica normalizzata

Per normalizzare i dati, usare il livello di espressione misurato di uno o più geni di riferimento come fattore
di normalizzazione. I geni di riferimento sono target che non sono regolati nel sistema biologico studiato,
come actina,GAPDH o tubulina.

Per impostare l’analisi dell’espressione genica normalizzata (ΔΔCq)

1. Aprire il file di dati (estensione .pcrd).

2. Revisionare i dati nella scheda Quantification (Quantificazione) della finestra Data Analysis (Analisi
dei dati). Regolare i dati, cambiando ad esempio la soglia e la modalità di analisi.

3. Scegliere la scheda Gene Expression (Espressione genica).

4. Nella scheda Gene Expression (Espressione genica), fare clic su Experiment Settings (Impostazioni
esperimento).

5. Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), procedere come segue:

a. Scegliere la scheda Samples (Campioni) e selezionare un controllo. Quando si assegna un controllo,
CFX Maestro Dx SE normalizza le quantità relative per tutti i geni rispetto alla quantità di controllo,
impostata su 1.

b. Scegliere la scheda Target e selezionare i geni di riferimento. L’analisi dell’espressione genica
richiede un riferimento fra i target nei campioni.

6. Selezionare Normalized Expression (Espressione normalizzata) (ΔΔCq) se non è già stata
selezionata, quindi visualizzare i livelli di espressione nella scheda Gene Expression (Espressione
genica).

Nota: è inoltre possibile usare la procedura di impostazione guidata per impostare il layout della
piastra per l’analisi dell’espressione genica normalizzata.

Quantità relativa

Per definizione, i dati della quantità relativa (ΔCq) non sono normalizzati. Questo metodo viene utilizzato
per quantificare i campioni che non includono geni di riferimento (target). Tipicamente, i ricercatori
confidano in una delle seguenti considerazioni quando approntano la propria analisi:

n Ogni campione contiene la stessa quantità di RNA o cDNA in ogni pozzetto.

n Ogni variazione nella quantità di campione biologico caricato sarà normalizzata dopo l’analisi con un
metodo utilizzato nell’analisi dei dati esterno al software. Ad esempio, un ricercatore potrebbe
scegliere di dividere il valore della quantità relativa per il fattore di normalizzazione, possibilmente la
massa di acido nucleico caricata per ciascun campione o il numero di cellule da cui è stato isolato
l’acido nucleico.
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Per eseguire un’analisi della quantità relativa (ΔCq)

u Nella scheda Gene Expression (Espressione genica), selezionare Relative Quantity (Quantità
relativa) (ΔCq) dall’elenco a discesa Mode (Modalità) che si trova nel riquadro di destra.

Suggerimento: per confrontare i risultati con i dati di altre analisi di espressione genica, aprire
un nuovo studio dei geni o aggiungere un file di dati a uno studio dei geni esistente.

Modifica e annotazione della vista grafico
Usando i comandi del menu della barra degli strumenti dei grafici e gli strumenti del grafico per l’analisi dei
dati, è possibile modificare la vista grafico, annotare ciascun grafico e cambiare la visualizzazione del
grafico. La barra degli strumenti dei grafici viene visualizzata tra il grafico e il foglio di calcolo dell’analisi
dei dati nella parte inferiore dello schermo.

Strumenti della barra degli strumenti del grafico

Suggerimento: per informazioni sugli strumenti del grafico visualizzati a destra dei grafici di analisi
dei dati, vedere il paragrafo Grafici a pagina 208.

La barra degli strumenti sotto i grafici offre un accesso rapido agli strumenti di annotazione.

La Tabella 31 elenca le funzioni dei pulsanti nella barra degli strumenti dei grafici.

Pulsante Nome Funzione

Bar chart (Grafico a
barre)

Visualizza l’espressione relativa dei target.

Box andWhisker chart
(Diagramma a scatola e
baffi)

Visualizza i dati come intervalli di quartile (per maggiori
dettagli sul calcolo, vedere Calcoli del diagramma a
scatola e baffi a pagina 309).

Nota: disponibile solo se l’opzione Analyze Using
(Analizza con) è impostata su Biological Groups Only
(Solo gruppi biologici).

Tabella 31. Barra degli strumenti dei grafici
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Pulsante Nome Funzione

Dot Plot Chart (Grafico a
punti)

Visualizza i punti dati dei singoli campioni per ogni target.
Nota: disponibile solo se l’opzione Analyze Using
(Analizza con) è impostata su Biological Groups Only
(Solo gruppi biologici).

Add Arrow (Aggiungi
freccia)

Traccia una freccia sul grafico attivo.

Add Circle (Aggiungi
cerchio)

Traccia un cerchio sul grafico attivo.

Add Text (Aggiungi testo) Inserisce una casella di testo nel grafico attivo in cui è
possibile aggiungere testo per identificare elementi di
interesse nel grafico.

Undo (Annulla) Elimina o annulla l’ultima annotazione fatta sul grafico
attivo.

Redo (Ripeti) Ripristina l’ultima azione di annullamento eseguita sul
grafico attivo.

Clear All (Cancella tutto) Cancella tutte le annotazioni sul grafico attivo.

Tabella 31. Barra degli strumenti dei grafici, continua

Ordinamento dei dati di target, campioni e gruppi biologici

Nota: questa opzione è disponibile solo nei grafici dell’espressione genica.

Per impostazione predefinita, gli elenchi Targets (Target), Samples (Campioni) e Biological Groups
(Gruppi biologici) vengono visualizzati in ordine alfabetico. Usare la finestra di dialogo Sort (Ordina) per
ordinare la visualizzazione in ordine alfabetico inverso o per spostare manualmente un termine in un’altra
posizione dell’elenco.

Per ordinare i dati di target, campioni e gruppi biologici

1. Dagli strumenti del grafico, fare clic su Sort (Ordina).

Viene visualizzata la finestra di dialogo Gene Expression Chart Sorting (Ordinamento grafico
dell’espressione genica).
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2. Nella finestra di dialogo, fare clic su Z-A per ordinare l’elenco nell’ordine alfabetico inverso.

3. Per spostare un termine manualmente, selezionarlo e fare clic sul pulsante appropriato tra i grafici:

n Fare clic sulla freccia Su o Giù per spostare il termine selezionato di una posizione.

n Fare clic sulla freccia della barra Su o Giù per spostare il termine selezionato in alto o in basso
nell’elenco.

4. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).
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Modifica delle impostazioni del target, del campione e del colore gruppo biologico

Usare la finestra di dialogo Color Settings (Impostazioni colore) per cambiare il colore di un target, di un
campione o di un gruppo biologico, oppure per rimuovere l’elemento dal grafico.

Per cambiare le impostazioni di colore del target

1. Nel riquadro di destra della finestra di dialogo Gene Expression (Espressione genica), verificare che
nell’elenco a discesa X-Axis (Asse X) venga visualizzato Sample (Campione).

2. Selezionare Color Settings (Impostazioni colore) dagli strumenti del grafico.

Appare la finestra di dialogo Color Settings (Impostazioni colore).

3. Per cambiare il colore di visualizzazione per un target, fare clic sul suo colore nella colonna Color
(Colore).

4. Nella finestra di dialogo Color (Colore) che viene visualizzata, selezionare un nuovo colore e fare clic
su OK.

5. Per rimuovere un target dal grafico dell’espressione genica, deselezionare la relativa casella di
controllo nella colonna Show Chart (Mostra grafico).

Suggerimento: per cancellare tutti i target, deselezionare Show Chart (Mostra grafico)
nell’intestazione della colonna.

6. (Facoltativo) Per impostazione predefinita le barre appaiono in tinta unita. Per visualizzare le barre in
colori sfumati, deselezionare Use Solid Colors (Usa tinte unite).

7. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).

Per cambiare le impostazioni di colore del campione o del gruppo biologico

1. Nel riquadro di destra della finestra di dialogo Gene Expression (Espressione genica), verificare che
nell’elenco a discesa X-Axis (Asse X) venga visualizzato Target.

2. Eseguire la procedura descritta nel paragrafo Per cambiare le impostazioni di colore del target a
pagina 273.

Modifica della vista a grafico

Per cambiare la vista attuale del grafico

u Selezionare il comando del menu della barra degli strumenti per la vista target.

Nota: la scheda Gene Expression (Espressione genica) apre sempre la visualizzazione dei dati nella
vista predefinita Bar Chart (Grafico a barre).
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Esclusione dei punti dati dei valori erratici

Nel diagramma a punti, è possibile visualizzare ed escludere facilmente i valori erratici dall’analisi.

Per escludere i punti dati dei valori erratici

u Nel grafico a punti, fare clic con il pulsante destro del mouse sul valore erratico desiderato e scegliere
Exclude Well from Analysis (Escludi pozzetto dall’analisi).

Il punto dati viene rimosso dal grafico a punti e il pozzetto diventa grigio nel selettore pozzetto della
scheda Quantification (Quantificazione).

Per includere un punto dati del valore erratico escluso

u Nella scheda Quantification (Quantificazione), fare clic con il pulsante destro del mouse sul pozzetto
nel selettore di pozzetti e scegliere Well > Include in Analysis (Pozzetto > Includi nell’analisi).

Visualizzazione dei dettagli sui punti dati

Per visualizzare i dettagli dei punti dati

u Nel diagramma a scatola e baffi o nel grafico a punti, fermare il cursore su un singolo punto dati.

Viene visualizzato un tooltip che mostra il nome campione e la sua espressione (quantità relativa o
espressione normalizzata, in base alla modalità selezionata).

Annotazione dei grafici

È possibile aggiungere frecce, cerchi e testo alla visualizzazione di ogni grafico a barre per comunicare in
modo chiaro i dati. Le annotazioni vengono salvate con il grafico a barre e appaiono nel file esportato e
stampato. Le annotazioni fatte alla visualizzazione di un grafico non vengono tuttavia aggiunte alle
visualizzazioni degli altri grafici.

Per tracciare una freccia o un cerchio nel grafico

1. Nella barra degli strumenti del grafico a barre, fare clic sullo specifico strumento.

2. Fare clic nel grafico a barre e trascinare il cursore nel grafico secondo necessità.
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Per aggiungere il testo al grafico

1. Nella barra degli strumenti del grafico a barre, fare clic su Add Text (Aggiungi testo).

2. Fare clic nel grafico a barre. Appare una casella di testo in quella posizione.

3. Aggiungere il testo nella casella.

4. Fare clic in qualsiasi punto del grafico per uscire dalla casella di testo.

Suggerimento: premere Enter (Invio) per aggiungere più righe alla casella di testo.

Per spostare un’annotazione

1. Passare il puntatore sopra l’annotazione. L’icona diventa un indice che punta e il bordo
dell’annotazione viene evidenziata.

2. Fare clic sull’annotazione e trascinarla in un’altra posizione.

3. Rilasciare l’annotazione per fissarne la posizione.

Per annullare un’annotazione

u Fare clic su Undo (Annulla).

Viene rimossa l’annotazione aggiunta più di recente.

Suggerimento: è possibile annullare le dieci annotazioni più recenti (una alla volta).

Per ripristinare un’annotazione

u Fare clic su Redo (Ripristina).

Viene ripristinata l’annotazione rimossa più di recente.

Suggerimento: è possibile ripristinare le dieci annotazioni più recenti (una alla volta).

Per eliminare un’annotazione

u Fare clic con il pulsante destro del mouse sull’annotazione e scegliere Delete (Elimina).
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Rettifica dei dati di espressione genica
Dopo aver selezionato la modalità di analisi, ossia espressione normalizzata (∆∆Cq) o quantità relativa
(∆Cq), rettificare i dati visualizzati nella scheda Gene Expression (Espressione genica) modificando le
opzioni delle impostazioni a destra del grafico.

Suggerimento: le opzioni predefinite dei dati dell’espressione genica vengono impostate nella finestra di
dialogo User Preferences (Preferenze utente) (vedere Impostazione dei parametri predefiniti del file di
dati dell’espressione genica a pagina 93).

Dati su grafico

Impostare il valore dell’asse delle ordinate su Linear scale (Scala lineare) per attivare le opzioni dei dati su
grafico. Le opzioni per i dati su grafico permettono di presentare i dati nel grafico con una di queste
opzioni:

n Relative to control (Rispetto al controllo): consente di diagrammare i dati con l’asse scalato da 0 a 1.
Se si assegna un controllo nell’analisi, selezionare questa opzione per visualizzare rapidamente la
up-regulation e la down-regulation del target.

n Relative to zero (Rispetto a zero): consente di diagrammare i dati con l’origine a zero.

Analyze Using (Analizza con)

Usare il menu a discesa per selezionare il modo in cui vengono analizzati e tracciati i dati. Le opzioni
sono:

n Samples Only (Solo campioni): i dati vengono analizzati e tracciati in base al campione.

n Biological Groups Only (Solo gruppi biologici): i dati vengono analizzati e tracciati per i gruppi
biologici. L’espressione visualizzata per il gruppo biologico è la media geometrica dei campioni di tale
gruppo.

n Sample Biological Group (Gruppo biologico campione): i dati vengono analizzati e tracciati in base al
campione con il gruppo biologico aggiunto dopo il nome del campione. I valori P mostrati vengono
calcolati in base al gruppo biologico.

n Biological Group Sample (Campione gruppo biologico): i dati vengono analizzati e tracciati in base al
campione con il gruppo biologico aggiunto prima del nome del campione. I valori P mostrati vengono
calcolati in base al gruppo biologico.

Utilizzare il menu a discesa per selezionare un campione che verrà utilizzato per normalizzare la quantità
relativa:
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Annotazione del p-value (Valore P) e della soglia dei p-values (Valori P)

Quando si seleziona Annotate P-Values (Annota valori P), il software visualizza un asterisco (*) sul
grafico a barre sopra un target se il suo valore P è inferiore alla soglia selezionata. Il software calcola
automaticamente il valore P confrontando il livello di espressione del campione con il livello di
espressione del campione di controllo selezionato usando un test t standard. L’intervallo di soglia del
valore P è 0,000–1,000.

Opzioni per l’asse X

L’opzione per l’asse x permette di selezionare i dati dell’asse x del grafico dell’espressione genica:

n Target: permette di rappresentare graficamente i nomi target sull’asse x.

n Sample (Campione): permette di rappresentare graficamente i nomi campione sull’asse x.

Opzioni per l’asse Y

L’opzione per l’asse y permette di mostrare il grafico dell’espressione genica in una di queste tre scale:

n Linear (Lineare): selezionare questa opzione per mostrare una scala lineare.

Suggerimento: l’impostazione dell’asse y su Linear (Lineare) attiva l’elenco a discesa Graph
Data (Dati su grafico) da cui è possibile scegliere di diagrammare i dati rispetto al controllo o a
zero.

n Log 2: selezionare questa opzione per valutare i campioni in base a un’ampia gamma dinamica.

n Log 10: selezionare questa opzione per valutare i campioni in base a una gamma dinamica molto
ampia.

Opzioni di scala

Per abilitare le opzioni di scala nel grafico dell’espressione genica, selezionare Normalized Gene
Expression (Espressione genica normalizzata) (ΔΔCq) e impostare su None (Nessuno). Selezionare una
di queste opzioni di scala per calcolare e presentare i dati nella maniera migliore per il modello di analisi:

n Unscaled (Non scalato): presenta l’espressione genica normalizzata non scalata.

n Highest (Più alto): scala l’espressione genica normalizzata per ciascun target dividendo il livello di
espressione di ogni campione per il livello di espressione più alto in tutti i campioni.

Questa opzione di scala utilizza la formula scalata rispetto al valore più alto.

n Lowest (Più basso): scala l’espressione genica normalizzata per ciascun target dividendo il livello di
espressione di ogni campione per il livello di espressione più basso in tutti i campioni.

Questa opzione di scala utilizza la formula scalata rispetto al valore più basso.
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n Average (Media): scala l’espressione genica normalizzata per ciascun target dividendo il livello di
espressione di ogni campione per la media geometrica dei livelli di espressione per tutti i campioni.

Questa opzione di messa in scala utilizza la formula scaled-to-average (rapportato alla media).

Selezionare un’opzione per il tipo di calcolo degli errori (barre di errore) nel grafico Gene Expression
(Espressione genica):

Moltiplicatore per le barre di errore del grafico

Selezionare un moltiplicatore per le barre di errore nel grafico Gene Expression (Espressione genica).
Selezionare uno di questi numeri interi:

n +/- 1 (predefinito)

n 2

n 3

Il tipo di moltiplicatore cambia quando si seleziona la barra di errore:

n SEM per errore standard della media

n Std Devs per deviazioni standard

Impostazioni dell’esperimento
Suggerimento: questa finestra di dialogo è disponibile anche nell’editor piastra. Per ulteriori
informazioni, vedere Modifica delle impostazioni dell’esperimento a pagina 155.

Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), è possibile visualizzare o
modificare l’elenco di target, campioni o gruppi biologici, selezionare i geni di riferimento, selezionare i
controlli oppure impostare il gruppo di analisi dell’espressione genica da analizzare se i gruppi biologici
sono stati aggiunti ai pozzetti.

Per aprire la finestra di dialogo Experiment Settings (Impostazioni esperimento)

u Nella scheda Graphing (Rappresentazione grafica), fare clic su Experiment Settings (Impostazioni
esperimento) nella parte inferiore del riquadro di destra.

Viene visualizzata la finestra di dialogo Experiment Settings (Impostazioni esperimento) che mostra
la scheda Targets (Target).

Per modificare le impostazioni Targets (Target)

u Nella scheda Targets (Target), eseguire una delle seguenti operazioni:

n Per selezionare un target come riferimento per l’analisi dei dati dell’espressione genica,
selezionare il nome nella colonna Reference (Riferimento).
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n Per cambiare il colore del target, fare clic sulla relativa cella nella colonna Color (Colore) e
cambiare il colore nella finestra di dialogo Color (Colore) visualizzata.

Il cambio di colore viene mostrato nei grafici dell’espressione genica.

n Per usare un valore di efficienza precedentemente determinato, deselezionare la casella di
controllo del target nella colonna Auto Efficiency (Efficienza automatica) e immettere un numero
per la percentuale di efficienza di un target.

Il software calcola l’efficienza relativa per un target utilizzando la funzione Auto Efficiency
(Efficienza automatica) se i dati per un target includono una curva standard.

Per modificare le impostazioni del campione

u Nella scheda Samples (Campioni), eseguire una delle seguenti operazioni:

n Per selezionare un campione come controllo per l’analisi dei dati dell’espressione genica,
selezionare il nome nella colonna Control (Controllo).

n Per cambiare il colore del gruppo del campione, fare clic sulla relativa cella nella colonna Color
(Colore) e cambiare il colore nella finestra di dialogo Color (Colore) visualizzata.

Il cambio di colore viene mostrato nei grafici dell’espressione genica.

n Per visualizzare il campione nei grafici dell’espressione genica, selezionarlo nella colonna Show
Chart (Mostra grafico).

n Per rimuovere il campione dai grafici dell’espressione genica, deselezionarlo nella colonna
Show Chart (Mostra grafico).

Suggerimento: i dati del gruppo del campione rimangono nella tabella dei risultati.

Per escludere un tipo di campione dai calcoli dell’analisi

u Selezionare la relativa casella di controllo nella parte inferiore della finestra di dialogo Experiment
Settings (Impostazioni esperimento).

Nota: in tal modo si escludono i controlli e/o gli standard dall’analisi dell’espressione genica.
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Opzioni del menu di scelta rapida
Fare clic con il pulsante destro del mouse sul grafico dell’espressione genica per selezionare gli elementi
mostrati nella Tabella 32.

Elemento Funzione

Copy (Copia) Copia il grafico negli appunti.

Save Image As (Salva immagine
con nome)

Consente di salvare il grafico come file immagine. Impostare la
risoluzione e le dimensioni dell’immagine, quindi selezionare il tipo di
file (PNG, JPG, o BMP).

Page Setup (Imposta pagina) Seleziona le impostazioni di una pagina per la stampa.

Print (Stampa) Stampa il grafico.

Set Scale to Default (Imposta
scala su predefinito)

Show All (Mostra tutto) visualizza tutti i dati nel grafico a barre. Scroll
Bar (Barra di scorrimento) visualizza una barra di scorrimento se sono
presenti troppi campioni da visualizzare nella struttura del grafico,
mantenendo un’ampiezza di barra minima.

Chart Settings (Impostazioni
grafico)

Consente di aprire la finestra Chart Settings (Impostazioni grafico) per
regolare il grafico.

Sort (Ordina) Mette in ordine i campioni o i target che sono visualizzati sull’asse x del
grafico.

Use Corrected Std Devs (Usa
deviazioni standard corrette)

Calcola le barre di errore usando la formula delle deviazioni standard
corrette.

Use Solid Bar Colors (Usa tinte
unite per barra)

Visualizza le barre in tinta unita nel grafico.

X–Axis Labels (Etichette asse x) Visualizza le etichette dell’asse x in orizzontale o inclinate.

Tabella 32. Elementi del menu di scelta rapida per l’espressione genica
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Foglio di calcolo dei dati
La Tabella 33 definisce i dati visualizzati nella tabella dei dati dell’espressione genica.

Nota: i valori nella tabella vengono calcolati in base al tipo di grafico e alle preferenze selezionate nel
riquadro di destra.

Informazione Descrizione

Target Nome target (gene amplificato) selezionato nella finestra Experiment
Settings (Impostazioni esperimento).

Biological Group (Gruppo
biologico)

Sample Biological Group
(Gruppo biologico campione)

Biological Group Sample
(Campione gruppo biologico)

Nome del campione e/o del gruppo biologico selezionato nella finestra
Experiment Settings (Impostazioni esperimento).

Control (Controllo) Nome del controllo selezionato nella finestra Experiment Settings
(Impostazioni esperimento). Quando l’opzione Analyze Using
(Analizza con) è impostata su Samples Only (Solo campioni), il
controllo è il campione selezionato nella finestra Experiment Settings
(Impostazioni esperimento). Quando si seleziona Biological Groups
Only (Solo gruppi biologici), Sample Biological Group (Gruppo
biologico campione) o Biological Group Sample (Campione gruppo
biologico), il controllo corrisponde al gruppo biologico selezionato nella
finestra Experiment Settings (Impostazioni esperimento).

Relative Quantity (Quantità
relativa) o
Expression (Espressione)

Relative Quantity (Quantità relativa) (ΔCq) o Normalized Gene
Expression (Espressione genica normalizzata) (ΔΔCq), a seconda
della modalità selezionata.

Relative Quantity (Quantità
relativa) o Expression SEM
(SEM espressione) (o SD)

Errore standard della media (SEM) o deviazione standard (SD) della
quantità relativa o dell’espressione normalizzata, a seconda
dell’opzione selezionata. Disponibile solo se Analyze Using (Analizza
con) è impostato su Samples Only (Solo campioni), Sample Biological
Group (Gruppo biologico campione) o Biological Group Sample
(Campione gruppo biologico).

Tabella 33. Descrizione delle informazioni incluse nel foglio di calcolo della scheda
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Informazione Descrizione

Corrected Relative Quantity
(Quantità relativa corretta) o
Expression SEM (SEM
espressione) (o SD)

Calcolo del valore corretto per SEM o SD della quantità relativa o
dell’espressione normalizzata, a seconda dell’opzione selezionata.
Disponibile solo se l’opzione Analyze Using (Analizza con) è impostata
su Samples Only (Solo campioni), Sample Biological Group (Gruppo
biologico campione) o Biological Group Sample (Campione gruppo
biologico).

Mean Cq (Media Cq) Media del ciclo di quantificazione (non visualizzato se Analyze Using
(Analizza con) è impostato su Biological Groups Only (Solo gruppi
biologici)).

Cq SEM (SEM Cq) (o SD) SEM o SD del ciclo di quantificazione, in base all’opzione selezionata
(non visualizzato se Analyze Using (Analizza con) è impostato su
Biological Groups Only (Solo gruppi biologici)).
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Opzione Show Details (Mostra dettagli)
Nella Tabella 34 sono definiti i dati visualizzati quando si seleziona Show Details (Mostra dettagli) dal
menu di scelta rapida del foglio di calcolo del grafico a barre.

Informazione Descrizione

Data Set (Serie dati) Dati di fluorescenza di un fluoroforo nel file di dati

Relative Quantity (Quantità
relativa)

Quantità relativa calcolata dei campioni

Relative Quantity SD (DS
quantità relativa)

Deviazione standard del calcolo della quantità relativa

Corrected Relative Quantity SD
(DS quantità relativa corretta)

Deviazione standard calcolata della quantità relativa corretta

Relative Quantity SEM (SEM
quantità relativa)

Errore standard della media del calcolo della quantità relativa

Corrected Relative Quantity
SEM (SEM quantità relativa
corretta)

Errore standard calcolato della media della quantità relativa corretta

Relative Quantity(lg) (Quantità
relativa, lg)

Log2 della quantità relativa che viene usata per l’analisi statistica

SD RQ(lg) (DV QR, lg) Deviazione standard della quantità relativa (log2)

SEM Expression(lg)
(Espressione SEM, lg)

Errore standard della media dell’espressione (log2)

Unscaled Expression
(Espressione non scalata)

Espressione non tarata calcolata

Unscaled Expression SD (DS
espressione non tarata)

Deviazione standard calcolata dell’espressione non tarata

Corrected Unscaled Expression
SD (DS espressione non tarata
corretta)

Deviazione standard calcolata dell’espressione non tarata corretta

Tabella 34. Informazioni disponibili nel foglio di calcolo del grafico a barre con l’opzione Show
Details (Mostra dettagli) selezionata
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Informazione Descrizione

Unscaled Expression SEM
(SEM espressione non tarata)

Errore standard calcolato della media dell’espressione non tarata

Corrected Unscaled Expression
SEM (SEM espressione non
tarata corretta)

Errore standard calcolato della media dell’espressione non tarata
corretta

Unscaled Expression(lg)
(Espressione non scalata, lg)

Log2 dell’espressione non tarata

SD Unscaled Expression(lg)
(Espressione non scalata DS, lg)

Deviazione standard dell’espressione non tarata (log2)

SEM Unscaled Expression(lg)
(Espressione non scalata SEM,
lg)

Errore standard della media dell’espressione non tarata (log2)

Expression (Espressione) Espressione genica normalizzata

Corrected Expression SD (DS
espressione corretta)

Deviazione standard calcolata dell’espressione corretta

Expression SEM (SEM
espressione)

Errore standard della media dell’espressione

Corrected Expression SEM
(SEM espressione corretta)

Errore standard calcolato della media dell’espressione corretta

Expression(lg) (Espressione, lg) Log2 dell’espressione (espressione normalizzata) che viene usata per
l’analisi statistica

SD Expression(lg) (Espressione
DS, lg)

Deviazione standard dell’espressione (log2)

SEM Expression(lg)
(Espressione SEM, lg)

Errore standard della media dell’espressione (log2)

Mean Cq (Media Cq) Media del ciclo di quantificazione

Cq SD (SD Cq) Deviazione standard del ciclo di quantificazione

Cq SEM (SEM Cq) Errore standard della media del ciclo di quantificazione

Tabella 34. Informazioni disponibili nel foglio di calcolo del grafico a barre con l’opzione Show
Details (Mostra dettagli) selezionata, continua
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Diagramma di gruppo
Il diagramma di gruppo visualizza i dati in una gerarchia basata sul grado di similitudine dell’espressione
per diversi target e campioni.

Nota: è necessario scegliere un target di riferimento per visualizzare uno dei grafici di dati diversi
dall’espressione relativa per i grafici a barre.

L’immagine del diagramma di gruppo illustra l’espressione relativa di un campione o target come segue:

n Up-regulation (rosso): espressione più alta

n Down-regulation (verde o blu): espressione più bassa

n Nessuna regolazione (nero)

n Nessun valore calcolato (nero con una X bianca)

Più chiara è la sfumatura del colore, maggiore sarà la differenza di espressione relativa. Se non è
possibile calcolare alcun valore Cq normalizzato, il quadrato sarà nero con una X bianca.

Sui bordi esterni del grafico dei dati un dendrogramma indica la gerarchia di raggruppamento. I target o i
campioni che hanno pattern di espressione simili avranno diramazioni vicine, mentre quelli con pattern
diversi saranno più distanti.

Impostazioni
È possibile impostare le seguenti opzioni:

n Cluster By (Raggruppa per): scegliere tra Targets (Target), Samples (Campioni), Both (Entrambi) o
None (Nessuno).

n Size (Dimensioni): consente di regolare le dimensioni dell’immagine e di cambiare la percentuale di
ingrandimento del grafico .

n Split Out Replicates (Dividi replicati): consente di visualizzare i valori per i singoli replicati.

Suggerimento: è possibile cambiare la combinazione colori da rosso/verde predefinito a rosso/blu
selezionando questa opzione dal menu di scelta rapida su questi grafici.

Opzioni del menu di scelta rapida
Le opzioni del menu di scelta rapida per il diagramma di gruppo sono uguali a quelle disponibili per il
grafico a barre. Per le opzioni disponibili, vedere la Tabella 32 a pagina 280. Inoltre, selezionare Color
Scheme (Combinazione di colori) per cambiare l’espressione della down-regulation da rosso/verde
predefinito a rosso/blu sul grafico.
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Foglio di calcolo dei dati
Il foglio di calcolo visualizza i valori per il target, il campione e l’espressione normalizzata.
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Grafico di dispersione
Il grafico di dispersione visualizza l’espressione normalizzata dei target per un controllo rispetto a un campione
dell’esperimento. Le linee nel grafico indicano la soglia di fold change. I punti dati tra le linee indicano che la
differenza nell’espressione per il target (gene) è irrilevante tra i campioni. I punti dati al di fuori delle linee
superano la soglia di fold change e potrebbero essere di interesse.

L’immagine del grafico mostra i seguenti cambiamenti nell’espressione del target in base alla soglia di fold
change:

n Up-regulation (cerchio rosso): espressione relativamente più alta

n Down-regulation (cerchio verde o blu): espressione relativamente più bassa

n Nessun cambiamento (cerchio nero)

Fare clic e trascinare una linea di soglia per regolare il valore di soglia di fold change.

Impostazioni
È possibile impostare le seguenti opzioni:

n Control Sample (Campione di controllo)

n Experimental Sample (Campione sperimentale)

n Fold Change Threshold (Soglia fold change) Quando si aumenta o si diminuisce il valore di fold
change, le linee di soglia nel grafico si spostano di conseguenza.

Opzioni del menu di scelta rapida
Le opzioni del menu di scelta rapida per il grafico di dispersione sono uguali a quelle disponibili per il
grafico a barre. Per le opzioni disponibili, vedere la Tabella 32 a pagina 280. Selezionare inoltre Symbol
(Simbolo) per cambiare il simbolo utilizzato nel grafico (cerchio predefinito) in uno dei seguenti:

n Triangolo

n Croce

n Quadrato

n Rombo

Foglio di calcolo dei dati
Il foglio di calcolo visualizza i valori per il target e l’espressione normalizzata per i campioni sperimentali e
di controllo. Indica anche se i target mostrano up- o down-regulation rispetto alla regolazione target.
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Foglio di calcolo Results (Risultati)
Il foglio di calcolo Results (Risultati) riassume i dati di tutti i grafici. Nella Tabella 35 sono definiti i dati
visualizzati nel foglio di calcolo Results (Risultati).

Informazione Descrizione

Target (Target) Nome target (gene amplificato)

Sample (Campione) Nome del campione

Mean Cq (Media Cq) Media del ciclo di quantificazione

Mean Efficiency Corrected Cq
(Media Cq con efficienza
corretta)

Media del ciclo di quantificazione dopo la correzione dell’efficienza
della reazione

Espressione normalizzata Espressione target normalizzata in base al target di riferimento (ΔΔCq)

Relative Normalized Expression
(Espressione normalizzata
relativa)

Espressione normalizzata relativa ad un campione di controllo;
chiamata anche Fold Change

Regulation (Regolazione) Cambiamento nell’espressione relativa ad un campione di controllo

Compared to Regulation
Threshold (Rispetto alla soglia di
regolazione)

Upregulation o downregulation di un campione sperimentale in base
all’impostazione della soglia

Tabella 35. Informazioni nella scheda Results (Risultati)

Nota: i dati per i replicati sono reperibili solo nei fogli di calcolo delle schede di analisi dei dati in cui è
stata selezionata l’opzione Split Out Replicates (Dividi replicati) (ossia, diagramma di gruppo).
Potrebbe esserci una discrepanza tra i dati dell’espressione nei fogli di calcolo dell’analisi
dell’espressione genica se è stata selezionata l’opzione “none” (nessuno) per il campione di controllo
nel grafico a barre.
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Studio dei geni
Creare uno studio dei geni per confrontare i dati dell’espressione genica di uno o più esperimenti di real-
time PCR utilizzando un calibratore inter-serie per la normalizzazione tra gli esperimenti. Creare uno
studio dei geni aggiungendo i dati da uno o più file di dati (estensione .pcrd) allo studio dei geni. Il software
li raggruppa in un unico file (estensione .mgxd).

Nota: il numero massimo di campioni che è possibile analizzare in uno studio dei geni è limitato dalle
dimensioni della RAM e della memoria virtuale del computer.

Calibrazione inter-analisi
La calibrazione inter-analisi viene tentata automaticamente in ogni studio dei geni per ciascun target al
fine di normalizzare le variazioni inter-analisi tra i target determinate tramite analisi PCR in tempo reale
separate (ossia, file .pcrd differenti generati da piastre differenti).

Affinché il software possa riconoscere un campione come calibratore inter-analisi, deve condividere lo
stesso nome target, nome campione e, se utilizzato, nome del set biologico per ogni piastra che viene
confrontata.

Nota: per consentire la calibrazione inter-analisi, nello studio dei geni deve essere presente almeno
un campione di calibrazione inter-analisi. I target senza campioni di calibratori inter-analisi
appropriati saranno elaborati senza correzione nello studio dei geni (sconsigliato).

I calibratori inter-analisi possono essere applicati in due modi:

n Per target (Per target): diversi primer PCR possono avere efficienze diverse. Per impostazione
predefinita, il calibratore inter-analisi viene applicato a tutti i pozzetti della stessa piastra che hanno lo
stesso nome target, ad esempio il Cq generato con lo stesso dosaggio.

n Entire study (Intero studio): un calibratore inter-analisi viene selezionato dall’utente e applicato
all’intero studio dei geni.
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Finestra di dialogo Gene Study (Studio dei geni)

La finestra di dialogo Gene Study (Studio dei geni) include due schede:

n Scheda Study Setup (Impostazione studio): consente di gestire le analisi nello studio dei geni.

Importante: l’aggiunta o la rimozione di file di dati in uno studio dei geni non cambia i dati nel file
originale.

n Scheda Study Analysis (Analisi dello studio): consente di visualizzare i dati dell’espressione genica
per le analisi combinate.

Scheda Study Setup (Impostazione studio)
La Tabella 36 definisce i dati visualizzati nella scheda Study Setup (Impostazione studio).

Titolo della colonna Descrizione

File Name (Nome file) Nome del file di dati dell’analisi (estensione .pcrd)

File Folder (Cartella file) Directory che memorizza il file di dati di ciascuna analisi nello studio
dei geni

Date Created (Data di
creazione)

Data di raccolta dei dati dell’analisi

Tabella 36. Scheda Study Setup (Impostazione studio) nella finestra di dialogo Gene Study
(Studio dei geni)
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Titolo della colonna Descrizione

Well Group Name (Nome
gruppo di pozzetti)

Nome del gruppo di pozzetti che è stato selezionato quando il file è
stato aggiunto allo studio dei geni

Suggerimento: per analizzare un gruppo di pozzetti nello studio
dei geni, occorre selezionare il gruppo di pozzetti nella finestra
Data Analysis (Analisi dei dati) prima di importare il file di dati nello
studio dei geni.

Step (Fase) Fase del protocollo che include la lettura piastra per raccogliere i dati
della real-time PCR

Run Type (Tipo di analisi) Analisi PrimePCR o definita dall’utente

Protocol Edited (Protocollo
modificato)

Se questo parametro è selezionato, indica che il protocollo usato per
l’analisi PrimePCR è stato modificato

View Plate (Visualizza
piastra)

Apre una mappa della piastra con i dati di ciascuna analisi inclusa nello
studio dei geni

Tabella 36. Scheda Study Setup (Impostazione studio) nella finestra di dialogo Gene Study
(Studio dei geni), continua

Preparazione di uno studio dei geni
Per preparare uno studio dei geni

1. Prima di importare i dati in uno studio dei geni, procedere come segue nella finestra Data Analysis
(Analisi dei dati):

n Verificare che i campioni con lo stesso contenuto abbiamo lo stesso nome. In uno studio dei
geni, il software presume che i pozzetti con lo stesso nome target o campione contengano gli
stessi campioni.

n Regolare la linea basale e la soglia (Cq) nella scheda Quantification (Quantificazione) per
ottimizzare i dati in ciascuna analisi.

n Selezionare il gruppo di pozzetti che si desidera includere nello studio dei geni.

Al fine di visualizzare i dati da un gruppo di pozzetti nello studio dei geni, tale gruppo deve
essere selezionato prima di importare i file di dati.

La scheda Study Setup (Impostazione studio) mostra un elenco di tutte le analisi nello studio dei
geni.

2. Nella finestra di dialogo Gene Study (Studio dei geni), scegliere la scheda Study Setup
(Impostazione studio).
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3. Fare clic su Add Data Files (Aggiungi file di dati) per selezionare un file da una finestra del browser.

Suggerimento: per aggiungere rapidamente analisi a uno studio dei geni, trascinare i file di dati
(estensione .pcrd) nella finestra di dialogo Study Setup (Impostazione studio).

4. CFX Maestro Dx SE esegue automaticamente l’analisi dello studio dei geni quando si aggiungono i
file di dati. Scegliere la scheda Study Analysis (Analisi dello studio) per visualizzare i risultati.

Per rimuovere analisi dallo studio dei geni

u Selezionare uno o più file nell’elenco e fare clic su Remove (Rimuovi).

Per aggiungere note sullo studio dei geni

u Inserire note sui file e sull’analisi nella casella di testo Notes (Note).

Scheda Study Analysis (Analisi dello studio)
La scheda Study Analysis (Analisi dello studio) visualizza i dati di tutte le analisi dello studio dei geni. Le
opzioni di analisi dei dati dell’espressione genica sono uguali a quelle usate per un singolo file di dati con
le seguenti eccezioni:

n Per i grafici a barre, i valori di calibrazione inter-analisi (se calcolati) vengono visualizzati quando si fa
clic su Inter-run Calibration (Calibrazione inter-analisi).

Nota: solo i seguenti tipi di campione possono essere usati come calibratore inter-analisi:

o Unknown (Sconosciuto)

o Errore

o Positive Control (Controllo positivo)

I tipi di campione Negative control (Controllo negativo), No template control (NTC, controllo senza
templato) e No reverse transcriptase control (NRT, senza trascrittasi inversa) non possono essere
usati come calibratore inter-analisi.

n Lo strumento di selezione del gene di riferimento identifica i geni di riferimento analizzati e li classifica
come Ideal (Ideale), Acceptable (Accettabile) o Unstable (Instabile) in base alla loro stabilità:

o I geni di riferimento ideali sono stabili e rappresentano variazioni minime attraverso i campioni
testati.

o I geni di riferimento accettabili non sono idealmente stabili e rappresentano una variazione
moderata attraverso i campioni testati. Usare questi geni di riferimento nell’analisi se non sono
presenti geni di riferimento ideali.
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o I geni di riferimento non stabili rappresentano una variazione eccessiva attraverso i campioni
testati. Si raccomanda di escludere questi geni dalle analisi.

n Lo strumento dei controlli di analisi PrimePCR visualizza i risultati dei campioni testati in una tabella:

o La scheda Summary (Riepilogo) visualizza un riepilogo di tutti i campioni testati. I campioni che
hanno superato tutti i dosaggi di controllo sono visualizzati in verde. I campioni che non hanno
superato uno o più dosaggi di controllo vengono visualizzati in giallo.

o La scheda PCR visualizza i risultati del dosaggio di controllo PCR positivo. Questo test rileva i
problemi sperimentali o di inibizione che influenzano l’espressione genica.

o La scheda RT visualizza i risultati del dosaggio di controllo della retrotrascrizione. Questo
dosaggio valuta qualitativamente le prestazioni RT e identifica i campioni in cui è probabile che
le prestazioni RT compromettano l’espressione genica.

o La scheda gDNA visualizza i risultati del dosaggio di controllo della contaminazione del DNA.
Questo dosaggio determina se il DNA genomico (gDNA) è presente in un campione a un livello
che potrebbe influenzare i risultati qPCR.

o La scheda RQ (QR) visualizza i risultati dei dosaggi di qualità dell’RNA (RQ1 e RQ2). Questi
dosaggi valutano qualitativamente se l’integrità dell’RNA potrebbe interessare negativamente
l’espressione genica.

Categorie di report dello studio dei geni
Usare la finestra di dialogo Gene Study Report (Report dello studio dei geni) per organizzare i dati dello
studio dei geni in un report. La Tabella 37 elenca tutte le opzioni disponibili per un report dello studio dei
geni.

Categoria Opzione Descrizione

Intestazione

Titolo, sottotitolo e logo per il report

Report Information
(Informazioni sul report)

Data, nome utente, nome file di dati, percorso file
di dati e il gruppo di pozzetti selezionato

Gene Study File List
(Elenco dei file dello studio
dei geni)

Elenco di tutti i file di dati nello studio dei geni

Notes (Note) Note sul report di dati

Tabella 37. Categorie per un report dello studio dei geni
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Categoria Opzione Descrizione

Analisi dello studio: grafico a barre

Analysis Settings
(Impostazioni dell’analisi)

Elenco dei parametri di analisi selezionati

Chart (Grafico) Grafico a barre dell’espressione genica, che
visualizza i dati

Target Names (Nomi
target)

Elenco dei target nello studio dei geni

Sample Names (Nomi
campione)

Elenco dei campioni nello studio dei geni

Data (Dati) Foglio di calcolo che mostra i dati

Target Stability (Stabilità
target)

Dati di stabilità target

Inter-run Calibration
(Calibrazione inter-analisi)

Dati di calibrazione inter-analisi

Box-and-Whisker Chart
(Diagramma a scatola e
baffi)

Diagramma a scatola e baffi dell’espressione
genica

Dot-Plot Chart (Diagramma
a punti)

Grafico a punti dell’espressione genica

Analisi dello studio: diagramma di gruppo e grafico di dispersione

Analysis Settings
(Impostazioni dell’analisi)

Impostazioni per ciascun tipo di grafico

Chart (Grafico) Grafico dell’espressione genica, che visualizza i
dati

Data (Dati) Foglio di calcolo in cui sono elencati i dati in
ciascun target

Analisi dello studio: dati ANOVA

Tabella 37. Categorie per un report dello studio dei geni, continua
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Categoria Opzione Descrizione

ANOVA Settings
(Impostazioni ANOVA)

Soglia del valore P usata nell’analisi

ANOVA Results (Risultati
ANOVA)

Tabella dei risultati dall’analisi ANOVA e post-hoc
HSD di Tukey

Shapiro-Wilk Normality
Test (Test di normalità di
Shapiro-Wilk)

Gruppo biologico, conteggio, valore P e qualsiasi
errore che si verifica per ciascun target
nell’analisi

ANOVA Errors (Errori
ANOVA)

Errori identificati durante i calcoli ANOVA

Tabella 37. Categorie per un report dello studio dei geni, continua
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Creazione di un report dello studio dei geni
Per creare un report dello studio dei geni

1. Prima di creare un report, modificare i dati e i grafici del report dello studio dei geni secondo
necessità.

2. Selezionare Tools > Reports (Strumenti > Report) nel menu Gene Study (Studio dei geni) per aprire
la finestra di dialogo Report (Report).

3. Scegliere le opzioni che si desidera includere nel report. Il report si apre con le opzioni predefinite
selezionate. Selezionare o deselezionare le caselle di controllo per modificare intere categorie o
singole opzioni all’interno di una categoria.

Le Categorie di report dello studio dei geni a pagina 293 elencano le opzioni disponibili da
visualizzare.

4. Cambiare l’ordine delle categorie e degli elementi in un report. Trascinare le opzioni nella posizione
richiesta. Gli elementi possono essere riordinati solamente all’interno delle categorie a cui
appartengono.

5. Fare clic su Update Report (Aggiorna report) per aggiornare l’anteprima del report con tutte le
modifiche.

6. Stampare o salvare il report. Fare clic sul pulsante Print Report (Stampa report) nella barra degli
strumenti per stampare il report corrente. Selezionare File > Save (File > Salva) per salvare il report
in formato PDF (file Adobe Acrobat Reader) e selezionare un percorso in cui salvare il file.
Selezionare File > Save As (File > Salva con nome) per salvare il report con un nuovo nome o in un
nuovo percorso.

7. (Facoltativo) Creare un modello di report con le informazioni desiderate. Per salvare le impostazioni
del report attuali in un modello, selezionare Template > Save oppure Save As (Modello > Salva/Salva
con nome). Caricare il modello di report la volta successiva in cui si desidera creare un nuovo report.
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Appendice A Calcoli dell’analisi dei dati
Il Software CFX Maestro Dx, Security Edition calcola automaticamente le formule e visualizza i risultati
nelle schede Data Analysis (Analisi dei dati). In questa appendice viene spiegato nel dettaglio in che
modo CFX Maestro Dx SE calcola le formule.

Efficienza della reazione
L’evidenza suggerisce che utilizzando una misura accurata delle efficienze per ciascun primer e set di
sonde si otterranno risultati più accurati quando si analizzano i dati dell’espressione genica. Il valore
predefinito dell’efficienza utilizzato nei calcoli dell’espressione genica è 100%. Per valutare l’efficienza
della reazione, generare una curva standard utilizzando diluizioni seriali di un campione rappresentativo
in tutta la gamma dinamica pertinente e quindi registrare l’efficienza per la successiva analisi
dell’espressione genica. Se l’analisi include una curva standard, il software calcola automaticamente
l’efficienza e la visualizza sotto la curva standard della scheda Quantification (Quantificazione) quando è
selezionata l’opzione Auto Efficiency (Efficienza automatica) nella scheda Targets (Target) della finestra
Experiment Settings (Impostazioni esperimento).

L’efficienza (E) nelle formule di efficienza fa riferimento alle “efficienze” secondo quanto descritto da Pfaffl
(2001) and Vandesompele et al. (2002). In queste pubblicazioni, un’efficienza pari a 2 (perfetto
raddoppiamento con ogni ciclo) equivale al 100% dell’efficienza in questo software. È possibile convertire
i calcoli di efficienza in quelli usati nel software utilizzando le seguenti relazioni matematiche:

n E = (% di efficienza * 0,01) + 1

n % di efficienza = (E – 1) * 100

Quantità relativa
La formula per la quantità relativa (ΔCq) per un campione (GOI) è:

Nota: questa formula viene utilizzata per calcolare la quantità relativa quando non vi è alcun
campione di controllo definito.

Dove:
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n E = Efficienza di primer e probe set. Questa efficienza viene calcolata con la formula
(% di efficienza * 0,01) + 1, dove 100% di efficienza = 2

n C q (min) = Cq medio per il campione con il più basso Cqmedio per il GOI

n C q (campione) = Cqmedio per il campione

n GOI = Gene di interesse (un target)

Quantità relativa quando si seleziona un controllo
Quando viene assegnato un campione o gruppo biologico di controllo, la quantità relativa (RQ) di ogni
campione con un gene di interesse (GOI) viene calcolata con la seguente formula:

Dove:

n E = Efficienza di primer e probe set. Questa efficienza viene calcolata con la formula
(% di efficienza * 0,01) + 1, dove 100% di efficienza = 2

n Cq (controllo) = Cqmedio per il campione di controllo

n Cq (campione) = Cqmedio per ogni campione con un GOI

n GOI = Gene di interesse (un target)

Deviazione standard della quantità relativa
Importante: questo calcolo è applicabile solo quando l’opzione Analyze Using (Analizza con) è
impostata su Samples Only (Solo campioni), Sample Biological Group (Gruppo biologico campione)
o Biological Group Sample (Campione gruppo biologico).

La formula per la deviazione standard della quantità relativa è:

Dove:

n SD quantità relativa = Deviazione standard della quantità relativa

n SD CqGOI campione = Deviazione standard del Cq per il campione (GOI)

n Quantità relativa = Quantità relativa del campione

n E = Efficienza di primer e probe set. Questa efficienza viene calcolata con la formula
(% di efficienza * 0,01) + 1, dove 100% di efficienza = 2
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Cq con correzione d’efficienza (CqE)

n GOI = Gene di interesse (un target)

Cq con correzione d’efficienza (CqE)
La formula per il valore Cq con correzione d’efficienza è

Dove:

n E = Efficienza

Cq medio con correzione d’efficienza (MCqE)
La formula per il valore Cqmedio con correzione d’efficienza è

Dove:

n CqE = Cq con correzione d’efficienza

n n = Numero di replicati
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Espressione normalizzata
L’espressione normalizzata (ΔΔCq) è la quantità relativa del target (gene) normalizzata con le quantità dei
target di riferimento (geni o sequenze) nel sistema biologico. Per selezionare i target di riferimento, aprire
la finestra Experiment Settings (Impostazioni esperimento) e fare clic sulla colonna Reference
(Riferimento) per ciascun target che funge da gene di riferimento.

La formula per l’espressione normalizzata, che utilizza il calcolo della quantità relativa (RQ), è

Dove:

n RQ = Quantità relativa di un campione

n Rif = Target di riferimento in un’analisi che include uno o più target di riferimento in ogni campione

n GOI = Gene di interesse (un target)

A condizione che i target di riferimento non cambino il livello d’espressione nel sistema biologico, il calcolo
dell’espressione normalizzata rappresenterà le differenze o le variazioni di carico nel numero di cellule
che sono rappresentate in ciascun campione.
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Espressione e quantità relativa per i gruppi biologici
Quando Analyze Using (Analizza con) viene impostato su Biological Groups Only (Solo gruppi biologici), il
software visualizza l’espressione media (espressione normalizzata o quantità relativa, in base alla
selezione della modalità) dei campioni all’interno del gruppo biologico. Poiché l’espressione di solito viene
distribuita con logaritmo normale, viene calcolata la media dell’espressione usando la media geometrica:

Dove:

n Exp1, Exp2, Expn = Quantità relativa o espressione normalizzata dei campioni nel gruppo biologico

n n = Numero di campioni nel gruppo biologico

Espressione normalizzata quando si seleziona un controllo
Quando si seleziona un campione di controllo nella finestra Experiment Settings (Impostazioni
esperimento), il software imposta su 1 il livello di espressione del campione di controllo. In questa
situazione, il software normalizza le quantità relative di tutta l’espressione target (gene) in base alla
quantità di controllo (un valore di 1). Questa espressione normalizzata è equivalente all’analisi
dell’espressione normalizzata non scalata quando si sceglie un controllo.

Nota: questo valore è noto anche come espressione normalizzata relativa (RNE) e fold change.
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Deviazione standard per l’espressione normalizzata
La rimessa in scala del valore dell’espressione normalizzata viene eseguita dividendo la deviazione
standard dell’espressione normalizzata con il valore dell’espressione normalizzata per il livello più alto o
più basso dell’espressione, in base all’opzione scelta di messa in scala. La formula per la deviazione
standard (SD) del fattore di normalizzazione è

Dove:

n RQ = Quantità relativa di un campione

n SD = Deviazione standard

n NF = Fattore di normalizzazione

n Rif = Target di riferimento

n n = Numero di target di riferimento

Quando viene assegnato un campione di controllo, non è necessario eseguire questa funzione di nuova
messa in scala sulla deviazione standard, come mostrato nella seguente formula.

Dove:

n NE = Espressione normalizzata

n RQ = Quantità relativa di un campione

n SD = Deviazione standard

n GOI = Gene di interesse (un target)
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Espressione normalizzata rapportata al livello più alto di
espressione

Quando l’analisi non include controlli, mettere in scala l’espressione normalizzata (NE) per ciascun target
(gene) dividendo il livello di espressione di ogni campione per il livello più alto di espressione in tutti i
campioni. Il software imposta il livello più alto di espressione sul valore di 1 e rimette in scala tutti i livelli di
espressione dei campioni. La formula per la scala rispetto al livello più alto è

Dove:

n GOI = Gene di interesse (target)

Espressione normalizzata rapportata al livello più basso di
espressione

Quando l’analisi non include controlli, mettere in scala l’espressione normalizzata (NE) per ciascun target
(gene) dividendo il livello di espressione di ogni campione per il livello più basso di espressione in tutti i
campioni. Il software imposta il livello più basso di espressione sul valore di 1 e rimette in scala tutti i livelli
di espressione dei campioni. La formula per la scala rispetto al livello più basso è

Dove:

n GOI = Gene di interesse (target)

Espressione normalizzata rapportata al livello di espressione
medio

Quando l’analisi non include controlli, rapportare l’espressione normalizzata (NE) per ciascun target
(gene) dividendo il livello di espressione di ogni campione per il livello medio geometrico di espressione in
tutti i campioni. Il software imposta il livello medio di espressione sul valore di 1 e rimette in scala tutti i
livelli di espressione dei campioni. La formula per la scala rispetto al livello medio è:

Dove:

n GOI = Gene di interesse (target)
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n GM =Media geometrica dell’espressione normalizzata per tutti i campioni
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Deviazione standard per l’espressione normalizzata rapportata

Deviazione standard per l’espressione normalizzata
rapportata

La nuova messa in scala del valore dell’espressione normalizzata (NE) scalata viene eseguita dividendo
la deviazione standard (SD) dell’espressione normalizzata per il valore dell’espressione normalizzata
relativo al livello di espressione più alto (MAX) o più basso (MIN), a seconda dell’opzione di scala scelta.

Nota: quando viene assegnato un campione di controllo, non è necessario eseguire questa funzione
di nuova messa in scala sulla deviazione standard.

Il calcolo per questa formula è:

Dove:

n NE = Espressione normalizzata

n SD = Deviazione standard

n GOI = Gene di interesse (target)

n MAX = Livello di espressione più alto

n MIN = Livello di espressione più basso
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Barre di errore per deviazione standard (lg) ed errore standard
della media (lg)

Oltre ad utilizzare gli intervalli di confidenza, le barre di errore possono essere visualizzate per gruppi
biologici in base alla deviazione standard o all’errore standard della media del log2 di espressione. Le
barre di errore vengono calcolate come segue:

Barra di errore inferiore RQ = 2RQ(lg)-SD RQ(lg) o 2RQ(lg)-SEM RQ(lg)

Barra di errore superiore RQ = 2RQ(lg)+SD RQ(lg) o 2RQ(lg)+SEM RQ(lg)

Dove:

n RQ(lg) = Log2 della quantità relativa per il gruppo biologico

n SD RQ(lg) = Deviazione standard della quantità relativa (log2)

n SEM RQ(lg) = Errore standard della media della quantità relativa (log2)

Barra di errore inferiore espr. = 2Exp.(lg)-SD Exp.(lg) o 2Exp.(lg)-SEM Exp.(lg)

Barra di errore superiore espr. = 2Exp.(lg)+SD Exp.(lg) o 2Exp.(lg)+SEM Exp.(lg)

Dove:

n Exp.(lg) = Log2 dell’espressione (espressione normalizzata) per il gruppo biologico

n SD RQ(lg) = Deviazione standard dell’espressione (log2)

n SEM RQ(lg) = Errore standard della media dell’espressione (log2)
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Fold change
Il fold change è una misura dell’aumento o della diminuzione dell’espressione di un target per un
campione sperimentale rispetto a un campione di controllo o gruppo biologico e viene determinato come
segue:

Se Espressione (sperimentale) > Espressione (controllo):

Se Espressione (sperimentale) < Espressione (controllo):

Nota: per la rappresentazione grafica, il valore Espressione si basa sulla quantità relativa o
sull’espressione normalizzata, a seconda della modalità selezionata (vedere Rappresentazione
grafica a pagina 268). Tuttavia, per il grafico di dispersione e il diagramma di gruppo, il fold change
viene sempre calcolato dall’espressione normalizzata.
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Formule dei valori corretti
Importante: questi calcoli sono applicabili solo quando l’opzione Analyze Using (Analizza con) è
impostata su Samples Only (Solo campioni), Sample Biological Group (Gruppo biologico campione)
o Biological Group Samples (Campioni gruppo biologico).

Una differenza tra i valori corretti e i valori non corretti si vede solo se viene creata una curva standard
come parte dell’analisi PCR in tempo reale. Il software utilizza tre equazioni per determinare la
propagazione dell’errore:

n Errore standard

n Errore standard per l’espressione normalizzata

n Errore standard per il gene di interesse normalizzato (target)

La formula per l’errore standard è

Dove:

n n = Numero di target di riferimento (geni)

n SD = Deviazione standard

L’errore standard per il fattore di normalizzazione nella formula dell’espressione normalizzata è

Dove:

n n = Numero di target di riferimento

n SE = Errore standard

n NF = Fattore di normalizzazione

n RQ = Quantità relativa

L’errore standard per la formula del gene di interesse normalizzato (GOI) è

Dove:

n SE = Errore standard
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n GOI = Gene di interesse (un target)

n NF = Fattore di normalizzazione

n n = Numero di target di riferimento

Calcolo dell’intervallo di confidenza per l’analisi del gruppo
biologico

Quando si esegue un’analisi dei gruppi biologici (Analyze Using (Analizza con) è impostato su Biological
Groups Only (Solo gruppi biologici)), gli intervalli di confidenza vengono calcolati per la quantità relativa e
l’espressione normalizzata relativa.

Gli intervalli di confidenza vengono calcolati in scala logaritmica in base alla distribuzione t usando la
seguente formula:

Dove:

n = Espressione media dei livelli di espressione della scala logaritmica dei campioni nel gruppo
biologico

n SD = Deviazione standard dei livelli di espressione della scala logaritmica dei campioni nel gruppo
biologico

n n = Numero dei campioni nel gruppo biologico

n t = Valore ottenuto dalla distribuzione t in base ai gradi di libertà e del livello alfa

Nota: il livello alfa può essere impostato usando il campo P-value threshold (Soglia valore P)
nella scheda Graphing (Rappresentazione grafica).

Dopo aver calcolato gli intervalli di confidenza, vengono convertiti in scala lineare e presentati nella
tabella dei dati dell’espressione genica e nel grafico a barre della scheda Graphing (Rappresentazione
grafica).

Calcoli del diagramma a scatola e baffi
Il diagramma a scatola e baffi mostra la distribuzione dei valori di espressione all’interno di un gruppo
biologico tracciando i dati come quartili. Il 1o e il 3o quartile sono rappresentati rispettivamente dai limiti
inferiore e superiore della scatola. La mediana viene visualizzata come una linea continua attraverso la
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scatola. I baffi rappresentano i valori minimi e massimi non esterni nella serie di dati. I valori erratici
aberrazioni sono dei valori che superano il 1o e il 3o quartile di 1,5 volte l’intervallo inter-quartile.

Nota: se nel gruppo biologico è presente un solo campione, viene mostrato come un singolo cerchio,
indicante un singolo punto dati.

Il seguente diagramma a scatola e baffi dimostra come vengono rappresentati questi dati.

1. Valore erratico. Il valore di questo valore erratico è > Q3 + (1,5 x [Q3 - Q1])

Nota: posizionare il cursore sul cerchio per visualizzare una descrizione comando che
mostra il nome del campione e la quantità relativa o le informazioni sull’espressione
normalizzata, a seconda della modalità selezionata.

2. Demarcazione massima dei valori non erratici

3. Quartile superiore/3o (Q3). Il 75% dei valori dell’espressione è inferiore al Q3.

4. Mediana, o valore intermedio, dei valori dell’espressione ordinati per rango

5. Quartile inferiore/1o (Q1). Il 25% dei valori dell’espressione è inferiore al Q1.

6. Demarcazione minima dei valori non erratici

7. Valore erratico. Il valore di questo valore erratico è < Q1 - (1,5 x [Q3 - Q1])

LEGENDA
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Il Software CFX Maestro Dx, Security Edition crea audit trail per file di dati e di studio dei geni
(rispettivamente file .prcd e .mgxd). Eventuali modifiche o azioni eseguite sui file di dati e di studio dei geni
protetti vengono acquisite nell’audit trail durante il salvataggio del file. CFX Maestro Dx SE crea un audit
trail separato per ogni file.

Dal percorso File > Save As (File > Salva con nome), è possibile salvare i file di dati o di studio dei geni
protetti con o senza firma in un'altra cartella o con un altro nome. Il nuovo file eredita l'audit trail dal file
originale. L'audit trail per il nuovo file include anche l'attività Save As (Salva con nome). Le modifiche o le
azioni eseguite sul nuovo file vengono acquisite nel relativo audit trail. Il file originale conserva il proprio
audit trail, in cui vengono acquisite ulteriori attività.

Nel paragrafo Eventi controllabili a pagina 313 vengono elencati gli eventi controllabili che il software
acquisisce.

Visualizzazione degli audit trail
Ciascun audit trail mostra le seguenti informazioni:

n Dettagli intestazione audit

o File version (Versione file): la versione salvata del file

o Date (Data): la data dell'evento controllabile corrente

o User (Utente): il dominio Windows e il nome utente dell'utente connesso

o Comment (Commento): l'ultimo commento salvato

o Signature (Firma): la firma elettronica dell'ultima persona che ha firmato il file

o Signature reason (Motivo della firma): il motivo della firma

o Application (Applicazione): CFX Maestro Dx SE

o Application version (Versione dell'applicazione): la versione corrente di CFX Maestro Dx SE

o Full user (Utente completo): il nome completo dell'utente connesso

o Machine (Computer): il computer su cui CFX Maestro Dx SE è installato

n Dettagli della modifica dell'audit
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o Object (Oggetto): l'elemento che è stato modificato (l'elemento controllato)

o Old value (Vecchio valore): il valore precedente

o New value (Nuovo valore): il nuovo valore

o Description (Descrizione): la descrizione della modifica

Per visualizzare l'audit trail

u Nel file di dati o di studio dei geni aperto, selezionare View > Audit Trail (Visualizza > Audit Trail).
Viene visualizzato l’audit trail del file.

Per impostazione predefinita, i dati vengono ordinati per data e ora e tutti gli eventi vengono
visualizzati nella vista espansa. È possibile filtrare la visualizzazione per nome utente e oggetto e
comprimere la visualizzazione espansa per ordinarla in tutta semplicità in base a qualsiasi campo di
intestazione. È inoltre possibile visualizzare l'audit trail come report html.

Per ordinare per nome utente

u Dall'elenco a discesa User Name (Nome utente), selezionare l’utente di destinazione.

Per ordinare per oggetto

u Dall'elenco a discesa Object (Oggetto), selezionare la destinazione.

Per nascondere la descrizione completa degli eventi

u Fare clic su Collapse All (Comprimi tutto).
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Per ordinare i dati nella tabella dei dettagli delle modifiche

u Fare clic sul simbolo del rombo nell'intestazione della colonna di dati per eseguire un ordinamento
crescente (dalla A alla Z, dal numero più piccolo al più grande o dal meno recente al più recente).

Per stampare l'audit trail

1. Fare clic su HTML Report (Report HTML) per visualizzare l'audit trail in un browser web.

2. Nella finestra del browser, eseguire una delle seguenti operazioni:

n Selezionare File > Print (File > Stampa).

n Fare clic con il pulsante destro del mouse sul report e scegliere Print (Stampa).

Eventi controllabili
CFX Maestro Dx SE acquisisce i seguenti eventi controllabili nei file di dati e di studio dei geni.

Eventi controllabili durante l'esecuzione

n Orario di inizio esecuzione

n Modifiche del tempo di esecuzione piastra

n Modifiche del tempo di esecuzione protocollo

n Orario di fine esecuzione

Eventi controllabili quando viene creato un file di dati

n File di dati creato

n Letture interpolate piastra aggiunte dal sistema

Eventi controllabili quando viene salvato un file di dati

n General (Generale)

o Name (Nome)

o Signing (Firma)

o Plate Setup (Impostazione piastra)

o Display Wells (Visualizza pozzetti)

o Analyzed fluorophores (Fluorofori analizzati)

o Plate edits (Modifiche alla piastra)

o Analysis Mode (Modalità di analisi)
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o PCR Active Well Group (Gruppo pozzetti attivi PCR)

n Scheda Quantification (Quantificazione)

o Active step (Fase attiva)

o Settings (Impostazioni) - Cq Determination mode (Modalità di determinazione Cq)

o Settings (Impostazioni) - Baseline Setting (Impostazione linea basale).

o Drift correction applied (Correzione della deriva applicata)

o Settings (Impostazioni) - Cycles to Analyze (Cicli da analizzare)

o Settings (Impostazioni) - Analysis Mode (Modalità di analisi)

o Settings (Impostazioni) - Baseline Threshold (Soglia linea basale)

n Scheda Melt Curve (Curva di fusione)

o Active step (Fase attiva)

o Peak type displayed (Tipo di picco visualizzato)

o Peak analysis threshold (Soglia di analisi del picco)

n Scheda End Point (Punto finale)

o Active fluorophore/target (Fluoroforo attivo/target)

o End cycles to average (Cicli finali per media)

o Tolerance calculation method (Metodo di calcolo della tolleranza)

o Percentage of range (Percentuale di intervallo)

n Scheda Allelic Discrimination (Discriminazione allelica)

o X- and Y-axis fluorophore (Fluoroforo assi X e Y)

o Select cycle number (Seleziona numero di ciclo)

o View call map (Visualizza mappa delle chiamate)

n Scheda Gene Expression (Espressione genica) - All plots (Tutti i grafici)

o Experiment Settings (Impostazioni esperimento) - Target reference (Riferimento target)

o Experiment Settings (Impostazioni esperimento) - Sample control (Controllo campione)

o Experiment Settings (Impostazioni esperimento) - Auto efficiency (Efficienza automatica)

o Experiment Settings (Impostazioni esperimento) - Efficiency (Efficienza)
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n Scheda Gene Expression (Espressione genica) - Graphing (Rappresentazione grafica)

o Analysis Mode (Modalità di analisi)

o Graph data (Dati su grafico)

o X-axis (Asse X)

o Y-axis (Asse Y)

o Opzione Scaling (Scala)

o Error bar (Barra di errore)

o Error bar multiplier (Moltiplicatore barre di errore)

o P-Value Threshold (Soglia valore p)

n Scheda Gene Expression (Espressione genica) - Clustergram (Diagramma di gruppo)

o Cluster By (Raggruppa per)

o Split out replicates (Dividi replicati)

n Scheda Gene Expression (Espressione genica) - Scatter Plot (Grafico di dispersione)

o Control biological group (Gruppo biologico di controllo)

o Experimental biological group (Gruppo biologico sperimentale)

o Fold change threshold (Soglia fold change)

n Scheda Gene Expression (Espressione genica) - ANOVA

o P-Value Threshold (Soglia valore p)

n Plate Setup (Impostazione piastra) - View/Edit Plate (Visualizza/Modifica piastra)

o Settings (Impostazioni) - PlateType (Tipo piastra)

o Settings (Impostazioni) - Units (Unità)

o Editing Tools (Strumenti di modifica) - Flip Plate (Capovolgi piastra)

o Well groups (Gruppi di pozzetti)

o Plate fluorophores (Fluorofori piastra)

n Plate Setup (Impostazione piastra) - Replace Plate (Sostituisci piastra) e Apply PrimePCR File
(Applica file PrimePCR)

o Plate Setup Import (Importazione impostazioni piastra)
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Modifiche di audit per i file di studio dei geni

General (Generale)

n Name (Nome)

n Scheda Study Setup (Impostazione studio)

o Add/Remove data files (Aggiungi/Rimuovi file di dati)

n Scheda Study Analysis (Analisi dello studio)
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È possibile configurare il Software CFX Maestro Dx, Security Edition per l’uso con un sistema di gestione
delle informazioni di laboratorio (LIMS, Laboratory Information Management System). Per l’integrazione
LIMS, CFX Maestro Dx SE richiede le informazioni di impostazione piastra generate dalla piattaforma
LIMS (un file LIMS, *.plrn), un file di protocollo creato usando CFX Maestro Dx SE (*.prcl), un percorso di
esportazione dati definito e un formato di esportazione definito.

Al termine dell’analisi, CFX Maestro Dx SE genera un file di dati (.pcrd) e lo salva in un percorso della
cartella di esportazione dei dati definita. CFX Maestro Dx SE può anche creare un file di dati compatibile
con LIMS in formato .csv e salvarlo nello stesso percorso.

Creazione di file di dati compatibili con LIMS
In questa appendice viene spiegato come impostare CFX Maestro Dx SE per creare, salvare ed
esportare file di dati compatibili con LIMS.

Impostazione della cartella LIMS e delle opzioni per l’esportazione
dei dati
Per impostazione predefinita, CFX Maestro Dx SE salva i protocolli LIMS, i file e i file di esportazione dati
in questa cartella:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

È possibile configurare CFX Maestro Dx SE per salvare i file in un’altra cartella e modificare le opzioni di
esportazione per i dati LIMS.

Per impostare la cartella LIMS e le opzioni di esportazione dati

1. Nella finestra Home (Home), selezionare Tools > Options (Strumenti > Opzioni).

2. Nella finestra di dialogo Options (Opzioni), selezionare Data Export Settings (Impostazioni
esportazione dati).
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3. (Opzionale) Selezionare Automatically export LIMS data at end of run (Esportare automaticamente i
dati LIMS al termine dell’analisi).

Il software esporterà automaticamente i dati LIMS dopo ogni analisi e li salverà nella posizione
specificata.

4. Per modificare le opzioni di esportazione predefinite per i dati LIMS, fare clic su LIMS Data Export
Settings (Impostazioni esportazione dati LIMS).

Importante: solo i dati LIMS esportati come file .csv possono essere reimportati in CFX Maestro
Dx SE.

5. Nella finestra di dialogo LIMS Data Export Format Settings (Impostazioni formato esportazione dati
LIMS), selezionare le opzioni di esportazione desiderate, quindi fare clic su OK.

6. Nella finestra di dialogo Options (Opzioni), navigare e selezionare una cartella predefinita nella quale
si desidera selezionate il file di dati LIMS. È possibile selezionare un percorso diverso per ciascun
tipo di file:

n Protocol (Protocollo)

n File LIMS
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n Esportazione dati

7. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo Options (Opzioni).

Creazione di un protocollo LIMS
Per avviare un’analisi LIMS, creare un file di protocollo CFX Maestro Dx SE (*.prcl) e salvarlo nel percorso
della cartella del protocollo LIMS designato.

Per ulteriori informazioni, vedere il Capitolo 7, Creazione di protocolli.

Creazione di un file LIMS
Un file LIMS (*.plrn) include i dettagli di impostazione della piastra e il nome file del protocollo. Questo file
viene generato dal proprio LIMS interno. CFX Maestro Dx SE utilizza il file LIMS per creare un file piastra
da utilizzare con un file protocollo.

CFX Maestro Dx SE fornisce modelli di file di importazione piastra che è possibile modificare per creare
file piastra LIMS personalizzati.

Suggerimento: tale attività deve essere eseguita da personale esperto di LIMS.

Per creare un file LIMS

1. Nella finestra Home, selezionare View > Show > LIMS File Folder (Visualizza > Mostra > Cartella file
LIMS).

2. Aprire la cartella dei modelli LIMS e selezionare un file .csv da importare nel LIMS interno.

3. Modificare il file modello compilando i campi obbligatori elencati nella Tabella 38.

4. Eseguire una delle seguenti operazioni:

n Per salvare le modifiche per un utilizzo futuro, salvare il file come file .csv.

n Per salvare le modifiche e utilizzare il file immediatamente, salvare il file con l'estensione .plrn.

n Salvare il modello con l’estensione nome file .plrn nella cartella dei file LIMS.

Importante: CFX Maestro Dx SE può aprire solo il file .plrn. È necessario salvare il file .csv
come .plrn per avviare l'analisi LIMS.
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Colonna Riga Descrizione Contenuto Scopo

A 1 Plate Header (Intestazione
piastra)

Non modificare Predefinito

A,B,C 2 Field/Data/Instruction
(Campo/Dati/Istruzione)

Non modificare Predefinito

B 3 Version (Versione) Non modificare Predefinito

B 4 Plate Size (Dimensione
piastra)

Non modificare Predefinito

B 5 Plate Type (Tipo di piastra) Inserire “BRWhite”,
“BR Clear” o un altro
tipo di piastra calibrata

Obbligatorio

B 6 Scan Mode (Modalità di
scansione)

Inserire “SYBR/FAM
Only:” (Solo
SYBR/FAM), “All
Channels” (Tutti i
canali) o “FRET”
(FRET)

Obbligatorio

Tabella 38. Definizione del contenuto del file .csv LIMS
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Colonna Riga Descrizione Contenuto Scopo

B 7 Units (Unità) Inserire una delle
seguenti voci “copy
number” (numero di
copie), “fold dilution”
(diluizione fold),
“micromoles”
(micromoli),
“nanomoles”
(nanomoli),
“picomoles”
(picomoli),
“femtomoles”
(femtomoli),
“attomoles” (attomoli),
“milligrams”
(milligrammi),
“micrograms”
(microgrammi),
“nanograms”
(nanogrammi),
“picograms”
(picogrammi),
“femtograms”
(femtogrammi),
“attograms”
(attogrammi) o
“percent”
(percentuale)

Obbligatorio

B 8 Run ID (ID analisi) Inserire una
descrizione breve o il
codice a barre che
identifichi questa
analisi (massimo 30
caratteri, non sono
consentite virgole)

Facoltativo

Tabella 38. Definizione del contenuto del file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

B 9 Run Notes (Note analisi) Inserire una
descrizione per
l’analisi

Facoltativo

B 10 Run Protocol (Protocollo
analisi)

Inserire il nome file
protocollo
esattamente come
elencato.

Obbligatorio

A 11 Data File (File di dati) Inserire il nome file di
dati

Facoltativo

A 12-15 TBD/Empty (TBD/Vuoto) Non modificare Predefinito

A 16 Plate Data (Dati piastra) Non modificare Predefinito

A 17-113 Well Position (Posizione
pozzetto)

Non modificare Predefinito

B-G Ch1 Dye (Colorante Ch1),
Ch2 Dye (Colorante Ch2),
Ch3 Dye (Colorante Ch3),
Ch4 Dye (Colorante Ch4),
Ch5 Dye (Colorante Ch5),
FRET

Inserire un nome
colorante calibrato
(per esempio, “FAM”)
per ciascun canale
usato

Obbligatorio

H Sample Type (Tipo
campione)

Inserire uno dei
seguenti tipi di
campione: “Unknown”
(Sconosciuto),
“Standard”
(Standard), “Positive
Control” (Controllo
positivo), “Negative
Control” (Controllo
negativo), “NTC”
(Nessun controllo
modello) o “NRT”
(Nessun controllo di
trascrittasi inversa)

Obbligatorio

Tabella 38. Definizione del contenuto del file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

I Sample Name (Nome del
campione)

Inserire il nome
campione

Facoltativo

J-O CH1 Target (Target CH1),
CH2 Target (Target CH2),
CH3 Target (Target CH3),
CH4 Target (Target CH4),
CH5 Target (Target CH5),
FRET Target (Target FRET)

Inserire il nome target
per ciascun canale
usato

Facoltativo

P Collection Name (Nome
raccolta)

Inserire il nome del set
biologico

Facoltativo

Q Replicate (Replicato) Inserire un valore
intero positivo per
ciascun set di replicati.
Il valore non può
essere zero.

Facoltativo

R-W CH1 Quantity (Quantità
CH1), CH2 Quantity
(Quantità CH2), CH3
Quantity (Quantità CH3),
CH4 Quantity (Quantità
CH4), CH5 Quantity
(Quantità CH5), FRET
Quantity (Quantità FRET)

Inserire i valori relativi
alle quantità per ogni
standard. Inserire la
concentrazione in
forma decimale.

Obbligatorio per
tutti gli standard

Tabella 38. Definizione del contenuto del file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

X Well Note (Nota pozzetto) Inserire la nota
pozzetto (massimo 20
caratteri)

Nota: sebbene
CFX Maestro Dx
SE abbia un
limite di 20
caratteri per
l’inserimento di
note in Well Note
(Nota pozzetto)
tramite il
software, il
campoWell Note
(Nota pozzetto)
può contenere
fino a 500
caratteri se
incluso in un file
.plrn importato.
Tuttavia,
CFX Maestro Dx
SE visualizzerà
solo i primi 20
caratteri. Il file
.pcrd esportato
conterrà tutti i
caratteri nel
campoWell Note
(Nota pozzetto);
nessun dato
andrà perso.

Facoltativo

Tabella 38. Definizione del contenuto del file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

Y-AD Ch1Well Color (Colore
pozzetto Ch1), Ch2Well
Color (Colore pozzetto
Ch2), Ch3Well Color
(Colore pozzetto Ch3), Ch4
Well Color (Colore pozzetto
Ch4), Ch5Well Color
(Colore pozzetto Ch5),
FRETWell Color (Colore
pozzetto FRET)

Inserire un colore stile
tracce definito
dall’utente in formato
decimale (argb) intero
a 32 bit

Facoltativo

Tabella 38. Definizione del contenuto del file .csv LIMS, continua

Avvio di un’analisi LIMS
Per avviare un’analisi LIMS

1. Per aprire un file LIMS .plrn, eseguire una delle seguenti operazioni:

n Nella finestra Home, selezionare View > Show > LIMS File Folder (Visualizza > Mostra >
Cartella file LIMS) e aprire il file .plrn target.

n Nella finestra Home, selezionare File > Open > LIMS File (File > Apri > File LIMS) e aprire il file
.plrn target.

Il file viene aperto nella scheda Start Run (Avvia analisi) nella procedura guidata Run Setup
(Impostazione analisi). La scheda Start Run (Avvia analisi) visualizza le informazioni relative
all’esperimento da eseguire. Visualizza anche il blocco o i blocchi di strumenti collegati sui quali è
possibile eseguire l’esperimento.

2. Nella scheda Start Run (Avvia analisi), selezionare uno strumento e fare clic su Start Run (Avvia
analisi).
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Esportazione dei dati in un LIMS
Una volta completata l’analisi, CFX Maestro Dx SE genera un file di dati (.pcrd) e lo salva nel percorso
della cartella di esportazione dei dati definita.

Per esportare il file di dati in un LIMS

u Aprire il file .pcrd e selezionare Export > Export to LIMS Folder (Esporta > Esporta nella cartella
LIMS).

Suggerimento: se si seleziona Automatically Export Data after Run (Esporta automaticamente i dati
dopo l’analisi) nelle opzioni LIMS, CFX Maestro Dx SE crea un file di dati compatibile con LIMS in
formato .csv e lo salva nella stessa cartella.
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Software CFX Maestro Dx, Security Edition

In questa appendice vengono forniti suggerimenti per la risoluzione dei problemi che potrebbero
verificarsi durante l'aggiornamento o l'esecuzione del Software CFX Maestro Dx, Security Edition.

File e cartelle del Software CFX Maestro Dx, Security Edition
consentiti

Per la protezione da virus e malware, il reparto IT potrebbe aver implementato misure di sicurezza
software molto rigide. Queste misure potrebbero influire sul tempo di aggiornamento o esecuzione di
CFX Maestro Dx SE.

Per migliorare le prestazioni di CFX Maestro Dx SE, Bio-Rad consiglia al reparto IT di inserire nell’elenco
degli elementi consentiti i seguenti file e cartelle nelle impostazioni del firewall del software antivirus
installato sul computer CFX Maestro Dx SE:

Cartelle

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

File

n Tutti i file .exe che si trovano nella cartella C:\Program Files (x86)\Bio-Rad\CFX_MDx

n R.exe e Rscript.exe (che si trovano nella cartella C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\bin)
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Registro dell’applicazione
Prima di iniziare una nuova analisi, il sistema CFX Opus Dx avvia un test di autodiagnostica per verificare
che stia funzionando secondo le specifiche. Il software registra i risultati di questo test nel file di registro
dell’applicazione e dell’analisi. Se si nota un problema in uno o più esperimenti, aprire i registri dell’analisi
e dell’applicazione per individuare l’origine del problema.

CFX Maestro Dx SE Dx tiene traccia delle informazioni sullo stato di uno strumento durante un’analisi nel
registro dell’applicazione. Utilizzare questi registri per tenere traccia degli eventi che si verificano sugli
strumenti e nel software e per la risoluzione dei problemi.

Per aprire il registro dell’applicazione

u Nella finestra Home, selezionare View > Application Log (Visualizza > Registro applicazione).

Per visualizzare il registro dell'applicazione come file HTML, fare clic sul pulsante HTML Report
(Report HTML).
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Recupero dei file di registro dell'applicazione e del firmware
I registri dell'applicazione e del firmware contengono informazioni che descrivono in dettaglio le azioni
eseguite durante l'uso del software e le prestazioni delle analisi. Questi registri registrano anche eventuali
errori software o firmware che si verificano durante il funzionamento del software o dello strumento.

Per accedere ai file di registro dell'applicazione e del firmware:

1. Nel riquadro Detected Instruments (Strumenti rilevati), fare clic con il pulsante destro del mouse sullo
strumento.

2. Selezionare Retrieve Log Files (Recupera file di registro).

3. Nella finestra di dialogo Browse for Folder (Sfoglia per cartelle), selezionare la cartella di
destinazione sulla rete o un'unità locale in cui si desidera salvare i file di registro.

Nota: la cartella è denominata "Logs” (Registri).

4. Fare clic su OK per salvare i file.

Importante: il salvataggio di un file di registro con lo stesso nome di un file di registro esistente
sovrascriverà il file di registro esistente.

Risoluzione dei problemi
I problemi di comunicazione tra software e strumento possono essere risolti tipicamente riavviando il
computer e il sistema. Assicurarsi di salvare il lavoro in corso prima di eseguire il riavvio.

Nota: verificare che sul computer siano disponibili RAM e spazio libero su disco sufficienti. Lo spazio
libero minimo per la RAM è 4 GB e quello per il disco rigido è 128 GB.

Interruzione di alimentazione
In caso di interruzione dell’alimentazione, lo strumento e il computer si spegneranno. Se l’interruzione di
alimentazione è breve, lo strumento riprenderà ad eseguire un protocollo, ma nel registro di applicazione
sarà annotata l’interruzione di alimentazione. In base alle impostazioni del computer e alla durata
dell’interruzione dell’alimentazione, lo strumento e il software tentano di riprendere a funzionare in base
alla fase del protocollo:

n Se il protocollo è in una fase che non prevede alcuna lettura piastra, il protocollo riprende a
funzionare non appena viene ripristinata l’alimentazione.

n Se il protocollo è in una fase che prevede una lettura piastra, lo strumento attende che il software si
riavvii e riprenda la comunicazione per raccogliere i dati. In questa situazione, il protocollo continua
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solo se il software non viene spento dal computer. Quando il computer e il software vengono riavviati,
il protocollo riprende.

Trasferimento di file nel computer CFX Maestro Dx SE
È possibile trasferire file di dati e di registro presenti nello strumento sul disco rigido di un computer
CFX Maestro Dx SE collegato.

Suggerimento: tutti i file presenti nella cartella dei dati in tempo reale della base dello strumento
vengono trasferiti nel computer.

Nota: dagli strumenti CFX Opus Dx, è possibile trasferire solo i file di registro. Tutti i file di registro
sullo strumento vengono trasferiti nel computer.

Per recuperare i file dallo strumento

1. Nel riquadro Detected Instruments (Strumenti rilevati) della finestra Home, fare clic con il pulsante
destro del mouse sullo strumento desiderato e selezionare Retrieve Log Files (Recupera file di
registro).

2. Scegliere un percorso della cartella in cui salvare i file recuperati.

3. Fare clic su OK.

Installazione manuale del Software CFX Maestro Dx, Security
Edition
Per installare manualmente CFX Maestro Dx SE

1. Se necessario, scollegare dal computer tutti gli strumenti collegati.

Individuare e scollegare il cavo USB dello strumento sul computer CFX Maestro Dx SE. L’estremità
collegata allo strumento può rimanere inserita.

2. Accedere al computer CFX Maestro Dx SE con i privilegi amministrativi.

3. Inserire l’unità USB di CFX Maestro Dx SE nella porta USB del computer.

4. In Windows Explorer (Esplora risorse), accedere e aprire l’unità USB di CFX Maestro Dx SE.

5. Aprire la cartella CFX e fare doppio clic su CFXMaestroDxSetup.exe per installare CFX Maestro Dx
SE.

6. Seguire le istruzioni visualizzate sullo schermo per installare il software.

Al termine, sullo schermo del computer viene visualizzata la schermata iniziale del Software
CFX Maestro Dx, Security Edition Bio-Rad e sul desktop viene visualizzata l’icona del Software
CFX Maestro Dx, Security Edition Bio-Rad.
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7. Rimuovere in sicurezza l’unità USB del software e avviare CFX Maestro Dx SE.

Reinstallazione dei driver
Per reinstallare i driver dello strumento

u Nella finestra Home, selezionare Tools > Reinstall Instrument Drivers (Strumenti > Reinstalla driver
strumento).

Nota: in caso di problemi di comunicazione del software con un sistema in tempo reale dopo avere
reinstallato i driver e aver controllato la connessione USB, contattare l’assistenza tecnica di Bio-Rad.
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This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output

Guida per l’utente | 337



Appendice E Bio-Rad Free and Open-Source Notices for PCR Products

from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Avviso di copyright Minpack (1999) Università di Chicago. Tutti i diritti riservati.

La ridistribuzione e l’utilizzo nei formati sorgente e binario, con o senza modifiche, sono consentiti purché
vengano soddisfatte le seguenti condizioni:

1. La ridistribuzione in formato sorgente deve mantenere l’avviso sul copyright riportato sopra, il
presente elenco di condizioni e la seguente dichiarazione di non responsabilità.

2. La ridistribuzione in formato binario deve riprodurre l’avviso sul copyright riportato sopra, il presente
elenco di condizioni e la seguente dichiarazione di non responsabilità nella documentazione e/o in
qualsiasi altro materiale fornito con la distribuzione.

3. La documentazione per l’utente finale inclusa con la ridistribuzione, se esistente, deve includere la
seguente citazione:

“Questo prodotto include il software sviluppato dalla University of Chicago, come Operator of Argonne
National Laboratory.”
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